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1 Introduction

PhytéGn

CPI2-Gx Gang
In-System Device Programmers

User's Guide

Copyright © 2017-2020, Phyton, Inc. Microsystems and Development Tools, All rights reserved

1.1 Terminology

Terms used in the document

Operations on device mounted on a board in user equipment. ICP is
performed via a cable connecting programmer to the target either directly]
or via needles or pogo contacts.

Same as ISP above.

ISP or in-system
programming

ICP or in-circuit
rogramming

Mode of the in-system programming that is usually defined by the
programming signals voltage or the ISP interface (JTAG, SWD, UART,
SPI, etc.). Distinct ISP modes are enabled for different target devices ang
more than one mode may exist for one device.

A serial flash memory device, microcontroller or programmable logical
device having memory inside which can be programmed by an in-system
device programmer. In CPI2-Gx GUI device nhames comprised of part
numbers (full or reduced) following types of ISP programming modes in
[ ] brackets (for example: PIC10F200 [ISP HV Mode], M25P X80 [ISP
Model]).

[DUT IWice Under Test - same as target device above.

Start and End Addresses [|Physical memory range of target device to perform programming

|(of the Target device) operations (read, write, verify, etc.) on.

Programming Interface On-device port that enables access to the internal memory that includes
but not limited to: SPI, 12C, JTAG, SWD, UART.

© 2021 Phyton, Inc. Microsystems and Development Tools

Target device or Target




18

CPI2-Gx Device Programmers - CPI12-Gx

ISP Mode

different target devices and more than one mode may exist for one
device.

\i/lode of the in-system programming. Distinct ISP modes are enabled for

ISP JTAG Mode

III—n—system programming using JTAG interface.

lisP SWD Mode

Illn-system programming using SWD (single wire debug) interface.

ISP EzPort Mode

Illn—system programming using Freescale proprietary EzPort interface.

[ISP HV Mode Iln—system programming that requires application of relatively high voltage
|to the target device (12V for example).
IFile In the CPI2-Gx context the term file may represent: a) an image of

information on a PC hard drive or other media that is supposed to be
ritten into the target device’s physical memory, or b) an image fetched

from the target device and stored on the disk or other media. Files in

ChipProg can be read from and written to a PC hard drive or CD.

IBuffer or Memory buffer

Buffers are intermediate data holders between data in files and data in
the target device. A buffer is a portion of computer memory (RAM) used
to temporarily store, edit and display data to be written to the target
device or read from the device. User can open any number of buffers of
any size only limited by available computer memory.

IBuffer layer or sub-layer

buffer may hold several layers (also known as sub-layers) that
according to architecture and memory model of a particular target
device. For example, for some microcontrollers one buffer can include
the code and data memory layers (see more details below).

IBuffer size

Buffers size may vary from 128KB to 32GB.

IBuffer start address

The address to display the buffer contents from.

IChecksum

An arithmetic sum of all bytes of data in a specified part of buffer
calculated by programmer to ensure data integrity. The program has a
variety of algorithms for checksum calculation and allows writing the
checksum into a specified location of the target device.

[Command Line mode

Method of controlling a CPI2-Gx in which the user issues commands to
the computer program in the form of successive lines of text (command
lines).

Standalone Operation
IMode

CPI2-Gx device programmer contains internal memory card that can
hold all information that the device programmer needs to run without
further interaction with a PC.

[Project

An integrated set of information that completely describes the target
device, properties of data buffers, programming options and settings, list
of source and destination files with their properties, etc. ChipProg-02
stores projects in the computer memory. Each project with a unique
name can be stored and promptly reloaded for immediate execution.
Usually user creates a project to work with one type of device. Using
projects saves a lot of time during initial configuration of programmer
every time you start working with a new device.

Standalone job (or Job)

This is the same as a project above but the ChipProg-ISP2 stores this

integrated set of information that completely describes the target device,
data to be programmed and other programming options and settings not
in a PC memory but on the SD card inside of the programmer hardware.
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hen a stored job can be launched by applying appropriate electrical
signals from the ATE to the connector CONTROL.

1.2 CPI2-Gx device programmer

ChipProg-ISP2 is a family of in-system device programmers produced by Phyton, Inc. Microsystems
and Development Tools. Currently this family consists of two models: a single-channel CPI2-B1 and
CPI2-Gx gang device programmer. See the ChipProg-ISP2 portfolio on the www.phyton.com.

A CPI2-Gx unit shown on the picture below is enclosed in a plastic housing with a small fan on a top.

Inside of this housing it is implemented as a compact motherboard with upright-positioned CPI12-GM1
plug-in modules. Up to seven CPI2-GM1 modules can be installed on a CPI2-Gx motherboard. Each
CPI2-GM1 module has a demultiplexer, which can be enabled by a special CPI2-DEMUX license.

A CPI2-Gx order code pattern is: CPI2-Gxx/yyPN, where:

CPI2 — the family abbreviation;

G — type of the programmer: gang;
xx —number of direct programming channels (CPI2-GM1 modules plugged to motherboard)*;

yy — number of demultiplexed programming channels (= xx*2);

© 2021 Phyton, Inc. Microsystems and Development Tools
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1.2.1

P — orientation of the programming modules with respect to the motherboard: V for upright position;
N - hardware revision (1, 2, etc.).

The following options are available for ordering:

Programmer model Number of direct channels Number of demultiplexed channels
CPI2-G02/04V1 2 4
CPI2-G03/06V1 3 6
CPI2-G04/08V1 4 8
CPI2-G05/10V1 5 10
CPI2-G06/12V1 6 12
CPI2-G07/14V1 7 14

Important Note. The CPI2-GM1 modules must be installed contiguously on the CPI2-Gx
motherboards. In other words, the placement of the modules must not skip motherboard slots.

CPI2-Gx device programmers are primarily intended for use in test fixtures for programming muilti-
board panels. Multiple CPI2-Gx units can be daisy chained and driven from one computer. The
programmer works under control of the ChipProg-02 software package.

Features Overview

Features Overview

e Custom configurable - can be equipped by 2 to 7 CPI2-GM1 programming modules*

Each CPI2-GM1 module is equipped by a demultiplexer that doubles a number of programming
channels (CPI2-DEMUX license is required).

Up to 10x CPI2-G07/14V1 units can be controlled by a single computer.

Programs devices with Vcc from 1.2V to 5.5V.

Supports JTAG, SWD, SPI, SCI, RC, UART, and other on-chip programming interfaces.
Extremely fast.

Can program some devices at a long distance of up to 5m (~15ft).

Each programming module in the programmer works independently.

USB 2.0 High Speed and LAN 100 Mbit/s communication interfaces.

Each module has memory card that enables stand-alone operations.

ATE interface for stand-alone operations.

Friendly intuitive graphical user interface (GUI).

Simplified graphical user interface for use by unskilled personnel.

Application Control Interface (ACI) with SDK for developers.

ACl enables control from programs in Visual Basic, C, C++, C#, etc.

ACl enables control from National Instrument® LabVIEW ™,

On-the-fly utility allows controlling already launched programmer.

Software includes scripting language.

Project files are protected against hackers and corruption.

* Important Note. The CPI2-GM1 modules must be installed contiguously on the CPI2-Gx
motherboards. In other words, the placement of the modules must not skip motherboard slots.
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1.2.2 Hardware characteristics

Housing Options and Applications

¢ Plastic enclosure that can be easily mounted inside of ATE.

e Compact motherboard with seven mini DIMM slots for plugging in upright universal CPI2-GM1
programming modules. Configurations with 2, 3, 4, 5, 6, or 7 modules can be ordered.

Communication interfaces
e USB 2.0 High-speed.
¢ 100 Mbit/s Ethernet (LAN).

Powering the programmer
e From external power supply 9 to 18V/2.5A (not included).

Powering Targets from the Programmer
¢ Provides the target equipment with the voltages: Vcc (1.2 to 5.5V @ up to 350mA) and Vpp (1.2 to
15V @ up to 80mA).

Control Methods

e From Automated Test Equipment (ATE), In-Circuit Test System (ICT), or programming fixtures; from
command line or via Application Control Interface (DLL).

¢ Integration with National Instruments® LabVIEW ™ software.

¢ On-the-fly management utility allows control of already launched and running device programmer.

e Scripting language for writing user scripts.

¢ Auto programming can be started by closing fixture lid or by connecting a device.

¢ Friendly and intuitive graphical user interface (GUI) for creating and debugging projects.

¢ Optional simplified user interface for unskilled personnel.

Standalone Control

The programmer can work in a standalone mode.

Each programming module stores up to 256 standalone jobs.

4 of these 256 standalone jobs can be launched by ATE signals.

In a standalone mode each module can flash different device type with different data.
Special utility allows monitoring standalone activity on a computer.

Signals to/from the Target (per one CPI2-G01 Module)

¢ Ten input/output lines with logical levels 1.2 to 5.5V that can be individually programmed as
TTL/CMOS logic /0.

e The signal lines above alternate with GND lines for stable programming via long cables.

¢ Two input/output lines which can be individually programmed as TTL logic VOs, GNDs, Vcc or Vpp.

e Each programming module has a built-in, software controllable demultiplexer that double a number of
programming channels for sequential programming.

Control Signals

¢ Start/Stop logic signal for external control.

e Output status signals for external control: BUSY, GOOD and ERROR.
e Two logic inputs for choosing one of 4 preloaded standalone jobs.

Dimensions
o CPI2-Gx unit: 162 x127 x 61 mm (~6-3/8 x 5 x 2-3/8 inch).
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1.2.3

Software features

NOTE. Some of the features and items below may be unavailable by the moment of sale of your CPI2-
Gx device programmer.

System Requirements

Microsoft® Windows™ XP, 7, 8 or 10.

Software Features

Supports loading and saving files in all popular formats.

Unlimited number of data buffers can be open and maintained.

Enables arithmetic operations with data blocks in buffers.

Enables writing serial numbers, MAC addresses and other device-specific parameters into user-
selectable shadow areas of target devices.

Allows writing of user-defined signatures and data blocks into target devices.

Offers several algorithms for calculating checksums.

Special DLL for user-defined checksum calculation.

Writes programming session logs with real time stamps.

The GUI has a special editor for easy setting of device and algorithm parameters, such as fuses, lock
bits, boot loader vectors, etc.

Comprehensive self-test procedure.

Managing Projects and Configurations

The software supports unlimited number of projects.

Project files are protected against hackers and corruption.

The software ensures data integrity - every data transfer to/from a PC or ATE system or memory
card is accompanied with CRC sum.

The software allows storing and retrieving the state of user interface: configurations, colors, fonts, hot
keys and other settable preferences.

Computer Control Methods

From Automated Test Equipment (ATE), In-Circuit Test System (ICT), or programming fixtures.
From command line or via Application Control Interface (DLL).

Integration with National Instruments® LabVIEW ™ software.

On-the-fly management utility allows control of already launched and running device programmer.
Built-in scripting language for writing user scripts. Auto programming can be started by closing fixture
lid or by connecting a device.

Friendly and intuitive graphical user interface (GUI) for creating and debugging projects.

Optional simplified user interface for unskilled personnel.

Standalone Control

The programmer can work in a standalone mode that does not require connection to a computer.
Up to 256 standalone jobs can be stored on memory cards embedded into each programming
modules.

Four of these 256 standalone jobs can be quickly chosen launched by ATE signals or from a
computer.

Special utility allows monitoring standalone activity on a computer.
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1.2.4 Programming channels

CPI2-Gx gang device programmer has two programming channels: A and B. Each of these
channels is comprised by multiple sub-channels (sites) represented by CPI2-GM1 modules. A
CPI2-Gx device programmer may carry two to seven CPI12-GM1 modules. In turn, each CPI12-GM1
module has a miniature mezzanine board - demultiplexer, which by default is disabled. This
demultiplexer can be enabled by activation a special CPI2-DEMUX license. See the diagram below.

© 2021 Phyton, Inc. Microsystems and Development Tools



CPI2-Gx Device Programmers - CPI12-Gx
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While this license is inactive the programmer can work only via the channel A. After activation the
CPI2-DEMUX license the programmer is able to program devices (or boards) via both A and B
channels - not concurrently but by rotation. The ChipProg-02 software allows the user to set the
following options:

¢ Via channel A, only;
¢ Via channel B, only;
¢ Via channel Afirst, then via channel B, etc.;

¢ Via channel B first, then via channel A, etc.;

In the GUIl 41 mode the options above can be chosen in the Program Manager[ 09 tab.

In terms of the electrical and timing characteristics both A and B channels are 100% identical.
Signals and Ground lines of the A and B channels are populated to a pair of connectors
TARGET/ 251 marked on the CPI2-Gx housing's top surface as Channel A and Channel B.

1.2.5 Communication Interfaces

CPI2-Gx is equipped with two communication interfaces: USB 2.0 and Ethernet (LAN) 100 Mbit/s. The
programmer's motherboard carries multi-port USB 2.0 hub and Ethernet 100 Mbit/s switch devices that
distribute communication interfaces to CPI2-GM1 modules installed in the programmer. Sockets for
USB and LAN connections are located on the front panel of the CPI2-Gx unit.

If the programmer is control from a graphical user interface (GUI[ 4, by default the Startup| <2 dialog
prompts the user to connect via USB. An operator may select the Ethernet radio button instead. If the
programmer is controlled from the command line and no ETH (Ethernet) options are specified in the
startup command line, the ChipProg-02 will establish connection with the programmer via USB. In order
to enable Ethernet communication use the ETH command options which are listed in the command
option matrix.

If a CPI2-Gx programmer, or a cluster comprised of multiple CPI12-Gx programmers, is controlled by
Ethernet there are two options of assigning IP addresses for the programming modules: dynamic, or
static IP addresses. By default, if the programmers are controlled via Ethernet, the ChipProg-02
software is set to get IP addresses dynamically distributed by your Internet router. Within a local
network, a DHCP server assigns a local IP address to each CPI2-GM1 module connected to the LAN.
However, it is possible to set unique static IP addresses for each CPI2-GM1 module.

1.2.6 Connector TARGET

TARGET connectors

CPI2-Gx has two 150-pin DIN connectors positioned on the side panels marked as TARGET -
channel Aand TARGET - channel B. Read about programming channels here[23. Signal and
Ground pinouts are shown in tables below.
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Pin #] Pin Name Description Pin #] Pin Name | Description| Pin #] Pin Name Description
Al 1/PA1 |Sitel: digital 10 pinl Bl GND Ground C1 1/PA7 |Sitel: digital 10 pin7
A2 1/PA2 |Sitel: digital 10 pin2 B2 GND Ground Cc2 1/PA8 |Sitel: digital 10 pin8
A3 1/PA3 |Sitel: digital 10 pin3 B3 GND Ground C3 1/PA9 |Sitel: digital 10 pin9
A4 1/PA4 |Sitel: digital IO pin4 B4 GND Ground c4 1/PA10 [Sitel: digital IO pin10
A5 1/PA5 [Sitel: digital 10 pin5 B5 GND Ground C5 1/PA11 [Sitel: digital 10 pinll
A6 1/PA6 |Sitel: digital 10 pin6 B6 GND Ground C6 1/PA12 [Sitel: digital IO pin12
A7 1/RCA [Signal relay control B7 GND Ground C7 1/GRCA |Ground relay control
A8 2/PA1  [Site2: digital 1O pinl B8 GND Ground C8 2/PA7 [Site2: digital IO pin7
A9 2/PA2 [Site2: digital 10 pin2 B9 GND Ground C9 2/PA8 [Site2: digital 10 pin8

Al0 2/PA3 [Site2: digital IO pin3 B10 GND Ground C10 2/PA9 [Site2: digital IO pin9

All 2/PA4  [Site2: digital 1O pind B11 GND Ground Cl1 ) 2/PA10 [Site2:digital IO pin10

A12 2/PA5 [Site2: digital 1O pin5 B12 GND Ground Cl2 | 2/PAl11 [Site2:digital IO pin11

Al3 2/PA6 [Site2: digital IO pin6 B13 GND Ground C13 | 2/PA12 [Site2:digital 10 pin12

Al4 2/RCA |[Notforusers B14 GND Ground Cl4 | 2/GRCA [Notforusers

Al5 3/PA1 [Site3: digital IO pinl B15 GND Ground C15 3/PA7 |Site3: digital IO pin7

Al16 3/PA2 [Site3: digital 1O pin2 B16 GND Ground C16 3/PA8 [Site3: digital IO pin8

A17 3/PA3 [Site3: digital 1O pin3 B17 GND Ground C17 3/PA9 [Site3: digital IO pin9

Al8 3/PA4  |Site3: digital IO pind B18 GND Ground C18 | 3/PA10 [Site3: digital IO pin10

A19 3/PA5 [Site3: digital IO pin5 B19 GND Ground C19 | 3/PAl1l [Site3:digital IO pin11

A20 3/PA6 [Site3: digital IO pin6 B20 GND Ground C20 | 3/PA12 [Site3:digital IO pinl12

A21 3/RCA |[Notfor users B21 GND Ground C21 | 3/GRCA |Notfor users

A22 GND  |Ground B22 GND Ground C22 GND [Ground

A23 4/PA1 |Site4: digital IO pinl B23 GND Ground c23 4/PA7 |Site4: digital IO pin7

A24 4/PA2 [Site4: digital IO pin2 B24 GND Ground C24 4/PA8 [Site4: digital IO pin8

A25 4/PA3 [Site4: digital IO pin3 B25 GND Ground C25 4/PA9 [Site4: digital IO pin9

A26 4/PA4  [Site4: digital 10 pin4 B26 GND Ground C26 | 4/PA10 [Site4: digital 10 pin10

A27 4/PA5 [Site4: digital IO pin5 B27 GND Ground C27 | 4/PA11 [Site4:digital 1O pin11

A28 4/PA6 |Site4: digital IO pin6 B28 GND Ground C28 | 4/PA12 [Site4: digital 10 pin12

A29 | 4/RCA |[Notforusers B29 GND Ground C29 | 4/GRCA |Notfor users

A30 5/RCA [Not for users B30 GND Ground C30 | 5/GRCA |Notfor users
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A31 5/PA1 [Site5: digital 10 pinl B31 GND Ground C31 5/PA7 [Site5: digital 1O pin7
A32 5/PA2 [Site5: digital 10 pin2 B32 GND Ground C32 5/PA8 [Site5: digital 10 pin8
A33 5/PA3 [Site5: digital 10 pin3 B33 GND Ground C33 5/PA9 [Site5: digital 10 pin9
A34 5/PA4 [Site5: digital 10 pind B34 GND Ground C34 | 5/PA10 [Site5: digital 1O pin10
A35 5/PA5 [Site5: digital 10 pin5 B35 GND Ground C35 ] 5/PA1l1 [Site5: digital 10O pin11
A36 5/PA6 [Site5: digital 10 pin6 B36 GND Ground C36 | 5/PA12 [Site5: digital 10 pinl12
A37 6/RCA |[Notforusers B37 GND Ground C37 | 6/GRCA [Notforusers
A38 6/PALl [Site6: digital 10 pinl B38 GND Ground C38 6/PA7 [Site6: digital 10 pin7
A39 6/PA2 [Site6: digital 1O pin2 B39 GND Ground C39 6/PA8 [Site6: digital IO pin8
A40 6/PA3 [Site6: digital 10 pin3 B40 GND Ground C40 6/PA9 [Site6: digital 1O pin9
A41 6/PA4  [Site6: digital 10 pind B41 GND Ground C41 ]| 6/PA10 [Site6: digital 10 pin10
A42 6/PA5 [Site6: digital 1O pin5 B42 GND Ground C42 | 6/PA1l [Site6: digital IO pin11
A43 6/PA6 [Site6: digital 1O pin6 B43 GND Ground C43 | 6/PA12 [Site6: digital IO pinl12
Ad4 7/IRCA [Notforusers B44 GND Ground C44 | 7/GRCA |Notfor users
A45 7/PA1  [Site7: digital 1O pinl B45 GND Ground C45 7/PA7 [Site7: digital 1O pin7
A46 7/PA2  [Site7: digital 10 pin2 B46 GND Ground C46 7/PA8 [Site7: digital 10 pin8
A4T7 7/PA3  [Site7: digital 1O pin3 B47 GND Ground C47 7/PA9 [Site7: digital 1O pin9
A48 7/PA4  [Site7: digital 1O pin4 B48 GND Ground C48 | 7/PA10 [Site7:digital IO pin10
A49 7/PA5 [Site7: digital IO pin5 B49 GND Ground C49 | 7/PAl11 [Site7: digital 10 pin1l
A50 7/PA6 [Site7: digital 1O pin6 B50 GND Ground C50 | 7/PA12 [Site7:digital 1O pin12
| |'\_-' =
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Pin #] Pin Name Description Pin #] Pin Name | Description | Pin #] Pin Name Description
A50 1/PB1 |Sitel: digital IO pinl B50 GND Ground C50 1/PB7 |Sitel: digital IO pin7
A49 1/PB2 |Sitel: digital 10 pin2 B49 GND Ground C49 1/PB8 |Sitel: digital 10 pin8
A48 1/PB3 |Sitel: digital 10 pin3 B48 GND Ground C48 1/PB9 |Sitel: digital 10 pin9
A47 1/PB4 |Sitel: digital 10 pin4 B47 GND Ground C47 | 1/PB10 [Sitel: digital IO pin10
A46 1/PB5 |Sitel: digital IO pin5 B46 GND Ground C46 | 1/PB11 [Sitel: digital 10 pin11
A45 1/PB6 |Sitel: digital IO pin6 B45 GND Ground C45 ] 1/PB12 [Sitel: digital 10 pin12
Ad44 1/RCB [Notfor users B44 GND Ground C44 | 1/GRCB [Notfor users
A43 2/PB1 [Site2:digital 1O pinl B43 GND Ground C43 2/PB7 [Site2: digital 1O pin7
A42 2/PB2 [Site2: digital 1O pin2 B42 GND Ground C42 2/PB8 [Site2: digital IO pin8
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Ad1 2/PB3 [Site2: digital 10 pin3 B41 GND Ground c41 2/PB9 [Site2: digital IO pin9
A40 2/PB4 [Site2: digital 10 pin4 B40 GND Ground C40 | 2/PB10 [Site2: digital 10 pin10
A39 2/PB5 [Site2: digital IO pin5 B39 GND Ground C39 | 2/PB11 [Site2:digital 10 pinll
A38 2/PB6 [Site2: digital 1O pin6 B38 GND Ground C38 | 2/PB12 [Site2: digital IO pin12
A37 ]| 2/RCB |[Notforusers B37 GND Ground C37 | 2/GRCB |Notfor users
A36 3/PB1 [Site3: digital IO pinl B36 GND Ground C36 3/PB7 [Site3: digital IO pin7
A35 3/PB2 [Site3: digital 1O pin2 B35 GND Ground C35 3/PB8 [Site3: digital IO pin8
A34 3/PB3 [Site3: digital IO pin3 B34 GND Ground C34 3/PB9 [Site3: digital IO pin9
A33 3/PB4 [Site3: digital 1O pin4 B33 GND Ground C33 | 3/PB10 [Site3:digital IO pin10
A32 3/PB5 [Site3: digital 1O pin5 B32 GND Ground C32 | 3/PB11 [Site3:digital IO pin11
A31 3/PB6 [Site3: digital IO pin6 B31 GND Ground C31 | 3/PB12 [Site3:digital 10 pin12
A30 ] 3/RCB |Signal relay control B30 GND Ground C30 | 3/GRCB [Notforusers
A29 GND  |Ground B29 GND Ground C29 GND  [Ground
A28 4/PB1 [Site4: digital IO pinl B28 GND Ground C28 4/PB7 [Site4: digital IO pin7
A27 4/PB2 [Site4: digital IO pin2 B27 GND Ground c27 4/PB8 [Site4: digital IO pin8
A26 4/PB3 |Site4: digital IO pin3 B26 GND Ground C26 4/PB9 |Site4: digital IO pin9
A25 4/PB4 [Site4: digital IO pin4 B25 GND Ground C25 | 4/PB10 [Site4: digital IO pin10
A24 4/PB5 [Site4: digital IO pin5 B24 GND Ground C24 | 4/PB11 [Site4:digital IO pin11
A23 4/PB6 [Site4: digital 10 pin6 B23 GND Ground C23 | 4/PB12 [Site4: digital 10 pin12
A22 | 4/RCB |[Notforusers B22 GND Ground C22 | 4/GRCB |Notfor users
A21 ]| 5/RCB |[Notforusers B21 GND Ground C21 | 5/GRCB |Notfor users
A20 5/PB1 [Site5: digital 1O pinl B20 GND Ground C20 5/PB7 [Site5: digital 1O pin7
A19 5/PB2 [Site5: digital 10 pin2 B19 GND Ground C19 5/PB8 [Site5: digital 1O pin8
A18 5/PB3 [Site5: digital 10 pin3 B18 GND Ground C18 5/PB9 [Site5: digital 1O pin9
A17 5/PB4 [Site5: digital 10 pind B17 GND Ground C17 | 5/PB10 [Site5: digital 1O pin10
Al6 5/PB5 [Site5: digital IO pin5 B16 GND Ground C16 | 5/PB11 [Site5: digital 10 pinll
Al5 5/PB6 [Site5: digital 10 pin6 B15 GND Ground C15 ) 5/PB12 [Site5: digital IO pin12
Al4 ]| 6/RCB |[Notforusers B14 GND Ground Cl14 | 6/GRCB |Notfor users
A13 6/PB1 [Site6: digital 1O pinl B13 GND Ground C13 6/PB7 [Site6: digital 1O pin7
Al12 6/PB2 [Site6: digital 10 pin2 B12 GND Ground C12 6/PB8 [Site6: digital 1O pin8
All 6/PB3 [Site6: digital IO pin3 B11 GND Ground C11 6/PB9 [Site6: digital IO pin9
Al10 6/PB4 [Site6: digital 1O pin4 B10 GND Ground C10 | 6/PB10 [Site6: digital IO pin10
A9 6/PB5 [Site6: digital 10 pin5 B9 GND Ground C9 6/PB11 [Site6: digital IO pinl1l
A8 6/PB6 [Site6: digital 1O pin6 B8 GND Ground C8 6/PB12 [Site6: digital IO pin12
A7 7/IRCB [Not for users B7 GND Ground C7 | 7/GRCB [Notfor users
A6 7/PB1 [Site7: digital IO pinl B6 GND Ground C6 7/PB7 |Site7: digital IO pin7
A5 7/PB2 [Site7: digital 1O pin2 B5 GND Ground C5 7/PB8 [Site7: digital IO pin8
A4 7/PB3 [Site7:digital 1O pin3 B4 GND Ground c4 7/PB9 [Site7: digital 1O pin9
A3 7/PB4 [Site7: digital 1O pin4 B3 GND Ground C3 7/PB10 [Site7: digital IO pin10
A2 7/PB5 [Site7: digital 10 pin5 B2 GND Ground Cc2 7/PB11 [Site7: digital 10 pin11
Al 7/PB6 [Site7: digital IO pin6 B1 GND Ground Cl | 7/PB12 |Site7: digital IO pin12
Where:

o Site#/PAn and Site#/PBn (n=1...10) - logical signals formed by high-speed buffers that can output
target-specific logic 0 or 1, Vcc or GND levels, according to the chosen target device type. These
lines can output Vcc with levels from 1.2 to 5.5V @ up to 350mA. The buffers are bidirectional, also
serving as inputs when the programmer reads data.
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o Site#/PAm and Site#/PBm (m=11 & 12) — signals formed by high speed mixed-signal circuits that
can also output target-specific logic 0 or 1, Vcc or GND levels according to the type of the chosen
target device. These lines can output Vcc with levels from 1.2 to 5.5V @ up to 350mA. The mixed-
signal buffers are bidirectional, also serving as inputs when the CPI2-Gx programmer reads data. In
addition, these two signals can output Vpp voltage with levels from 1.5V to 15V @ up to 100mA.

The P1...P12 signals are target-specific. A CPI2-Gx user must ensure that the target device (DUT) is
properly connected, according to the target-specific wiring diagram. When programmer is controlled by
the GUI, this connection diagram can be open in the browser by clicking the Connection to the target
device link in the Device Information window.

To “cut off” the target in the stand-by mode or after completion of any programming operation, CPI2-Gx
programmer leaves the P1...P12 signals in high impedance state.

1.2.7 Connector CONTROL

CONTROL connector

A 48-pin DIN connector CONTROL is positioned on the front panel of the CPI2-Gx unit. This connector
is intended for connecting the programmer to Automated Test Equipment (ATE). All signals on this
connector are optically isolated. See below the connector pin assignment and description of the signals
in the matrix below.

Control f Top
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E%Z[E(].E’]EEIE]E[[ =EPEP=P=h=p==(| e

HEHEHEEEY ARAEEEEEEL B
WHEEHESEﬂHHEEHEE_&

Pin # | Pin Name | Description Pin# | Pin Name | Description Pin #| Pin Name Description
Al JVISO lisolated 5v B1 [GND_ISO lisolated Ground C1 |[GND_ISO [JIsolated Ground
A2 [1/JOBSELO|Sitel: Job Sel0 B2 J1/ST_GOO [Site 1: Status: 0 - C2 J1/START |Site 1: 0 - Start
D GOOD
A3 J1/JOBSEL1|Sitel: Job Sell B3 J1/ST_ERR [Site 1: Status: 0 - C3 J1/BUSY Site 1: Status: O - Busy
Error
A4 J2/JOBSELO|Site2: Job Sel0 B4 J2/ST_GOO ISite 2: Status: 0 - C4 J1/START |Site 2: 0 - Start
D GOOD
A5 J2/JOBSEL1|Site2: Job Sell B5 [2/ST_ERR [Site 2: Status: 0 - C5 |2/BUSY Site 2: Status: 0 - Busy
Error
A6 [3/JOBSELO|Site3: Job Sel0 B6 J3/ST_GOO [Site 3: Status: 0 - C6 J3/START |[Site 3: 0 - Start
D GOOD
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A7 |J3/JOBSEL1|Site3: Job Sell B7 JB/ST_ERR [Site 3: Status: 0 - C7 B/BUSY Site 3: Status: 0 - Busy
Error
A8 J4/JOBSELO|Site4: Job Sel0 B8 J/ST_GOO [Site 4: Status: 0 - C8 WY/START |Site 4: 0 - Start
D GOOD
A9 J/IJOBSEL1|Site4: Job Sell B9 W/ST_ERR [Site 4: Status: 0 - C9 K/BUSY Site 4: Status: 0 - Busy
Error
A10 |5/JOBSELO}Site5: Job Sel0 | B10 [5/ST_GOO [Site 5: Status: 0 - C10 |5/START  [Site 5: 0 - Start
D GOOD
A1l |5/JOBSEL1[Site5:Job Sell | B11l |5/ST_ERR [Site 5: Status: 0 - Cl11|5/BUSY Site 5: Status: 0 - Busy
Error
Al2 |6/JOBSELO|Site6:Job Sel0 | B12 |6/ST_GOO |Site 6: Status: 0 - C12 |6/START |Site 6: 0 - Start
D GOOD
A13 |6/JOBSEL1[Site6:Job Sell | B13 |6/ST_ERR [Site 6: Status: 0 - C136/BUSY Site 6: Status: 0 - Busy
Error
Al4 |7/JOBSELO|Site7:Job Sel0 | B14 |7/ST_GOO [Site 7: Status: 0 - Cl4 |7/START [Site 7: 0 - Start
D GOOD
A15 |7/JOBSEL1[Site7:Job Sell | B15 |7/ST_ERR [Site 7: Status: 0 - C15§7/BUSY Site 7: Status: O - Busy
Error
Al16 |MUX_B/A [MUX:1 - B16 JSA_MODE [Standalone mode C16 |ST_SAMODJ|Standalone mode
channel B, O - control E status
channel A

o Site#/JOBSELO and Site#/JOBSEL 1 — two-bit selector for choosing one of 4 preloaded standalone
jobs;

o Site#/ST_GOOD | ST_ERROR | ST_BUSY - programmer status lines; active status: log 0;

e MUX_BJ/A- External signal switching the channel demultiplexer[ 23%;

¢ VISO - 5V output optically isolated from the CPI2-Gx hardware;

e GND_ISO - Ground lines optically isolated off the CPI2-Gx hardware;

¢ SA MODE - Input control signal - log. 1 on this input at the moment of powering the CPI12-Gx
programmer switches all its programming modules (sites) to standalone mode;

o ST_SAMODE - Standalone mode status - if either one of the CPI2-Gx programming sites works in
standalone mode the status is active (log O level).

NOTE: All the lines above are optically isolated off the CPI2-Gx hardware that provides reliable
galvanic isolation between automated test equipment (ATE) and target device (DUT).

1.2.8 Gang- and Single-site programming

ChipProg-02 software allows the user to drive CPI2-Gx device programmers in two different modes:

e Gang-programming mode for simultaneous programming of multiple devices by means of multiple
CPI2-GML1 modules installed in one or more CPI2-Gx programmers driven by a single instance of
the ChipProg-02 program. This programming mode, which is default for CPI2-Gx programmers, is
intended for mass production in test fixtures and other ATE.

¢ Single-programming mode for programming one target device at a time by means of one CPI12-Gx
CPI2-GML1 module, specified by its unique serial number or the site number.

The programming mode is set in the Startup[ +1 dialog. For launching a CPI2-Gx gang programmer
check the Gang Mode box in this dialog. See the command line options.

Gang-programming mode differs from Single-programming mode in the following ways:

1. Inthe Gang-programming mode only same device type may be selected for all programming
modules controlled by one instance of the ChipProg-02 program.
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2. Inthe Gang-programming mode all programming modules controlled by one instance of the
ChipProg-02 program share the same data buffer;

3. Only the Auto Programming/ 08 function can be performed by ChipProg-02 in the Gang-
programming mode. In order to execute one command only (for example, Erase, Read, Write,
etc.) it is necessary to modify a default set of Auto Programming] 8 commands by removing
unwanted commands and leaving the single command that is needed.

By running several instances of the ChipProg-02 software it is possible to control some modules in the
Gang-programming mode and others in Single-programming mode.
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2 Installation and Launching

This chapter covers the following topics.

How to install the CPI2-Gx hardware| 331
How to install the ChipProg-02 software[ 351
How to launch the CPI2-Gx device programmer.

It is highly recommended that before you start using the tool you read all basic topics in the chapters
Graphical User Interfacel 48) and Operating ChipProg programmers[199) of this manual.

Experience using MS Windows and familiarity with basic Windows operation are required.

2.1 Getting Assistance

Context-Sensitive CPI12-Gx Online Help

The ChipProg-02 software comes with a comprehensive context-sensitive on-line Help. To access it press F1
key or use Help menul 8. Almost ewvery ChipProg-02 dialog, message box, and menu has a help item
associated with it; for the active dialog or menu it can be viewed by pressing F1.

In most cases you can find the necessary topic by searching for a keyword. For example, if you type "Verify" in
the first box of the Find tab, the third box will list topics related to the programming \erification. Choose
appropriate topic from this list and press Display.

A CPI2-Gx PDF manual is also available.

Technical Support

For the length of a product’s warranty period Phyton provides technical support free of charge. Although we do
our best to clean up and improve our software, ChipProg-02 software may contain minor bugs and some
programming algorithms may not be stable on some of recently supported devices. We kindly ask you to report
bugs when you get an error message or have a problem with programming a particular device or devices. We
are committed to promptly checking your information and fixing discovered bugs.

To minimize difficulties using ChipProg-02 it is highly recommended to get familiar with the manual before
using the programmer. The ChipProg-02 - user interfacel 48Y is quite friendly and intuitive; howewer, it includes
some specific functions and controls that a user should learn about.

Before Contacting Phyton

e Make sure you use the latest ChipProg-02 version which is always available as free download from the

http://phyton.com/support/updates.
e Make sure the detected error is reproducible under the same conditions and is not a casual glitch.

When Contacting Us

Please provide the following information to our technical support specialists.

e Your name, the name of your company, your contact phone, and your e-mail address.

o The CPI2-Gx serial number that can be found in the About[ 9 information box or on a sticker on the CPI12-Gx
bottom shell.

e Software version number taken from the Aboutl 9 information box.

e The target device or DUT's part number.

e Basic parameters of your computer and operating system.
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¢ Descriptions of detected errors, relevant bug reports and error screen shots.

Please send your requests or questions to support@phyton.com. This is the easiest way to get professional
help quickly.

Contact Information

Phyton Inc., Microsystems and Development Tools

6701 Bay Parkway, Ste 3M-2
Brooklyn, New York 11204
USA

Web address:_www.phyton.com
E-mail contacts:

General inquiry: info@phyton.com
Sales: sales@phyton.com

Technical Support: support@phyton.com
Tel: 1-718-259-3191

Fax: 1-718-259-1539

2.2 Hardware installation

The power connector is situated in a center of the CPI2-Gx front panel (see the picture below).

Production In-System Device Programmer

CONTROL +9.18V- i oL

16 15.. 2 1

Ll ] L | Y|

A female power plug is included in the CPI2-Gx kit. A user of the programmer user must mount wires
for connecting a regulated 9V to 18V power adapter to the power plug on a front panel of the
programmer. The power adapter should be capable of generating at least 2.5A to provide enough
power for supplying the CPI2-Gx device programmer itself and to transmit power to 7 target devices
at atime.

Connect a CPI2-Gx device programmer to a USB 2.0 slot of your computer or USB hub by means of
the cable supplied with the programmer. Or, the user may connect the programmer to a LAN port on
your computer or router by means of a standard Ethernet cable.
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2.3

To control your CPI2-Gx device programmer from your test fixture or other ATE use the CONTROL
port. The CPI2-Gx kit includes a 48-pin male DIN connector that is intended to be mounted on a
user's own custom transition board that interfaces the programmer to ATE. Refer to the
CONTROL[ 281 connector pinout| 2.

The channel A and B[ 231 TARGET connectors are situated on side panels of the CPI2-Gx unit (see
the picture below). The CPI2-Gx kit includes two 150-pin male DIN connectors that are intended to be
mounted on a user's own custom transition boards that interfaces the programmer to ATE.

50 Connector TARGET

Connect the CPI2-Gx device programmer to the target device (board) or a test fixture in accordance to
the device-specific connection diagram published on the http:/phyton.com/products/isp/chipprog-
isp2-family/cpi2-bl-connecting web page. After a device was selected in the programmer GUI, the
diagram is also accessible by clicking the Connection to the target device link in the Device
Information[ 21 window.Refer to the TARGET [ 25] connector pinout| 251,

IMPORTANT NOTE! All 50 contacts in the middle B line of the TARGET connectors are assigned for
the ground (GND) signals. To ensure stable programming operations it is extremely important to
bring all these 50 ground lines from the programmer's TARGET connector to the GND points on the
target board. Do not join these GND wires in a single wire or fewer wires, as this may cause sporadic
crashes or malfunctioning of the programmer!

System Requirements

To run ChipProg-02 and control a CPI2-Gx device programmer, you need a personal computer (PC) with the
following components:

Pentium-V or higher CPU.

Microsoft Windows XP, 7, 8 or 10 operating system.

A hard drive with at least 200MB of free space.

In case of use the USB communication: at least one USB 2.0 port.

In case of use the Ethernet communication: at least one LAN port or an Ethernet router with the
Dynamic Host Configuration Protocol (DHCP).
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2.4  Software Installation

Since beginning of 2020 Phyton does not supply device programmer kits with CD ROMs with the ChipProg-02
software. Users should download the latest software version from the https://phyton.com/support/updates

webpage. To begin the software installation launch the cp-02.exe self-extracting executable file. Or, if you have a
CD ROM, insert it into a CD drive on your PC. When installer launches, click the Install ChipProg-02 button,
accept the license agreement, and follow the series of prompts that will guide you through the installation
process.

@ ChipProg-02 v. 6.00.23 cuiEl

—=—— = Phyt©®
Install ChipProg-02

.
SCEM 1. Sopped, FE=S001 BO4E (CEM Bter stan [0 -

T
S Schama | Hotes. Cods |6 oeaben
Microchip PACIBCISE |

Phyton WEB Site
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-

- - - F
H5 Phyton ChipProg-02 Programmer v. £.00.23 Installation ‘ M

License Agreement I

Flease read the following license agreement carsfully.

MOTICE: -
Phyton, Inc. Microsystems and Development tools (hereafter Phyton) licenses the accompanying e
software to you anby upon the condition that you accept all of the terms contained in this license

agreement. Please read the terms carefully before continuing installation, as pressing the "yes" |

buttan will indicate your assent to them. K you do not agree to these terms, please press the "no”
button to exit install.

i@ | accept the tems of the license agreement

(7 | do not accept the tems of the license agreement

| ® e ] @ s ) (e B |

85 Phyton ChipProg-02 Programmer v. 6.00.23 Installation ﬁ

Transfer Working Enviromnent from Previoushy Installed Version

Setup has found that the following Phyton ChipProg-02 Programmer versions has been
already installed on this computer. You may wish to transfer the working environment
from one of the installed versions. Click the ‘Details’ button for mare information.

[] Transfer working environment from version:

w3

(@ 6.00.23

el R
O UL U

) (=8
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85l Phyton ChipProg-02 Programmer v. 6.00.23 Installation u

Uninstall Previoushy Installed Version(s)

Setup has found that the following Phyton ChipProg-02 Programmer versions has been
already installed on this computer. You may wish to uninstall some of these versions.
Choose Phyton ChipProg-02 Programmer versions to uninstall before installing version
6.00.23:

Maote: Version &.00.23 has been already installed
an this computer and will be uninstalled.

@ o ] (e )

85 Phyton ChipProg-02 Programmer v. 6.00.23 Installation M

ala

Installation Folder

Please choose the folder to install Phyton ChipProg-02 Programmer below. If the folder specified does not
exdst, it will be created.

Falder:

™ Phyton\ChipProg-07\6_00_73

(4@ Back | [ instal )]

bl

Ak
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: - - ,
Ha Phyton ChipProg-02 Programmer v. £.00.23 Installation Iﬁ
Installation Progress
C:MPhytonChipProg-02%6_00_23\ChipProgUSE pdf
Drive space used: 27 227 584 Bytes |
I - |
Phyton ChipProg-02 folder
At the end of the software installation the installer creates a folder with ChipProg-02 shortcuts.
Mame . Date modified Type Size
@ Phyton ChipProg-02 6.07.00 6/24/2017 5:52 PM Shortcut 1KE
[#l) Phyton USE Device Driver Installer 6/24/2017 5:52 PM Shortout 1KBE
@ Uninstall Phyton ChipProg-02 Programm..,  6/24/2017 5:52 PIM Shortout 1KBE
The first shortcut - Phyton ChipProg-02 opens the setup vizard[ 421 ending with the startup dialog[ 421,
In this dialog you can create multiple shortcuts for launching the device programmer(s) with different
startup settings. All of them are accessible from the Phyton ChipProg-02 folder.
2.5 Launching device programmers

Launching a CPI2-Gx device programmer in the Gang-programming mode

CPI2-Gx device programmers are most often used in the Gang-Programming] 31 control mode. If
startup options are correctly specified in the Startup dialogl 42, then after clicking on the Start Device
Programmer button, the program tries to establish communication with the CPI2-Gx. This may take up
to 30-40 seconds. If the programmer is controlled via the GUI, the main window will appear on the
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screen, and in the Program Manager window you will see as many site tabs as were specified in the
Startup dialog. The example below shows the Program Manager window after launching a CPI2-
06/12V1 device programmer with 6 programming modules.

Frogram Manager H EI
Program Manager | Options | Statistics |

% Execute: & - @' Execute: & - % Execute: & - % Execute: & -

Mo device Mo device Mo device Mo device
Tatal: O Total: O Total: O Tatal: 0
Good: 0 Good: 0 Good: 0 Good: 0
Bad: O Bad: O Bad: 0 Bad: 0

& Execute: A w | & Execute: A -

Mo device Mo device
Tatal: O Total: O
Good: 0 Good: 0
Bad: 0O Bad: O

T2 Ja [4 [5 [ |
[ 1

Launching a CPI2-Gx device programmer in the Single-Programming control mode

Even though a CPI2-Gx device programmer may be equipped with more than one programming
modules, it is possible to to operate with one selected programming module in the Single-
Programming! 301 control mode. There are two command line options, which enable controlling a single
module specified by its unique serial number. These options (keys) are: -GANG and -N following by the
modules' serial numbers. In the GUI control mode, use of these key will cause Program Manager[ 103 to
open windows with different appearances. See two examples below:

The -GANG#GM2-00029 in the command line opens the window similar to the above but with one site tab only:

Program Manager k=

Program Manager | Options | Statistics |

S Execute A l -

Mo device
Tatal: 0
Good: 0
Bad: 0

T

Device changed to Atmel AT8558253 [ISP Mode] —
Ready: Jan 31, 2018 17:20:50

The -NGM2-00029 in the command line opens the window that enables access to all basic programming functions:
Erase, Program, Verify, etc. Use of the -N option is intended for debugging programming projects on one site before
launching mass production in the Gang control mode.
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|| Program Manager Bzl

Program Manager | Options | Statistics |

Buffer: [BLrHer #0: Code (128 KB), bytes, User (128 KB), bytes, Data (128 KB). bytes ']
Functions

- Bl

ank: Check @ .

- Program Ececut

.. Read

- Verify Repetitions:

| .. Erase 1 -

[#- Data
- User
[+ Device Parameters

© b

Auto Programming
Launching daisy-chained CPI2-Gx device programmers

If it is desired to program 8 or more devices in parallel, then multiple CP12-Gx programmers must be
daisy chained together, since the maximum number of devices that can be programmed in parallel by
one CPI2-Gx device programmer is 7. In this case, additional information is required in the Additional
Command Line Options field of the Startup Dialog box. The figure below shows the Startup Dialog
for launching two CPI2-Gx programmers with a total of 8 CPI12-GM1 programming modules installed in
two CPI2-Gx programmer motherboards.

Important Note. The CPI2-GM1 modules must be installed contiguously on the CPI12-Gx
motherboards. In other words, the placement of the modules must not skip motherboard slots.

%t ChipProg-02 v.610.00

Programmer Startup Options
|#| Create a
‘@ Start Device Programmer
(V| Gang Mode ["| Diagnostic Mode
Mumber of sites in gang (optional): 8 - Connection: @ USB () Ether

Additional Command Line Options:
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Since there is nothing in the Additional Command Line Options text field, an attempt to start the
programmers the ChipProg-02 program generates the following message:

# [ChipProg-02] Eror ===

There are 2 (PI2-Gx gang device programmers connected to the computer. Their motherboards
have the following serial numbers: GMV-188@11, GMV-188@25.

@ To inform the program how to distribute the programming site numbers between the gang
device programmers, you must specify the list of motherboard serlal numbers In the /GANG
command line option, e.g. /GANGHEGMV-100@25;GMV-108@11. See the SGANG option description in
the documentation.

This message is saying that the controlling program does not know how the programming sites are
distributed between the two CPI2-Gx programmers. Each CPI2-GM1 module is a site, which will be
dedicated to the task of programming a particular device on the target board. In order to do this,

the /GANG key must be used with specification of the serial numbers of the CPI12-Gx programmers. In
the figure below, programmers with serial numbers GMV-100025 and GMV-100011 respectively are
specified.

e ChipProg-02 v. 6.10.00

Programmer Startup Options

|#| Create a
‘@ Start Device Programmer
[¥| Gang Mode ["| Diagnostic Mode
Mumber of sites in gang (optional): 8 - Connection: @ USB () Ether

Additional Command Line Options:
JGANG#GMY-100025;GMV-100011

In this case, Site#1 will start at the first occupied slot of the GMV-100025 programmer. Site#2,#3... will
be assigned successively until the number of programming modules in unit GMV-100025 is exhausted.
Then, Site#s will continue to be assigned to the modules in programmer GMV-100011 until those
modules are exhausted. For example, if there are six CP12-GM1 modules installed in CPI12-06/12V1
device programmer with serial number GMV-100025 in slots 1-6, then they will be assigned to Site#1 to
Site#6. If the remaining two CPI2-GM1 modules are installed in the CPI12-02/04V1 programmer with
serial number GMV-100011 starting with slot 1, then they will be assigned Site#7 and Site#8
respectively.

With this configuration, clicking on the Start Device Programmer button, the Program Manager
window will display 8 programming sites - six sites, belonging to the CPI2-06/12V1 with the
motherboard GMV-100025, are shown below within a red frame, two others, belonging to the CPI2-
02/04V1 with the motherboard GMV-100011 - in a blue frame:
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2.6

Program Manager

K

Program Manager | Options | Statistics | Sites #1 to #6 - GMV-100025

2 FReady
Mo device Mo device Mo device Mo device
Total: 0 Total: 0 Total: 0 Total: O
Good: 0 Good: 0
Bad: 0 Bad: 0

|
% Execute: A % Execute: A =

8 Ready
Mo device Mo device i Mo device
Total: 0 ; Total: O
Good: 0 g Good: 0

Bad: 0 ; Bad: 0

T 2 3 [4 [5 s |72 [s T\srtes#?,#ﬂ-ﬁuv-m{m

Device changed to Atmel ATS358253 [ISP Mode] —
Ready: Jan 31, 2018 19:21:08

Setup Wizard and Startup Dialog

If you launch the programmer first time, the program opens the ChipProg-ISP2 setup wizard welcome

page:

e Wizard: Welcome

programmer model and setup basic options.

Welcome to the ChipProg-ISP2 wizard. Follow the prompts to choose the device

e

Help

F 4 Skip

vy Next

On the next step the wizard prompts you to select the device programmer model:
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& Wizard: Choose your device programmer's model @

Choose your device programmer’'s model. It is impossible to operate on
different programmer types at a time. Setup each device programmer
separately.

Device programmer's model:

CPI2-B1: ISP Universal Programmer

o ECF‘IE-GX: Gang In-System Device F‘rngrammer‘é
CPI2-FXI: Gang In-System Device Frogrammer PXI Module

L Back | | E Help [ﬂ" Mext ]

Then select the control interface in the next dialog:

% Wizard: Choose the communication interface @

CPI2-Gx device programmer can be controlled from a computer via USB or
Ethernet interfaces. Choose the communication interface:

@ Programmer is connected via USB

Programmer is connected to LAN via Ethernet

s B

@ Back | | e Help | [v" Next ]

The setup wizard ends with the following prompt:
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e Wizard: Setting complete [ B[]

You have completed setting basic parameters. Click the Complete button to
open the programmer Start Up dialeg. In this dialog you will be able to add some
advanced settings and to change earlier set options. The Start Up dialog has a
link allowing to recall the ChipProg-ISP2 wizard.

A Back | | 2] Help | " Finish

By clicking the Finish button above you open the Startup dialog that displays all the settings made in
the wizard. This dialog enables to enter some additional settings. The dialog window is divided in
several zones: Program Startup Options, Documentation, Contact Technical Support, For
Developers. The very bottom filed displays prompts for the dialog widget pointed to a mouse cursor. In
the picture below the cursor is placed over the Create a shortcut with this options link in the top right
corner. The picture below displays an example with some specified startup options.
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[ ChipProg-02v.6.2003 =] @ [

Programmer Startup Options
|#| Create a shortcut with these options

£ Open shortcuts folder

l@ Start Device Programmer

7] Gang Mode 7] Diagnostic Mode «, Launch wizard
Mumber of sites in gang (optional): 4 - Connection: @ USE Ethernat
Additional Command Line Options:
-C"MNXPMCIS080V3ZMLF [ISP Mode]" -L"C:\Work\Output\Bin\Serial.bin" -FB0x2000 -A -12 -
‘QE Start Standalone Mode Monitor Demonstration Mode (without hardware)

| Close this window after programmer start

Documentation
Mo newer Phyton ChipProg-02 versions

@ CFI2-B1 On-Line H.elg . Changelag available.
'I% CPI2-B1 User's Guide # Phyton Homepage
X CPI2-B1 Quick Start Manual

CPI2-Gx On-Line Help
I? A IEUE R ¥| Check for updates on start
T4 CPI2-Gx User's Guide
Contact Tech Support For Developers

@  Submit Bug Report ® Application Control Interface (ACI) Manual

&® Start ACI Functions Explorer

3 Create a ticket on the Phyton Site

Phone: 718-259-3191
E-mails: info@phyton.com, sales@phyton.com,
support@phyton.com

| | Open LabVIEW Library for the Programmer (32-bit)

| | Open LabVIEW Library for the Programmer (64-bit

Create a shortcut for launching the programmer with the options specified. The shortcut will be available in the Windows' "Start"
Menu.

Prompt

The Program Startup Options zone concentrates major settings, including:

Connection: Select one of communication interfaces: either USB (default) or Ethernet or Local Area
Interface (LAN). Control of CPI2-Gx device programmer(s) via USB interface does not require any
special settings. Connecting via Ethernet requires appropriate setting in the Additional Command Line
Options[12h. See a description of the -ETH key and associated parameters (IP addresses, etc.)

Gang Mode[ 193} Leave it unchecked to control either a single CPI2-B1 device programmer or a certain
one from a cluster of multiple CPI2-B1 programmers or a certain module number of a CPI2-Gx gang
device programmer. Check this box to control either multiple CPI2-B1 device programmers or a CPI2-
Gx gang device programmer connected to the computer.

Number of sites in gang[2h: In this field you may optionally specify an actual number of programming
modules in the CPI2-Gx gang device programmer that you are launching.

Diagnostic Mode: This option enables/disables tracing programming operations - i.e. collecting the
trace to the UPROG.LOG file located in the folder where the the programmer software had been
installed. This UPROG.LOG file can be shared with Phyton Technical Support for remote
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troubleshooting. By default, the Diagnostic Mode box is checked and a running programmer
permanently updates the diagnostic information into the UPROG.LOG file. This slightly slows down a
target device programming. If the programming speed is extremely important, a user may uncheck this
box. In this case the UPROG.LOG remains empty.

Additional Command Line Parameters: Here you can type in command line options[ 128, which will be
added to the options specified in this zone above, i.e. the Gang Mode, Number of sites in gang,
Diagnostic Mode options. By default this field is blank.

Create a shortcut with this options: This link allows to store a shortcut for launching the device
programmer with the options specified in the Program Startup Options zone. You may create multiple
shortcuts for launching the programmers.

Open shortcut folder - Opens a folder that displays all the shortcuts launching the device
programmer with different options.

Demonstration Mode: Check this box if you want to evaluate the product's user interface without in
the absence of programmer hardware driven from a computer.

Start Device Programmer: click on this button launches the device programmer(s) connected to a
computer with the options set in the Program Startup Options zone of the dialog.

Start Standalone Mode Monitor: if the programmer works in the standalone mode, click on this
button launches the monitor/ 133,

The Documentation zone concentrates: links that invoke different types of user's guides for two device
programmer models: CPI2-B1 and CPI2-Gx.

Changelog link opens the Phyton ChipProg-02 Revision History file that lists most recent feature
changes, newly added devices and bug fixes

Phyton Homepage links opens the www.phyton.com website in your default web browser.

The Contact Tech Support zone includes Phyton contact information and enables users to open a
new support case by clicking the Create aticket on the Phyton Site link.

If the programmer was launched in the Diagnostic mode (see above) then you can send a bug report to
the Phyton technical support by clicking the Submit Bug Report button.

The For Developers zone includes links to a set of tools for those who develop applications[ 5 for
CPI2 device programmer control.

Control Interfaces

CPI2-Gx device programmers can be controlled by an operator in one of the Computer Controlled
modes or in the Standalone Mode[ 135 mode controlled remotely by Automatic Test Equipment (ATE) .

Computer controls include the following:

e Full-capable Graphic User Interface (GUI[ 4"),
« Simplified User Interface (SUIl 1)),
e Command Line[2%, On-the-Fly[23 control
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« Application Control Interface (ACI[159))

First three methods above are described in this chapter, the AClis described in a separate chapter.

The Standalone[132) control mode is also described in a separate chapter.

3.1

Using device programmer involves many operations such as choosing target device, loading a file to be
programmed into the device, customizing programming algorithm, constructing a batch of commands
for Auto Programming] 198 procedure, configuring the CPI2-Gx user interface, etc. These actions require

Using Projects

working with tens of dialogs, menus and sub-menus in different ChipProg-02 windows. The ChipProg-

02 program allows you to store all such settings in a single file called project. You can create| s any
number of projects for programming a variety of devices and store them in the project repository| 6.

When needed, these files can be loaded and used just by a mouse-click, or by including a project name

on command line[ 120. Use of projects saves time and simplifies programming process.

Projects are especially beneficial for production programming where a typical scenario includes

replication of a lot of chips programmed with the same data but different serial numbers. In such case it

is very convenient to create and lock a project that completely defines the programming session and
then assign programming operation to a worker who will simply replace the chips being programmed
while watching programming progress and results.

The table below lists major project options.

Option group

| Project options

Where to set up...

Major properties

Project name; Description; Permissions
(password, selected locking options); Files to
be programmed into the device, File format,
Start and end address for file loading,
Destination buffers; Scripts to be preloaded;
Desktop.

Menu Project - Options - Dialog Project
Options@

IDevice type; Auto Detect; Insert test; Check
device ID; What to do when the device insertion
is detected; Device parameters (fuses, lock

Menu Configure[ s - Dialog Select
Device[ 58,
Window Program Manager - tab

file settings.

Device bits, specigl functiqn registerfs, etc.); . Obtions/108)
|Programming algorithm (applicable chip Windows Device and Algorithm
sectors, wltages, oscillator frequency, etc.) Parameters Editor[ 93
Menu Configure| 51— sub menu
Buffers| 61
Buffers Buffer name; Buffer size; Default fill value; Swag Window Buffer — toolbar; Dialog Buffer

Configuration[ 97,
Window Buffer — toolbar; Dialog Memory

Dump Windows Setup/ 9

Serialization,
Check sum, Log
files

IAlgorithm for programming serial numbers;
Custom signature patterns; Algorithm of the
check sum calculation; Check sum formats;

Menu Configure[ 57— tabs of the sub menu

Serialization. Check sum. Log files[ 6"
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Option group I Project options Where to set up...
[Parameters and locations of log files to be
saved.

IActions triggered by certain events, issuing .
Menu Configure[ 51— sub menu

Actions on events i .
error messages and sounds, logging results Preferences| 7
Screen configuration, fonts and colors of
Graphical User  windows, key mappings, messages and Menu Configure[ 51— sub menu
Interface miscellaneous settings. Environment| 79

Number of chips to be programmed and related

Statistics settings. Window Program Manager - tab

Statistics[119)

You can create, edit and save projects within the CPI2-Gx Graphical User Interface - read about the Project
Menul 52 and related dialogs. The project files have the name extension .upp.

Note. ChipProg-02 software does not automatically save changes to project options on exit. You must
execute the Save or Save as command from the Project[s21 menu to save project changes made in
all GUI settings dialogs since this project was opened.

3.2 Graphical User Interface

The ChipProg-02 graphical user interface (GUI) contains the following elements:

Windows| 2.

Menus| 501 - global and local.
Toolbars| 491 - global and local.
Dialogs.

Hot Keys| &1,

Context-sensitive help prompts| &,

The GUI features several useful additions| 48" designed specifically for the CPI12-Gx operations.

To make your using ChipProg-02 program easier we highly recommend you read the Menus[ 5% and
Windows| ¢ chaptersin full. You will be able to use the CPI2-Gx device programmers much more
effectively.

3.2.1 User Interface Overview

ChipProg-02 features standard Windows interface with several useful additions.

1. Each window has its own local menu (the shortcut menu). To open this menu, click the right mouse button
within the window area or press Ctrl+Enter or Ctrl+F10. Each command in the menu has a hot key
shortcut assigned to a Ctrl+<letter> key. Pressing the hot key combination in the active window executes
the corresponding command.

2. Each window has its own local toolbar. The toolbar buttons access most of the local menu commands of
the window. A window toolbar buttons work only within that window. The main ChipProg-02 window has
seweral toolbars which can be turned on or off (in the Environment dialog, the Toolbar[ " tab).
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3. Toolbar buttons feature mouse-over help: when you place the mouse cursor over a toolbar button for two
seconds, a small yellow box appears nearby with a short description of the button’s function.

4. To save screen space, you can hide any window title bar. To do this, use the Properties command in the
local menu. You can identify the ChipProg-02 windows by their contents and position on the screen (and,
if you wish, by color and font). When the title bar is hidden, you can move the window as if the toolbar were
the title bar: place the cursor on a free space in the toolbar, press the left mouse button and drag the
window to a new position.

5. You can open any number of windows of the same type. For example, you can open seweral Buffer
windows.

6. Every input text field of any dialog box has a history list. ChipProg-02 saves them when you close
programming session. Then a previously entered string can be picked from the history list.

7. All input text boxes in the dialogs feature automatic name completion.

8. All check boxes and radio buttons in the dialogs work in the following way: a double-click on the check box
or radio button is equivalent to a single click on the box or button, followed by a click on the OK button.
This is convenient when you need to change only one option in the dialog and then close it.

3.2.2 Toolbars

The ChipProg-02 program shows several toolbars at the top of the main window (see below).

G CPI2-Gx -- ABC test -- [Atmel ATB9S8253 [ISP Mode]]
File | View Project Configure Commands Scripts Window Help

Jﬁ h Fv{:’ E_% ‘P’i ‘u; L _J [n‘;'sj E |_—| ‘:‘: ,,»j-' /@ _4}1 Auto
M Select Device... | |[Amel ATass8253 (1SP Moce] - 0 2 B [ ¢

The topmost toolbar (right under the CPI2-Gx main window title) includes the Main menul s bar with
drop-down submenus File, View, etc.. The second toolbar contains icons and buttons for the most
frequently used commands on files and target devices (Open project, Load file, Save file... Check,
Program, Verify, etc.). There is an indicator of the ChipProg-02 status (Ready, Wait, etc.). The third
toolbar displays a target device selector. The fourth toolbar, which is not displayed by default, includes
the built-in editor options and commands for scripts. The default toolbars can be customized. Refer
also to the topics The Configure Menu[ 57, The Environment dialog[ 7%, Toolbar| &2\,

NOTE. Hereafter some toolbar elements can be displayed grayed out - it means that these elements
are unavailable for a particular target device or a mode of use. For example, since only one operation -
Auto Programming[ 18] - is available for gang programmers|198), the Check, Program, Verify, Read,
Erase buttons are disabled and grayed out.

Besides the main window toolbars, windows of other types have their own local toolbars with buttons
assigned to the most frequently used commands related to the window. See for example the Buffer
window's[ s toolbar below.

Buffer #0 - Code (128 KB), bytes: 00000000 [00000000] [B]==E
Code User Data

é Addr | Load | Save |Configure Buffer | Setup | View Modify| Blocl-:|

File: Mone ~
Checksum: 002FD000 [Summation, discard overflow]

oooeeeoo: FF FF FF FF FF FF FF FF FF FF FF FF FF |
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3.2.3 Menus

The ChipProg-02 Main menu bar contains the following pull-down sub-menus:
e File menul ™

e View menul 53

e Project menuls

o Configure menulsM

e Commands menul s

e Scripts menul s

e Window menul el

e Help menul &

To access these menus, use the mouse or press Alt+letter, where "letter" is the underlined character in the
name of the menu item.

e Context Menus

Each window has a context menu associated with it. To open context menu, either click the right mouse
button within the window or press Ctrl+Enter or Ctrl+F10.

Most, but not all, context menu commands are also available as toolbar buttons at the top of the window.
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3.2.3.1 The File Menu

File menu commands invoke file operations. For those commands that have a corresponding toolbar button,
the button is shown in the first column of the table below. In case there is a shortcut key for a command, the
shortcut key will be displayed to the right of the command in the menu.

Button Command

Description

L

I

f" ] Load ... Opens the Load file[103) dialog that specifies all the parameters of
= the file to be loaded and the file destination.
d=l Reload Reloads the most recently loaded file.
L
Save...

Sawes the file from the currently active window to a disk. Opens the
Save file from buffer[10h dialog.

Configuration
Files

Gives access to operations with configuration files[ 521

:ﬂ Exit

Closes ChipProg-02. Alternatively, use the standard ways to close
a Windows application (the Alt+F4 or Alt+X keys combination).
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3.2.3.1.1 Configuration Files

On exit ChipProg-02 automatically saves its configuration data in several configuration files named
UPROG.*. On start-up, configuration is restored from the most recently saved configuration files. In addition,
you can sawe and load any of these files at any time using the Configuration Files command of the File[ st
menul 510, You can have several sets of configuration files for different purposes.

e The Desktop file stores display options and screen configuration as well as positions, dimensions, colors,
and fonts of all open windows. The extension of this file is .dsk. The default file name is UPROG.dsk.

e The Options file stores target device type, file options, etc. The extension of this file is .opt. The default
file name is UPROG.opt.

e The Session file stores session data and specifies the desktop and options; it can also be saved and
loaded by means of the Save session or Load session subcommand of the Configuration Files
command. The extension of this file is .ses. The default file name is UPROG.ses.

e The History file contains all settings entered in the text boxes of all the ChipProg-02 dialogs. This file is
hidden but the settings stored earlier are available for quick selection from the History lists. The extension
of this file is .hst. The default file name is UPROG.hst.

3.2.3.2 The View Menu

This menu provides a way to show various to ChipProg-02 windows.

Command Description

oo
c
I~
o
-]

Program Manager Opens the Program Manager[109) dialog.

=
Ed
——

Device and Algorithm Parameters Opens the Device and Algorithm
Parameters/ 9" dialog.

Opens the Buffer[ %1 dialog.

"
—
-

-—

Buffer Dump

Memory Card Window Opens the Memory Card [ window

. . i i 92 i
Device Information Opens the Device Information[ 2 dialog.

Console Opens the Console[10) dialog.

H O (o[

3.2.3.3 The Project Menu

This menu contains commands for working with projects [4M,

© 2021 Phyton, Inc. Microsystems and Development Tools



Control Interfaces 53

Button Command Description
ia New Opens the Project Options[ 531 dialog.
ﬁ Open Opens the Open Project/ 5N dialog for loading an existing project
file.
j Close Closes and saves current project.
=
(ﬁ Save Saves all settings of current project.
'|ﬁ Save As Opens the Save project dialog. Duplicating projects under different
names and/or in different folders is helpful for cloning similar projects.
‘@ Export Opens the Exporting Project dialog
[ Import Opens the Importing Project dialog
5 Repository Opens the Project Repository@ dialog for storing current project
= in project data base for convenient handling.
ﬁ Options Opens the Project Options| 531 dialog for editing project options.
Note. ChipProg-02 software does not automatically save changes to project options on exit. You
must execute the Save or Save as command from the Project[s21 menu to save project changes
made in all Ul settings dialogs since this project was opened.

3.2.3.3.1 The Project Options Dialog

This dialog is used for setting initially and editing project options.

Control

Project File Name

Description

Specifies the project file name and path. If extension is omitted. when you
close the dialog by clicking the OK button, the program saves the project file
with extension .upp.

Permissions...

Opens the Editing Permission Settings dialog. Here you can protect the
project file against unauthorized editing. By checking appropriate boxes in
this dialog you can lock major groups of project options.

Project Description
(optional)

Here you can enter your custom comments for the project.

Desktop

Two radio buttons which allow you to choose if current project will have its
own desktop, or all ChipProg-02 projects will use the same desktop
settings.

Files to Load to Buffers

One or more files to be loaded into the buffers upon opening the
project.

Add file

Opens the Load File[10} dialog for adding this file to the Files to Load to
Buffers.
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Remove file Remowe selected file from field Files to Load to Buffers.

Opens the Load File[103 dialog for editing a file highlighted in the Files to
Load to Buffers list.

Edit file options

Script to execute before Here you can enter the name of a script to be executed before loading

loading files: the files to the project.
Script to execute after Here you can enter the name of a script to be executed after loading thej
loading files: files to the project.

The dialog should be completed by clicking the OK button. Then a specified project file with the extension .upp
will appear in a specified folder.

3.2.3.3.2 The Open Project Dialog

This dialog is used to open a previously created project.

Control Description

. . Here you can enter full path of a project file name or browse project files. The
Project File Name ChipProg-02 project files hawe file name extension .upp.

Shows a list of previously opened projects. Double-clicking on a line in the list

Project Open History opens corresponding project.

Remove from list Deletes selected project from the Project Open History list.

3.2.3.3.3 Exportand Import Project Dialogs

The ChipProg-02 allows exporting and importing projects[ +71 created for the CPI2-Gx control.

The Export Project dialog allows moving an entire project along with the user's data to another
computer.

© 2021 Phyton, Inc. Microsystems and Development Tools



Control Interfaces 55

® Export Project @

Exporting a project creates a compressed file that contains the project file and all data files loaded into
buffers. This makes it easier to move projectto another location.

Afterwards the compressed project can be loaded just like a normal project (everything will be
decompressed automatically) or unpacked with the 'Project’ -= 'Import...' command.

Folder for compressed project file:

C\Work\Projects - 2l Browse.

v | Overwrite output file without prompt

Add timestamp postix to the compressed file name ("yyyy-mm-dd-hh-mm-ss")

| Encrypt file with password: eose

‘v" oK | |n’ Cancel ‘ ‘P Help

The program zips a specified the project file (for example, ABC.upp) with the data file(s) to be loaded by
opening the ABC.upp project to the CPI2-Gx programmer's buffer and stores the exported compressed
project into a specified folder (here C:\Work\Projects). Exported project files have the .upc extension -
in this case the ABC.upc file. The .upc files have a standard zip format.

Checking the Overwrite output file without prompt box prevents casual spoiling of a previously
stored compressed project.

Checking the Add timestamp postfix to the compressed file name enables to create a series of .upc
files with the same name but made at a different time.

For security you may encrypt the .upc file. Check the Encrypt file with password box and type in your
password in a field at right. Later, when you attempt opening or importing the project, you will be
prompted to enter this password.

These exported files can be moved or copied to another PC and then can be open by the Project >
Import command.

The Import Project dialog enables extracting a project exported from one computer to another.
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@® Import Project

% el
Compressed projectfile:
C\Work!\Projects\RTX-028.upc hd i@l Browse...

Folder to unpack projectfiles to:

C\Projects\UnpackedRTX - 2l Browse...

v | Open project after unpacking

«  OK ] |n’ Cancel ‘ |E" Help ‘

Specify an exported .upc file, a destination folder to unpack it and click OK. If the source .upc file was
encrypted with a password enter it into a popped up box.

For the example above, all parts of the RTX-028.upc compressed project will be extracted into the
folder UnpackedRTX, including the RTX-028.upp project file and all the data files associated with this
project.

Compressed .upc files can be loaded to ChipProg-02 by the Open Projectl 58 command as well as
"simple" .upp project files. When you use the Open Project[ 51 command from the Project/ 5 menu
ChipProg-02 program extracts a .upc file to a temporary folder, loads the extracted project and then
deletes this temporary created folder. If the .upc file includes large data, opening the project may take
quite a long time. Use of the Import Project function vs Open Project saves time because an
imported project extracts to a specified folder and all extracted files remain in this folder.

Since opening a compressed .upc project completes with deleting a folder that temporary stores
extracted files they cannot be stored and modified.

3.2.3.3.4 Project Repository

The Project Repository command of the Project menul =21 opens the Project Repository tree.

Project Repository is a small database that stores records with links to project files. Here you can
see the CPI2-Gx projects in a tree form similar to the Windows File Explorer, to logically organize
projects for convenient access. Operations with the repository do not change the projects
themselves - the repository works only with records about the projects (links to the project files). A
tree branch may show projects and other branches. Any branch may contain different projects with
the same names. Different branches may contain links to the same project.

Tree branches show each project file as a name (without a path) and a description in square
brackets. The ChipProg-02 remembers state of tree branch (expanded/collapsed) and restores it
next time you open the dialog.

When you install a new version of the ChipProg-02 software and copy the working environment
from the previously installed version, the new version will inherit the existing project repository (the
repos.ini file).
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Dialog Control

Description

Add New Branch

Opens the Add New Branch dialog in which you can specify the name
of a new branch.

Add a Project to Branch

Show the Open Project/ s dialog to select a project to be added.
Clicking the Open button adds the selected project to the selected
branch.

Add Current Project to
Branch

Adds the currently opened project to the selected branch.

Remove Project/Branch

Deletes the selected project or branch from the repository. All child
branches are also deleted.

When deleting a project from the repository, the ChipProg-02 deletes only
the repository record about the project, and does not delete the project
file from disk.

Edit Branch Name

Opens the Edit Branch Name dialog for the selected branch.

Move Up Mowes a selected project or branch up within the same lewel of hierarchy.
The branch mowes together with all its child branches .
Move Down Mowes the selected project or branch down within the same lewvel of

hierarchy. The branch moves together with all its child branches .

Save Repository

Writes or updates the repository to the disc file repos.ini in the CPI2-
Gx working folder.

Browse Project Folder

Opens MS Windows Explorer with the opened folder of the selected
project.

Open Project

Writes the repository to the disk file and opens a selected project.

Close

Closes the dialog. If the repository is changed, ChipProg-02 will
prompt to sawe it.

3.2.3.4 The Configure Menu

This menu gives access to major ChipProg-02 configuration dialogs.

© 2021 Phyton, Inc. Microsystems and Development Tools



58 CPI2-Gx Device Programmers - CPI2-Gx

Button Command Hot | Description
key

m Select Device Select device F3 | Opens the Select Device[ 581 dialog.

Devi lection hist Alt+H Opens the list of previously selected
evice selection historyl "oy oo

Buffers F5 | Opens the Buffers[ 6 dialog.
Serialization, F6 Opens the Serialization. Checksum
Checksum, Log file |Log File[ 63 dialog

Data caching,
Standalone jobs...

Opens the dialog for setting static 1P}

Jaddresses of programming modules

W o )

IP address settings...

: J& Preferences Cég” Opens the Preferencesl 771 dialog.
-, Simplified User Opens the Simplified User
) . .
igh linterface editor Interface[13) editor
Opens the Environment dialog with
tabs: the Fonts| 80 tabl &, the
A Environment Colorsl 8 tabl 8, the Key

Mappings/ 81 tab[ 81, the Toolbar[82"
tabl 82 and the Misc[ &2 tabl &2\,

3.2.3.4.1 The Select Device Dialog

The dialog allows specification of the device to work with; it has several groups of controls.
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ﬁ Select Device

Devices to list Devices [Texas Instruments]

EF’F{OM. EEFPROM, FLASH Search mask:
[¥]PLD, PAL, EPLD
Micrngantrnllers

LM3S102-ERN [ISP JTAG Mode]
LM3S102-ERN [ISP JTAG-Chain Mode]
LM3S102-ERN [ISP SWD Mode]

|Programmable In-Sockst

...... |Programmable In-System LM3S102-IRN [ISP JTAG Mode]
LM33102-IRMN [ISP JTAG-Chain Mode]
(@ Selected manufacturer only LM3S102-IRN [ISP SWD Mode]

LM3S1110-EQC [ISP JTAG Mode]

—
e LM3S1110-EQC [ISP JTAG-Chain Mode]

Scenix -~ LM3S1110-EQC ISP SWD Mode]
Seiko LM3ST1110-1QC [ISF JTAG Maode]
Semtech LM3ST1110-1QC [ISF JTAG-Chain Mode]
Sensory LM3ST1110-1QC [ISF WD Mode]

Sis LM3S1133-EQC [ISP JTAG Mode]
Siemens LM3S1133-EQC [ISP JTAG-Chain Mode]
Signetics LM3S1133-EQC [ISP SWD Mode]
Silicon Labs LM3S1133-1QC [ISF JTAG Maode]
Spansion

SyncMOS Type: Microcontroller = MSP430
Syntronix

TOPRO Packages/Adapters
Tests

Toshiba

Unknown

VLS|

Vantis

Weltrend

Winbond Memgw
AEMICS Code: 589,824 Bytes

K!;nr Password: 8,193 Bytes

Zilinx

ZDEC

Fentel

Zilog v

o  OK ‘ﬁ Cancel ‘ @ Hel

Control Description
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Devices to list:

In this field you can check one or more boxes to specify the target
device type. Devices are combined into three functional groups: a)
Serial memory devices; b) Programmable Logical Devices; ¢)
Microcontrollers. Speed up the search by specifying the device
properties if possible.

Manufacturer

The box lists the device manufacturers in alphabetic order.

Search mask:

Here you can enter a mask to speed up device search. The "*'
character (star) represents any number of any characters in
device part number. For example, the mask 'PIC18*64" will list all
PIC18 devices ending in '64".

Devices

Displays all devices by the chosen manufacturer that satisfy
search criteria specified in Devices to list, Search mask, and
Packages/Adapters fields.

Sometimes you may see some devices listed in the Devices pane "greyout":

Devices [Microchip]

Search mask:

PIC18LFE620
PIC18LFE621
PIC18LFE622
PIC18LF8E2Y
PIC18LF8625
PIC18LF8E80
PIC18LF8720
PIC18LF8722
PIC18LF8723

PIC32MR220F
PIC32MR220F
PIC32MA320F
PIC32ZMX320F032H I/PT
PIC32ZMX320F032H VIMR
PIC3ZMX320F032H VP T
PIC32ZMX320F032H-401/MR

[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
[ISP HV Mode]
032B-I/ML
0320-ML
032H /MR

Support of "greyout" part numbers requires having appropriate CPI2-D-xxxx device library licenses.
After activation a certain CPI2-D-xxxx device library license all the part numbers of the devices covered

by this license become visible and can be selected.
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3.2.3.4.2 The Buffers Dialog

Description

Displays names, sizes and sub-layers of all open buffers| 187

Buffer list:

Add... Opens Buffer Configuration[ 61 dialog to create a new buffer
Delete Deletes the buffer highlighted in the 'Buffer list' box.

Edit... Opens Buffer Configurationm dialog for editing.

View Switches focus to the window displaying the buffer highlighted in

the 'Buffer list' box. If this window is hidden behind others it will be
brought to the foreground.

This drop-down menu allows limiting the amount of computer RAM|
allocated for each buffer. The amount of free memory available for
allocation is shown here in this screen area.

Memory Allocation

If computer's RAM s limited, the ChipProg-02 can temporarily
store buffer images on PC hard drive to free some RAM. You can
select the hard drive or allow the program to swap files
automatically.

Swap Files

Checking this box enables swapping memory to the network drives

Use network drives
connected to your computer.

Here you can reserve space on the hard drive that will never be

Amount of space to leave . .
used for file swapping.

free on each drive (GB):

3.2.3.4.2.1 The Buffer Configuration Dialog

The Buffer Configuration dialog allows to setup sub-layers in buffers and to make their presentation
easier to work with. To open this dialog click the Buffer Configuration button in the toolbar of the
Buffer window| o).

The dialog has one tab for each sub-layer[ 181 of a particular device. Every buffer has at least one
main Code layer, so the tab 'Code’ is always displayed in the dialog foreground. If selected device
has other address spaces (‘Data’, 'User’, 'ID location', etc.) the buffer will have additional sub-layers.
For example: Microchip PIC16LF18875-I/PT device has two sub-layers: ID location and Data (see the
picture below). Here the Buffer Configuration dialog has three tabs: one main for Code settings and
two for ID location and Data sub-layers.

The "Buffer name, Code settings" tab contains a dialog for configuring the main buffer layer - the
‘Code’ layer.

© 2021 Phyton, Inc. Microsystems and Development Tools



62

CPI2-Gx Device Programmers - CPI12-Gx

-
Buffer Configuration

Buffer name, Code settings | |D lacation | Data |

Buffer Mame

Buffer £#0

Size of layer Code”:

128 KB

Fill layer Code' with data:

Eefore loading file
After device is selected

[ Data to fill layer with:
i i@ Predefined (3FFF)
() Custom: (cFF

(") Random

f Shrink; buffer size when device is selected

[/ oK

][ﬁ Cancel ][ﬂ Help ]

Dialog Control

Description

Buffer Name

Here you can type a name for the buffer or pick it from the history
list. By default the first opened buffer gets the name "Buffer #0",
the next one "Buffer #1", etc. Using this field you can give the
buffer any name you wish.

Size of sub-layer 'Code’

Here you can select the size of the 'Code' layer using drop-down
menu, from 128KB to 32MB.

Fill sub-layer 'Code' with
data:

The program fills the buffer sub-layers with default data pattern,
usually 'FF's or zeros. By checking these boxes you specify
when the 'Code' layer fills with default information - before
loading the file or right after device type has been chosen or
both.

Leaving the "Before loading file" box unchecked enables merging
multiple files in a single buffer with following programming a
merged file into a target device. This, for example, can be
convenient for merging code with configuration data for
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programming microcontrollers if the configuration file exist
separately from the main code file.

These two radio buttons define whether the 'Code' sub-layer will
be filled with default information specific for the selected device,
or by a custom bit pattern or randomly.

Data to fill sub-layer
with:

Initially, buffer size usually exceeds target device 'Code’ size. By
checking this box you decrease buffer size to match target
device layer size and to free unused PC memory.

Shrink buffer size when
device is selected

Other tabs open appropriate dialogs which control filling the sub-layer with data similarly to filling the
main (Code) layer.

3.2.3.4.3 The Serialization, Checksum, and Log Dialog
The dialog allows writing serial numbers, unique signatures, checksums and user-specified

information into target device memory. It also allows to configure writing log of the process of mass
production device programming.

Important!
All functions available with these dialogs: Serialization, writing in Checksums, Signatures,
etc.
work ONLY when you use the Auto Programmingl 18l mode for mass production.

The tabs of the dialog shown below allow manual setting of the parameters and methods of their
calculation:
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Serialization, Checksum, Log File

General Serial Number Checksum Signature String Custom Shadow Areas Log File

Attention! All operations with Senal Number. Checksum, Signature String. Shadow Areas and
Log File are performed with Auto Programming only.

Using Serialization

® Discard serial numbers of defective devices. In this mode serial numbers ofthe device yield ma},ur
include gaps in the sequence of numbers written into successfully programmed devices.

If a programming operation fails, discard the device but keep incrementing serial numbers (in
() accordance with the 'Serial Number' dialog's settings). In this mode. serial numbers ofthe device
yield are always represented by continuously increasing sequence, i.e. without gaps.

Generall &

Serial Number[ e
Checksum [e

Signature String[

Custom Shadow Areas[ 71

Log File[ 72

ChipProg-02 merges: a) the data loaded to buffers and b) special data set in the shadows areas and
then writes the merged data array into the target memory device. If some addresses of the merged
data overlap each other then the data taken from the shadow areas overwrite ones taken from the
memory buffer and the merged data physically move[ &1 to the target device memory.

3.2.3.4.3.1 Shadow Areas

Concept of Shadow Memory Areas
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Shadow memory areas are special parts of the computer RAM that the ChipProg-02 program
handles in a special way allowing to create unique data images for each single device to be
programmed. In most cases such a challenge is essential for Gang-Programming[=1when a CPI2-
Gx gang programmer concurrently flashes identical devices on boards comprising a multi-PCB
panel. Then very often, besides the same code, it is necessary to write into each device a unique,
device-specific, information: such as a serial number, checksum, bar code scanned from the board,
device MAC address, etc.. The ChipProg-02 software is featured with a mechanism allowing to
create such unique, dynamically changing data and to merge these data with the code, writing these
merged images into specified part of the device memories. The ChipProg shadow memory
mechanism, implemented in the ChipProg-02 software and CPI2-Gx firmware, enable correct
merging of the common data with dynamically changeable portions of data into one data image,
unique for each target device. Shadow areas are special memory locations laying away from the
buffer[ 18, in the computer RAM. Hereafter in this chapter the "buffer" means a specified layer| 181 of
the device memory (Code, ID parameters, Data, EEPROM, etc.) that contains a common part of data
image to be written in the devices on boards.

CPI2-Gx operates with two types of shadow memory areas:
a) dedicated to certain, frequently used parameters;
b) custom shadow areas that can be used for programming custom parameters.

CPI2-Gx has three types of shadow memory areas dedicated to the parameters frequently
programmed into devices along with the code: Serial Number[ es], Checksum| es', and Signature
String[ 7. The ChipProg-02 setting dialogs for each of these parameters are very specific and the
mechanisms of blending these parameters located in dedicated shadow memory areas with the
buffer content are built into the ChipProg-02 software and cannot be changed by the programmer
user.

For specifying other parameters, such, for example, as bar codes scanned from target boards,
device MAC addresses, parameters exceeding limitations of the dedicated shadow memory settings,
etc., ChipProg-02 enables creation virtually unlimited number of Custom Shadow Areas[ 711 and
manipulation with them.

How does it work?

When a current programming site initiates a request for the device #N programming, the CPI2-Gx
fetches data from the source buffer layer, browses shadow areas predefined for the site #N and
replaces the layer data by contents of these area forming the merged data image to be written to the
device #N and physically writes this merged image to the device. Then the programmer repeats the
operations for the device #N+1 taking content of the shadow areas predefined for the device #N+1
and so on and so on. The addresses of each identical shadow memory areas and their sizes are the
same for all devices but the contents vary. The picture below shows how the programmer prepares a
data image to be written to a target device.
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=
\{

Data inthe Buffer Layer

—_— Merged data image for programming to target device

The diagram below displays shaping data images for four board programming. Each unique data
image includes a common part fetched from the buffer layer[ 181 merged with contents of three

dedicated and one custom shadow areas.
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Shadow Memory Areas #1

5N CREC | | Sign. Eustnr‘

Target Boards

#1

-

:} Image#1

Shadow Memory Areas #2

5N CRE | | 5ign. | Euston

#
77

e | Shadow Memory Areas #3

> Image#?

#3

S ! 5.0 | | CRC | |51‘gn.| tust[d
. -

> Image#3

Shadow Memory Areas #4

5.N. CRC Sign. I‘_'ustm{

#4

Overlapping of Shadow Areas and Buffer Data

‘> Image#4
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If any addresses in the merged data overlap, the data read from shadow areas overwrite the data

read from memory buffer, in the order shown below.

Custom shadow areaN ?
Custom shadow area N-1 ?
Custom shadow area N-2 ?

Custom shadow area 2 ?
Custom shadow area 1 ?
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Signature string ?

Checksum ?

Serial Number ?

Data in memory buffer

The ChipProg-02 software itself does not prevent of or warn about the shadow memory overlaps. The
user should carefully check correctness of the addresses set in the the Serial Number] e9,
Checksum[ &, Signature Stringl 701and Custom Shadow Areas[ 711 setting dialogs to prevent data
image corruption as a result of accidental shadow areas overlapping.

3.2.3.4.3.2 General settings

The tab contains a dialog to handle serialization of the devices in case a device programming fails. The
two options are shown in the figure below.

Serialization, Checksum, Log File

General Serial Number Checksum Signature String Custom Shadow Areas  Log File

Attention! All operations with Senal Number. Checksum. Signature Sirning. Shadow Areas and
Log File are performed with Auto Programming only.

Using Serialization

©§Discard serial numbers of defective devices. In this mode serial numbers of the device yield mayé

include gaps in the sequence of numbers written into successfully programmed devices.

If a programming operation fails, discard the device but keep incrementing serial numbers (in
() accordance with the 'Serial Number' dialog's settings). In this mode. serial numbers ofthe device
yield are always represented by continuously increasing sequence, i.e. without gaps.
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3.2.3.4.3.3 Device Serialization

The Serial Number tab defines a procedure of assigning a unique number to each single device
from a series of devices to be programmed. By default serial number starts at 0, is incremented by 1,
and occupies one byte.

Element of dialog Description

If this box is checked, the programmer will write a serial number
into the specified address of the specified memory layer of the
target device, as defined by the settings below.

Write S/N to address:

Use this field to specify the starting serial number. Default value is

Current serial number: 0

Specify the size of serial number in bytes; for example: 1, 2, 4, etc.

S/N size, in byte: .
12€, 1N By Default is one byte.

These radio buttons define the order of bytes in the serial number
(if it occupies more than one byte): either the least significant byte
(LSB) follows the most significant byte (MSB) or vise versa.

Byte Order

These radio buttons choose the serial number display format - decimal or

Display S/N as: hexadecimal.

By selecting this radio button you set the serial number increment

I t ial b . e
nerement serial number as the fixed value specified here: 1, 2, 10, etc.

by:

By checking this radio button you set the increment value to the

Use script to increment B o o
IPLIo result of executing the specified script file.

serial number:

3.2.3.4.3.4 Checksum

The Checksum tab controls automatic calculation of checksums of data in buffers and writing the
checksums into the target device memory. Checksums can be calculated using a commonly used
"standard" algorithm, or using a complex custom algorithm implemented in a script[ 17,

Element of dialog Description

If this box is checked, the programmer will write a checksum into
the specified address of the specified memory layer of the target
address: device, in accordance to the parameters below.

Write checksum to

Address range for There are two options for setting the address range: Auto and
checksum calculation: User-defined.

Auto: The address is defined as a full range of the selected device
memory layer. This is the default.
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User-defined:

Here you can specify the start and end addresses of the selected
device memory layer for which the program calculates the
checksum.

Use algorithm to calculate
checksum:

This drop-down menu allows to select one of several available
algorithms. The default is "Summation, discard overflow".

Use script to calculate
checksum:

By checking this radio button you specify a script that implements
custom checksum calculation.

Size of calculation result:

These radio buttons choose the size calculated checksum: one,
two or four bytes.

Size of data being
summed:

These radio buttons choose the size of data being summed up:
one, two or four bytes.

Operation on summation
result:

These radio buttons allow to perform no operation on the
calculated checksum, or to negate or complement it.

Byte Order:

These two radio buttons define an order of bytes that represent the
checksum - either the least significant byte (LSB) follows the most
significant byte (MSB) or vice versa.

Exclude the following
areas from checksum
calculation:

Checking off this box allows to specify one or more memory
ranges that will be skipped by the checksum calculation algorithm.
To specify a range, enter its start and end addresses and click the
'‘Add’ button.

3.2.3.4.3.5 Signature string

The tab contains settings for writing user-defined signature string into the target device. The signature
may include generic data (such as the date when the device was programmed) and unique data
(such as project name, operator name, etc.).

Dialog Control

Description

Write Sighature String to
address:

in sub-layer:

When this box is checked, the programmer will write the specified
signature into the specified address of the specified memory layer
of the target device, according to parameters below.

Max. size sighature string:

This field defines the maximum length of the signature string as a
number of characters.

Use Signature String
template:

One of two radio buttons. If checked, the string of parameters from
Template String Specifiers drop-down menu will be programmed into
the target device.
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Use script to create T_hls radio bu_ttonbselects anfalternatlve me_thod of composing the

Signature String: signature string by means of a custom script.

Template String This field lists available parameters (specifiers) for inserting into

Specifiers: the Use Signature String template field. Each parameter starts with
the '$' symbol.

3.2.3.4.3.6 Custom Shadow Areas

The tab opens the dialog allowing to set custom shadow areas and to watch content of these areas
for debugging of automated device programming.
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’Seﬁaﬁzaﬁun, Checksum, Log File @

| General | Seral Number | Checlsum | Signature String | Custom Shadow Arsas | Log File|

List of Shadow Areas:
| # Sublevel Address Size

IHETEEC O (o A |

2 IDlocation kA 2
’ [ Edit... ]
o Delte |
Data in shadow area #1 (Code: (bBF)
<Area modified or has been just added:
Launch script to fill shadow areas:
D\ Temp \CALC CMD » [yl Browse..

[ OK |[i Cancel | (@ Hep |

Click the +Add button opens a sub dialog prompting to specify the buffer layer[ 11, content of which
will be merged with the custom shadow memory area, the area’'s address and size. A user may
create as many custom shadow areas as needed to be blended to same or different buffer layers.
The picture above displays two custom shadow areas reserved for two buffer layers: Code and ID
parameters.

The pane Data displays current content of the highlighted shadow area. Right after creation it is
blank. Then the area can be filled by executing of an ACI function or by a script. To use a script check
the box below the Data pane and specify the script name and location. In the example above the area
#1 is going to be filled by the script CALC.CMD.

3.2.3.4.3.7 Logfile

The tab allows set up of a log or logs of the device programming.
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Dialog Control

Description

Enable log file

Check this box to enable logging device programming sessions
and to set log parameters below.

Separate log file for each
device

Radio buttons to select whether separate logs will be written for
each manufacturer or target device type, or single log will be
written for all devices programmed.

File Name (Generated
Automatically)

Radio buttons to select what kind of specifier will be included in the
log file name: both manufacturer and device type (for example:
Atmel ATSAM3S1BB-AU, Microchip PIC18F2525, etc.) or device
type only (for example: ATSAM3S1BB-AU, PIC18F2525, etc.).

Folder for log file:

The field for entering the full path to the folder where log files will be
created. There is also a button for path browsing.

Single log file for all
device types

Check this radio button to write single log for all types of devices
programmed.

File Name

The field for entering the full path to the folder where the common
log file will be created. There is also a button for path browsing.

Log File Contents

Log file settings.

Gang mode: Socket #

If device is programmed in Gang (multiprogramming) mode when
this box is checked, the socket number will be logged.

Date/Time

Check this box to log date and time of device programming.

Events (device type
change, file names, etc.)

Check this box to log all events associated with device
programming, such as target device replacement, loaded file
names, etc.

Device operation

Check this box to log all events associated with device
manipulations.

Detailed Device operation

Check this box to enable more detailed logging of all events
associated with device manipulations.

Operation Result

Check this box to log results of programming operations.

Device #/Good devices/Bad
devices

Check this box to log the total number of the devices programmed,
the number of successfully programmed devices and the number
of failed ones.

Serial Number

Check this box to log serial number read from the device.

Signature string

Check this box to log signature string read from the device.

Checksum

Check this box to log checksum value read from the device.
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3.2.3.4.4 The Sata Caching, Standalone... Dialog

Buffer name

Check this box to log buffer name.

Programming address

Check this box to log ranges of device locations that have been
programmed.

Programming options

Check this box to log all programming options.

Log File Format

A Pair of adio buttons: one selects plain text format of the log file,
the other selects comma-separated text that can be imported into
Microsoft Excel.

Log File Overwrite Mode

A pair of radio buttons. Checking the top one selects the mode of
appending new records to a specified log file. Checking the other
selects overwriting the old log each time CPI2-Gx re-starts.

Warn if size exceeds

If this box is checked, ChipProg-02 will issue a warning every time
log size exceeds a user-specified value.

Immediately write log file
to disk, no buffering

If this box is checked, ChipProg-02 writes log directly to hard drive
without buffering it in computer RAM.

This topic refers to the settings of Standalone Operation Mode. Read the entire chapter| 133,

3.2.3.4.5 |P Address Setting Dialog

If a CP12-Gx programmer is controlled via Ethernet, a DHCP server assigns local IP addresses to each
CPI2-GM1 module connected to the Ethernet switch device installed on the programmer's
motherboard. The addresses are changed dynamically by the LAN router. However, it is possible to
set unique static IP addresses for each CPI2-GM1 module.

To set static IP addresses a CPI2-Gx programmer should be connected to a PC via USB. When then,

after setting static IP addresses, the programmer has been switch to the LAN control, these static IP
addresses assigned to CPI2-GM1 modules, can be always examined, but not changed!, within the

programmer GUI.

To set the IP addresses open the Configure > IP address settings... menu. This will open the dialog

below:
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% Device Programmer IP Addresses Settings
Programmer Serial IP address Subnet mask Default gateway MAC address
MB: GMV-100032, Site 1 GM-100047 <Auto= <Auto> <Auto> 70-B3-D3-8A-41-9F
[T me: GMY-100032, Site 2 GM-100053 <Auto= <Auto> <Auto> 70-B3-D3-8A-41-A5
] me: GMV-100032, Site 3 GM-100041 <Auto= <Auto> <Auto> 70-B3-D5-8A-41-4E
[T mB: GMV-100032, Site 4 GM-100048 <Auto= <Auto> <Auto> 70-B3-D5-8A-41-A0
4 Edt. | [) ResettoAuto |
"4 0K

It lists serial numbers of the motherboard (MB:) and site order numbers in the Programmer column.

The column Serial# lists serial numbers of CPI2-GML1 programming modules installed on the

motherboard. A far right column lists MAC addresses of the modules. To assign static IP addresses
for selected CPI2-GM1 modules check appropriate boxes in a very left column and click the Edit

button.

If only one box is checked the Edit IP Address dialog will pop up.

o

it EditIP Address

IP Address Settings

Distribute IP addresses sequentially starting with this address:

[ 2 |l

IP Address: 192 . 168 211 3|

Subnet Mask: 255 . 235 253 0

Default Gateway: 192 . 168 222 1
" 0K l | s Cancel | | € Help

Type in the address in the IP Address field and click OK. The example above specifies the IP

address 192.168.211.3 for the site #1.

If you check more than one site in the Device Programmer IP Addresses Settings dialog, as it is

shown below and click OK
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it Device Programmer IP Addresses Settings

Programmer Serial IP address Subnet mask  Default gateway MAC address
MB: GMV-100032, Site 1 GM-100047 192.168.211.1 255.255.255.0 192.168.222.1 70-B3-D5-8A-41-9F
] | mB: GMW-100032, Site 2 GM-100053 <Auto= <Auto= <Auto= 70-B3-D5-8A-41-A5
MB: GMV-100032, Site 3 GM-100041 192.168.211.2 255.255.255.0 192.168.222.1 70-B3-D3-8A-414E
MB: GMV-100032, Site 4 GM-100048 192.168.211.3 255.255.255.0 192.1068.222.1 70-B3-D3-BA-41-A0
[ Edt. | [®) ResettoAuto

Copy IP address list to clipboard

you will be prompted with the Edit IP Address dialog allowing to set static IP addresses for multiple
modules:

[ o]

#f Edit IP Address (3 device programmers selected) @
IP Address Settings
Distribute IP addresses sequentialy starting with this address:

IP Address: 192 . 168 . 211 . 1|

Subnet Mask: 255 . 235 . 255 . 0

Default Gateway: 192 . 168 . 222 .1
¥ 0K | %  Cancel | | € Help

Check the Distribute IP addresses... box and enter the first IP address. Then click OK to complete
settings. This will assign the specified address to the most top module in the list; other selected
modules will be automatically assigned with IP addresses incremented by 1. See below the result of
setting static IP addresses for 3 of 4 modules installed in a CPI12-G04/08V1 gang device programmetr;
the #2 site (GM-10053 remains getting IP address dynamically):
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it Device Programmer IP Addresses Settings

Programmer Serial IP address Subnet mask  Default gateway MAC address
MB: GMV-100032, Site 1 GM-100047 192.168.211.1 255.255.255.0 192.168.222.1 70-B3-D5-8A-41-9F
MB: GMV-100032, Site 2 GM-100053 <Auto= <Auto= <Auto= 70-B3-D5-8A-41-A5

MB: GMV-100032, Site 3 GM-100041 192.168.211.2 255.255.255.0 192.168.222.1 70-B3-D3-8A-41-4E
MB: GMV-100032, Site 4 GM-100048 192.168.211.3 255.255.255.0 192.168.222.1 70-B3-D5-8A-41-A0

EEOE

[ Edt. 1 [®) ResettoAuto

Copy IP address list to clipboard

ChipProg-02 will set identical Subnet mask and Default gateway for all the programmer sites. After
setting static IP addresses you may copy these settings to the clipboard and then to a file.

Clicking the Reset to Auto button resets all the settings made in the Edit IP Address dialog.

Important Note.

to complete setting static IP addresses before restarting the programmer with LAN control
you must cycle the programmer power.

3.2.3.4.6 Simplified User Interface Editor

This topic refers to the settings of the Simplified User Interface (SUI). Read the entire chapter[ 3.

3.2.3.4.7 The Preferences Dialog

This dialog contains settings for miscellaneous options.

© 2021 Phyton, Inc. Microsystems and Development Tools



CPI2-Gx Device Programmers - CPI12-Gx

Options

Enable caching of buffer data to the programmer SD card
[ ]Reload lastfile on start-up
Execute Power-On test on startup
[ ] Terminate device operation on error and do not display error message
Show error messages in the 'Operation Progress' pane
Display clock in the 'Operation Progress' pane
Log operations to the Console window
Reset all settings to defaults when closing project
[«] Deny computer power suspension

Sounds

Use PC SpEEkEFtﬂ p|E sounds
¥

Use sound card to p|E sounds
¥

Device operation error. | Sound 1 w @ Test

Device operation complete: |Mone v| [E Test

Device operation complete (Gang Mode).  Mone ~| [E Test

Programming start (AutoDetect Mode).  Mone ~| [E Test

Device countdown value reaches zero: | Mone v| |@ Test
< 0K i Cancel © Help

Dialog Control Description

Options Some (but not all) dialog options are described below.

Check this box to reload the last loaded file into the open buffer(s) every

Reload last file on start- B
time you start CP12-Gx.

up

© 2021 Phyton, Inc. Microsystems and Development Tools



Control Interfaces 79

Execute Power-On test on
start-up

This box is checked by default. Uncheck it to skip running self-test at
CPI2-Gx start-up.

Terminate device
operation...

Check this box to stop programmer operations operations on any error
and suppress error messages in the user interface.

Log operationsin the
Console window

Check this box to enable dump of programming session trace to the
Console window.

Deny computer power
suspension

While the programmer is not communicating with the target device, the
computer may switch to the sleep mode. Check this box to prevent
Windows from entering the sleep mode. This does not prevent entering
sleep mode when an operator closes notebook lid or shuts down the
computer by selecting Start > Shut down. This option will not disable
screen saver nor prevent powering off the monitor.

In the process of CPI2-Gx executing any command on the target device,
entering sleep mode is disabled regardless of this check box status
because powering off USB port may cause damage to the target
device.

If this box is unchecked, PC wake-up will cause ChipProg-02 software
crashes. If a crash happens, it is necessary to cycle CPI2-Gx power
and re-launch the ChipProg-02 application.

Sounds

All programmable sounds can be picked from the preset ChipProg-02
sounds

Device operation error:

Select the sound for error operations.

Device operation
complete:

Select the sound for successful completion of the programming
operations in a single programming mode (i.e. when one CPI2-Gx is in
use).

Device operation
complete (Gang Mode):

Select the sound for successful completion of the programming
operations in a gang programming mode (either a few single-site
programmers are connected to one PC for multi-device programming
or the CPI2-Gx gang programmer is in use).

Programming start
(AutoDetect Mode):

Select the sound for indicating the start of the device programming
when the CPI2-Gx automatically detects insertion of a device into
programming socket.

3.2.3.4.8 The Environment Dialog

The Environment dialog includes the following tabs:

Fonts[ &0 tab,

Colors[ 8" tab,

Mapping Hot Keysl &0 tab,

Toolbar[ &M tab,
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Miscellaneous Settings| &2 tab.

3.2.3.4.8.1 Fonts

The Fonts tab of the Environment dialog provides settings for fonts and some Ul elements in ChipProg-02
windows. Only monospaced (non-proportional) fonts are used to display information in windows (default is
Fixedsys). To change window appearance you can select a font to be used in all windows, or in any
particular window.

The Windows area lists the types of windows. Select a type to change its settings. The settings apply to all
windows of selected type, including the windows that are already open.

Control Description

Window Title Bar Toggles display of title bar for windows of the selected type. If the box is
checked it adds a toolbar at the position specified by the Windows Toolbar
Location option. To save screen space uncheck the box. Also, see notes
below.

Window Toolbar Sets the toolbar location for selected window.

Location

Grid Toggles display of the vertical and horizontal grids in windows of certain types,
and enables adjustment of column width if the vertical grid is allowed.

Additional Line Provides additional line spacing to be added to the standard line spacing.

Spacing Specify a new value or choose from the list of most recently used values.

Define Font Opens the Font dialog. The selected font applies to all windows of the selected
type.

Use This Font for All Applies the font of the selected window type to all ChipProg-02 windows.

Windows

Notes

1. To move a window that does not have a title bar, place the cursor on its toolbar, where there are no buttons,
and then act as if the toolbar were the window title bar. Also, you can access the window control functions
via its system menu by pressing the Alt+<grey minus> keys.

2. Each window has Properties item in its context menu, which can be accessed by a right click. The Title
and Toolbar items of the Properties sub-menu toggle the title bar and toolbar on/off for the active window.

3.2.3.4.8.2 Colors

The Colors tab of the Environment dialog contains color settings for window elements such as background,
font, etc. By default most colors are inherited from MS Windows; here you can set your preferred colors.

Control Description
Color Scheme Name of the color scheme. Your can type a name or choose a recently used

one from the list.

Save button saves the current scheme to disk; later you can restore color
settings by just a mouse click. Remove button removes the current scheme.
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Colors

Lists the names of color groups. Each group consists of several elements.

Inherit Windows
Color

When this box is checked, the selected color is inherited from MS Windows
color scheme. If later you change the MS Windows colors through the Windows
Control Panel, this color will change accordingly. This option is available only for
background and text colors.

Use Inverted

When this box is checked, the program inverts the selected window colors (for

Text/Background text and background). For example, if the Watches window background is white

Color and the text is black, then the line with the selected variable will be highlighted
with black background and white text.

Edit Opens the Color dialog if the Inherit Windows Color and Use Inverted
Text/Background Color boxes are unchecked for this type of window.
The Color dialog also opens with a double-click on a color in the Colors list.

Spread Sets the selected color for all windows. This option is useful for text and
background colors. For example, if you set yellow text on blue background for
the Source window, and then click the Spread button, these colors will be set
as the text and background colors for all windows.

Font To highlight syntax in the Source window you can specify additional font

attributes - Bold and Italic.

In some cases when synthesizing bold fonts, MS Windows increases character
size so that the font becomes unusable, because the bold and regular
characters should be of the same size. In these cases, the Bold attribute is
ignored.

Sometimes this effect takes place with Fixedsys font. If you need to use Bold
fonts, choose the Courier New font.

3.2.3.4.8.3 Mapping Hot Keys

The Key Mapping tab of the Environment dialog is used to assign hot keys to all ChipProg-02 commands.
The Menu Commands Tree column displays a tree-like expandable diagram of all commands. The Key 1
(Key 2) columns contain hot key combinations corresponding to commands. The actions apply to the currently

selected command.

Control Description

Define Key 1 Opens the Define Key dialog. In the dialog, press the key combination you

Define Key 2 want to assign to the selected command, or press Cancel.
Alternatively, double-click the "cell" in the row of this command and the Key 1
(Key 2) column.

Erase Key 1 Deletes the assigned key combination for the selected command.

Erase Key 2 Alternatively, right click the "cell" in the row of this command and the Key 1
(Key 2) column.
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3.2.3.4.8.4 Toolbar

The Toolbar tab of the Environment dialog controls display and contents of window toolbars.

Control Description
Toolbar Bands Lists the ChipProg-02 toolbars. To enable/disable a toolbar check/uncheck its
box.

Buttons/Commands Lists the buttons available for the toolbar selected in the Toolbar Bands list. To
enable/disable a button on the toolbar check its box.
"Flat" Local Toggles between "flat" and 3D appearance of toolbar buttons in specifyed

Window Toolbars windows.

Toolbar Settings are
the Same for Each
Project/Desktop File

Applies current settings of this dialog to other projects or future opened files.

3.2.3.4.8.5 Messages

Check messages that program should display, uncheck messages that you do not want to be
displayed.

3.2.3.4.8.6 Miscellaneous Settings

The Miscellaneous tab of the Environment dialog contains settings for miscellaneous properties of
ChipProg-02 windows and messages.

Control Description

Main Window Sets visibility and location of the <%CM%> window status line.
Status Line

Quick Watch Turns Quick Watch functionl 199} on or off.

Enabled

Highlight Active
Tabs

Toggles highlighting for the currently active tab (MS Windows-style) in windows
that have tabs.

Double Click on
Check Box or Radio
Button in Dialogs

Makes mouse double click equivalent to single click plus pressing OK button in
dialogs.

Show Hotkeysin
Pop-up Descriptions

Toggles display of hot keys in mouse-over help for toolbar buttons.
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Do not Display Box
if Console Window
Opened

If Console 1A window is open it will show messages. Otherwise messages will
be shown in message box.

Always Display
Message Box

All messages will be displayed in the message box. In addition, the Console
window will also display same messages.

Automatically Place
Cursor at OK Button

When this box is checked, the cursor will always be on the OK button whenever
message box opens.

You can also press Enter key instead of using the mouse to click OK.

Audible Notification
for Error Messages

If this is selected, error message will be accompanied with a beep. Information
(as opposed to error) messages never come with a beep.

Log Messages to
File

Specifies message log file name. All messages will be written to this file.
Writing method depends on the radio button with two options:

Overwrite Log File
After Each Start

For every session, erase previous log file if exists, and create a new one.

Append Messages
to Log File

Append messages to the existing log file. In this case log file can grow without
limit.

3.2.3.4.9 The Editor Otions Dialog

The ChipProg-02 software includes a built-in Scripts Files[ 177 editor. The Editor Options dialog provides
access to editor settings and includes the following tabs.

General Editor Settingsl 83 tab,

Key Mapping@tab.

3.2.3.4.9.1 The General Tab

The General tab of the Editor Options dialog has settings for common options that apply to every
Source[ 180 window.

Descrigtion

Toggles Backspace Unindent mode (see below).

Dialog Control

Backspace Unindents

Keep Trailing Spaces When this box is checked, the editor does not remowe trailing spaces
in lines when copying text to a buffer or saving it to a disk. When the

box is unchecked such spaces are removed.

Vertical Blocks If checked, the Vertical Blocks mode is enabled for block

operations| 188
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Persistent Blocks

If checked, the Persistent Blocks mode is enabled for block
operations.

Create Backup File

If checked then each time a file in the Source window is saved
ChipProg-02 creates a back-up file (with file name extension *.BAK).

Horizontal Cursor

If checked, the cursor will have the shape of a horizontal line, similar to
DOS command prompt.

CR/LF at End-of-file

If checked, a carriage return/line feed sequence will be added to the
end of the file (if it does not hawe it already) when saving file to disk.

Syntax Highlighting

If checked, forces syntax highlightingl@ for language elements.

Highlight Multi-line
Comments

If checked, enables highlighting of multi-line comments. By default,
only single-line comments are highlighted.

Auto Word/AutoWatch Pane

If checked, new Source[18h windows will have Auto
Word/AutoWatch pane at their right, and the automatic word
completion function will be enabled.

Full Path in Window Title

If checked, the Source window caption bars display full path to the
open file.

Empty Clipboard Before
Copying

If not checked, previously kept data remains retrievable after copying to
the clipboard.

Convert Keyboard Input to
OEM

If checked, the Source window conwerts input characters from MS
Windows character set to OEM (local) character set that corresponds
to your localized version of Windows operating system. Also, see
note below.

AutoSave Files Each ... min

If checked, ChipProg-02 will save the file being edited every ‘X
minutes. The value of ‘X can be selected from a list.

Tab Size Sets the tabulation size for text display. Possible values are from 1 to
32. If the file being edited contains ASCII tabulation characters, they
will be replaced with the number of spaces equal to this tabulation
size.

Undo Count Sets the maximum number of available undo steps (512 by default).

Maximum allowed value is 10000 steps; however, larger values
increase the editor's memory usage.

Automatic Word Completion

If the Enable box is checked, it enables the automatic word
comgletionll_giﬁfunction. The Scan Range drop-down list sets the
number of text lines to be scanned by the automatic word completion
system.

Indenting

Toggles automatic indentation of new lines created on pressing. Enter.

NOTE 1. Convert Keyboard Input to OEM box only needs to be checked when adding characters to a file
with OEM character encoding in the Source window. To only display such file correctly without modifying it,
select the Terminal font for use in Source windows. This can be done in the Fonts[ 807 tab of the
Environment dialog: select Editor in Windows list and press the Define Font button.

NOTE 2. The Backspace Unindents mode establishes the editing result from pressing the Backspace key
in the following four cases, when the cursor is positioned at the first non-space character in the line (there are
sewveral spaces between the first column of the window and the first non-space character):
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Backspace Unindent enabled Backspace Unindent disabled

Insert mode Any preceding blank spaces in the line One space to the left of the cursor is
are deleted. The rest of the line shifts deleted. The cursor and the rest of the
left until its first character is in the first line to the right of the cursor shift one
column of the window. position left.

Overwrite mode The cursor mowes to the first column of Only the cursor moves one position left.
the window. The text in the line The text in the line remains in place.
remains in place.

3.2.3.4.9.2 The Key Mappings Tab

You can manage the list of available editor commands in the Key Mappings tab of the Editor Options
dialog. You can add and delete editor commands, assign or reassign hot keys for new and built-in
commands.

In the list, the left column shows command descriptions, corresponding command types are in the right
column. The term Command refers to a built-in ChipProg-02 command; Script NNN refers to an added
user-defined command. Two columns on the right specify hot key combinations that invoke the command, if
they are defined.

Dialog Control Description
Add Opens the Edit Command E dialog for adding a new command to the list and

setting up the command parameters.

Delete Remowes a selected user-defined command from the list. Any attempt to
remove a built-in command is ignored.

Edit Opens the Edit Command dialog to change the command parameters. For
built-in commands, you can only reassign the hot keys (the Command
Description and Script Name boxes are not available).

Edit Script File Opens the script source file of this command in the Script Source[183) window.

Creating new commands

To create a new command, you should develop a script for it. In fact, you add this script to the editor, not the
command. This means that your command is able to perform much more complex, multi-step actions than a
usual editor command. Moreover, you can tailor this action for your convenience, or for a specific work task or
other need. Your scripts may employ the capabilities of the script language with its entire set of built-in
functions and variables, text editor functions|2sh and existing script examples.

A script source file is an ASCII file. To execute your command, the editor compiles the script source file. Note
that before you can switch to using the script which you have been editing, you must first sawve it to the disk
so that ChipProg-02 can compile it.

Script source files for new commands will reside only in the KEYCMD subdirectory of the ChipProg-02
system folder. Several script example files are available in KEY CMD. For more information about dewveloping
scripts, see Script Files[177
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This Edit Command dialog defines parameters for a new or existing command.

Control Description

Command Enter the command description here (optional). Text entered in this box will be
Description displayed in the list of commands, to ease identification of the command.
Script Name Name of the script file that implements this command.

Define Key 1 Opens a special dialog box where you can assign two hot key combinations.
Define Key 2

Script source files for commands will reside only in the KEYCMD subdirectory of the ChipProg-02 system
folder. Enter the file name only, without the path or extension.

Notes
1. You should not specify any key combinations reserved for Windows (e.g. Alt+— or Alt+Tab).

2. We do not recommend assigning any combinations already used for commands in the Source window or
ChipProg-02, as you!l have fewer ways to access those commands. Some examples are Alt+F,
Shift+F1, Ctrl+F7 which open application menus; pthers are local menu hot keys of the editor window.

3. You can use more than one modifier key in the keystroke combinations. For example, you can use
Ctrl+Shift+F or Ctrl+Alt+Shift+F as well as Ctrl+F combination.

4. Hot keys for some built-in commands cannot be reassigned (e.g. cursor movement keys).

3.2.3.5 The Commands Menu

This menu items invoke main commands (a.k.a. functions) that control programming process - from
Blank Check to Auto Programming, mode switches as well as some utility commands. Most
commands of this menu can be launched by hot keys [F7] ...[F12].

Commands | Scripts  Window Help

Blank Check Fa
Program Fa
Verify F10
Read F11
Erase F7
Auto programming F12
Self-Tests...

Switch to Stand-Alone mode...
Switch to Simplified User Interface...

Local menu Ctrl+F10, Ctrl+Enter
Calculator... Shift+F4
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Command Description

3
| |

Launches the procedure of checking the target device
F8 |before programming to make sure it is blank.
Programming of certain memory devices does not
require erasing them before re-programming. For such
devices the Blank Check command is disabled and
shown grayed out on the screen.

F9 |Launches the procedure of programming the target
device, i.e. writes the contents of the buffer into the target
device’s cells.

F10 |Launches the procedure of comparing the information
taken from the target device with the corresponding
information in the buffer.

F11 |Launches the procedure of reading the content of target
device cells into the active buffer.

F7 JLaunches the procedure of erasing the target device.
Some memory devices cannot be electrically erased. In
this case the Erase command is disabled and shown
grayed out on the screen

F12 |Launches the Auto Programming/o8,

Blank Check

Program

Verify

Read

Erase

Auto Programming

Launches testing the CPI2-Gx hardware. In case of
failure the diagnostic results screen will open.
Switches the CPI2-Gx from the computer-controlled
mode to standalone operation mode|:3).

Self-Tests

Switch to Stand-Alone
mode

Hides a standard GUI and replaces it with a preset

Switch to Simplified . o
P Simplified User Interface[113).

User Interface

Local menu Opens local menu of the active window.

Opens Calculator[ &1 dialog which performs calculator

Calculator .
functions.

3.2.3.5.1 Calculator

The primary purpose of the embedded calculator is to evaluate expressions[203 and to convert values from
one radix to another. You can copy the calculated value to the clipboard.

|_Control Description
Expression The text field for entering an expression or a number.
Copy As Specifies format of the result to copy to clipboard.
Signed Values If checked the result of calculation will be interpreted and displayed as a signed

value (for decimal format only).

Display Leading If checked, binary and hexadecimal values retain leading zeroes.

Zeroes

Copy Copies result to clipboard using format set by Copy As radio button.

Clr Clears the Expression text box.

Bs Deletes one character (digit) to the left of the insertion point (Backspace).
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0x Inserts "0x".

>> Shifts expression to the right by specified number of bits.
<< Shifts expression to the left by specified number of bits.
Mod Calculates the remainder of division by specified number.

While you are typing the expression in the Expression field, a drop-down list box ChipProg-02 tries to
evaluate the expression and immediately display the result in different formats in the Result area. States of
Copy As radio button and two check boxes in this area define format of the result.

You can assign values to program variables and SFRs by typing an expression that contains the assignment.
For example, you may type SP = 66h and the value of 66h will be assigned to SP.

Examples of expressions:
0x1234
-126
mai n + 33h
(float)(*ptr + RO)
101100b & OxF

3.2.3.6 The Script Menu

The Script menu contains several commands related to script files.

The ChipProg-02 contains a script language interpreter. Its purpose is automation of programming operations by
mastering complex procedures involving both the device programmer and the programmer operator's actions.
The ChipProg-02 supports composing and executing script files (SF). Working with scripts is describe in
the Script files[1 topics.

Commands in this menu are user-configurable, and the list can be expanded by adding new items (commands).
To add a new item to the menu, place a script file into current folder or into the ChipProg-02 installation folder.

The first non-empty line of any script file must contain three forward slashes followed by a title that will appear in
the Scripts menu:

///<Menu itemtitle>

When ChipProg-02 builds the Scripts menu, it searches the current folder and its installation folder for *. CMD
files whose first line starts with ///' (please remember that //' denotes beginning of a single-line comment) and
inserts the text following ///* into the Scripts menu.

When you select an item from the Scripts menu, click the Start button, ChipProg-02 launches the selected

script.
Button Command Description
EE Start... Opens the Script Files[179) dialog from which you can
New Script Source |Create a new Script File text.
Q Open Watches Opens the Watches|[ 1A window.
window
Add watch... Adds watch to the Watches window .
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Editor window 187 Opens a list of the commands to Compose a new, Open, Save,
Save as, Print a script file. of the Editor|18A window.

Text Edit[ 18} Edit a list of the commands for editing a selected Script File
Example Scripts Invokes the

Help on this menu

Working with scripts is describe in the Script files[17 topics.
3.2.3.7 The Window Menu

This menu lets you control how the windows are arranged within the computer screen. The list of open windows
is shown in the lower part of the menu. By choosing a window in from list you activate it and bring it to the

foreground.

Command Description

Tile Arranges all windows without overlap. Makes the window sizes
approximately equal.

Tile Horizontally Arranges all windows horizontally without overlap. Makes the window sizes
as close to each other as possible.

Cascade Cascades windows.

Arrange lcons Arranges icons of minimized windows.

Close All Closes all windows.

3.2.3.8 The Help Menu

This menu gives access to the help system. See also, How to Get On-line Helpla"l.

mman Description
Contents Opens the contents of the help file.
ChipProg-02 User's Guide Opens complete User's Guide PDF file
(PDF)
ChipProg-02 Quick Start Opens Quick Start Manual PDF file
Manual
Search for Help on Opens a dialog for searching the tool's help system for the content,

index and keywords.

License Management... Opens the dialog that displays a list of current licensed features and
device libraries available for this CPI2-Gx and enabling to upgrade them.

Visit Phyton WEB site Opens the www.phyton.com site in your default Internet browser.
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Create problem report If the CPI2-Gx crashs you can create a problem report and send a it to
Phyton technical support. ChipProg-02 generates problem reports only
when it was launched in the Diagnostic mode. In case the programmer
is running in a working mode click on this menu line causes restarting it
in the Diagnostic mode and then leads to sending a report to Phyton
technical support.

Check for updates Opens the Update Checking dialog that checks whether you are
running the most recent software version of ChipProg-02 and enables
automatic checking with different period of time.

Phyton HelpDesk Opens the HelpDesk web page where you can open a new ticket for
Phyton technical support, track your old tickets or send a question to
Phyton.

About CPI12-Gx Displays the ChipProg-02 and CPI12-Gx software versions, paths

selected target device type, and device type and manufacturer, the
CPI2-Gx serial number, memory card capacity and some other
parameters.

3.2.3.8.1 License Management Dialog

This dialog displays a list of current licensed features and device libraries available for this CPI2-Gx. It also
enables adding new features and licenses.
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@ License Management e

License options on Phyton WEB site

Extended Features @  Apply license

License  Feature Status
CPI2-ACI Using the Application Control Interface (ACI) Enabled

Device Libraries

License Device Library Status
[00] Basic Basic lbrary Enabled
[01] CPI2-D-ATCM  Microchip & Atmel Cortex device library Enabled
[02] CPI2-D-CYCM  Cypress Cortex device lbrary Enabled
[03] CPI2-D-FRCM  NXP & Freescale Cortex device lbrary Enabled
[06] CPI2-D-ELMOS Elmos controller library Not licensed
[08] CPI2-D-SLCM  Siicon Labs Cortex device library Enabled
[09] CPI2-D-STCM ST Microelectronics Cortex device lbrary Enabled
[10] CPI2-D-TICM  Texas Instruments Cortex device library Enabled
[11] CPI2-D-TOCM  Toshba, Maxim Cortex device library Enabled
[12] CPI2-D-ALPLD  Alera PLDs device lbrary Enabled

[13] CPI2-D-FR0O812 NXP & Freescale HC08/508/512 device lbrary  Enabled
[14] CPI2-D-TI430 Texas Instruments MSP430 device lbrary Enabled
[15] CPI2-D-STM8 ST Microelectronics ST7/STM8 device lbrary  Enabled
[16] CPI2-D-RE26  Renesas RL78/RX200/RX6xxx device lbrary  Enabled

[17] CPI2-D-UPD78 Renesas uPD78xx device lbrary Enabled
[18] CPI2-D-SL51 Siicon Labs EFM8/8051 device library Enabled
[19] CPI2-D-PIC32  Microchip PIC24/32, dsPIC30/33 device lbrary Enabled
[20] CPI2-D-RESC  Renesas R8C device lbrary Enabled
< (lose | ‘ e

Clicking on the License options on Phyton WEB site link opens a page in the CPI2-Gx item catalog where
you can check a list of all currently available licenses - both Extended Features and Device Libraries
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licenses.

The Extended Features pane lists the licenses that go beyond the set of CPI12-Gx default features. For
example, the CPI12-AClI license enables use of the Phyton ChipProg-02 Software Development Kit
(SDK)[158), On-the-Fly Controll 12 utility and integration with NI LabVIEW [173] software in addition to
the default capabilities.

The Device Libraries pane lists Device Library licenses available at the moment of building the ChipProg-02
distributive. The Status column indicates the licenses physically tied to the CPI2-Gx with a certain serial
number as "Enabled" in green color. The licenses which optionally may be added at a later time are marked
as "Not licensed" in grey color.

If you have purchased a new license or licenses Phyton sends you a binary file that enables specific
capabilities. To update the license list for a CPI12-Gx with a certain serial number, click the Apply license file...
button, browse for the file on your PC, select it, and click Open to update the license list.

3.2.4 Windows

The following types of ChipProg-02 windows can be open from the View menul 52:

Program manager| 109
Device and Algorithm Parameters' Editor/ s

o Buffer[ )
e Device Information|[ ¢
e Console[10

In addition there are two types of windows associated with ChipProg-02 script files:

o Editor
e Watches

3.2.4.1 The Device Information Window

This window displays the type of selected target device and a link opening a connection diagram
between the TARGET connector of CPI2-Gx and a selected target device (DUT).

Dévice Information FHEEE
Socket Scheme | Notes
Device: Microchip PIC16LF18875-1/PT [ISP HY Mode]

Device Type: Microcontroller = PICmicro
Connection to the tammet device

It is highly recommended to verify correctness of the CPI2-Gx - to - DUT connection before beginning
your programming session either by clicking the Connection to the target device link in this window
or on the http://phyton.com/products/isp/chipprog-isp2-family/cpi2-b1-connecting web page.
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3.24.2 The Device and Algorithm Parameters Window

The Device and Algorithm Parameters Editor window displays and allows editing (where
appropriate) target device internal parameters and settings. The edited settings must be programmed
into target device by executing the Programl ss1command in the Program Manager 105 window.

Device and Algorithm Parameters Editor [B=l=E
Edit | MinValue | MaxValue | DefaultValue | AliDefault |
Mame Value Description

Device Parameters

8 Fuse Bits =

- Lock bits Lock bits

- Calibration Byte (0h Calibration value for the internal RC Oscillator
Algorithm Parameters

- Algaorithm "In-System Programming" | Programming algorithm

- Oscillator Frequency | 2500 kHz
- Delay after Vee is On

- Programming Mode

Oscillator frequency

Delay afterVccis On

Programming Mode

Power supply valtage
Changed values shown in red color

500V

Changeable parameters shown in blue color

Parameters are displayed as two groups: Device Parameters and Algorithm Parameters. The
groups are separated by a light blue stripe.

Device This group includes parameters specific to each selected device, such as sectors
Parameters | for flash memory devices, lock and fuse bits, configuration bits, boot blocks,
start addresses and other settings for microcontrollers. Usually these parameters
represent certain bits in a microcontroller Special Function Registers (SFRs). Some
of the SFRs can be set in the CPI2-Gx buffers in accordance with device
manufacturer data sheets. However, setting the parameters in the Device and
Algorithms Parameters window is more intuitive. It is impossible to specify all
features that may become available in future devices; therefore not all possible
parameters for new devices are described here.

Important! Changing device parameters| | ProoramManager

in the Device and Algorithm | Progrsm Manager | Options | Statitics |

Parameters Editor window does not Device Status: ALto-detect off

immediately result in corresponding Buffer: | Buffer #0: Code (128 KE), bytes, User (128 KE), byte
changes inside the target device. By Functions

editing the changes you just prepare a - User e @ e
new configuration that is different from o e

the default for the device to be
programmed. The parameters will be

m

{— ‘ Repetitions
1

L X - Verfy 4
changed inside target device on_ly V\_/hen . Lock Bits EEY
you execute the Program function in i~ Program M P a—
Device Parameters group in the Frogramming memory

Function pane of the Program
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Manager 18 window as shown in the

illustration.
Algorithm This group includes parameters of the programming algorithm for the selected
[Parameters | device — including the algorithm type and editable programming voltages.

The window has three columns: 1) parameter name, 2) parameter value or setting, 3) a short
description. Names of the editable parameters are shown in blue; other names are shown in black.
Default values in the Value column are shown in black; after changing a parameter the new value will
be shown in red. If the value is too long to display, it is shown as three dots ('..."). The red color of
these dotst means that the parameter has been edited.

To edit a parameter double click its name. Some editable parameters are represented by a group of
check boxes, others have to be typed into text fields.

Local toolbar located at the top of Device and Algorithm Parameters Editor window contains the
following buttons:

Toolbar Button Description

Edit Opens a dialog to modify highlighted parameter in the format most
convenient for the parameter. Double click on a highlighted
parameter also opens such dialog.

If the parameter being modified is restricted to values from a
certain range, clicking on the Min.value button sets the highlighted
parameter to the minimum allowed value.

Min.Value
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Max Value If the parameter being modified is restricted to values from a
' certain range, clicking on the Max.Vvalue button sets the highlighted
parameter to the maximum allowed value.

Clickin on this button returns the highlighted parameter to the
Default

default value.
Al Default \S:V:L(]:(;(ér;? on this button sets default values for all parameters in the

Depending on the type of a parameter ChipProg-02 offers the most convenient format for editing the
parameter:

Method of Editing Description

D When a parameter value may be picked from a few preset values,
rop-down menu . . S

the dialog shows a drop-down list of such values. Highlight a new
value in the list and click OK to complete editing. For example,
some microcontrollers can be programmed to work with different
types of clock generators, so the menu prompts to select one of
them.

Check Box dialog When some options can be_set or reset, the dialog appears i_n a

form of several boxes showing the default or recently set option
states. To toggle this behavior, check or uncheck the box. For
example, some microcontrollers allow locking of particular part of
memory by setting several lock bits, so the menu prompts to
select lock bits represented as a set of check boxes.

c - When a parameter value may be set to any value within allowed
ustomizing the - . :
parameter range, the dialog offers a box for entering a new value and a history
list displaying a few recently set values. The dialog prompts with
the min and max values and restricts entry to values in the allowed
range. This type of editing is used for custom values of Vcc and
Vpp voltages.

3.2.4.3 The Buffer Dump Window

The Buffer Dump window is used to display contents of memory buffer.
CPI2-Gx provides flexible buffer management:

¢ You can create an unlimited number of buffers. The number of buffers that can be created
is limited only by the available computer RAM.

e Every buffer has a certain number of sub-levels depending on the type of target device.
Each sub-level is associated with a specific section of the target device address space. For
example, for the Microchip PIC16F84 microcontroller, every buffer has three sub-levels: 1)
code memory; 2) EEPROM data memory; 3) user identification.
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This flexible structure facilitates manipulating with several data arrays mapped to different buffers.
To open a Buffer Dump window, select Main Menu > View > Buffer Dump..

Buffer #0 - Code (128 KB), words: 0000 [0000] [7|=I=E3| Buffer #0 - Data (4 GB),
Code |Dlocation Data Code IDlocation Ds:

Q Addr | Load | Save |Configure Buffer| Setup | View Q Addr | Load |

File: AXTMPYUserDLLES dII S File: Mone
Checksum: 00153598 [Summation, discard overflow] Checksum: FFDFIAEZ
000e: 5A4D 0099 0003 08D |IM [ 0Poee200: 74 83
0e04: 0004 0000 FFFF 0000 [ PPPee210: 28 00
0OoE: OOBE 0OOO 0000 0BOO bBoee220: 8B 28
AeC: 9040 PORO 00 PRee | @ w || B00062360: E6 FF
- 0ePe0240: 00 E8
Q Addr | Load | Save |Conflgure Buffer | Setup | View | \ap0p0250: 00 48
1068: 58468 65535 35656 34251 d H A PARRE2660: AC 0P
1864 : 29888 13065 59602 2458 ([t 2 PPERE270: E6 FF
1008: @ 5867 06128 13 0 D APPPB220 - BA 20
1868C: 59648 65200 65535 64131 PPERB290: ER E6
1816: 29955 13063 59593 3130 (ul 30 3: APPPE2AR: S5F EA
1914: 6 448 @ 18432 [ H APERE2RA: 48 81
1818: 35979 16420 1 18432 @ 0 H v | lpeeee2ce: 48 21

The figure above shows three Buffer Dump windows representing three parts of the same buffer:

¢ Window #1 (the largest) shows buffer contents starting at address 0Oh.

¢ Window #2 shows the same buffer contents starting at the same address, displaying data in
decimal format.

o Window #3 shows the data starting at address 200h.

The leftmost column of the above windows shows absolute address of the first cell in each row.
The addresses always increment by one byte: 0, 1, 2.... Each address is followed by a colon ().
When you resize a window, the addresses shown in the address column automatically change in
accordance with the number of data items in each line. Some windows may be split into two panes
— the left pane showing data in a selected format, and the right pane showing the same data in
ASCII format.

The window has a toolbar for invoking settings dialogs and commands. Full path to the loaded file
and checksum of the dump are displayed beneath the toolbar.

Local Menu and Toolbar

The context-sensitive menu brought up by a right mouse click is used to invoke context commands and
dialogs of the Buffer Dump window. Most, but not all, local menu entries are duplicated by local toolbar
buttons at the top of the window. Following are local menu and toolbar items:

Menu Item Toolbar Description
button
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New address... Addr Opens the Display from AM@ dialog.

Load file to buffer... Load Opens the Load Window Dumgmﬁ dialog.

Save data to file... Save Opens the Save Window Dumgm dialog.

Configure buffer... Configure | opens the Configuration Window Dump[ 7 dialog.
buffer

Window setup... Setup Opens the Window Dump Setugm dialog.

Editing in the buffer dump windows is disabled by

) o View default, so you can only view the data. If this box is
View only, edit disabled unchecked editing will be enabled and you will be able
to modify value under the cursor.

Opens the Modify Datal 108 dialog. This is only enabled
when the View only, edit disabled is unchecked.

Modify data Modify

Operations with memory

blocks Block Opens the Operations with Memory Blocks[ 108 dialog.

Swap fields No button Mowves the cursor between right and left window panes.

3.2.4.3.1 The 'Configuring a Buffer' dialog

The dialog allows to configure buffer dumps using the most convenient way, and name or rename
open buffers. By default, the first opened buffer is named ‘Buffer #0’, the next buffer is named ‘Buffer
#1', and so on. You can, however, rename buffers to your liking.
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Buffer Configuration

Buffer name, Code settings  |D location Data

Buffer Mame

Buffer #0 e

Size of layer 'Code".

125 KB e

Fill layer 'Code' with data:

Before loading file
[v] After device is selected

Data to fill layer with:

(@) Predefined (Ix3FFF)
() Custom: OxFF
() Random

Shrink buffer size when device is selected

«  OK ¥ Cancel € Help

Initially each buffer is allocated a minimum of 128K of PC RAM and the ChipProg-02 program fills the
buffer with a predefined pattern (usually OFFh). You can customize these buffer settings - check the
Custom radio button and type in the pattern to be used to fill the buffer..

By default ChipProg-02 program fills the buffer sub-layers with default data pattern, usually 'FF's or
zeros. By checking these boxes you specify when the 'Code' layer fills with default information -
before loading the file or right after device type has been chosen or both.

Leaving the "Before loading file" box unchecked enables merging multiple files in a single buffer with
following programming a merged file into a target device. This, for example, can be convenient for
merging code with configuration data for programming microcontrollers if the configuration file exist
separately from the main code file.

3.2.4.3.2 The 'Buffer Setup' dialog

The dialog allows controlling the data presentation in the Buffer Dump| %1 window. You can open the dialog
using the Windows Setup command of the local menu or by clicking the Setup button on the local toolbar.
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Control

Description

Buffer:

Displays a list of all open buffers. Programming functions will be
applied to the active one.

Display Format

Three radio buttons select the format for the data displaye: binary,
decimal or hexadecimal.

Display Data As:

Four radio buttons select the format of data presentation in the
buffer: 1, 2, 3 or 4 bytes.

Options

Options to customize display format.

ASCII pane

If checked, the right pane will display ASCII characters
corresponding to the data in the buffer dump.

Display checksum

If checked, calculated checksum will be displayed in the blue strip
over the data dump, beneath the local toolbar.

Limit dump to sub-layer
size

If checked, dump window will display part of the memory whose
size is equal to the size of the active sub-layer.

Signed decimal and hex
values

If checked, the most significant bit (MSB) of the data shown in
binary or hexadecimal formats will be treated as a sign. If MSB=1
the data is negative, if MSB=0 they are positive.

Always display '+' or '~

This is a sub-setting for the Signed decimal and hex values option.
If both boxes are checked then the signs '+' and -' will be
displayed.

Leading zeroes for decimal
numbers

If checked, data in decimal format will be shown with leading
zeros; for example, 256 will be shown as 00000256.

Reverse bytesin words
(LSB first)

If checked, the order of bytes in words will be reversed so that the
MSB follows the LSB.

Reverse words in dwords

If checked, the order of 16-bit words in 32-bit words will be
reversed.

Reverse dwordsin qwords

If checked, the order of 32-bit words in 64-bit words will be
reversed.

Non-printable ASCII
characters

Characters in the range 0x00...0x20 and 0x80...0xFF are non-printable.
Following options customize display of non-printable ASCII
characters in the ASCII pane of the buffer dump window.

Replace characters
0x00...0x20

If checked, all characters in the range 0x00...0x 20 will be replaced
with the dot (.") or space ('"). Pair of radio buttons Replace with
selects the replacement character: dot (.") or space ().
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Replace characters If _checked, all characters in the range 0x80...0xFF will be r'eplaced
0x80.. OXEF with dot (.") or space (' ). A pair of radio buttons Replace with
selects the replacement character: dot (.") or space ().

3.2.4.3.3 The 'Display from address' dialog

The dialog allows to set a new starting address for the \isible part of the Buffer Dump] 91 window.

Element of dialog Description

Type new address to Here you may enter any address within valid range.
display from:

History Displays a list of previously entered addresses. You can pick one to set as
starting address for the buffer dump.

3.2.4.3.4 The 'Modify Data' dialog

The dialog allows to edit data in the Buffer Dump[ ¢ window. The dialog can be invoked only when the View
toolbar button if off, otherwise editing is disabled. To modify a data item in the buffer move cursor to its
location and click the Modify toolbar button. You will be able to enter a new data value in the pop-up box
or pick one from the history list. Alternatively, select a location by moving cursor to it and enter new
value using the PC keyboard.

3.2.4.3.5 The 'Memory Blocks' dialog

The ChipProg-02 program supports complex operations with memory blocks. This dialog controls operations with
blocks of data within a selected buffer or between different buffers.
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o Operations with memory block - ﬁ

Source Operation Destination
Buffer: i@ Fill with value(s); [©F0 - Buffer:
(@) Buffer £#0 (") Search for data: (@) Buffer #0
() Copy
(7) Compare
Layer- () Invert Layer.
@ Code (128 KB). bytes © AND with value: © Ende (138 e byies
) User (128 KB), bytes e ) User (128 KB), bytes
() Data (128 KE). bytes () XOR with value: () Data (128 KE). bytes
Start address: () Swap bits of data bus <3 Start address:
0 - (") Swap bits of address bus | < - 0
End address:
Dc1FFFF -

Full range

o OK [ﬁ Concel ] ’ﬂ el

The dialog has three columns. Source, the left column, describes the source memory area used in
operations described in the middle column. Operation result will be placed in the area described by

Destination, the right column. By default, destination is same as source. Two operations — Fill and Search —
do not require destination; if any of these two operations is chosen, Destination radio button will be

disabled.
Control Description

Start Address
(of the Source)

Starting address of the memory area in the selected Source buffer to
which the operation will be applied.

End Address
(of the Source)

Ending address of the memory area. Ending address can be entered for the
Source area only. Once the source address range is defined, program
automatically calculates destination area ending address.

Full Range
(of the Source)

Sets the starting and ending addresses to span entire address space of
selected target device.

Start Address
(of the Destination)

Starting address of the memory area in the Destination buffer where the
result of the selected Operation will be stored.

The following operations are available via this dialog. Operation starts when you click OK in the dialog box

(see notes below).

|_Operation

Descrigtion

Fill with Value

Fills the source buffer with a value (or a sequence of values) specified in the

text box at the right.
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Search for Data

Searches the source memory area for a particular value (or a sequence of
values) specified in the text box at the right.

Copy Copies contents of the source area to the destination address. A block can
be copied within the same address space or to another one.

Compare Compares contents of source and destination memory areas. The sizes of
source and destination areas are equal. If there is a mismatch, a mismatch
message box will request permission to continue the comparison process.

Invert Inverts contents of the source area bit-wise and stores the result in the

destination area.

Calculate Checksum

Calculates a 32-bit checksum for the source area. The calculation is done
by simple addition. See note below.

Negate Result

If checked, the 32-bit checksum will be subtracted from zero (this is a
widely used method of checksum calculation).

Write Result to
Destination

If checked, the 32-bit checksum will be written to the destination sub-level
at destination Start Address. If this box is cleared, the checksum wil onlyl
be displayed in a message.

AND with Value

Performs bit-wise AND operation on the contents of the source memory
area using operand specified in the text box on the right. The result is
stored in the destination area. See notes below.

OR with Value

Performs bit-wise OR operation on the contents of the source memory area
using operand specified in the text box on the right. The result is stored in
the destination area.

XOR with Value

Performs bit-wise XOR operation on the contents of the source memory
area using operand specified in the text box on the right. The result is
stored in the destination area.

Notes

1. Source and destination memory areas may overlap; since operations on memory blocks are carried out

using a temporary intermediate buffer, the overlap does not cause corruption of results.

2. The Copy and Compare commands use blocks specified in the Source address space and the
Destination address space.

3. The checksum is calculated as a 32-bit value by simple addition. If a memory space has byte organization,
then 8-bit values will be added. If it has word organization then 16-bit values will be added.

4. Logical operations (AND, OR, XOR) are performed on the contents of the Source address space, while the
operation result is written to the Destination address space. The program automatically converts the
operands to the word size of the selected type of memory (16-bit for Prog, Datal6, Reg and Stack
memory, 8-bit for Data8 memory).

3.2.4.3.6 The 'Load File'dialog

The dialog defines how a file is loaded into the buffer.

Description

Control
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File Name: Enter a full path to the file in this box, pick the file name from a drop-down
menu list, or browse files on your computer or network.
File Format: Select format[103 of the file to be loaded by checking one of the radio

buttons in the File Format field of the dialog.

Buffer to load file to:

Select buffer to load the file into, by checking one of the Buffer# radio
buttons. There may be just one such button.

Layer to load file to:

The Buffer to load file to can have more than one memory layer. Select
the layer into which the file will be loaded by checking one of the radio
buttons. There may be just a single button available for selection.

Start address for binary
image:

Files in Binary format do not carry any address information. When
loading binary files you have to specify the starting address for
loading. In case the file to be loaded is a binary image enter starting
address in the box here.

Offset for loading
address:

Files in formats other than Binary may carry information about the
starting address for the loading. If the file to be loaded is not a binary
image, enter the offset for the file addresses in the box here. The
offset can be positive or negative.

3.2.4.3.6.1 File Formats

The ChipProg-02 program supports a variety of file formats that can be loaded to the CPI12-Gx

buffers.

File Format

Description

Standard/Extended Intel
HEX (*.hex)

The Intel HEX file is a text file, each string of which includes the
starting address to load the data to the buffer, the data to load, line
checksums, and some additional information. The ChipProg-02
loader supports both Standard and Extended Intel HEX format.

Binary image (*.bin)

Binary image contains only data. These data will be loaded to the
buffer beginning with the specified starting address.

Motorola S-record
(*.hex, *.s, *.mot)

The Motorola S-record is a text file, each line of which includes
starting address to load the data into buffer, the data to load, line
checksums, and some additional information. The ChipProg-02
loader supports all kinds of the Motorola S-records with filename
extensions .hex, .s, .mot.

Altera POF (*.pof)

The Altera POF-file is a text file, each line of which includes
starting address to load the data into buffer, the data to load, line
checksums, and some additional information. The format is mostly,
used for programming PALs and PLDs.
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JEDEC (*.jed)

This format is used for programming PALs and PLDs. A JEDEC-
file includes starting address to load the data into the buffer, the
data to load, test-vectors, and some additional information.

Xilinx PRG (*.prg)

The Xilinx PRG-file is a text file, each line of which includes starting
address to load the data into buffer, the data to load, line
checksums, and some additional information. The format is used
for programming the Xilinx PLDs.

Holtek OTR (*.otp)

This format is presented by Holtek company. An OTP-file includes
the starting address to load the data into the buffer, the data to
load, line checksums, and some additional information.

Angstrem SAV (*.sav)

This format is presented by Angstrem company. A SAV-file
includes the starting address to load the data into the buffer, the
data to load, line checksums, and some additional information.

ASCII Hex (*.txt)

The ASCII TXT-file includes the starting address to load the data
into the buffer, the data to load, line checksums, and some
additional information.

3.2.4.3.7 The 'Save File' dialog

The dialog defines how the buffer is to be saved to a file.

Control

Description

File Name: Enter a full path to the file in this box, pick the file name from a drop-
down menu list, or browse files on your computer or network.

Addresses Start and End Addresses define buffer address range that will be written
to the File. To save entire buffer click the All button.

File Format: Selected format[103) of the file to be written by checking one of the radio

buttons in the File Format field of the dialog.

Buffer to save file from:

Select the source buffer to write into the file by checking one of the
Buffer# radio buttons. There may be just one such button available.

Sub-level to save file
from:

The Buffer to save file from can have more than one memory layer.
Select the source layer by checking one of the radio buttons. There may
be just one such button available.

3.2.4.4 The Console Window

The Console window displays messages generated by the ChipProg-02 program. These messages
fall into two categories: the CPI2-Gx error messages and what-to-do prompts. The window
accumulates messages even when it is closed. You can open it at any time to view the last 256
messages, and get help for any of them. Error messages are shown in red color, others in black.
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The window should be large enough to see several messages. To save screen space you can close
the Console window and redirect all messages to pop-up message boxes. To do this, go to the
Configure menu > Environment > M@ tab and select the Always Display Message Box
option. Alternatively, you can select the Do not open box if Console window opened option,
redirecting all messages to Console window.

Click the Help button in the box to show the CPI2-Gx context-sensitive Help topic associated with the
error, or click the Close button and continue after correcting a parameter error.

Local Menu and Toolbar

The local menu contains Console window context commands and dialog calls. This menu can be opened
by a right mouse click in the window. Most, but not all, local menu commands are duplicated as local toolbar
buttons at the top of the window. Following are the local menu and toolbar commands:

Menu Command Toolbar Description
Button

Clear Window Clear Deletes all messages from the window

Opens context-sensitive Help topic associated with
Help on message MHelp . L. o

the error or information in the highlighted message
Help on window No button Opens the Console window Help topic
Help on word under o b Opens the context-sensitive Help topic associated
cursor o button | with the word under cursor

3.2.45 The Program Manager Window

The Program Manager window is the primary screen object used by an operator to control the
CPI2-Gx in the GUI mode. While some windows can be closed during programming operation, the
Program Manager is supposed to be always open and visible. The window includes three tabs:

The Program Manager tab[108] - by default this tab is open (see below)

The Options tab[18)

The Statistics tab[1d

In the Gang Programming[ 391 control mode the window displays as many tabs as many sites are
united into the programming cluster of multiple CPI2-Gx programmers. See below an example of the
window for a CPI2-G06/12V1 gang device programmer with 6 programming modules. Each tab has a
pair of buttons: Execute and a small ? button at the right.
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Program Manager s
Frogram Manager |Dptiur15 I Statistics|

@E}cecute: B+A4A T| %E}cecute: B+& [w @E}cecute: B+& | w %Eﬁecute: B+4 |w

Mo device Mo device Mo device Mo device
Total: O Total: 0 Total: 0 Total: 0
Good: 0 Good: 0 Good: 0 Good: O
Bad: 0 Bad: 0 Bad: 0 Bad: 0
& Execute: B+A | w || S Execute: A
DEMUK PMode: Channel A

- - DEMUX Mode: Channel B
Mo device Mo device
Total: O Total: O DEMUX Mode: Channel 4, then B
Good: 0 Good: 0 .
Bad: O Bad: O DEMUX Mode: Channel B, then A
| 1 | 2 | Y I 4 | 5 | g Set this mode for all sites

Device changed to Atmel AT83552 [ISP Mode] —
Ready: Jan 27, 2018 17:28:41

The ? button allows you to specify the programming channels| 2%, on which a corresponded
Execute button will launch the Auto Programming[ 8] command. If the the on-module demultiplexer
is enabled by the CPI2-DEMUX license, click on the ? button opens a drop down menu that list all
the DEMUX mode options which can be selected individually for each site: Channel A, Channel B,
Channel Afirst, then B, Channel B first, then A. By checking the Set this mode for all sites box
you can set the same DEMUX mode for all sites when you set it for any one site. Then click on the
Execute button will launch the Auto Programming[08] command for a chosen site.

If the CPI2-DEMUX license is not installed on the CPI2-Gx, click on the ? button causes opening a
warning that the demultiplexer is disabled. In this case the site will always execute the Auto
Programming/ 8 command on the channel A.

CPI2-Gx device programmer operating in the Single Programming[ 21 mode, when only one

3.2.4.5.1 The Program Manager tab

This tab serves for setting major programming parameters, carrying out programming operations and displaying
the CPI2-Gx status.

Control Description

Buffer: Displays the active buffer to which the programming operations
' (functions) will be applied. A full list of open buffers is available here
via the drop-down menu.
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Shows a tree of functions available for the selected target device.

Functions . .
Some functions represent CPI2-Gx commands while others group
several sub-functions and can be expanded or collapsed. Double-
clicking on a function invokes the command and is equivalent to
single-clicking the Execute button (see below).

Blank check Checks if the target device is blank

Program Programs the target device (physically writes the information from active buffer
to the target device).

Read Reads contents of the target device into active buffer.

Verify Compares contents of the target device with contents of active buffer.

Executes a preset sequence of operations (batch operations). The sequence
can be defined using the Auto Programming] e8! dialog. The Edit Auto
button opens this dialog.

Auto Programming

Addresses Here you can set the addresses for the buffer and the target device to
which the programming functions will be applied.

Device start: Starting address of the target device physical memory which will be
programmed or read.

Device end: Ending address of the target device physical memory which will be
programmed or read.

Buffer start: Starting address of the buffer memory from which the data will be written to the
target device or to which the data will be read from the device.

There are three alternative ways to activate a highlighted function: a)

Execute . . -
to click the Execute button; b) to double click on the function line; ) to
press Enter button on PC keyboard.

Repetitions: Any function can be executed repeatedly. The number of repetitions
can be set here.

Edit Auto Clicking on this button opens the Auto Programminngosﬁ dialog.

Operation Progress Dlsplays progress bar and the status (OK, failed, etc.) of current
operation.

Besides generic functions such as Blank Check, Read, Verify, Program, Auto Programming, the Functions
window often includes collapsed submenu of functions specific to the selected target device. When expanded it
shows a list of commands for the parameters that can be set in the Device and Algorithm Parameters| o)
editor window.

IMPORTANT NOTE!

Any changes made in the ‘Device and Algorithm Parameters’ window do not
immediately cause corresponding changes in the target device. Parameter settings
made within this window just prepare a configuration of the device to be programmed.
Physically, the programmer makes all these changes only upon executing an
appropriate command from the ‘Program Manager’ window.
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3.2.4.5.1.1 Auto Programming

Each device has its own typical set of programming operations that usually includes: Erasing, Blank Checking,
Programming, Verifying and often Protecting against unauthorized reading. The ChipProg-02 stores default
batches of these programming operations for each supported device type. A batch can be executed by a simple
mouse click or pressing the Start button on the programmer panel. A sequence of functions (operations) can be
customized via the Auto Programming dialog. To open this dialog click on the Edit Auto button.

Selected functions Awailable functions
W Blankc Check
Blank Check Code: 0..(k<2FFF, Buf. Start: 0 ....pmg?
Prcugrclm Code: 0..0x2FFF, Buf. Start: 0 . Read
Verify Code: 0..2FFF, Buf. Start: 0 -
Data: Blank Check Data: 0..B¢7FF, Buf. Start: 0 - Verty
Data: Program Data: 0..0«7FF, Buf. Start: 0 - Erase
Data: Verfy Data: 0..0«7FF, Buf. Start: 0 ¥ Remove > =) Data
Device Parameters: Fuss: Program - Blank Check
Device Parameters: Fuse: Verfy
- Program
- Read
- ey
=) User
- Blank Check
- Program
. Read
o ey
[=)- Device Parameters
- Fuss I
Program
..... Read |
..... Verify
=) Lock Bits
Program
..... Read
Edit function addresges... | [ 7 Verfy
| e |CJ'|ed<Jng memary

’ Restore defaults

A tree of all functions available for the selected device is shown in the right pane, Available
functions. To add a function to the batch highlight it in the right pane and click the Add button - the
function will appear in the left pane, Selected functions. The functions will be executed in the order in
which they are listed in the Selected functions pane, starting from the top. To edit a batch highlight
the command to be removed and click the Remove button.

3.2.4.5.2 The Options tab

This tab contains controls for setting additional programming parameters and options:

Control ‘ Description

© 2021 Phyton, Inc. Microsystems and Development Tools



Control Interfaces 109

. Radio buttons in the Split data group control programming of 8-bit
Split data[10%) ) S 9 ;

— memory devices to be used in microprocessor systems with 16-
and 32-bit address and data buses. In such cases buffer contents
have to be properly prepared in order to split single memory file
into several smaller files.

Options:

Check device ID

This option is on by default, and the CPI2-Gx always verifies
target device identifier assigned by device manufacturer. If this
box is unchecked the program will not check device ID.

Reverse bytes order

If checked, the ChipProg-02 will reverse byte order in 16-bit
words while it executes Read, Program, and Verify operations.
This option does not affect data in CPI2-Gx buffers.

Blank check before
program

If checked, the ChipProg-02 will make sure the target device is
blank before programming it.

Verify after program

If checked, the ChipProg-02 will verify the device content after it
has been programmed.

Verify after read

If checked, the ChipProg-02 will verify device content once it has
been read.

On Device Auto-Detect or
'Start' Button:

The checked radio button in this group defines what CPI12-Gx will
do upon when either 'Start' button has been pushed or when the
programmer detected the START signal applied to the pin #4 of the
CONTROL connector.

3.24.5.2.1 Splitdata

Radio buttons in the Split data group of the Option[ 108 tab control programming of 8-bit memory
devices to be used in microprocessor systems with 16- and 32-bit address and data buses. In such
cases buffer contents have to be properly prepared in order to split single memory file into several
smaller files. Splitting the data allows to convert data read from 16- or 32-bit devices in a way
required to create file images for writing them to memory devices with byte organization.

Radio Button

Description

No split

This is the default. The buffer is not split and is treated as an array
of single-byte data.

Even byte

The data in the buffer is treated as an array of 16-bit words. The
buffer-device operations are conducted using even bytes only.
For example, programmer reads one byte of device data at
address 0 and stores the byte in buffer location also at address 0.
The byte read from device address 1 will be stored in the buffer
location at address 2, etc.
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Odd byte

The data in the buffer is treated as an array of 16-bit words. The
buffer-device operations are conducted with odd bytes only. For
example, programmer reads one byte of device data at address O
and stores the byte in buffer location also at address 1. The byte
read from device address 1 will be stored in the buffer location at
address 3, etc.

Byte 0

The data in the buffer is considered to be an array of 32-bit words.
The buffer-device operations are conducted with the byte #0 only.
For example, programmer reads one byte of device data at
address 0 and stores the byte in buffer location also at address 0.
The byte read from device address 1 will be stored in the buffer
location at address 4, etc.

Byte 1

The data in the buffer is considered to be an array of 32-bit words.
The buffer-device operations are conducted with the byte #1 only.
For example, programmer reads one byte of device data at
address 0 and stores the byte in buffer location also at address 1.
The byte read from device address 1 will be stored in the buffer
location at address 5, etc.

Byte 2

The data in the buffer is considered to be an array of 32-bit words.
The buffer-device operations are conducted with the byte #2 only.
For example, programmer reads one byte of device data at
address 0 and stores the byte in buffer location also at address 2.
The byte read from device address 1 will be stored in the buffer
location at address 6, etc.

Byte 3

The data in the buffer is considered to be an array of 32-bit words.
The buffer-device operations are conducted with the byte #3 only.
For example, programmer reads one byte of device data at
address 0 and stores the byte in buffer location also at address 3.
The byte read from device address 1 will be stored in the buffer
location at address 7, etc.

3.2.4.5.3 The Statistics tab

This tab displays statistics of programming session - Total number of devices programmed during
the session, what was the yield (Good) and how many devices have failed (Bad). These statistics
are helpful when you need to program a series of same type devices. It is important to remember that
statistic counters are affected by executing the Auto Programming[ 108 only, execution of other
functions has no effect on statistics.

Control

Description

Clear statistics

Resets the statistics.

Device Programming
Countdown

Normally the Total counter increments after each Auto
Programming/ 108}, the Good and Bad counters also count up. The
ChipProg-02 reverses the counters to decrement their content (to coung

down).
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If checked the ChipProg-02 will count the number of the programmed
Enable countdown devices down.

Display message If checked the ChipProg-02 will issue a warning when the Total counter

when countdown reaches zero.
value reaches zero

Reset counters If checked the ChipProg-02 will reset all counters when the Total
when countdown counter reaches zero.
value reaches zero

Count only If checked the ChipProg-02 will count only successfully programmed
successfully (Good) devices. All other statistics will be ignored.

programmed

devices

Clicking on this button opens a field for entering a new Total number

Set initial that will then be decremented after each Auto Programming][08),
countdown value

Below you can see an example of Statistic tab displays programming session statistics for each of
four programming sites. Total number of devices that were programmed during the session, what was
the yield (Good) and how many devices have failed (Bad).

© 2021 Phyton, Inc. Microsystems and Development Tools



112

CPI2-Gx Device Programmers - CPI12-Gx

3.2.4.6

Program Manager [7]ES

Program Manager Options Statistics

Site#  Total Remaining Good Bad
1
2
3
4
All

K.;mmmm
gwmwm
b = @O = Q

970

= ] Clear statistics

Device Programming Countdown

Enable countdown
Display message when countdown value reaches zero
Reset counters when countdown value reaches zero

Count only successfully programmed devices
Setinitial countdown value...

Current initial value: 1000

The Memory Card Window

The window displays information about projects stored on memory cards in programmers, about limit
counter, and about serialization record counter. The window can be brought up using menu " View" [ 52

->"Memory Card Window."
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Memary cards window [F==E
Collapse All | Expand

L
M

ﬁupPoject @: Job: -, "<Unnamed>", Chip: "Macronix MX25L12873FM2I [ISP Mode]", Da
“Project 1: Job: -, "TXY-@l-Atmel”, Chip: "SST SST25VF@4eB  [ISP Mode]", Data: 1
$"File5 loaded into buffers
gmLimit: Mone
=% Shadow areas (@ of 1000 devices programmed)
B Shadow Area Descriptors
i -#@: SublLevel: @, Addr: Bx2008, Size: 4, Type: Serial Number
~#1: Sublevel: @, Addr: Bx2020, Size: 4, Type: CRC
-#2: Sublevel: @, Addr: Bx32, Size: 8, Type: User
B Shadow Areas Data (1000 total)
-S/N: DOOOABTSE, CRC: PODOQIFE, User: 00OQ0A32: 00 00 00 00 00 20 00 00
-S/N: DODOABTY9, CRC: PODOALFE, User: 00OQ0A32: 00 00 00 00 00 00 00 00
-S/N: DODOABTA, CRC: PODOALFE, User: 00OQ0A32: 00 00 00 00 00 20 00 00
-S/N: DOOOABTE, CRC: PODOAIFE, User: 00DOQ0A32: 00 00 00 00 00 20 00 00
-S/N: POOOABTC, CRC: PODOAIFE, User: 00DOQ0A32: 00 00 00 00 00 00 00 00
-S/N: POOOABTD, CRC: PODORIFE, User: 00DOQON32: 00 00 00 00 0O 00 0P 00
-S/N: POOOABTE, CRC: PODOOIFE, User: 00DOQON32: 00 00 00 00 00 00 00 00
-S/N: PODOABTF, CRC: PODOQIFE, User: 00DOQON32: 00 00 00 00 00 00 0P 00
..992 more records

Click the Erase button in the window toolbar deletes selected project from the card. This is useful when
the card is filled up to capacity.

3.2.4.7 Windows for Scripts

ChipProg-02 provides windows for working with scripts.

(Script) Editor[7 window
Watches| 183 window

User[ 180 window
I/O Streaml 0 window

These windows cannot be opened from the View menuls2. They may only be opened when you work
with scripts. Operations with these windows are described in the Scripts Files|177 chapter.

3.3 Simplified User Interface

The CPI2-Gx default graphic user interface makes heavy use of menus, windows and controls that are
redundant in case of mass production. Furthermore, an unskilled operator is usually employed for such
production. Programming a lot of chips or boards of the same type with the same data is routine work
that consists of two operations: replacing target boards in a test fixture and executing a predefined
batch of programming operations (Auto Programming[ % command). To prevent casual CPI2-Gx
mismanagement and to simplify routine operations, the ChipProg-02 enables switching the CPI2-Gx
graphical user interface[ 48) from the default mode to the Simplified User Interface mode (SUI). In this
mode, operator can see a very simple PC screen with very limited information: a single Start button and
three virtual LEDs that indicate CPI2-Gx status: Good, Busy or Error.

The screen shots below displays SUI set for launching a CPI12-Gx device programmer equipped with
four programming modules running in the Gang Programming[ %1 mode when each of two device
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programmers can be launched asynchronously and independently or synchronically. The settings
enable to start programming by clicking either multiple Start buttons - one for each site - or a common
Start button - one for all programming sites (see below).

@f CPL2-Gx Simplified User Interface

g

Project: |ABC test - |

Device: Atmel AT8958253 [ISP Mode]
Statistics: Total: 0, Good: 0, Bad: 0

Ready
" Start

Ready
&  Start

Ready
& Start

Ready
& Start

% Bt | (@ Hep |

© 2021 Phyton, Inc. Microsystems and Development Tools



Control Interfaces 115

@ CPL2-Gx Simplified User Interface | 22 |

Project: |ABC test -

Device: Atmel AT8958253 [ISP Mode]

Statistics: Total: 0, Good: 0, Bad: 0

Ready

Ready

Ready

Ready

‘@ Start ‘

[ri Exit ] ’E‘ Help

NOTE. Two conditions should be preserved for use of SUI mode. A programming session:
- should be configured by making a project;[+7
- can be started by executing Auto Programming[1él command, only.

Atypical use scenario consists of two steps: Preparation[ 116 and Usel 120

1. Preparationméi An engineer or a technician (hereafter a supervisor) configures the programming
session using the default CPI2-Gx graphical user interface[ 467 and saves the session project| 4. Project
file can be stored at any location on PC hard drive. To launch[ 28] the CPI2-Gx with the SUI, a supervisor
can create a PC desktop icon and specify the project and configuration files. After that supervisor
switches| &1 the user interface to SUI mode for use of the CPI2-Gx by a less skilled operator.

2. Use[10). There are two methods launching the programming when it is controlled via SUI:
automatically by an ATE signal or manually by an operator. In case the ATE (test fixture) generates the
START signal on the CPI2-Gx CONTROL connector (for example, upon closing the fixture lid and
contacting test needles the target device) this launches preset programming session. An operator then

© 2021 Phyton, Inc. Microsystems and Development Tools



116

CPI2-Gx Device Programmers - CPI12-Gx

3.3.1

keeps replacing target boards and close the fixture lid to continue programming boards. Alternatively
launching the programming can be initiated by either clicking the Start button in the CPI2-Gx Simplified
User Interface window or by pressing the Start button on a top of the CPI2-Gx unit.

Settings of Simplified User Interface[18)

Operations with Simplified User Interface[ 1281

Settings of Simplified User Interface

A session project contains information on device type, file name, serialization| 63" parameters, check
sum, list of the functions included in the Auto Programming[ 08 batch and other options, including the
SUI windows and controls configurations| s2). The SUl interface settings[ 1 contain a list of pre-
configured projects, so that operator can pick a project from the list in the Use project pane unless the
Allow operator to select project from the list box is unchecked. This option can be set by a
supervisor.

To control programming sessions using SUI you first need to create a project. Start with the following
steps.

e Configurationl s menu - select target device.

e Configuration[ 51 menu - set up a buffer[ o7,

« Configurationl 571 menu - set options for device serialization[ 63), writing check sum/[e" and
signatures| Y, and log file[ 72 controls.

e Device and Algorithm Parameters Editor| 21 window - specify the options different from default for a
chosen device.

e Program Manager[ 109 window > Program Manager[ 10 tab > Edit Auto| 108 dialog - configure Auto
Programming/ 8] batch of functions.

e Program Manager[ 109l window > Program Manager[ 6] tab - set programming options.

e Program Manager/[ 105l window > Statistics| 18 tab - enter the number of chips to be programmed and
select other options. When using SUI, countdown of programmed chips is disabled, and the program
only displays the numbers of successfully programmed and failed chips. Other options set in this tab
remain in force.

Once the above settings are done, create the project. In the menu select Project > New. In the Project
Options| s dialog enter project name, file name, format, and other information. Click OK button to save
the project to disk.

NOTE. Itis absolutely crucial that the project is stored on disk before use. The ChipProg-02 does not
protect the SUI project files and window configurations against unauthorized modifications by an
operator or any third party.

Once the project has been created and stored on the hard drive, set SUI options. In Configuration[ 571
menu select the Simplified Mode Editor command. This will bring up Simplified User Interface
Setup window docked to the SUI window at its left. The picture below displays the Setup pane only.
Any changes made in the Simplified User Interface Setup window immediately become visible in the
SUIl window. Clicking the OK button in the Simplified User Interface Setup window completes the
SUl setup; the setup window is closed and Return to Editing button appears in the SUI window. This
allows quick switching back and forth between SUI session setup and actual device programming.

The Simplified User Interface Setup dialog has two tabs described below.

The General Settings Tab
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" ™
Simpiified User Interface 5&_ L7 S|
General Settings |Appeamnce

Current corfiguration: [SUI 1 v]

[ Save | | saveas. |

Auto-save configuration on ‘0K button
Projects

Use project:

(7) D\ Temp“UPP projects"MSD-55¢c Cortroller - Debug 1.upp

(73 D:\TempUPP projects"\MSD-55¢ Controller - Debug 2 (18 Hz).upp
i@ DM\Temp PP projects' STM32F437 upp

’i—.—i Add.. ] ’x Remove from list l ’ﬁ Open project

[ Allow operator to select project from the list

Start Operation
When the device has been automatically detected in the socket
@ Bxplicitty by the “Start” button in dialog
Gang Mode
@) fts own "Start’ button in dialog for each site
(7 Single "Start” button in dialog for all stes

[ Allow operator to terminate operation

(#/ 0K | (% Canced | [@ Hep |

The Current configuration field displays the name of currently active SUI configuration. SUI
configuration files with have name extension .smc and are stored in SMConfig sub-folder of ChipProg-
02 working folder.

The Save button writes current configuration to a file under the name shown in the Current
configuration field; the Save as... button allows saving configuration file under a different name. If the
Auto-save configuration on 'OK" button box is checked, clicking on OK button at the bottom
automatically saves current configuration before dismissing the dialog.

The Projects pane lists all projects associated with current configuration. When Simplified User
Interface Setup window is opened for the first time, the Projects list will be empty. To add a project
use the + Add button. Single configuration may include more than one project; this allows operator to
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change projects without restarting the programmer. If Allow operator to select project from the list
box is checked, the SUI window will list all projects associated with current configuration. Otherwise,
only one project selected from the Use project list will be displayed. To remove a project from the Use
project list, highlight it and click the x Remove from list button. Removing project from the list does
not remove it from disk. The Open project button loads selected project from disk; this will not close
editor window.

The Start Operation pane specifies a method of manual launching programming operation.
The only batch command that can be launched in SUI mode is Auto Programming/ 8. This command

is executed either by pressing the physical button on the CPI2-Gx unit or by clicking the 'Start' button in
the SUI window.

NOTE. These settings do not block or influence in any other way launching CPI12-Gx by an external
START signal generated by ATE on the CONTROL connector.

If Allow programming termination by operator box is checked, the operator will be able to interrupt
programming by clicking Exit button in the SUI window, otherwise the operator will only be able to
initiate device programming.

The Appearance Tab

Here you can choose the type, size and color of the Default Font for each element in the SUI window:
Project name, Device part number, Statistics, Device operation status, and "Start" button.
Checking boxes in Display elements list makes corresponding elements visible in the SUI window.
Clicking Move up and Move down adjusts position of selected element within the window.
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= ™
Simplified User Interface _ L9 eS|

Settings for "Project™

Default Fort
[ Choose fort ...
Tahoma (11)
’ Choose color...
Display elements:
¥l Project
K Proj - Move up
Device part number
Device operation status
"Start" button

[ Frame
Fort
i@ Default
() Custom: Tahoma (11) Choose...
Font color at left Fort color at ight
@ Default (@ Default
(™) Custom Custam Choose. .
(«# oK | (% Cancel | [@ Hep |
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If an element is set to be visible in the SUI window, you can maodify its appearance to differ from the
default and from other elements. Checking the Frame box causes a thin blue frame to appear around

the element. The Font, Font color at left and Font color at right radio buttons modify appearance of
an element to make it distinct from other elements in the SUI window.

When the Statistics element is highlighted, Allow operator to reset statistics box will be displayed.

Check this box to allow operator clear displayed programming statistics.

When the Device operation status element is highlighted, two additional checkboxes, Serial number

and Checksum are displayed. Checking these boxes makes serial number| ¢ and check sum|[ &
written into the last programmed device be displayed below the status line.
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3.3.2

3.4

Operations with Simplified User Interface

To launch programming operations controlled by a configured Simplified User Interface[13 open the
Command|[ 1 menu, and double click the Switch to Simplified User Interface.. line.

To launch the ChipProg-02 with the Simplified User Interface[13) (or in the Simplified Mode) use
the /Y<configuration name> option key in Command linel 120l mode (there must be no spaces
between /Y and <configuration name>). If <configuration name> includes spaces, it must be
quoted. For example, if the configuration name is STM32F429BGT [ISP SWD Mode] - Release, the
command line may look like this:

C:\Program Files\ChipProg-02\6_00 20\UprogNT2.exe /Y"STM32F429BGT [ISP SWD Mode] -
Release" ,

When launched in the Simplified Mode, the ChipProg-02 only displays the SUI window. The main
ChipProg-02 window remains invisible unless an error occurs. If a programming operation fails, the
programmer performs actions according to error handling settings. These settings are available via
Configurel 571> Preferences[ 71 menu. If the Terminate device operation on error and do not
display error message... box in the Preferences dialog is unchecked (default setting), the ChipProg-
02 issues an error message and prompts the user to either ignore the error and resume operation or
terminate it. If this box is checked, any error will cause the programming session to come to a halt; in
such case no error message will be issued.

Command Line Interface

The ChipProg-ISP2 device programmers (both CPI2-B1 and CPI2-Gx) can be controlled from Command Line
using the UProgNT2.EXE executable.

Command line has the following format:
UProgNT2.exe [option 1] [option 2] ... [Name of the project file] [option 3] [option 4]...

Elements in square brackets are optional and may follow in arbitrary order, separated by spaces. These
elements are called options, square bracket characters themselves are not part of the option. Options specify
certain CPI2-Gx functions and settings. Some options are called keys. Command line may also optionally
contain the name of a pro'ectm"l file that will be used to control programmer operation.

Each option begins with either ‘/’ (slash) or ‘-* (hyphen) followed by an option name. The slash and hyphen
characters can be used interchangeably; for example: ‘/L’, is the same as ‘-L’. Valid names are listed in the

Command line options[ 221 table.

Option names, project names, and the application executable name are NOT case sensitive, so there is no
difference between the ‘/A’ and ‘/a’ options. Names containing spaces must be quoted, for example: -L"Data file
5.hex”.

Some options listed in Command line optionsm table require additional parameters; these are shown in the
table enclosed in angle brackets (< >). Parameters specify file names, devices, text strings, serial numbers, etc.
Parameters must follow options without space. For example: "/LData file 5.HEX' (load the Data file 5.HEX into
the buffer after launching the programmer) or "/FH” (file format is hexadecimal).

Upon executing a command line the ChipProg-02 checks whether a project loaded before the program has been
closed at the previous programming session. If it has, the program automatically reloads this old project unless a
new project name is specified in the command line.

There is no difference between loading a project by executing a command line, or loading it manually by means of
the ChipProg-02 user interface menus.
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Some command line examples are:

1) UProgNT2.exe -C"Atmel*AT89C51ED2 [ISP BL Mode]" -L"C:\Work\Output Files\Bin\Serial.bin" -
FB0x2000 -A -I12

Launch the ChipProg-02 application, then:

-C"Atmel"AT89C51ED2 [ISP BL Mode]" - select the Atmel ATB9C51ED?2 [ISP BL Mode] device;
-L"C:\Work\Output Files\Bin\Serial.bin" - then load the file C:\Work\Output Files\Bin\Serial.bin into the buffer #0;
-FB0x2000 - specify the binary format for the Serial.bin file with the start address 0x2000 in the buffer;

-A - then begin the Auto Programming session using the default set of commands programmed in the Auto
Programming menu;

-12 - make the ChipProg-02 main window invisible, when the Auto Programming session completes. If an error
occurs, copy error message to clipboard and close the ChipProg-02 application.

2) UProgNT2.exe "C:\Work\Programmer Projects\Nexus.upp" /Al

Launch the ChipProg-02 application, then load project file "Nexus.upp" from folder "C:\Work\Programmer
Projects" and launch the Auto Programming session from buffer #1. If programming was successful close the
ChipProg-02 application. The CPI2-Gx main window remains visible.

3) UProgNT2.exe

Launch the ChipProg-02 with no options.

3.4.1 Command Line Options

Option name starts with either ‘/’ (slash) or *-* (hyphen), followed by one of the reserved names listed
below. The slash and hyphen characters have the same effect and can be used interchangeably, for
example: ‘/C’, -C'.

-N<serial number> The -N key enables control one CPI12-GM1 programming module installed in a
CPI2-Gx programmer by specifying a serial number of this module. The CPI2-
GM1 programming modules' serial numbers in by using the Help > About...[ 8N
menu command.

For example, the option -NGM2-00029 specifies that all other command line
options apply to the programmer with the serial number -GM2-00029, only.

-GANG This option should be always specified when you control a CPI2-Gx
programmer with multiple CP12-GM1 modules inside, unless you want to
control one selected module only. In this case use the -N option instead. The -
GANG key cannot be used in a combination with the -N key.

The -GANG option can be used either alone, without any specifiers, or with one
of two following: <number of sites> or #<list of serial numbers>. Each
specifier requires use of its own -GANG key. For example: -GANG:4, -
GANG#GM2-00029;GM2-00030. You cannot set both of these specifiers by a
single -GANG key. Below see detail descriptions of use the -GANG option with
the <number of sites> and #<list of serial numbers> descriptors:
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-GANG:<number of
sites>

If the :<number of sites> parameter follows the -GANG key then after
launching the ChipProg-02 application it is waiting until the program detects a
specified number of CP12-GM1 programming modules or for 16 sec, whatever is
longer. For example, the -GANG:2 key stops attempts to establish
communication after the first two CPI2-Gx device programmers have been
detected. The :<number of sites> parameter can be omitted.

For example: -GANG:10 allows operating with 10 CPI12-GM1 modules. Since
CPI2-Gx may allows installing maximum 7 modules the example abowve refers
to the case of use two cascaded CPI2-Gx programmers.

-GANG#<list of serial
numbers>

If the -GANG key is followed by # sign with a list of unique serial numbers
separated by semicolons, the application waits until the number of CPI12-GM1
programming modules matches the number of serial numbers in the list, then
automatically assigns sequence numbers according to the serial numbers in
the list. The CPI2-GM1 modules, specified in this options, can be physically
installed in one CPI2-Gx gang programmers or two or more different, controlled
from one PC. Examples of use:

1. Launch a CPI2-Gx as a two-channel gang programmer operating with two
programming modules having serial numbers GM2-00029 and GM2-00030. The
options to run: -GANG#GM2-00029; GM2-00030.

2. If you have a CPI2-Gx gang programmer equipped with four modules with
serial numbers: GM2-00032, GM2-00044, GM2-00045, and GM2-00047
and wish to operate with it as with two separate 2-channel gang
programmers concurrently programming two pair of different devices,
then launch one copy of the ChipProg-02 program with the option: -
GANG#GM2-00032;GM2-00044 and a second copy - with the option: -
GANG#GM2-00045;GM2-00047. In this example it does not matter if the
modules are physically installed on one CPI2-Gx gang programmer or two
different controlled for the same PC.

3. If you have two CPI2-Gx gang programmers - one with seven and another
with two CPI2-GM1 programming modules with serial numbers of motherboards
VM2-00036 and VM2-00089, respectfully, then the option -GANG#VM2-
00089;VM2-00036 distributes the site (channel) numbers in a 9-channel gang
programmer as following:

Site# 1: VM2-00089, module# 1
Site# 2: VM2-00089, module# 2
Site# 3: VM2-00036, module# 1
Site# 4: VM2-00036, module# 2
Site# 5: VM2-00036, module# 3
Site# 6: VM2-00036, module# 4
Site# 7: VM2-00036, module# 5
Site# 8: VM2-00036, module# 6
Site# 9: VM2-00036, module# 7

Each CPI2-Gx gang programmer's motherboard has its own unique serial
number. An alternative command line option allows to specify a serial numbers
in the of #Module order number in the programmer@Motherboard serial
number format. For example: the

-GANG#1@VM2-00012;2@VM2-00012 option specifies that all other command
line options apply to the CPI2-GM1 modules #1 and #2 installed on a CPI12-Gx
motherboard with the serial number -VM2-00012.
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-ETH This option initiates control one or more CPI2-Gx device programmers

connected to a local network (LAN) via Ethernet (USB is a default option that
does not require use of any keys). The -ETH option can be used either without
any specifiers or with one of two following: <number of sites> or #<IP
addresses list>. Each specifier requires use of its own -ETH key. For example:
-ETH:4, -ETH#192.168.1.{2-128}. You cannot set both of these specifiers by a
single -ETH key. Below see detail descriptions of use the -ETH option with the
<number of sites> and #<IP address list> descriptors:

-ETH:<number of sites> If no parameters follow the -ETH key the program pings IP-addresses of LAN

adapters in a range automatically detected by a computer. This process may
take up to 16 seconds. To speed up connecting all the programmers it is
recommended to specify a <number of sites> parameter. For example, if your
CPI2-Gx programmer has four CPI12-GM1 programming modules and you wish
to use all these modules include the -ETH:4 option in the command line. This
will shorten establishing communications with the programmer.

-ETH#<IP addresses This option specifies an individual IP address or a range of multiple IP

list> addresses to be pinged by a computer while it tries connect programming
modules of one or more CPI2-Gx device programmer(s). Normally, in a local
network (LAN), IP addresses are assigned by a DHCP server automatically.
The DHCP server dynamically distributes IP addresses used by the CPI2-Gx
programming modules.

However, it is possible to specify static IP address if it is assigned to a
particular programming modules unit or a list of IP addresses or a range of IP
addresses assigned to multiple modules. See the examples below:

-ETH#192.168.1.32 - connect a programming module with the 192.168.1.32 static]
IP address.

-ETH#192.168.1.32;192.168.1.38 - connect either a programming module with
the 192.168.1.32 or 192.168.1.38 IP address. After launching the program you
will be prompted to select one of two IP addresses above.

-ETH#192.168.1.{16-128} - scan the programming modules IP addresses in a
range of 192.168.1.16 to 192.168.1.128.

-ETH#192.168.1.* - scan IP addresses in a full range of 192.168.1.1 to
192.168.1.254.

-ETH#192.168.1.{12-33,127,164-254} - scan IP addresses in a range of
192.168.1.12 to 192.168.1.33, then ping a single IP address 192.168.1.127 and
then scan a range of 192.168.1.164 to 192.168.1.254 |IP addresses.

-ETH#192.168.1.* -ETH:1 - scan IP addresses in a full range of 192.168.1.1 to
192.168.1.254 and stop scanning upon connecting to the first detected
programming module.

This option tells the ChipProg-02 program to use the device specified as
C"<manufacturer manufacturer name followed by a * character followed by device part number
Ndevice>" specified here exactly as it presents in the CPI2-Gx device list. The device
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specified in a previously loaded project will be replaced by a device specified by
the -C"<manufacturer”device>" key.

For example: -C"NXPA*MC9S08DV32MLF [ISP Mode]".

Note. The use of the -C option is less beneficial than using projects[ 47,
Projects provide much more flexible and effective control of device
programming. It is highly recommended, especially for mass production, to
create, configure, and save as many projects as needed and use them with
command line.

-L<file name> This option loads the <file name> file into the CPI2-Gx buffer upon launching
the ChipProg-02 program. If other files were previously loaded using some
project, then a new one will be loaded in accordance to the file format and start
address. The loader determines file format[ 103 from the file name extension. If
actual file format differs from the one listed in the file format[ 103 list use the -F
option to explicitly specify file format (see below).

-F<file format> This option sets format of the file specified by the -L<file name> option. The
<file format> must be one of the following letters:

H - standard or extended Intel HEX format
B - binary format

M - Motorola S record format

P - POF (Portable Object Format)

J - JEDEC format

G - PRG format

O - Holtek OTP format

V - Angsrem SAV format

For example, -FH option loads file in the HEX format, which contains starting
address in CPI2-Gx buffer.

If binary format (B) is specified by the -F option, it should be followed by a
destination starting address in the format used in C language. For example: the
option -FBOxFF04 loads binary file and places data starting at the address
O0xFFO04 in the buffer.

In the absence of -L<file nhame> the -F<file format> option is ignored.

This option initiates the Auto Programminngoﬁ session upon launching the
ChipProg-02 application. Upon successful completion the application terminates.
In case of error the ChipProg-02 application remains open until it is manually
closed by operator. If the [buffer number] is omitted, the data for Auto
Programming are taken from buffer #0; otherwise the data are taken from the
buffer with the number that follows -A. For example: the option -A2 specifies that
data for the Auto Programming session will be taken from the buffer number 2.

-Albuffer number]

The -A option is only meaningful if a project name or an -L<file name> option is
also specified on the same command line.

-1 This key hides the ChipProg-02 main window. If an error occurs during
programming process, the window is displayed on the PC screen along with the
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error message. This option is only meaningful if an -A (Auto Programming)
options is specified on the same command line; otherwise the -l option is be
ignored.

-11 This key is similar to the -l key except the -1 keeps the ChipProg-02 main
window hidden even if a programming error occurs. The first occurrence of a
programming error terminates the ChipProg-02 program and returns the error
code 1. (Successful Auto Programming session ends with return code 0.) Return
codes can be used by external applications that control the CPI2-Gx remotely,
such as LabVIEW, similar programs, or batch files.

-12 This key is similar to the -I key; however, -12 keeps the ChipProg-02 main
window hidden at all times, suppresses error messages display, but copies the
error message to Windows clipboard.

-M This key starts the ChipProg-02 software in the demo mode, without use of the
CPI2-Gx hardware and without real data exchange between computer and
programmer hardware. This mode is convenient for evaluating the product without
use of CPI2-Gx hardware.

-S<file> This key replaces the default session configuration file[ 523 UPROG.ses with a
new one named <file> (with the extension .ses). Session configuration file
stores major CPI2-Gx settings, and includes the name of the most recently
used project; it resides in the ChipProg-02 folder. The new session settings will
be used by the ChipProg-02 when invoked from command line.

-O<file> This key replaces the default option configuration filel 521 UPROG.opt with a
new one named <file> with the extension .opt. Option configuration file stores
target device type, file options, etc.; it resides in the ChipProg-02 folder. The
new options will be used by the ChipProg-02 when invoked from command line.

-D<file> This key replaces the default desktop configuration file[ 521 UPROG.dsk with a
new one with name <file> and extension .dsk. Desktop configuration file stores
computer screen configuration, i.e., positions, dimensions, colors and fonts for al
open windows; it resides in the ChipProg-02 folder. The new desktop
configuration will be in force when ChipProg-02 is invoked from command line.

-ES<file> This key executes a script whose file name follows the -ES key, immediately
after starting the ChipProg-02 application. If the command line does not include
the -ES key, the ChipProg-02 application searches for the script file named
‘Start.cmd’ in the working folder and, if such script exists, executes it.

3.4.2 Command Line Option Files

Command line options can be specified directly or by command line option files - response files.
Instead of specifying a command line option it is possible to put a character @ following by a name of
the file that includes the command line options. This character @ following by a file name can be
inserted in the command line anywhere. The ChipProg-02 reads the option file and inserts its content
into the command line. For example, specifying the command line as:
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3.5

UProgNT2.exe -G1 @C:\Files\Programmer.txt
where the C:\Files\Programmer.txt file includes the following lines:

-LF\ARMAIARCPP\Debug\Exe\Test.hex
-FHEX

-A

-12

is equivalent to specifying the command line:

UProgNT2.exe -G1 -LFANARMAIARCPP\Debug\Exe\Test.hex -FHEX -A -I12

Each line in a response file may include one or more options. Blank lines, lines beginning with the a
semicolon (;) or double slash (//) characters are treated as comments and ignored them. For example,

see the C:\Files\Programmer.txt file with added comments:

;== Load file to buffer FAARMAIARCPP\Debug\Exe\Test.hex
-LFAARMAIARCPP\Debug\Exe\Test.hex

§ - Specify the HEX file format
-FHEX

e Conduct Auto Programming

;== Hide GUI. Copy error messages to clipboard.

A command line may include several response files. For example:
UProgNT2.exe @F:\Configl @C:\Files\Programmer .txt

It is also allowed to include one response file into another - then a command line interpreter will extract
all the options of both response files.

On-the-Fly Control Interface

The On-the-Fly Control interface is very similar to command line[123 control interface. However, it can
control a CPI2-Gx programmer that has already been started and is running, without restarting it. On-
the-Fly Control interface can be used to start any operation available for target device, such as Read,
Program, load project| 47, execute script[ 171, etc. On-the-Fly Control utility can be used to control a
running CPI2-Gx programmer by Windows batch files coming with third-party graphical packages such
as National Instruments LabVIEW.[173)

The On-the-Fly Control utility is an alternative to a more advanced Application Control Interface[159)
(DLL control[158): using the latter requires some programming skills.

The OFControl.exe executable resides in the ChipProg-02 installation folder. We suggest you keep it
in that folder and start it from there. Once started, the utility does not modify its working directory..
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After completion, On-the-Fly Control utility issues return codes[131). The code is 0 (zero) in case of
success. Error codes are listed in the UPControl return codes section. The program writes error
messages to the Console[ 03 window and, optionally, to log file[ 721 and/or Windows clipboard.

After the On-the-Fly Control process has exited, CPI2-Gx keeps running unless On-the-Fly Control
utility had been started with the -X key. You may re-launch the On-the-Fly Control utility to control the
same device programmer. However, please keep in mind that only one On-the-Fly Control utility can
control a running device programmer at the same time. In case you launch a second instance of the
On-the-Fly Control while the CPI2-Gx device programmer is being controlled by previously launched
instance, the second instance will not "find" the programmer.

The On-the-Fly Control command line format is as follows.
OFControl.exe [Options] [@<Option File>] [Options]

Each option starts with either /' (slash) or *-* (hyphen) character, followed by a name. Valid nhames are
listed below. The /' (slash) and *-* (hyphen) can be used interchangeably. For example, /L', -P".

The order of options[2Ain the command line is not important. Operations specified by options are
performed in logical order. For example, operations on target device will be performed after loading a
project and executing a script, regardless of the order in which options appeared on command line.
However, the -F<device operation list> and -A options are exceptions. These options define an
order of operations on target device, therefore they are always performed according in the order they
are appear on the command line.

Note. Brackets [] in option descriptions denote optional parameters; brackets should not be used when
specifying actual parameters. Angle brackets <> are used to denote entities and are not part of the
option notation. For example, replace -G[+] with -G+; replace -G[+][<C:\Temp\UPC.log] with -G+C:
\Temp\UPC.log.

If a file name used in an option includes spaces, full name with the path should be used. Any additional
part of an option should not be separated by spaces. For example, -L"H:\Program Files\ChipProg-
02\6_00_20\UprogNT2.exe /g". Here the file name and path is enclosed in quotation marks (") and
there are no spaces between the /L and the rest of the option

The @<Option File> construction specifies a text file containing additional options for On-the-Fly
Control utility. Each option in such file must be listed on a separate string. For example: :

UPControl.exe -D @response.txt -WK

In the option file, lines starting with semicolon (;) are treated as comments and are ignored. A
commented example file response.txt is shown in the Option File example[s2)

3.5.1 On-the-Fly Command Line Options

On-the-Fly Control command line has the following format:
OFControl.exe [Options] [@<Option File>] [Options]

The following table provides detailed descriptions of available options.
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Debug mode: include additional information in console log and in log file
This option is helpful for debugging On-the-Fly Control program.

-G[+][<log file name and
path>]

Send the ChipProg-02 Console[ 104 window output also to a log file. If -
G is followed by a + sign output will be appended to the log file if it
exists. If the + sign is omitted a new log file is created. By default the
log file is called OFControl.log and resides in the ChipProg-02
working folder; you can specify a new file name and location if desired.

|[Examples:

-G - create a new log file, named OFControl.log, in the
OFControl.exe working folder.

-G+ - append records to OFControl.log file if it exists; otherwise
create the file.

-G+C:\Temp\OFC.log - append records to C:\Temp\OFC.log file if it
exists; otherwise create it.

[Keep On-the-Fly Control program running until a key is pressed on thg
keyboard. This allows perusing messages in the Console[03 window
|before it terminates.

options>

-L< ChipProg-02 executablejLaunch the CPI2-Gx device programmer if it is not running. If it has
file name and command line]been already launched the option is ignored. The On-the-Fly Control

program executes the -L option before all other options on command
line, that is before loading a project, executing scripts, or performing any
operations with the device. The -L cannot be used together with -R
option (see below).

[Example: -L"UProgNT2.exe /g1"

-R<device programmer's
serial number>

If more than one CPI2-Gx device programmer is controlled by the PC in
|the gang mode, connect to the unit whose serial number is given by this
option. -R cannot be used in a combination with -L option. If more than
one programmer is controlled by the PC and On-the-Fly Control
command line does not contain an -R option, the program terminates
with error code #14.

Copy error message to the Windows clipboard. Whenever On-the-Fly
Control program terminates with a return code other than O (except
when -T option is used, see below), it means that an error has
occurred. If the the -C option is given, the error message will be copied
[to the clipboard; otherwise the clipboard contents remain unchanged.

If more than one operation specified on On-the-Fly Control command
line results in an error, error messages of all operations will be copied
|to Windows clipboard if the command line also contains the -I option
(ignore errors).

-M[=<timeout in seconds>]

Specifies timeout in seconds when waiting for device programmer to
|pbecome ready before performing certain operations. The operations
include loading a project, running a script, programming target device,
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and terminating execution triggered by the -X option. If -M option is not
specified, On-the-Fly Control program does not check whether
ChipProg-02 is ready to perform the next operation. In case it is not, an
attempt to perform a programming operation will result in program
[terminating with an error.

If the -M option is not accompanied by a [=<timeout in seconds>]

|[parameter, On-the-Fly Control program will wait for the programmer
ready state indefinitely. In this case you can interrupt program execution
and make it quit by pressing Ctrl+C on the keyboard.

Stop an operation with the device. If CP12-Gx performs a programming
[function (Read, Program, Verify, etc.) on target device, it will be
interrupted. This action takes place prior to performing all actions
specified by the options -P, -S, -F, -X options. It is possible, however,
[that the -B option does not interrupt operation on target device. This
happens when the program displays an error dialog that requires
operator response. In this case On-the-Fly Control program exits with
an error code.

-P<project file>

[Load the specified project[ 47 file. Project files with .UPP extensions
contain all information and settings defining a programming session
(device type, file(s) to be written to the device, customized device and
algorithm parameters, interface settings, device serialization options,
scripts, etc.).

Before loading the project file, On-the-Fly Control program waits for

the programmer to stop operations on device (see the -M option). If the
-P option is specified on On-the-Fly Control command line along with
-S and/or -F options, the project file will be loaded before running scripts
or performing any operations on target device.

|Exam ple: -P"C:\Prog\Projects\Antenna-01 Test.upp"

-S<script file>

|Run the specified script] 172, Before running the script On-the-Fly
Control program waits for the programmer to stop operations on
device (see the -M option). By default On-the-Fly Control program
\waits for the script to complete. To allow On-the-Fly Control program
|to continue operations while the script is still running, add the -NWS
option to the option list.

|Example: -S"D:\Prog Scripts\Checksum.cmd"

-NWS

IDo not wait for completion of the scriptl 171 specified by the -S option.

-F<function list>

Execute listed operations (functions) on the target device. Names of the
functions in the list must be separated by semicolons (;). In order to
execute the Auto Programming function the -F option should be
followed by an asterisk character (*).
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If command line has more than one -F option, functions will be executed
in the order in which they are specified on the command line.

If one or more -F options is specified in the command line along with -P
(load project) and/or -S (launch script) options, all functions specified by
-F option(s) will be performed after loading the project file and/or running
the script.

By default On-the-Fly Control program waits for function to complete
before proceeding. To enable the program to proceed while function
specified by the -F option is still executing, add the -NWF option to
command line. In this case you may specify only one -F option on the
command line.

If an -F option specifies a sub-function displayed in the drop-down
menus of the Program Manager function tree, use both menu name
and function name separated by the caret '*' character. For example: -
FProgram (for the Code Memory chip layer) but -FData
Memory”Program (for the Data Memory) .

Examples:

-F* - launch the Auto Programming function.

-FErase;Blank Check;Program;Verify - erase the device, check if it is
[blank, write the file from the programmer buffer and compare the buffer
and device memory contents.

"-F*;Verify;Device Parameters’Program HSB and XAF" - execute the
Auto Programming function, then compare the buffer and device
memory contents, then launch the function Program HSB & XAF from
the Device Parameters sub-menu.

-NWF

|Do not wait for completion of the function specified by -F option. This
option is incompatible with -X.

Ignore errors during programming operations. By default On-the-Fly
Control program stops operations on target device in case of any error
The -1 option enables the operations to continue regardless of error
conditions; this allows logging of all errors that occurred.

-T[+][W=<delay in
milliseconds>]

\Wait for programmer status ['Ready" or "Busy"]. On-the-Fly Control
program returns code 0 (zero) when CPI2-Gx stops and becomes
ready to perform a programming operation ("Ready"), or 1 if an
operation on target device is underway ("Busy").

In addition, if '+' sign follows the -T and the programmer status is busy,
current function name (Read, Program, etc.) will be output to the
console window along with the completion percentage of the function
being executed. For example: Program, 87%.

Optional [W=<delay in milliseconds>] parameter sets a delay before
getting the programmer status. Delays allow checking programmer
status within a settable period of time.
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Examples:

-T - get the programmer status "Ready" or "Busy"
-TW=1000 - wait for 1 sec, then get the programmer status "Ready" of

IIBusyll
-T+ - get the programmer status "Ready" or "Busy" then output to the

Console window the name of currently executed function and
percentage of its completion. An example of the function status string:

Read 56%.

V=[0 1]

|Hide (-V=0) or make visible (-V=1) the ChipProg-02 main window.

If ChipProg-02 main window is hidden, the program will not be present
among other open applications in the Applications tab of the Windows
Task Manager. In order to stop a running ChipProg-02 program you
will have to go to the Process tab of the Task Manager, then locate and
highlight the programmer executable name (UprogNT2.exe) and click
the End Process button.

Stop the programmer and quit the program. To quit the ChipProg-02
|[program, the programmer must complete all current operations on the
device. The On-the-Fly Control program waits for completion of the
current programming operation for the period of time specified by -M
option. If this option is omitted or the timeout period has expired, On-
|the-Fly Control returns an error.

-?or-H

Show a brief description of the On-the-Fly Control program options
and exit.

3.5.2 On-the-Fly utility return codes

Upon completion On-the-Fly Control program returns code O (zero) in case of success. Otherwise it
returns one of the error codes listed below. There is one exception related to the use of option —T. If -T
option is specified On-the-Fly Control returns 0 if the programmer is stopped and 1 if an operation on

the target device is underway.

Error messages are set to the Console[ 0% and, optionally, to a log file and/or Windows clipboard.

Return codes:

0

Successful completion.

1

The —T option was specified and the programmer is busy performing an operation on taget

device.

Invalid option or parameter on command line[ 29,
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3 | Error calling a Windows API function; it could be caused by an abnormal exit of the programmer|
software.

4 | The programmer application was closed while the On-the-Fly Control utility has been waiting

Ifor response. Possibly the operator has forced closing of the program.

5 | Timeout set by an -M option occurred.

6 | The programmer was launched in the gang mode but an option in the On-the-Fly Control utility,
Jtried performing a____function not applicable to multiple CPI2-Gx running in the gang mode.

7 | Failure to perform requested action because programmer is busy performing anoter operation
on the target device.

8 | Failure to load project file specified by -P option.

9 | Failure to run script specified by -S option.

10 | General error.

11 | Programming function specified by the -F option is not applicable to current target device.

12 | An error occurred while programmer performed operation on the target device.

13 | Programmer could not complete an operation and closed the program after receiving the -X
option request.

14 | More than one device programmer is running. -R option must be used.

On-the-Fly Control Examples

; Launch programmer in diagnostic mode unless it is already in use
-L"C:\Phyton\ChipProg-02\6_00_ 21\UProgNT2.exe /g1"

; Append records to the log
-G+

; If programmer is busy, wait for 30 seconds max
-M=30

; Load project file. The FuelPump-08.upp project file is in D:\Projects folder
-PD:\Projects\FuelPump-08.upp

; Execute csm-16.cmd script located in the D:\Scripts folder
-SD:\Scripts\csm-16.cmd

; Execute auto programming using parameters defined by the FuelPump-08.upp project
-F*
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4 Standalone Operation Mode

CPI2-Gx device programmers can be operated in the standalone mode that does not require a
computer for driving device programmers. The major difference between the computer and standalone
control modes is a physical location of the memory which stores the data to be programmed into target
devices. These data includes:

e Target device type;

¢ Static data - usually the same code, which should be replicated inside of a series devices belonging
to the same type;

« Dynamically changing data, unique for each device in the series: serial numbers| &3}, signatures| 7",
date stamps, etc.

o User-specified Device and Algorithm Parameters| 3.

e Factory programmed serial number of the programming module inside of the CPI2-Gx units.

While the programmer is under computer control, all the data above form an image (or several images)
physically located in the computer RAM. In case of the standalone control mode, these images are
physically stored on an SD card inside of programming modules installed in a CPI2-Gx gang
programmer.

An SD card is a kind of flash memory media that connects directly to master MCU inside the
programmer. Storing data on this media inside of device programmer enables much faster
streaming the data into a target device. Moreover, even if the programmer is controlled by a PC, utilizing
the benefits of faster streaming images from SD cards to target devices allows to speeding up the
mass programming. To store the data image on the SD card for both standalone and faster PC control
modes, the data should be first configured in the GUIl 61 mode and then cashed| 3% onto SD cards.
Capacity of SD card used in the CPI2-Gx device programmer may vary from 8 to 64 GB - Phyton has
the rights to use the cards of any capacity without prior notice.

Preparing the data above for the standalone control unavoidably requires use of projects[+. A user
should conduct the following steps:

1. Inthe GUIl 41 mode create a project and store it on a computer as a file with the .UPP extension.
The project should include all the data and parameters above - target device type, static and
dynamically changing data, etc.

Connect the device specified in the project to a device programmetr;

Enable data caching| 139,

Program one device using the Auto Programming] 18 command.

Assign a number for the created Standalone Job/ 3.

arwDN

Upon completion of the steps above the programmer creates a replica of the project above on the SD
card. A project replicated on the SD card is hereafter called as a Standalone Job[126), The programmer
enables to create and to store as many as 256 independent standalone jobs, which can be launched in
the GUI by the job number. Only 4 of them can be assigned for launching by applying a 2-bit code to the
JOB_SELO0...JOB_SEL1 inputs on the connector CONTROL. After the job is selected by the JOB_SEL
code, it launches by applying the START signal to the CONTROL connector| 291,
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4.1 Preparing Standalone Mode Jobs
Preparing of use a CPI2-Gx device programmers in the Standalone Mode (SA) includes the following
steps:
¢ Enabling data caching;
¢ Creating projects to be run in standalone mode;
e Converting these projects into standalone jobs by caching data on the embedded SD card,;
¢ Assigning numbers to prepared standalone jobs, so they can be called by a certain number by the
Start signal or from the GUI;

Open the Configure[s1> Data caching, Standalone jobs... menu:
Project Commands Scripts Window Help

- Select device... F3
2h B ™ Selectdevice..
t Devi ] Device selection history... Alt+F3

Vi
CLUEVI i putfers.. F5

fd Serialization, Checksum, Log file... F6
Data caching, stand-alone jobs...
This will open the Standalone Mode and Data caching Settings dialog. Open the Settings tab and
check the Enable caching check box.
Stand-Alone Mode and Data Caching Settings
Seftings | Stand-Alone Jobs | Serializatic:n|

Buffer data caching to the programmer memory card(s)

Cnrfant rarhinn ctata
This is the first step. The green text in this dialog indicates a real data caching status. This status is
also indicated by the icon

a Awaiting AutoProg
located in the top right corner of the main window, at the right of the button Auto on main toolbar.
4.1.1 Data Caching

Data Caching is a process of copying data to be programmed into the target device onto the SD card
inside of the programming module of the CPI2-Gx device programmer. Then the programmer streams
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the data stored on the SD card to the target device instead of streaming them from the computer RAM
that greatly speeds up all the programming operations.

This mechanism of fast programming can be used in two ways: a) in trues standalone mode when the
programmer is disconnected from a PC and is controlled by electrical signals from a fixture or ATE and
b) when it is driven from the ChipProg-02 GUI. Taking data for device programming from the SD card
allows to speed up device programming in the computer control mode as well as in the true standalone
mode.

If you plan to control the programmer by electrical signals from your fixture or ATE in the true
standalone mode, caching data to the SD card is a mandatory. But, if you plan to control the
programmer from the ChipProg-02 GUI, data caching makes sense in case of programming devices
with relatively large flash memory, only. Otherwise, the time spent of the data caching procedure will
not be paid off by saving time on the faster device flashing.

Data Caching function is off by default. The Data caching status is displayed in a very right position of
the ChipProg-02 main window toolbar:

W& 4 || Check Program Verify Read Erase Auto || B Awaiting AutoProg

-] W [2 3 [ [g

The following Data Caching statuses can be observed when you operate in the standalone mode:

The SD card was not found by the programmer's hardware or it
malfunctions. Data caching is not possible.

B caching is off Data caching is turned off by an operator.

The programmer is ready to cash data. To perform caching, start Auto

Awaiting AutoProg X ; N
8 Programming| 18 operation on the target device.

B Cached Data caching was completed. Since then the programmer will take data
cashed on the SD card, not from the buffer.
B Cached, Job: #2 Data caching was completed. Project was assigned to standalone job with

a specified number (#2 here) and is ready for launching.

To bring up settings for caching, standalone jobs, and serialization, click on the image of caching status
(Awaiting AutoProg), or use the Configure| 7> Data caching, Standalone jobs... menu command.

First, create a project that can be then convert to a standalone job. Use a universal mechanism of
creating a project described in the Project Options Dialog[ s31. What is important is to name each
project to simplify assigning a number for each standalone job and to easily navigate in the line of jobs
in the Stand-Alone Jobs tab.

After storing your first project under a certain name (for example, RTX-12 (2016-11-21)) connect target
devices specified in this project to the CPI2-Gx device programmer and click the Auto button on the

main toolbar or click twice on the Auto Programming line in the Project Manager window. If the data
caching was enabled[123, the first run of the Auto Programming macro command ends with issuing a
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4.1.2

short warning "Accessing memory card(s)" and the icon
u Cached

will appear in the right position in the main toolbar. Similarly, you can create and store on one SD
card(s) as many standalone jobs as you need - up to 256. ChipProg-02 application automatically
assigns numbers to each job from the #0 up to #255.

The ChipProg-02 program uses the following rules of assigning job numbers stored on the SD card:

e [f there is an open project in the ChipProg-02 GUI, the program searches a standalone job with the
same name on the SD card. If it finds such an SA job, the program updates it with the data and
parameters stored in the project in the GUI. If the program cannot find the SA job with the same
name, then the program assigns to this job the lowest number, not taken yet by an unnamed project.
If there is no such an unnamed project, the ChipProg-02 application assigns the lowest available
number. If there are no free numbers ssues an error message.

o If there is no open project in the ChipProg-02 GUI, then the cashed data are considered as a
"unnamed job". Then the program checks whether the SD card already stores another job with the
same parameters, the caching procedure completes. Otherwise, the program assigns the "oldest"
number earlier assigned an unnamed job. If there is no an available jobs to be assigned, the program
iSsues an error message.

All created SA jobs are visible in the Stand-Alone Jobs tab of the dialog. First four SA jobs addressed
by the 2-bit JOB_SELO0...JOB_SEL1 selector can be launched by applying the START signal to the
CONTROL connector| 2,

Standalone Jobs

All SA jobs, created by caching data to SD card(s), are visible in the Stand-Alone Jobs tab of the
Standalone Mode and Data caching Settings dialog. Any SA job can be launched either by electrical
signals applied to the CONTROL connector (below displayed as "Selected by
Control.Job_Sel[x...0]") or from the ChipProg-02 GUI (displayed in the tab as "Defined
programmatically".

First four SA jobs addressed by the 2-bit JOB_SELO0...JOB_SEL1 selector can be launched by applying
the START signal to the CONTROL connector| 2.

In the Stand-Alone Jobs tab picture below you can see how to assign SA job numbers. The jobs are
displayed here in the ascending numerical order: from 0 to 255. Click the { (arrow down) sign at the
job line to open the list of cashed SA jobs, pick the project name to assign the job number. Only a
named project can be associated with an autonomous job. Each project can only be associated with a
single job.
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Stand-Alone Mode and Data Caching Settings @

Settings | Stand-Alone Jobs |Seria|ization|

Active Stand-Alone job number

(@) Selected by Control.Job_Sel[x.0] pins

(7) Defined programmatically: | Job #0 -

Stand-Alone Job Assignment:

Job #0:| RTX-12 (2016-11-21) (Macronix MX25L12873FM2I [ISP Mode]) -1
Job #1:| Left Wing Controller (Atmel AT8358253 [ISF Mode]) hd |E|
Job #2:| MavigationMadulel08 (Altera EPCS4SI8N [ISP Mode]) -]

Job #3:| <Mot assigned=

Job #4- (RN EEEEES

TXY-01-Atmel (SST SST25VF040B [ISP Mode])
Job #5:| Left Wing Controller (Atmel AT8358253 [ISP Mode])

RTX-12 (2016-11-21) (Macronix MX25L12873FM2I [ISP Made])
Job #6:| NavigationModule008 (Altera EPCS4SIEN [ISP Mode])

Job #7:| <Not assigneds 'i

Jnh #8-| <Mnt accianads v-

Two radio buttons "Selected by Control.Job_Sel[x...0]") and "Defined programmatically”" enables
to choose a method of the standalone launching. Clicking the OK button at the bottom of the dialog
window fixes the method of launching standalone jobs: by ATE signals or from the GUL.

After assigning a number in the Stand-Alone Jobs tab a project becomes a standalone job. This job
physically locates on the SD card, it has a unique humber and can be launched by this number either
by the ATE signals or by a mouse click from the GUI. However, any SA job can be updated by adding
dynamically changing data (Serialization[1s8)) and a limitation[ 1] of the devices to be programmed that
is described in the following chapters.

4.1.3 Standalone mode settings

To setup the standalone mode options open the Configure > Data caching, Standalone jobs...

dialog:
Configure Commands Scripts  Window Help
e Select device... F3
Device selection history... Alt+F3

) &l Buffers... F5

3 [i@ serialization, Checksum, Log file... F&

= Data caching, Standalone jobs...
| 52 IP address settings...

{5 Preferences... Ctrl+F6
[ Simplified User Interface editor...

[ Environment...

S —— L

The dialog enables to set all possible standalone mode options:

© 2021 Phyton, Inc. Microsystems and Development Tools



138

CPI2-Gx Device Programmers - CPI12-Gx

@ standalone Mode and Data Caching Settings ? >
Settings  Standalone Jobs  Serialization

Buffer data caching to the programmer memory card(s)
Enable caching

Current caching state:
Awaiting a successful Auto-Programming of a device to complete data caching/memory
card image checking.

Checking integrity of data on the programmer memaory card(z) in Standalone mode

[+ When a Standalone job iz activated

(] After programming of each 100 device samples

Demultiplexer Mode

O Channel A These options are

O Channel B accessible for CPI2-Gx

@ Channel A, then B <+« gang programmers and if

O Channel B. then A the gang programmer has

() Channel is selected with Contral MUX signal an activated CPI2-
DEMUX license, only

" OK # Cancel & Hep

If you operate with the CPI2-Gx device programmer in the Standalone mode the Enable caching box
must be checked. When it is unchecked, the programmer can be operated from the GUI[ 4, only. The
Demultiplexer Mode pane at the bottom of the dialog window enables to chose one of five options:

Option

Description

Channel A

Any launch of Auto Programming initiates ISP on the channel A, only. The B
channel remains disabled.
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Channel B Any launch of Auto Programming initiates ISP on the channel B, only. The A
channel remains disabled.

Channel A, then | Any launch of Auto Programming initiates ISP on the channel A. Then, upon
B completion of ISP on the channel A, the programmer immediately begins
programming on the channel B. Upon completion of this operation the
programmer waits for a new launch.

Channel B, Any launch of Auto Programming initiates ISP on the channel B. Then, upon
then A completion of ISP on the channel B, the programmer immediately begins
programming on the channel A. Upon completion of this operation the
programmer waits for a new launch.

Channel is This option allows to control A and B channels by applying a signal to the contact
selected with MUX_B/A (#A16) on the connector CONTROL.This signal, generated by ATE or
Control MUX the test fixture, enables programming either on the A or B channel. After

signal (on the launching the Auto Programming command the programmer checks the
connector MUX_B/A input status. Log 0 on this input enables in-system programming on
CONTROL) the A channel, log 1 - on the B one.

4.1.4 Device serialization

Very often the image to be written into the target device is comprised of the static data, common for all
the devices to be programmed in one session, and the data unique for each device in this series.
Usually such data represent unique serial numbers| s, checksums| e, signatures[ 701 and custom data
stored in the custom shadow memory[ 7 areas. Such dynamically changed data blend with static data
before physical writing the image into the target device. The ChipProg-02 enables to program complex
images in the standalone mode as well in the computer controlled mode.

Dynamically changed data mentioned above should be prepared in the project by means of the serial
numbers| e, checksums| ), signatures| 701 and custom shadow memory[ 711 dialogs below.

Serialization, Checksum, Log File @

General | Serial Mumber | Checksum | Signature String | Custom Shadow Areas | Log File

V| Write S/N to E%dress: 0x2008 - inlayer. |Code - |
Current serial number: 0x87 Byte Order Display S/N as:
@) LSE first Decimal
5/N size, in bytes:
IN size, inbytes: |4 ~) MSE first @) Hex
@) Increment serial number by: 1 hd
Use scriptto increment serial number: - Browse

In context of the standalone programming, preparing all dynamically changes data is defined here in
one term: "Serialization". Each SA job has its own serialization settings. These settings must be done
before generating serialization information for standalone mode. See the picture below.
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Serialization information for a project must be generated beforehand. Settings that control generation
can be done in a dialog brought up by clicking on the image of serialization status, or by menu
command "Configuration" -> "Data Caching, Standalone Jobs..." as it is shown below.

Stand-Alone Mode and Data Caching Settings @

| Settings | Stand-Alone Jobs | Serialization |

For stand-alone programmer operation you can generate senalization information (senal numbers,
checksums, etc. in advance. When generated, information will me written to the programmer's memaory card.
See help for details.

Project TXY-01-Atmel

Generate seralization information for ¥ device samples, max.: 1827817

If programmer(s) contain still unused records:

@) Discard them and replace with new ones

Add new records to existing ones

Start generation

Serialization information is stored in a fixed part of the SD card memory. The maximum number of
target devices is the project specific. For example, in the picture above the maximal number of the
devices to be programmed is 182781.

When operating in standalone mode, the programmer fetches serialization records one by one, and
programs them into target devices. The number of the next record to be fetched is preserved even if the
programmer is powered off. Once all records have been written into devices, the ChipProg-02
terminates the programming process and issues an error message. To continue programming
process, additional serialization information should be generated.

The dialog above enables two alternative options of how to handle unused records if they remain in the
programmer - either to discard them and replace with new ones or to add new records to remaining
unused. In the last case, the added serial number will continue to carry out the number of numbers.

Since it is impossible to predict a capacity of free memory on the SD card that can be assigned for the
serialization information, the Serialization records can be generated by a new data caching, only.

Note! To perform a new generation click the "Start Generation" button in the
dialog. Clicking the "OK" button at the bottom of the dialog does not start
generation of the device serialization in the standalone mode.

In the CPI2-Gx device programmers the same serialization information will be written in SD cards of
all programming modules..

Current serialization information can be viewed in the Memory cards window[43] (see an example
below). In this window serialization records are called "shadow areas" (which they actually are).
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Memary cards window [B=l=E
Collapse All | Expand | Erase

= HL51% ard / GB
ﬁupPoject @: Job: -, "<Unnamed>", Chip: "Macronix MX25L12873FM2I [ISP Mode]", Da
“Project 1: Job: -, "TXY-@l-Atmel”, Chip: "SST SST25VF@4eB  [ISP Mode]", Data: 1
$"File5 loaded into buffers
gmLimit: Mone
=% Shadow areas (@ of 1000 devices programmed)
B Shadow Area Descriptors
i -#@: Sublevel: @, Addr: Bx2008, Size: 4, Type: Serial Number
-#1: Sublevel: @, Addr: Bx2020, Size: 4, Type: CRC
-#2: Sublevel: 0, Addr: Bx32, Size: 8, Type: User
B Shadow Areas Data (1000 total)
-S/N: DOOOABTSE, CRC: PODOQIFE, User: 00OQ0A32: 00 00 00 00 00 20 00 00
-S/N: DODOABTY9, CRC: PODOALFE, User: 00OQ0A32: 00 00 00 00 00 00 00 00
-S/N: DODOABTA, CRC: PODOALFE, User: 00OQ0A32: 00 00 00 00 00 20 00 00
-S/N: DOOOABTE, CRC: PODOAIFE, User: 00DOQ0A32: 00 00 00 00 00 20 00 00
-S/N: POOOABTC, CRC: PODOAIFE, User: 00DOQ0A32: 00 00 00 00 00 00 00 00
-S/N: POOOABTD, CRC: PODORIFE, User: 00DOQON32: 00 00 00 00 0O 00 0P 00
-S/N: POOOABTE, CRC: PODOOIFE, User: 00DOQON32: 00 00 00 00 00 00 00 00
-S/N: PODOABTF, CRC: PODOQIFE, User: 00DOQON32: 00 00 00 00 00 00 0P 00
..992 more records

Limitations of Serialization in Standalone Mode

Besides a necessity to remember to add in serialization records in time, the following limitations should
be kept in mind:

¢ If programming of a target device causes an error, serialization record is still used up, in spite of the
application program settings. In such case, serial numbers of target devices will not remain
consecutive, they will include gaps.

e If you use scripts[ 171 for generating serial numbers, checksums, and other dynamically changing data
take in account the difference of launching the scripts in ChipProg-02 application. in the GUI control
mode scripts launch immediately before programming of a next target device. However, when
generating records for standalone mode, scripts launch immediately after generation of a next record.
If the script includes some real-time related parameters, such script will not work correctly. If the
scripts modify the data to be written into target device, that is not going to work either.

4.1.5 Permissions and setting limits

A CPI2-Gx user is able to set the number of target devices to be programmed in standalone mode.
Before setting the limit this function should be permitted through the Project Option| =3 dialog. Open
the dialog, browse the project file ((UPP file) and click the button Permissions| 7.
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@® Project Options = @
Project File Name
Ftmp)\ TXY-01-Atmel upp ~| B Browses ] | %  Permissions.. |
Project Description (optional) Desktop

(@) Project has its own desktop

(7) One desktop for all projects

Files to Load into Buffers

|Fi|e Format Buffer Layer StartAddr Offset

CIRay\UProgT 04 bin _m_‘

= Add file... I l x Remove file l l [ Editfile options... I
Scriptto execute before loading files: -
Scriptto execute after loading files: -

[ ] Automatically reload files if they are modified by an extemal application

< 0K l lg Cancel I IG Help ]
Y

This brings up the Project Permission Settings dialog, in which you can specify the number of
devices to be programmed. To enable this setting, you must check the Protect the project with
password box and specify a password.
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% Project Permission Settings @

[¥|Protect the project with passward: 123 -

Choose items to disable when the projectis protected:

Changing the buffers memaory, including file loading

Changing device and algorithm parameters

Changing the programming addresses, auto functions list and statistic settings
Changing the programming addresses, auto functions list and statistic settings
Changing interface settings

[¥] Access to scriptfiles

[¥] Project closing

Limitations for Stand-Alone mode

[+] Allow programming of not more than 500 * device samples

Disabling of the project editing protects it against incidental changes of important
settings and data. However. it does not protect the project settings intentional changes
by experienced users.

0K | |i Cancel | ‘ﬂ' Help

A current state of the device counter can be monitored in the Memory cards[14) window. See an
example below.

Memory cards window [B=l=lE
Collapse AII| Expand| Erase |
EI--S_/N: SI2-10883, Card: 7.42 GB
--iject @: Job: @, "RTX-028", Chip: "Atmel AT89LS51 [ISP Mode]"™, Data: 1.0 MB
£lProject 1: Job: 1, "TXY-@1l-Atmel”, Chip: "SST SST25VF@4@B [ISP Mode]", Data: 1
--Files loaded into buffers
§-|-Limit: 497 of 500 devices remaining |
#-Shadow areas (3 of 1000 devices programmed)

Once the limit was achieved, ChipProg-02 issues an error warning and the programming stops. To
continue programming, it is required to confirm or remove limitation using Project Permission
Settings dialog.

416 SD card window

Memory cards (or SD cards) window can be used to examine information stored on the card, as
shown on the figure below. Use the View[ 521 menu to open this window.
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Memory cards window PEEE

Collapse All | Expand | Erase
e ———————
= g

$~Project @: Job: -, "<Unnamed>", Chip: "Macronix MX25L12873FM2I  [ISP Mode]", Data: 16.0 MB (0.21%)
9~Project 1: Job: 1, "Caching3", Chip: "Macronix MX25L12873FM2I [ISP Mode]", Data: 16.2 MB (@.21%)
$~Eiles loaded into buffers
 L"C:\Ray\UProgNT2\@xFF.bin", Buffer: @, Sub-Level: @
?~Limit: Mone
=-Shadow areas (0 of 10008 devices programmed)

é~8hadow Area Descriptors
#0: Sublevel: @, Addr: @x108, Size: 4, Type: Serial Number
. #1: SubLevel: @, Addr: Ox1A, Size: 4, Type: CRC
f-Shadow Areas Data (10006 total)
#-Project  2: Job: 2, "Left Wing Controller", Chip: "Atmel AT89S8253 [ISP Mode]", Data: 1.8 MB (0.81%
F-Project  3: Job: -, "RTX-12 (2016-11-21)", Chip: "Macronix MX25L12873FM2I [ISP Mode]", Data: 16.@ NI
H-Project 4: Job: -, "NavigationModule@®8", Chip: "Altera EPCS4SI8N  [ISP Mode]", Data: 1.0 MB (08.01%

During subsequent programming operations, the programmer uses buffer layers data from SD card.
The ChipProg-02 application tracks changes in the settings that may cause maodification of data stored
in the SD card. If necessary the program launches data re-caching. This may be triggered by the
following changes:

¢ Writing data into the memory buffer - manually or by reading a file or by a script or communication via
the ACI[1s3;

¢ Modification of the target device settings;

« Modification of serialization[ 3% settings:

« Modification of the Auto Programming[ 18] parameters.

Switching to Standalone Mode

After powering-up, a CPI2-Gx device programmer keeps staying in the idle mode until it will be launched
either in the computer controlled mode from the CPI2-Gx startupl s dialog or in the standalone| 13
mode. In turn, launching the programmer in the standalone mode can be done either programmatically,
or by applying electrical signals to appropriate pins on the connector CONTROL/[ 2.

Launching the CPI2-Gx in the SA mode programmatically can be done in two ways:

e From the ChipProg-02 GUI menu Commands -> Standalone Mode. This will open the Switch to
Standalone Mode dialog below. In this dialog you can specify a method of selecting SA jobs - by the
signals applied to the connector CONTROLI[ 29" or programmatically from the drop down Job menu in
this dialog.
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Cﬁ Switch to Stand-Alone Mode @

Programmer(s) will be switched to Stand-Alone mode and Stand-Alone mode
monitor will be launched. The programmer shell will exit

Active Stand-Alone job number

Selected by Control. Job_Sel[x..0] pins

@ Defined programmatically: |Job: #1, Project TXY-01-Atmel - |

i Cancel | |'i? Help |

e By clicking the Start Standalone Mode Monitor button in the CPI2-Gx startupl dialog. Or just by
calling the SAMonitor.EXE executable that locates in the same folder where the ChipProg-02 was
installed. This will open the Standalone Mode Monitor[ 48 window (read the next chapter).

Launching the CPI12-Gx in the SA mode by applying electrical signals from ATE can be done by one
the way below

« By applying a logical 1 signal to the SAMODE pin of the connector CONTROL[ " right after
powering the CPI2-Gx unit, while it remains in the idle mode.

¢ By applying and holding for at least 2 sec logical O signal to the START pin of connector
CONTROL/ 24\

Once CPI2-Gx switches to standalone (SA) mode, the green (GOOD) and red (ERROR) LEDs start
blinking. These LEDs will keep blinking until the programmer is switched back to computer controlled
mode. When the CPI2-Gx remains running in the SA mode, a SA job can be launched by either one of
the signals above.

ChipProg-02 software allows real-time monitoring of activity device programmers driven by this
software by a special utility - the Standalone Mode Monitor| 143, This monitor window displays status(es)
of the device programmer(s) along with a current Standalone Job humber, device counters, statistics of
failures, and other useful information.

To interact with ATE or test fixture CPI12-Gx device programmers running in the standalone mode output
three status signals onto appropriate pins of the connector CONTROL/[ 29} BUSY, GOOD and
ERROR. These signals - log. 0 means active - indicate statuses of the device programming
operations:

e BUSY=log.0 while the operation lasts, then returns to the log.1 state,

¢ GOOD-=log.0 in case the device was programmed and successfully verified and stays low until a
new programming cycle starts;

¢ ERROR=log.0 in case of failure.

These signals, outputted to the connector CONTROL, are duplicated by, respectfully, yellow, green and
red LEDs on the top panel of the CPI2-Gx units.
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If the programming session involves programming of different data into two or more devices of different
types, by means of the same CPI2-Gx programmer, standalone jobs must be switched by external ATE
or other equipment, not programmatically. For this purpose,.the CONTROL/ 2¢ connector contains two
pins (Job_Sel [2..0]) per each site which can be used for choosing a standalone job. For example, if
Job_Sel code = 01B the programmer will run the Job #1, if the the code = 11B -- Job #4. When no
electrical signals are applied to these pins, the Job #0 will be automatically selected.

The ChipProg-02 program takes care of synchronizing Standalone Mode Jobs on all programming
modules installed inside of the CPI2-Gx device programmer.

Standalone Mode Monitor

Standalone Mode Monitor is an application program for watching the states of programmers
operating in standalone mode. This application can also perform certain operations with the
programmers.

The application can be launched in the following two ways:

e By clicking the Start Standalone Mode Monitor button in the in the CPI2-Gx startupl s dialog below.
Or just by calling the SAMonitor.EXE executable that locates in the same folder where the
ChipProg-02 was installed.

" ChipProg-02 v. 6.07.00 fo] @ s

Programmer Startup Options
|#| Create a shortcut with these options

‘@ Start ChipProg-02 &1 Open shortcuts folder

Gang Mode Diagnostic Mode

4 M Connection: (@ USB Ethernet

Additional Command Line Parameters:

‘ (IE Start Stand-Alone Mode Monitor Demonstration Mode (without hardware)

| Close this window after programmer start

e From the menu "Commands" -> "Switch to standalone mode in the GUI mode.

Being launched in one way or another, the Standalone Mode Monitor switches all the programmers,
which it is able to communicate with to,into the standalone mode[133 (SA mode) unless these units
are already running in the SA mode. The Monitor can "see" only those programmers which are not
being used at the moment by the ChipProg-02 application; this is because at any given time a
programmer cannot be be under control under more than one application. On the other hand, the
ChipProg-02 application does not "see" the programmers already running in the SA mode.

The Standalone Mode Monitor does not disturb running the launched programmers; it does not slow
them down. The monitor displays their current state, only. See below an example of the Standalone
Mode Monitor window for a gang cluster comprised of three CPI2-B1 device programmers with serial
numbers SI2-10002, SI2-10003 and SI2-10004.

© 2021 Phyton, Inc. Microsystems and Development Tools



Standalone Operation Mode 147

B Stand-Alone Programmer Mode Monitor \E’
# SIN Job  Project Good Bad Lmit Function Progress % LEDs Device S/N  Error Device
#1 SI2-10002 1 Left Wing Controller 2 0 None  Stopped DOHENE o Atmel AT8958253 [ISP M
] #2 s12-10003 1 TXY-01-Atmel 4 o 493 Program [ | 49% MM A798 SST SST2SVF040B  [ISP I
] #3 s12-10004 1 * RTX-12 (2016-11-21) 5 5 488 Program M ] 5% HOIME A792 erSD_EmptyJob:1,erDeviceBad:5  Macronix MX25L12873FM2

* Project on memory card must be updated

[ Select active job: 1 -

IQ Start programming l l Switch to Online mode l
d Terminate programming ® Exit
V.
Where:
# The programmer number in the list.
SIN Serial number of the device programmer.
Job Order number of the active SA job.
Project Name of the project associated with the SA job (it specifies the data being written into
the target device).
Good Counter of successfully programmed devices. This counter resets to zero when the
programmer is powered off or when a new job is selected.
Bad Counter of devices programmed with errors.
Limit Number of devices remaining before achieving the limit defined in the project settings.
Limit counters are preserved upon powering off the programmer.
Function Name of the currently performed programming function.
Progress Indicator of the function execution process.
% Percent completeness of the function.
LEDs LEDs that indicate the programmer status.

Device S/IN | Current target device serial number, if it was defined in the standalone mode
serialization settings.

Error Error codes following the error counts. Programmer keeps up up to 8 types of errors.

Device Target device as it was selected in the project.

All buttons in the dialog above are exclusively applicable to the CPI2-Gx device programmers marked in
the check boxes in the very left column of the Monitor window.

Select Active Job button: For selected device programmers, set active SA job number in the field at
the right of the button. Setting the SA job number by itself does not activate the job - only clicking this
button does activate it. If the selected job was not associated with any project, then an attempt to start
programming aborts with an error SD_EmptyJob. The Select Active Job button is accessible if all
selected device programmers are stopped, only.

Start Programming button: Start device programming on selected CPI2-Gx device programmers that
are currently in the stopped state.
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Terminate Programming button: Abort target device operations on all currently selected CPI2-Gx
device programmers. Completing of this command can be delayed for a while.

Switch to Online Mode button: Here Online mode means the computer controlled mode. Clicking this
button immediately switches selected device programmers from the SA mode into the GUI computer-
controlled mode. This could be used for restarting the Standalone Mode Monitor and to make the
programmers running in the SA mode visible for the GUI. The problem is that the ChipProg-02 GUI does
not "see" the programmers running in the SA mode. Once the programmers are switched into the
online (computer controlled) mode, the Monitor is no longer able to communicate with them. For
refreshing communications between the GUI and the Standalone Mode Monitor it should be
restarted. Then the monitor re-establish communications with the device programmers.

Show Errors button: Show table of errors for all selected device programmers. Error counters are
reset to zero when the programmer is powered off. At switching an active SA job, the error counters are
not reset.

If a project name is displayed in red characters, this indicates that the project data were written by an
older version of the ChipProg-02 software and must be refreshed. In many cases this is crucial
because updating the ChipProg-02 version automatically causes updating the CPI2-Gx firmware that
include device programming drivers. If you see the project name displayed by red characters you must
cycle the power, launch the ChipProg-02 in the GUI mode, open the project, make sure the data
cachingl 34l is enabled, connect a board with a target device selected in the project to the programmer
and launch the Auto Programming| 108 command once to re-cash the project data on the programmer's
SD card.

Example of Setting Up Standalone Mode

This example lists all operations necessary for setting up a standalone mode. The example refers to a
single-site CPI2-B1 device programmer but with some minor correction it can be applicable to use of
the CPI2-Gx gang device programmer.

o Target device: Microchip/Atmel AT89LS51 [ISP Mode].

¢ File C:\Work\Monitors\RTX-028.hex (in standard hex format) has to be loaded into the ChipProg-02
memory buffer.

o A 32-hit serial number has to be written into each target device at address 0x200. Serial numbers are
increased by 1 for each device.

Connect a CPI2-B1 device programmer to a computer via a USB cable, launch the ChipProg-02
software and launch the programmer in the GUI mode.

Click on "Select device" button: m Select Device...

Select device type Atmel AT89LS51 [ISP Mode]:
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@R Select Device Lo B e

Devices to list Devices
EPROM. EEPROM. FLASH Search mask:
PLD. PAL. EPLD ATEILS -

7| Mi froll
R Atmel AT89LS51 [ISP Mode

Atmel ATBILSEZ [ISP Mode]
Atmel AT89LSE3 [ISP Mode]
Programmable In-System Atmel ATB9LS8252 [ISP Mode]
Atmel ATBILSE253 [ISP Mode]

Programmable In-Socket

() Selected manufacturer gnly

(@) All manufacturers

Open the menu Project -> Create New:

@® Project Options =
Project File Name
C\Waork\Projects\RTX-028| - 2 Browse.. ] l S Permissions... l
Project Description (optional) Desktop

(@) Project has its own deskiop

() One desktop for all projects

This brings up project creation dialog. In the field "Project file name" enter the name of the project file.
Alternatively, click on Browse button and select folder and file using standard Windows dialog:

© 2021 Phyton, Inc. Microsystems and Development Tools



150 CPI2-Gx Device Programmers - CPI12-Gx

@® Project Options = @
Project File Name
C\Work\Projects\RTX-028| - ) Browse.. ] l ) Permissions... l
Project Description (optional) Desktop
- (@) Project has its own desktop
(") One desktop for all projects
Files to Load into Buffers
File Format Buffer Layer StartAddr Offset
E Add file... I l x Remove file l l [ Editfile options... I
g
Add a file To The Tist. The "Load File” dialog will be displayed. l
Scriptto execute before loading files: -
Scriptto execute after loading files: -
[ ] Automatically reload files if they are modified by an extemal application
« 0K l l ¥ Cancel I l @ Help ]

Select file C:\Work\Monitors\RTX-028.hex to be loaded:
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&% Load File

File Mame:

C:‘LWOrk‘LMonitors‘;RTX-DZB.hE)d

File Format:

Buffer to load file to:

- 1 Browse..

(@) Standard/Extended Intel HEX (*.hex*.mcs)

(") Binary image (* bin)

(")Motorola S-record (*.hex:™.s™* mot)
(IPOF (* pof)

(7) JEDEC (" jed)

(JPRG (*prg)

(") Holtek OTP (*.otp)

(7)) Angstrem SAV (*sav)

(C)ASCII Hex (* )

(C)ASCI Octal (* bxt)

Start address for binary image: |0

Offsetfor loading addresses: 0

(@) Buffer #0

Layerto load file to:

@) Code (128 KB), bytes

OK

| [% comcel | [@

Help

In file selection dialog enter C:\Work\Monitors\RTX-028.hex, or use Browse button. Select

"Standard/Extended Intel HEX":
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&R Load File

File Mame:

C:‘LWOrk‘LMonitors‘;RTX-DZB.hE)d

File Format:

- 1 Browse..

Buffer to load file to:

(@) Standard/Extended Intel HEX (*.hex*.mcs)

() Binary image (*.bin)

(")Motorola S-record (*.hex:™.s™* mot)
(IPOF (* pof)

(7) JEDEC (" jed)

(D)PRG (prg)

(") Holtek OTP (*.otp)

(T)Angstrem SAV (* sav)

(C) ASCI Hex (" bd)

(CIASCI Octal (* )

(@) Buffer #0

Layerto load file to:

@) Code (128 KB), bytes

Start address for binary image: |0

Offsetfor loading addresses: 0

oK l lﬁ Cancel ] lﬂ Help

Confirm file selection by clicking OK, and the settings dialog will show the name of selected file.
Confirm project settings by clicking OK; the project will be saved as the file C:\Work\Projects\RT X-
028.upp. If the folder :\Work\Projects does not exist, the program will prompt you to create it.

© 2021 Phyton, Inc. Microsystems and Development Tools



Standalone Operation Mode 153

Project File Name

CiWork\Projects\RTX-028 - 5 Browse... ] l & Permissions... l

Project Description (optional) Desktop
@ Project has its own desktop
(") One desktop for all projects

Files to Load into Buffers

|Fi|e Format Buffer Layer StartAddr Offset

C:AWork\Monitors\RTX-028.hex | Standard/Extended Intel HEX| Buffer #0 __‘

= Addfile... | [ %  Removefie ] [ [ Editfile options... I
Scriptto execute before loading files: -
Scriptto execute after loading files: -
[ ] Automatically reload files if they are modified by an extemal application
&  OK l ¥ Cancel I l @ Help ]

y

Now we are working with a project, as shown in the window title:

“Gx — —

File View Project Configure Commands Scripts Window Help

B-P58 | 0RH HNeabde|@ecHb

M, Select Device... ||[AmelAT8ILS51 [ISP Mode]

Now we need to set parameters of serial numbers written to each target device. To do this, open
serialization settings:

roject |C{:-nfigure Commands Scripts Window Help
Window Help & s Select device... F3

% @ - [7] Device selection history... Alt+F3
X @ 2 ort Devi L

b — - i Buffers... Fs
| Serialization, Checksum, Log file... [F&]

I8 Serialization, Checksum, Log file... h‘ F6

B Data caching, stand-alone jobs..

In the appeared dialog select the "Serial Number" tab:
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[

Serialization, Checksum, Log File

General

Serialﬁumber

Checksum | Signature String | Custom Shadow Areas | Log File|

Lrl.f

|:|Write S/M to address:

0 - inlayer. |Code

Check off the "Write S/N address" box and enter 0x200 into the address field. Set serial number size
equal to 4 bytes, set increment to 1, then click OK:

Serialization, Checksum, Log File @
General | Serial Number |Chec|~csum | Signature String | Custom Shadow Areas | Log File|
[¥] Write S/M to address: =200 - in layer: [Code VI
Current serial number: 0 B}de Order D_ISp|EI‘y’ SN as.
(@) LSB first [ )Decimal
5/N size. in bytes: |; ~ _
[N'size. inbytes: |4 | @ MsB first @ Hex
(@) Increment serial number by: 1 -
_ Use scriptto increment serial number: - Browse...

Store serial numbers in registry
D Separate storage for each Windows user

Separate serial number for each device type

N\

‘?\ OK | [% cancel || @ Help

We are almost done setting project options but now we need to turn on the data caching; to do this, run
menu command Configure -> Data Caching...
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Project [Cﬂnfigure Commands Scripts Window Help
& a M Select device... F3

— | [@ Device selection history... Alt+F3
ct Devi|

-~ T =7 gl Buffers... F5
Serialization, Checksum, Log file... F&

Data caching, stand-alone jobs...

L'

This brings up a dialog for serialization parameters. Check off the Enable Caching box, then click OK:

Stand-Alone Mode and Data Caching Settings

Seftings | Stand-Alone Jobs | Serializatic:n|

Buffer data caching to the programmer memory card(s)

Cnrfaent rarhinn stata

Data caching status now looks like this: H a Awaiting AutoProg ‘

File View Project Configure

Since projects are not saved automatically in the ChipProg-02 - C =1
application, you not must save the project by clicking the Save project [ﬁ E‘& @ € le
icon on the main toolbar: e sele. . oroject [Atme

Preserving the connection diagram for the chosen AT89LS51 device connect it to the connector
TARGET on your CPI2-B1 device programmer and launch the Auto Programming command in the
Program Manager window:
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Program Manager [F]ES
Program Manager | Options | Statjsﬂcs|
| Cevice Status: Auto-detect off
Buffer: |Buffer #0: Code (128 KB), bytes v|
Functions
- Blank Check
Prcgram % NEHECUT-E
- Read g
-~ Verify Repetitions:
- Erase 1 -
- Read Lock Bits
[+H-Lock Bits . . |
= Auto Programming ) EditAuto..
(7] Hel |
|Aum FProgramming ‘ -

If the Auto Programming operation has completed successfully, the history field will display a line saying
"Caching datato the programmer SD card enabled"; caching status will read "Cached."

Operation Progress

Ready

File loaded: "C:\Work\Monitors\R TX-028 hex"

Device #1: S/N: 00000000, Checksum: 0x000000F0

Erasing... Ok [0:07, 14:01:36]

Checking... Ok [0:00, 14:01:38]

Programming... Ok [0:04, 14:01:42]

Verifying... Ok [0:00. 14:01:44]

Caching data to the programmer SD card enabled d4——

Auto || B cached o

)@ T~

Now we need to generate the serial number information for writing serial numbers into target devices.
To do this, either click on the caching status field or select menu Configure -> Data Caching...:

ProjectICc:-nﬁgure Commands Scripts Window Help

\uto H”i Cached H

: wwm ct Devi

|

. M Select device... F3
=1

Data caching, stand-alone jobs...

[0 Device selection history... Alt+F3
&l Buffers... F5
Serialization, Checksum, Log file... F6

This brings up standalone mode options dialog. Select the Serialization tab and specify amount of
10000 devices to generate serial numbers for. Then click Start Generation button:
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Stand-Alone Mode and Data Caching Settings

| Settings | Stand-Alone Jobsl Serialization ||

See help for details.

Project RTX-028

Generate serialization information for| 10000|

If programmer(s) contain still unused records:

(@) Discard them and replace with new ones

() Add new records to existing ones

Start generation {

For stand-alone programmer operation you can generate serialization information (serial numbers,
checksums, efc. in advance. When generated, information will me written to the programmer's memory card.

device samples, max.: 57663

Assign our project to a standalone job #0 by selecting "Standalone Jobs" tab and selecting project

RTX-08 for job #0:

Stand-Alone Mode and Data Caching Settings

| Settings I Stand-Alone Jobs I Serialization|

Active Stand-Alone job number
(@) Selectad by Control.Job_Selfx.0] pins

Defined programmatically:

Stand-Alone Job Assignment:

Job #0:| «<Mot assigned>

<MNot assigned:=
RTX-028 (SST SST25VF040B
Job #2:| <MNot assigned>

Job #1:

Job #3:| <Not assigned>

The dialog now looks like this:
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Stand-Alone Mode and Data Caching Settings

Settings | Stand-Alone Jobs |Seria|ization|

R 5

Active Stand-Alone job number
(@) Selected by Control.Job_Sel[x.0] pins

(7 Defined programmatically: | Job #0

Stand-Alone Job Assignment:

Job #0:| RTX-023 (SST SST25VF040B [ISP Mode])

‘ )
»

Job #1:] <Not assigneds
Job #2:| <Not assigned>
Job #3:| <Not assigned>

Confirm settings by clicking "OK™ at the bottom.

[ m

This completes preparation of the standalone job associated with the project RTX-028. Contents of the
memory buffer and all settings have been stored as a project on programmer internal SD card,
information for 10000 serial numbers has been generated, the project has been associated with

standalone job #O0.

The simplest way to switch the programmer into standalone mode is to call the menu command

Commands -> Switch to Standalone Mode:

Commands | Scripts Window Help

Blank Check
Program

Verify

Read

Erase

Auto programming

Self-Tests

F8
F9
F10
F11
F7
F12

Switch to Stand-Alone mode... [\h

This brings up the dialog below allowing you to to select the job #0 to be activated for execution from the

GUI:
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fﬁ Switch to Stand-Alone Mode @

Programmer(s) will be switched to Stand-Alone mode and Stand-Alone mode
monitor will be launched. The programmer shell will exit

Active Stand-Alone job number

(") Selected by Control. Job_Sel[x.0] pins

(@) Defined programmatically: IJub: #0. Project RTX-028 -

mil
v

o OK | ‘i}' Cancel ‘ ‘i? Help

5 Software Development Kit (SDK)

This section describes Phyton ChipProg-02 Software Development Kit (SDK) called ChipProg-02
Application Control Interface (or Application Control Interface).

Developers can use Application Control Interface to control CPI2-Gx programmers by means of their
own software.

Application Control Interface provides a comprehensive set of features to control the programming
process, including selection of device type, accessing data buffers, loading files, launching
programming procedures (also in gang mode), and more.

5.1 ACIComponents

Application Control Interface Files
The CPI2-Gx SDK includes the following components:

1. ACIL.DLL dynamic-link library which implements Application Control Interface functions.

2. AClLlib export library.

3. Header file aciprog.h to be included in user software written in C/C++ programming language.
The header contains declarations of all ACI functions| 6%, structures and constants. The
windows.h file must be included in user program before the aciprog.h.

4. Aset of example files illustrating the use of Application Control Interface.

Platform Requirements

1. Phyton Application Control Interface requires Windows 7, 8 or 10 operating system.

2. ChipProg-02 software must be installed on the computer that controls the CPI2-Gx hardware.
The latest ChipProg-02 software version is available for free download from the
http://www.phyton.com/htdocs/support/update.shtml webpage.
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5.2

Usage with 32- and 64-bit Applications

32-bit applications must use the ACI.DLL dIl and the ACLlib export library.

64-bit applications must use ACI64.DLL and ACI64.lib.

Otherwise, there's no difference between 32- and 64-bit applications.

There's no need to develop 64-bit applications for use with 64-bit operating system: both 32- or 64-bit
applications can be used in such case.

Programming Languages

Developers can use any programming language of his choice when working with Application Control
Interface; ACIL.DLL exports its functions according to the standard rules for Windows operating system.

Using ACI

To control a CPI2-Gx programmer, user program calls functions in the ACL.DLL. When user program
calls the ACI_Launch()[s7 function, ACI.DLL launches ChipProg-02 executable UProgNT2.exe and
then controls its operations.

ChipProg-02 GUI can be made hidden or visible. In most cases there is no need to display GUI
windows or daialogs; however, this may be used for debugging purposes. User program can also use
ChipProg-02 partially, for example to bring up dialogs that show settings, target device selection, file
loading and others. Once the programming environment has been set up, the ChipProg-02 GUI can be
hidden to free more screen space for the controlling application.

When launching a programmer by means of the ACI_Launch()[3] function, ACI creates internal object
called connection that identifies a launched programmer or multiple programmers working in the
Gang-programming| 198 mode.

ChipProg-02 enables launching multiple CPI12-Gx device programmers and control each of them
individually. The ACI_SetConnection| 37 function is used to select a particular connection to work with.
Once a connection is selected, all further calls to ACI functions will be applicable to this connection
use that connection (i.e. they all will affect only the selected device programmer). If there is only one
programmer, the connection is selected automatically.

If, for example a CPI2-Gx has 6 programming modules inside but the ACI_SetConnection| 37 function
has specified only one particular module inside of this gang programmer, then this connection will
control one module, not a whole gang programmer with 6 modules.

All ACI functions, when called, take either no parameters or one parameter which is a pointer to a
structure. Each such structure has its first field set to the structure size; this ensures compatibility of
different ACL.DLL versions. The only exception is the ACl_IDECommand() function; this sacrifices
uniformity in favor of simpler pseudo-function declaration. The aciprog.h header file provides
declarations of the parameter-carrying structures.

Names of all the ACI objects (functions and structures) conform to the same naming convention. All
names begin with ACI_ prefix. Names of the parameter structure patterns end with _Params suffix.

Numeration of all memory buffers and layers of memory buffers startins with zero. All addresses are
64-bit long and consist of two 32-bit parts (lower and upper), to make them compiler-independent. For
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example, if the compiler recognizes the uint64 type, then the structure ACI_Memory_ Params can be
initialized as follows:

ACl _Menory_Par ans npar ans;
*((uint64 *)nparans. AddressLow) = 0x123456789ABC,

Note. All addresses in the structures are shown in the format specified by the device manufacturer, i.e.
in Bytes, Words, etc. For example, for any 16-bit microcontroller the address format is always a word
not a byte.

ChipProg-02 automatically allocates buffer number 0 so that it always exists and does not have to be
explicitly created.

All ACI functions provide return code to the calling application. The return code constants -
ACI_ERR_xxx - are defined in the aciprog.h file included into the ACI software set.

5.3 ACI Functions

This section provides an overview of Application Control Interface functions. Detailed description of
each function can be found in the ACI Fuctions| ) reference section.

Calling some functions requires filling in and passing structures that specify memory locations, pointers
and other objects associated with the called function, while other functions do not take any parameters.

Table below shows ACI functions grouped by functionality. Most functions are grouped in "bidirectional
couples" (In-Out or Get-Set).
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Application Control
Interface function name

Brief description

Associated
windows and
dialogs

Associated Application
Control Interface
structures

1. ACI functions that start and stop programming sessions and control connections

with device programmer(s)

ACI_Launch[373

Starts the ChipProg-02 program. This
function must always be the very firstin the
chain of other Application Control Interface
functions that form the programming
session.

NA

ACI_Launch_Params/[388)

ACI_Exit[368)

Closes the ChipProg-02 program. This
function must always be the last one in the
chain of other Application Control Interface
functions. It completes the control session
via AClI.

NA

ACI_SetConnection[3™

Specifies a current device programmer(s)
connection. Use this function when you
control a number of device programmers by
means of multiple calls of the
ACI_Launch[373 function.

NA

ACI_Connection_Params
[382)

ACI_GetConnection[ 37

Allows getting the identifier of a current
device programmer connection.

NA

AC|_Connection_Params
383

ACI_ConnectionStatus[ 367

Checks and returns a current connection
status.

NA

NA

2. ACI functions that configure the programmer or

get its current configuration

Loads the programmer configuration
parameters from the host computer to the

ACI_LoadConfigFile[373) NA ACI_Config_Params[ 383
programmer.
Saves the programmer's current

ACI SaveConfigFiIelﬁ configuration parameters 1o the host NA ACI_Config Params/ 382

computer.

ACI_SetMUXmode[ 370

Applicable to CPI12-Gx gang programmers
only. Enables built-in demultiplexers in all
CPI12-Gx programming modules.

ACI_GetMUXmode|[ 37

Applicable to CPI12-Gx gang programmers
only. Gets status of demultiplexers builtinto
CPI12-Gx programming modules.

3. ACI functions that get the target device properties or

set them

Gets the manufacturer's name (brand) and
the part number of the device currently

ACI_GetDevice[ 37 being programmed from the programmer to DeSv(iecl—ZICt_SB'ﬁ ACI_Device_Params|[38)
the host computer.
Sets the manufacturer's name and the part
i fth ice t i Select i
ACI_SetDevice[3™ number of the device to be programmed in _eelc_ﬁ ACI_Device_Params[32)
the programmer. Device| 58
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Application Control
Interface function name

Brief description

Associated
windows and

dialogs

Associated Application
Control Interface
structures

4. ACI functions that get current parameters of the buffers and layers or configure

them
Gets the parameters of a specified memory Buffer
37 = — 38
ACI_GetlLayer[3 buffer and layer from the programmer to the Dump[ o ACI_Layer Params|[38%
host computer. zump
ACI_CreateBuffer[ 368) Creates a memory buffer with specified Bl ACI_Buffer_Params[3ed
parameters in the programmer. Dumpl 9
AC| ReallocBuffer[372) Changes a size of the layer #0 in a specified Buffer AC| Buffer Params[3
- memory buffer in the programmer. Du_mg@

5. ACI functions that read the content of the buffer layer or write into it

Reads data from a specified memory buffer

ACI_ReadLayer[ 33 in the programmer to the host computer. Ll ACI_Memory Params[38%)
Dumplﬁhl
Writes data into a specified memory buffer of
. the host computer to the programmer Buffer
ACI erteLayerlaﬁ ACI_Memory. Params[ 389
memory buffer. Dumpl e
Fills a whole selected layer of a specified Buffer
ACI_FillLayer[ 363 memory buffer with a specified data pattern. Butel ACI_Memory_Params|3%
Dumpr%ﬁ

6. ACI functions that

get programming parameters fro
in the programmer

m the programmer or set them

ACI_GetProgrammingParam | Gets current programming parameters from '\gggraerl ACI_Programming_Para
sl 3 the programmer to the host computer. nag msl| 39
Options 108
. . Program .
ACI_SetProgrammingParam | Sets programming parameters from the host Manager > ACI_Programming_Para
sl 37 computer to the programmer. ; msl| 39
- P prog Options 108 |

or set them in the programmer

7. ACI functions that get device-specific programming options from the programmer

Gets current programming options from the —DE‘ViC? and _
ACI_GetProgOption[37h programmer to the host computer. Algorithm | ACI_ProgOption_Params
Parameters | [390)
)
Sets programming options from the host w _
ACI_SetProgOption[ 373 computer to the programmer. Algorithm | ACI_ProgOption_Params
Parameters | [390)
[

i Sets default programming options and Device and _
ACI_AlIProgOptionsDefault programming algorithms in the Algorithm AC|_ProgOption_Params
* programmer Parameters | [0

: [

8. ACI functions that control programming operations

© 2021 Phyton, Inc. Microsystems and Development Tools




164

CPI2-Gx Device Programmers - CPI12-Gx

Application Control Brief description Associated Associated Application
Interface function name windows and Control Interface
dialogs structures
Initiates a specified programming operation,
keeping under control its successful
Program | ACI_Function_Params

ACI_ExecFunction|368)

completion or failure. It controls a single
programmer.

Manager 108)

ACI_StartFunction[373)

Initiates a specified programming operation
and then does not check the operation
result. It controls a single programmer.

Program
Manager[108)

ACI_Function_Params

ACI_GangStart[ 37

Used to control multiple device
programmers. Initiates auto programming in
the gang (gang-programming[198) mode.

Program
Manager/[108)

ACI_GangsStart_Params
38!

ACI_GetStatus[372)

Gets a current programmer status
information.

Program
Managerlm

ACI_PStatus_Params[39h

This macro sends a command that opens

Serialization
Checksum

ACI_SerializationDialog[ 37h S . NA
Serialization dialog. and Log
Dialog[ 63",

ACI_TerminateFunctionl?é’l Terminates a current programming Program NA

operation.

Manager[108)

AC|_GangTerminateFunction

[378)

Terminates a current programming
operation on a specified site of the gang
programmer.

Program
Managerll_%“l

ACI_GangTerminate_Par
ams/ 388

ACI_ErrorString[368)

Get the string describing the result of the last
ACI function call

Program
Managerll_%bl

NA

9. ACI functions that

save files from the programmer and load projects or filesto the

programmer
Select
Device[ 58
Loads a specified project that mustbe Buffer
ACI_LoadProject[ 37 previously prepared and saved manuallyin | 2UMPI L | Ac) project Params@h
the programmer GUI. Device and
Algorithm
Parameters
[ %Y
Saves a specified file from a specified Buffer
ACI_FileSave[ 3% buffer's layer of the programmer into the —— ACI_File_Params[383)
) Dump[ %Y
instrumental computer.
Loads a specified file from the instrumental Buffer
' R & . : Buffer . -
ACI_FilelLoad[ 363 computer to a specified buffer's layer in the Dumpl & |ACI_File Params/ 383

programmer.

10. ACI functions that display programmer's windows and dialogs for setting up and

debugging external programming sessions

ACI_SettingsDialog[ 3™

Displays the programmer Preferences
dialog.

Configure >

Preferences
™™

NA
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Application Control Brief description Associated Associated Application
Interface function name windows and Control Interface
dialogs structures
ACI_SelectDeviceDialog[ 3 | Displays the Select Device dialog. Seledt NA
Device[ 58
) . ) . Buffer
361 . ——
ACI_BuffersDialog[366) Displays the memory buffers setting dialog bumpre | VA
ACI_LoadFileDialog[373 Displays the file loading dialog. Dlﬁnﬂ%ﬁ NA
S . ) . . Buffer
ACI_SaveFileDialog[37 Displays the file saving dialog. bumpr e | VA

5.4 ACI Structures

This section provides an overview of the structures used in calls to ACI functions|sll. Detailed
description of each structure can be found in the ACI Structures| 3 reference section.

Structure The ACI function that uses the structure
ACI Launch_Params| s ACI_Launch(s7)

ACI Config_Params| 3 ACI_LoadConfigFile[s73), ACI SaveConfigFile[s7)
ACI| Device Params|ss2 ACI| _GetDevicel 370, AC|_SetDevice[ ),

ACI Layer Params|[? ACI GetLayer[s)

ACI Buffer Params|zsd) ACI CreateBuffer[38, ACI_ReallocBuffer[s7)

ACI ReadLayer[373), ACI WriteLayer[ssd),
ACI_FillLayer|3s)

ACIl Memory Params|ssd)

ACI SetProgrammingParams/79),
ACI GetProgrammingParams[32

ACI Programming_Params|[3)

ACI|_ProgOption_Params|[ ) ACI_GetProgOption[s7), ACI_SetProgOption[37)
ACI_Function_Params| s ACI_ExecFunction[se8, ACI StartFunction[s)
ACI PStatus_Params|[z ACI GetStatus[+72)

ACI_File_Params| 3 ACI FileLoad[ 3%, ACI_FileSave[ze)

ACI GangStart Params|ze) ACI GangStart[s), ACI_GetStatus|s72)

ACI GangTerminate Params| e ACI_GangTerminateFunction[37)

Here is an example of the structure syntax:

typedef struct tagACl_Buffer_Parans

{
Ul NT Si ze; /1 (in) Size of structure, in bytes
DWORD Layer 0Si zeLow; /1l (in || out) Low 32 bits of layer 0 size, in bytes
DWORD Layer 0Si zeHi gh; /1 (in || out) High 32 bits of layer 0 size, in bytes
/1 Layer size is rounded up to a nearest val ue
supported by programrer.
LPCSTR Buf f er Nane; /1 (in) Buffer name
Ul NT Buf f er Number ; /'l For AClI_CreateBuffer(): out: Created buffer number
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/'l For ACI_ReallocBuffer(): in: Buffer nunber to realloc
Ul NT NumBuf f er s; /1 (out) Total nunber of currently allocated buffers
Ul NT Nunmiayers; /1 (out) Total number of layers in a buffer
} ACI _Buffer_Parans;
Each structure includes a number of parameters (here Size, Layer0SizeLow, NumBuffers, etc.). The
parameter's name follows its format (UINT, DWORD, LPCSTR, CHAR, BOOL, etc.). The comment to
the parameter begins with a symbol in parentheses showing the direction in which the parameter is
passed, as follows:
e (in) - the parameter is sent from the instrumental computer to the programmer;
¢ (out) - the parameter is sent from the programmer to the instrumental computer;
e (in || out) -the parameter can be sentin either direction, depending on the ACI function
context.
5.5 Examples

Phyton ChipProg-02 SDK comes with several usage examples of Application Control Interface
functions and structures. Examples reside in the AC\Programmer ACI Examples subdirectory of
CPI2-Gx installation directory.

Examples are written in the C language and are projects that can be built using Microsoft Visual
Studio® 2008. Project sources can also be compiled using other C/C++ compilers, sometimes with
minor adjustments. Building a project creates a Windows console application executable.

To adjust an example project (or a part of it) for use in your application, in the main() function adjust
paths to the ACI functions. This includes paths to the CPI2-Gx executable file, to file loaded into
programmer memory buffer or saved from buffer to disk. You also have to specify real target device
type. Sample main() function fragment is shown below.

¥+ main ° 01.07.09 17:37:24*/

/I Launch the programmer executable
if (! Attach("C:\\Program Files\ChipProg-02\\6_00_01\UPrognt2.exe", ™, FALSE)) return-1;

/I Select device to operate on
if (! SetDevice("Microchip”, "PIC16C505 [ISP HV Mode]") return-1;

/I Load .hex file to buffer O, layer O
if (! LoadHexFile("C:\\Programi\test.hex", O, 0)) return -1;

All examples use the ACI.DLL file, therefore that file must be located in the same folder where the
example executable file resides, or in a folder listed in the PATH environment variable. For provided
examples, ACIL.DLL file has already been copied to the folder in which Microsoft Visual Studio creates
executable files.

Description of the Examples

Each example has an opening comment briefly describing the program purposes; more comments are
added to the code. All examples start with calling the ACI_Launch()[ function that launches the
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programmer.You will have to adjust the path the CPI2-Gx executable that is passed as parameter to the
Attach() function. After that, target device type is selected; you will need to modify that accordingly.

AutoProgramming.c

This is the simplest and most frequently used example of the CPI12-Gx control by an external program.
User program launches the programmer, selects the PIC18F242 target device, loads the test.hex file
into programmer buffer, sets default programming options, and then executes a preset Auto
Programming batch of functions: Erase, Blank Check, Program, Verify.

SaveMemory.c

This example shows how to save a binary image of a device to a file on disk. First, the user program
makes sure a device is insertion into the programmer socket by calling the ACI GetStatus(&Status)|s72)
function. After detecting correct and reliable insertion, the program reads data from the specified
address range of SST89V564RD device's memory and saves it to the file test.bin on disk.

Checksum.c

This example shows how to calculate a checksum of data read from a device. First, user program
verifies device insertion into programmer socket by calling the ACI_GetStatus(&Status)[ 372 function.
After detecting correct and reliable placement, the program calculates the real size of the
SST89V564RD device flash memory by executing the ACI_ExecFunction[3% function. It then allocates
the buffer 'buf' in the host computer memory for holding data read from the device, reads the data into
this buffer, and calculates buffer content checksum.

LongProgramming.c

This example shows how to monitor the AutoProgramming procedure that takes a long time.
Programming is launched by calling the ACI_StartFunction[ 3. Completion percentage of the operation
is then checked by calling the ACI_GetStatus|=72] function. If the operation fails, the programmer issues
an error message; otherwise operation is continued.

ProgrammingOptions.c

This example shows how to read, display, and change options set in the Device and Algorithm
Parameters Editor| 1 window. First, the program checks device insertion in the programmer's socket
by calling the ACI_GetStatus()[372) function. After detecting correct and reliable insertion of the device,
the program reads current set of options by calling the ACI_GetProgOption()[s4 function, and prints
them the options. Then the program changes the Vpp from default value to 10.5V and disables device
Brown-out Reset feature.

5.6 APl Explorer

API Explorer is a GUI application program that allows experimentation with ACI functions without writing
custom code. You can vary ACI function call parameters, study return codes, and see code in C
programming language recommended for performing function calls. API Explorer is shipped as part of
Phyton ChipProg-02 package. Figure below shows API Explorer window.
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AP Explorer for Application Control Interface SDK EI@
) e : What is ACI? e
Function: |ACL Launch < B G ] (@ Hep PESTorToro ®oEt |
Parameter structure ACI_Launch_Params: C code snippet: Copy code to clipboard
UINT Size = | sizeof(ACI_Launch_Params) - | BOOL result;
ACI_Launch_Params ln_params;
LPCSTR ProgrammerExe =| UProghT2.exe v | memset(&1ln_params, @, sizeof(ln_params));
LPCSTR CommandLine =| /ml - . .
In_params.Size = sizeof(ACI_Launch_Params);
BOOL DebugMade =| TRUE = | 1n_params.ProgrammerExe = "UProgNT2.exe";
- 1n_params.CommandLine = "/ml";
UINT NumSites - T | 1n_params.DebugMode = TRUE;
LPVOID ConnectionId = -
result = ACI_Launch(&ln_params);
CHAR ProgrammerName = v | if (result != ACI_ERR_SUCCESS)
{
}
[
Result: Clear results

ACI_Launch() = ACI_ERR_SUCCESS: Success
ACI_Launch_Params on return:
Size a8

De de
NumSites
ConnectionId

Programmeriame

1
Bxl13B2AER
"CPIZ2-B1"

The name of ACI function to call is shown In the upper left corner of the window. In the figure the
function is ACI_Launch. The drop down list contains names of other functions. Help button brings up
description of the selected function.

Below function name is the title of the structure used to pass parameters to the function. in the figure
this is ACI_Launch_Params structure. Structure body follows its name and contains field names and
types. Each field can have its value set for the function call. Input parameters are shown in bold type; on
the figure these are Size, ProgrammerExe, CommandLine n Debug.

To the right of the list of structure fields is sample code in C programming language that performs the
call with parameter passing. This code can be copied to clipboard to be pasted into user program.

To call the function, press the Call button. Results pane will show the return code, a string describing

the result, and structure field values. Output parameters that are results of the function call are shown
in black, input parameters that the function does not change are gray. To get the string description of

the result, the program automatically calls ACI_ErrorString function once the selected function returns
control.

How to set values for structure fields.

The first field of each structure is Size which is the size of the structure itself. When a function is
selected, AP| Explorer sets this value to the 'sizeof' of the structure; in the figure it is
sizeof(ACI_Launch_Params). This field should be left as is; while experimenting, a number can be
entered here.

If a field type is string, the text in the field can be quoted. The program missing quotation marks
automatically. The special string NULL is treated literally, as a null pointer.
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If a field type is int or Boolean, you can enter 1 or TRUE, and 0 or FALSE which will be placed as is into
generated code. In the figure TRUE value is entered in the DebugMode field.

Numeric values may be entered in decimal or hexadecimal format according to C language
conventions. An example of hexadecimal number is OXFFFO.

Fields left blank will be set to zero. This is true also for fields of type string; for example, LPCSTR
pointers will be set to NULL, and function call will result in error.

Generated Code Fragment
As shown in the figure, the parameter structure initially is filled in with zeros:
memset(&In_params, 0, sizeof(In_params));

Then follows the code to set values of structure field for which values are non-empty. All other fields will
contain zeros because the structure has already been zero-filled.

Specifics of ACI_ReadLayer, AClI_WriteLayer functions

When calling ACI_ReadLayer|37 the program allocates its own data buffer. If data size specified in
ACI_Memory_Params.DataSize field exceeds 128, the program will impose size limit if 127 cells.

To define data to be written by ACI_WriteLayer call, ACl_Memory_Params.Data must contain
hexadecimal numbers without the Ox prefix, for example: CO 03 FF. Value of the
ACI_Memory_Params.DataSize field must be equal to the count of specified numbers.

Using APl Explorer

All function call are carried out and not simulated. APl Explorer allocates and fills in structures and
actually calls functions in the ACL.DLL library.

When API Explorer is started, the ACI_Launch function is automatically selected because without
calling it first other functions cannot be activated. Filename of the CPI12-Gx executable is specified
without full path since it resides in the same directory as API Explorer executable. The CommandLine
field contains option /1 which launches programmer in demo mode. If you would like to use one or more
real programmers connected to the computer, option /1 must be removed.

When developing custom programs that controls programmers using ACI, please be sure to update the
library ACI.DLL and aciprog.h header file in the directories where you executables reside. The ACI.DLL
may be updated in future CPI2-Gx releases.

6 Integration with NI LabVIEW

The National Instruments LabVIEW ™ (hereafter LabVIEW) is a popular graphical development
environment that makes possible integration of a variety of design, production, and testing tools. CPI2-
Gx programmers can be controlled by LabVIEW using two methods:

e ChipProg-02 Command line[ 2} table;
e Application Control Interface (ACI[ 1s3).
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Each method is described in an appropriate section below.

The ChipProg-02 software includes a few examples[174 of the Virtual Instrument (.VI) files.

LabVIEW Integration Using Command Line

This is the most simple way to integrate ChipProg-02 with LabVIEW that involves two steps.
e Set up a programming session using ChipProg-02 user interface.
e Operate device programmer using LabVIEW user interface.

Here is an example:

1) Create a folder for controlling ChipProg-02 software from LabVIEW user interface, for example C:
\LabView\1.

2) On Windows desktop make a copy of ChipProg-02 icon. Rename it for use exclusively with
LabVIEW. The path to the program referred to by this icon is usually "C:\Program Files\ChipProg-
02\x_xx_xx\UprogNT2.exe", where the 'x_xx_xx" is the version of ChipProg-02 software. Right-click
on the icon, select Properties, Shortcut tab, and in the Start in field change path to C:\LabView\1 as
in the following figure:

Phyton ChipProg-02 Properties )
#& Phyt pProg pe
Security I Details | Previous Versions
General | Shortcut | Compatibility | Carbonite

@ Phyton ChipProg-02

Target type: Application
Tanget location: &_00_23

Target: C:APhytonChipProg-02%6_00_23\UProgh T2 exe

Start in: "CALabWIEW"

Shortout ey Mone

3) Power on CPI2-Gx device programmer, connect it to a USB port on your PC, and launch the
ChipProg-02 program by clicking the icon in C:\LabView\1 folder. When programmer user interface
opens, start setting programming session options by choosing the target device (for example by
pressing the F3 hot key). After choosing the device set up programming options and parameters using
ChipProg-02 windows, menus, and dialogs if these options differ from default ones. The following
options can be set within the ChipProg-02 GUI:

- Settings in the Program Manager /|18 window, such as selecting functions to be included into the
Auto Programming batch (button Edit Auto...); these include Split data, Insert test, Auto Detect, and
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other settings in the Options[18) tab; the number of chips to be programmed during a programming
session and other options in the Statistics[ ol tab.

- Settings in the Device and Algorithm Parameters Editor/[ e window that are device-specific, such
as boot vectors, fuses, lock bits, Vcc voltage, oscillator frequencies, etc.

- Settings in the dialogs accessible via Serialization, Checksum, Log file...[ e31menu, such as
algorithms for writing serial numbers and custom signatures into the devices being programmed, buffer
checksum calculation, custom shadow areas, dumping data to log files, etc.

- Miscellaneous settings in the dialogs accessible via Preferences| 71 and Environment[ 7 menus,
such as color, fonts, sounds, etc.

Complete the definition of programming session by including appropriate Command line options[ 28\

- Specifying method of control through the programming session (key /S);

- Choosing target device (key /C<manufacturer>"<device>);

- Loading the file to be programmed and its format (key /L<file name> /F<file format>);
- Specifying the Auto Programming| 108l mode (key /A);

- Launching programmer in hidden mode, when the ChipProg-02 GUI is hidden (key /12).

Notes:

- Device specified by the /C key on command line must be the same as chosen in the ChipProg-02
user interface.

- Specifying /12 key on command line hides ChipProg-02 application main window, suppresses display
of error messages but copies them to the Windows clipboard. If the session terminates successfully
ChipProg-02 application returns exit code 0; in case of errors exit code 1 is returned.

For example, if you want to program a HEX file myfw1020.hex located in the Program Files (x86)
\ChipProg-02\6_00_21 folder into the flash memory of a number of NXP MK20N64VFT7 [ISP EzPort
Mode] devices, then the command line should have the following format:

"C:\Program Files (x86)\ChipProg-02\6_00_21\UprogNT2.exe" /L"Program Files (x86)\ChipProg-
02\6_00_21\myfw1020.hex" /FH /C"NXP*MK20N64VFT7 [ISP EzPort Mode]" /A /12

4) To start CPI12-Gx in command line mode use the standard LabVIEW module SystemExec.

The figure below shows a screen shot of LabVIEW GUI front panel with the cp48_01.vi module loaded.
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3 cp48_01.vi Front Panel

File Edit View Project Operate Tools Window Help

[ || @ [n][ 17pt Appication Font |~ |[8=~ |[«da~ &~ | [28~] - A [2]2lo zﬁ
| [
I Working directory

C:\LabView\l

Call Chip Prog program
"C:\Program Files (x86)\ChipProgUSB\5_21_00\UproghT2.exe"
Firmaware path

JL"C:\Program Files (x86)\ChipProgUsB\5_21_00\myfw1020.hex" /FH
Device selecting

JC"Texas Instruments~CC2540F256" /A /12
Result commandiine

"C:\Program Files (x86)\ChipProgUsB\5_21_00\UprogNT2.exe" /L"C:\Program Files (x86)\ChipProgUsB}
5_21 00\myfw1020.hex" /FH [C"Texas Instruments~CC2540F256" [A /12

0Os error report

ChipProg Error report
OsError  ETNo

I_ Wrong device identifier
@

ChipProg Exit
System output string P 10g Std output std error

s N

And below is the same module block diagram:

© 2021 Phyton, Inc. Microsystems and Development Tools



Integration with NI LabVIEW| 173

I B cp48_01.vi Block Diagram

Flie Edt View Project Operate Tools Window Help 3
- S - - — = - .‘:-'—p.
> [@| @[n][5][eg] [+alm* -+ [ 17t Appication Font |~ |[$o |5 | [#0~ |[Ead|[+ =carc Iy ) e
Cal Chip Prog —‘J
[abe
[ I_ Std output
Result commandiine
=33 J
O C -
Firmaware path =M = st
— |wait until completion] —
E e —:‘:Ti‘—
[Device selecting
[abz ChipProg Exit Code

I3

Os error report

Waorking directory - m.j
At A 7 =
ﬁ L=ghd|Clears clipboard e pp__x ChipProg Error report
S Clipboard.Read!
n  ADD  a g s 2
Clipboard.Write Be
[}t Text

%
|

ﬁ
2

&
|I|:|’
%]

e
N S,

-

Kl oy

The <CPI2-Gx starts in hidden mode, its GUI remains invisible during the programming session. If no
errors occur, the ChipProg Exit box returns exit code 0, otherwise exit code 1 is returned. The error is

displayed in the ChipProg Error box report.
6.2 LabVIEW Integration Using ACI

The ChipProg-02 software package includes the Virtual Instruments (VI) library developed in the
National Instruments' LabVIEW ™ graphical development environment. It also includes a few usage
examples[ 17 of these virtual instruments. The library files reside in the LabVIEW folder located in the
ChipProg-02 installation directory. The library is created using the 2013 SP1 version of LabVIEW.

The DLL control is based on use of the Application Control Interface. Each Vlis a wrapper over the
appropriate function exported by the ACI.DLL library. You should be quite familiar with the Application
Control Interface in order to use the Virtual Instruments library.

Because of limitations imposed by LabVIEW on passing parameters to functions exported from DLLs,
the virtual instruments do not call the ACL.DLL functions directly. Instead, they call functions exported
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from the intermediate DLL - the ACI_LV.DLL. This DLL packs parameters into structures required by
ACIL.DLL and then calls its functions. The declarations of functions exported by ACI_LV.DLL are placed
in the C/C++ header file named ACIProgLabVIEW .h.

Each virtual instrument has its own front panel. It allows calling an appropriate Application Control
Interface function. In order to do this, before launching this function, you should launch the CPI2-Gx by
means of the VI with the name ACI Launch. Each virtual instrument has input and output terminals for
inputting and outputting parameters of the ACI function served by the virtual instrument.

See the VI file examples here[74,

LabVIEW Integration Examples

The ChipProg-02 software includes a few examples of the Virtual Instrument files (VI files) that illustrate
control of the CPI2-Gx programmers by the NI LabVIEW software. These examples are located in the
folders:

- For the 32-bit LabVIEW version - C:\Phyton\ChipProg-02\x_xx_xx\LabVIEW\x86\Examples\
- For the 64-bit LabVIEW version - C:\Phyton\ChipProg-02\x_xx_xx\LabVIEW\x64\Examples\

Currently, these folders contain three Virtual Instrument examples below but Phyton may add new
examples further:

- Device Programming Example.vi
- Programming Params Control Example.vil[173

- Gang_serial.vi 178)

The Device Programming Example.vi demonstrates use of all major ACI functions, namely:

¢ launch a device programmer;

¢ |oad a project;

 display the device programmer buffer content in the GUI;

¢ display a chosen device in the GUI;

¢ display the device programmer socket's status (if a chosen programmer type supports this feature);
o write a serial number and increment it automatically in the device programmer buffer;

o perform programming functions on target device and display the results in the GUI;

o count numbers of successfully programmed and failed devices, and display them in the GUI;

To evaluate the example, start the CPI2-Gx and launch Device Programming Example by clicking
Run continuously button in the LabVIEW GUI. Then click the Launch Programmer button on the VI
front panel. This will open front panel of the virtual instrument ACI Launch. Enter full path to the
ChipProg-02 executable file, for example: "C:\Program Files\ChipProgUSB\6_00_00\UprogNT2.exe"
and (optionally) specify the command line parameters. To avoid prompts to restart programmer you
can specify the path to the UprogNT2.exe in a constant string in the virtual instrument diagram and un-
check the Prompt for programmer name, switches, etc... box on the front panel (see the diagram
below).
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B! ACI_LV Iviib-Device Programming Example.vi Block Diagram
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After launching the programmer its current status becomes visible in the virtual instrument's front panel.
Clicking the Start button launches the operation with the name that you can enter into the Function
Name field, for example: Blank Check. If the Function Name field is left blank, the programmer will
execute Auto Programming| 108 function. This process is illustrated in figures below.

B ACI_LV.Ivlib:ACI Launch.vi

File Edit

View Project Operate

Tools Window Help

o

@]

ALY
Launch
LY

/g

ProgrammerExe
% C:\Program Files\ChipProgUSB\6_26_00WprogNT2 exe

CommandLine

¥ Programmer window visible (Debug)

Launch Programmer

|

Programmer Name Mumber of Sites
a
error out %
status code source
4 o -
—1
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k. ACI_LV Ivlib:Device Programming Example_vi

File Edit View Project Operate Tools Window Help
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The Gang_serial.vi example is a modification of the Device Programming Example described
above and illustrates of how to operate with multiple CPI2-Gx device programmers running in the gang
programming[ 198 mode (or gang mode). The structure of the Gang_serial example is identical to the
structure of the Device Programming Example.

To add a new site:

1. Copy all the contents of the last "case" structure containing the "Get status” function to a free space.
Create a new "case" inside the structure and paste the copied data into it. Attach the data outputs in the
same manner as in the previous "case" (it is necessary to copy and paste instead of duplicating the
"case" entirely because copy/paste creates new variables required for the program to work. Duplicating
the "case" will use old variables.

2. Create local variables from the newly created 'Total', 'good', 'bad' (Right Mouse Button (hereafter
RMB) - > Create - > Local variable. Add them to
the event structure of the "Clear all* event. Connect these variables just like others.

3. Create a local variable from the new 'Executing' element in the 'Read’ mode. Include it into the
iteration block via the logical 'OR" just like the other 'Executing’ variables are.

4. Copy and paste the last (by number) 'Program Site' button. Duplicate the last (by number) "case" of
the "Program site value change" in the event structure. As a condition set a change of the newly
created button value.

When adding new ACI Functions[26] make sure to set the correct site number in the appropriate
variables. (Steps 1, 4 in particular).

The last thing to do is to arrange all new indicators on the front panel.
Adding "site online" light is optional.
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7 Scripting

7.1  Scripting Overview

ChipProg-02 application can execute commands contained in script files. Scripting is a convenient
way to automate programming process when using CPI2-Gx programmers.

Scripts can be used to perform various operations, such as automatically load data into memory buffers,
calculate checksums, initiate device programming, pause programming in case of an error, manipulate
windows, and others.

For the purpose of customizing CPI2-Gx user interface (and for debugging purposes) scripts can create additional
windows of two types: the User window [ 18} and the I/O Stream window |18}, Scripts can also create
custom menus.

Scripts can send messages to Console window/[ 0% or to User| 1 window created from within the
scripts. User windows can display text and graphical data.

ChipProg-02 scripting language is similar to C programming language; most C language features are
supported, except structures and pointers. However, there are some differences(208). The scripting
subsystem supports many built-in functions, such as printf(), sin() and strcpy().

Scripts are stored in files with filename extension .CMD.

The scrips controls and associated dialogs and windows are concentrated under the Script menu| ss1.
The major dialog that controls scripts is the Script Files dialog[7.

How to write a script file

Script is similar to a in C language program. You can use the ChipProg-02_built-in editor[ 189 or any other text
editor to create or edit scripts. You can store script files in your working directory or in the ChipProg-02
installation directory.

Note that you must not use special characters (braces, dash, etc.) in the script file names.

How to run a script file

To start, stop, restart, and debug a script file use the Script Files l75’k_iia|og|?§’|.

The Reference section contains detailed information about scripting.

7.1.1 Simple example

This sample script loads a file, performs automatic programming, and displays the result.

#include <system.h>
#include <mprog.h>

woid main()

{

LoadProgram(“test.hex", F_HEX, SubLewel(0, 0)); /I load file "test.hex" that is an Intel
HEX file
/I to buffer 0, sub-level O
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InsertTest = TRUE; /I set testing of chip presence
to "on"
if (ExecFunction("Auto Programming") == EF_OK) /I perform an automatic programming
{
if (ExecFunction("Verify", SubLewel(0, 0), 10) = EF_OK) /I verify 10 times
{
printf("Verify failed: %s", LastErrorMessage); /I display error message if verify failed
return; /I terminate script
}
printf("Verify ok."); /I display Ok result
}
else
printf("Programming failed: %s", LastErrorMessage); /I display error message
}
7.2  The Startup Script
When the ChipProg-02 application starts, it automatically runs the start.CMD script if it exists. This is similar to
execution of the autoexec.bat file in Windows. ChipProg-02 first looks for start.CMD file in the current directory; if
it is not found, ChipProg-02 then looks for start.CMD in its installation directory. If the START.CMD is not found, the
default CPI2-Gx GUI shell will open.
7.3 Running Scripts

Scripts can be started and restarted in several ways. The easiest one uses the commands of the Script
Files[173) dialog. A script can be also be started by calling the StartCommandFile() function from another

script.
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7.3.1 The Script Files Dialog

This dialog is used to start, stop, and debug scripts.

< Script Files
Scriptfiles list
ROLLING "ROLLING" Id: 1. Stopped. PC=00010000 ("ROLLING" Terminate
SCANNER "SCANNER" Id: 2, Stopped, PC=00020068 ("SCANNER") =
Terminate All
Restart
Debug
Start new scriptfile
Scriptfile name:
|y:\ray‘tuprognf&hscanner.cmd w ) Browse..
Defines:
| v]
#include-file folders:
| v]
Debug (open Script Source window)
#  stn .
[] Auto-save scriptfile sources
«  Done @ Help

In the top pane of this dialog you see the list of loaded script files along with the state of each script. A script
can be in one of the following states:

State of Script
Stopped

Running

Waiting

Cancelled

Description

Execution of the script file is temporarily stopped.
The script file is being executed.

The script is waiting for an event. This state is initiated by calling certain wait
functions in the script file text (for example, Wait).

The script execution is terminated, but the script file is not yet unloaded from
the memory.

To select a script highlight its name in the window. The four buttons on the right of the list affect the highlighted

script:
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Button Description

Terminate Unloads the selected script file if it can be unloaded. Otherwise, it sets up the
Unload Request flag for the selected script that then goes to the Canceled
state.

Terminate All Unloads all script files visible in the window.

Restart Restarts the highlighted script.

Debug Switches to the Debug mode for the highlighted script. This command stops

execution of the script and opens it in the Script Window[ 183 for debugging. If
the script is in the wait state, execution will be stopped immediately after the
script returns from the Waiting state.

When you use several script files simultaneously and unload or restart some of them, remember that script files
can share global data and functions. If one script accesses data or functions belonging to a script that is
already unloaded, the script interpreter will issue error messages and the active script will also be unloaded
(terminated).

The buttons and fields in the lower part of the dialog box determine how scripts are run:

Dial ntrol Description

Script File Name Specifies the filename of the script for loading. You may type in file name with
full path, or select it from the drop-down history list, or browse files on disk.

Browse Opens the Load/Execute Script File dialog for locating and loading script
files into the Script File Name box.

Defines Defines preprocessor variables. For more information, see Preprocessor
Variables below.

#include-file Specifies directories to search for files specified in the #include <file_name>

Directories directive(s). To specify more than one directory separate them by semicolons.
The current directory is searched as well.

Debug (open Script If this box is unchecked, a script file automatically start execution upon the

Source window) file loading. If the box is checked, then upon loading script file a window for
debugging is opened. See also How to Debug a Script File[18h.

Auto-save Script File If this box is checked, clicking the Start button automatically saves the source

Sources texts of all script files \isible in the Script Source windows.

Start Starts the script file specified in the Script File Name box.

Preprocessor Variables

The content of the Defines text box is equivalent to the #define directive in C language. For example, if you type
DEBUG in this text box, the result will be as if the #define DEBUG directive is placed in the first line of the
script source.

You can use Defines to specify values for variables. For example, DEBUG=3 is equivalent to #define DEBUG 3.
You can list seweral variables in a line, separated by semicolons. For example:

DEBUG, Passes=3; Abort =No
Also, see Predefined Symbols at the Script File Compilation[ 233

© 2021 Phyton, Inc. Microsystems and Development Tools



Scripting 181

7.3.2 The User Window

User window is a window created by calling built-in OpenUserWindow function from within a script. User
window provides the following functionality:

o displaying text;
e displaying graphics (indicators, LEDs, buttons, arrows, etc. by calling built-in graphic functions);
e responding to events (see WaitWindow Event).

These capabilities allow write scripts working in interactive mode.

All functions working with windows (including User windows) take window identifier (handle) as a parameter.
Because of this you can have several windows of the same type open at the same time.

User window does not have context menu. Howe\er, it provides a toolbar with 16 buttons (0...F), and each
button can be programmed to perform a certain function. Pressing a button generates the
WE_TOOLBARBUTTON event.

7.3.3 The I/O Stream Window

I/0 Stream window is created by calling built-in OpenUserWindow function from a script. Script use
windows of this type to display text I/O streams. The most common examples of I/O streams are the
characters input from PC keyboard and text messages output by the script. Also, you can assign I/O streams
to files and input data from those files.

Functions that operate on windows (including the 1/0O Stream window), receive window identifier (handle) as a
parameter. Therefore, several windows of the same type can be open simultaneously.

When a function sends some text to this window, the text is appended at the current cursor position. To start
the next line the function outputs \n' (line feed character).

I/0 Stream window features two text display modes, with or without automatic line advance (wrap). In
automatic line feed mode, text that does not fit into current line is wrapped to the next line. If auto wrapping
mode is off, then a line that does not fit in the window it is truncated. The Wrap button in the toolbar toggles the
this modes. The Clear button clears the window contents.

Windows of this type do not have context menu.

7.4  Debugging a Script

A script can be started in Debug mode. This is usually necessary while you test the script to see if it works
properly, and make necessary corrections. To start a script in debug mode, highlight its name in the Script Files
dialog[ 17 and click the Debug button. This brings up the Script Window[ 183\,

The ChipProg-02 application is designed for source-level debugging. Scripts are debugged in the same way the
programs are debugged, executing script step-by-step or up to cursor, setting breakpoints, watching variable
values, etc. Debugging process uses Script Source[182) and Watches windows. If the Debug option is set in the
Script Files Mll_ﬁﬂ, the Script Source[183) window opens automatically when starting the script.

When the StartCommandFile() function in a script is called to start another script, you can specify parameter
instructing it to start the new script in debug mode and open the Process window.

To view the value of a script variable in the Watches 183window( 183, use the Add Watch command in the Script
window menu or the Add Watch toolbar button. This can also be done manually in the Watches window. For
example, if you need to view the value of the addr variable, which is used in a script named TEST, place the
#TEST#addr construct in the Watches window. If addr is declared public, that is, outside the function, then it
should be written as ##addr.
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7.4.1 The Script Window

The Script window is divided into two panes; the left pane displays the script source, while the right pane is the
AutoWatches pane[183)

Syntax constructions and the lines that correspond to the current Program Counter (PC) value (blue strip) and the
breakpoints (red strips), are highlighted in the script file text (for more information, see Syntax Highlightingl@).

Script: Rolling.cmd (20,32) E=E=]

ave tep un rea +Watc rigin ew estart etup
O S S Ri Break | +Watch | Origin | New PC | R S
« if (handle != -1) ~ | lhandle=@xFFFFFFFF

{ . [}H Save file .
. read(handle, rollingTmp, si Step Ctrl+T handle=@xFFFFFFFF, rollingTmp="\@\@IMIKY\@"
. close(handle); handle=@xFFFFFFFF

1 Run Ctrl+U

Run to cursor F4
s uint8 RAD_SYNC_L = rollingTmp Origin Ctrl+0 RAD_SYNC_L=0, rollingTmp="\@\@ImIKY\8"
* uint8 RAD_ID H = rollingTmp[g New PC Ctrl+N RAD_ID_H=0x59, rollingTmp="\@\@IMIKY\Q"
* uint8 ID = RAD_IDH = RAD_ID| o 0\ . . £ CuleB ID=0x59, RAD_ID H=0x59, RAD_SYNC_L=0
+  uint8 RAD_SYNC_H — rollingTmp 22 i ‘ RAD_SYNC_H=8xB2, rollingTmp="\@\@TMIKY\@",
« uint8 ID2 = RAD SYNC_H + RAp| AddtoWatcheswindow —Ctrl+W 1D2-0xB2, RAD_SYNC_H=0xB2, RAD_SYNC_L=0
« rollingTmp[2] = RAD_SYNC_H; Restart Ctrl+E rollingTmp="\@\@IMIKY\8", RAD_SYNC_H=0xB2
* rollingTmp[3] = (©x00FF & (RA i rollingTmp="\@\@IMIKY\0", RAD_SYNC_H=0xB2
s rollingTmp[4] = ID2; [/ Right pane on rollingTmp="\@\QIMIKY\0", ID2-0xB2
e rollingTmp[5] = (6x00FF & (RA []Line numbers rollingTmp="\@\@IMIKY\®", RAD_SYNC_L=0
+ rollingTmp[6] = ID; i rollingTmp="\0\@IMIKY\@", ID=0x59
+ rollingTmp[7] = (8x0eFF & 1p2  Help onwindow.. rollingTmp="\@\BIMIKY\@", ID2-BxB2
Help on word under cursar &

= Properties r 2 = 2

"ROLLING" Id: 3. Stopped. PC=00030271 ("ROLLwvay

Note. To get help on a function or a variable, click mouse button on the function or variable name in the script
source.

7411 Menu and Toolbar

The context menu contains the following commands, most of which are duplicated by the toolbar.

Menu Command Toolbar Button Description
Step Step Executes one operator of the script.
Run Run Starts continuous execution of the script in the window.

The script execution can be stopped either by reaching
a breakpoint or by the executing Stop command.

Run to Cursor Executes the script up to the line containing cursor.
Alternatively, you can double-click the line to carry out
this command.

Stop Stops the running script.

Origin Origin Shows script source from the line whose address
corresponds to the script file Program Counter. This
operation is not available when source lines do not exist
for the program addresses.
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New PC New PC Sets the script’s Program Counter to the address
corresponding to the line containing cursor.

Toggle Breakpoint  Break Sets or clears breakpoint at the address corresponding
to the line containing cursor. When you execute the
Run or Run to cursor command, the program execution
will be stopped at the breakpoint.

Add to Watches +Watch Opens the Watches[ 163 window[ 183} (if not already open)
Window and places the name at the cursor into it.
Restart Restart Restarts execution of the highlighted script.

7.4.1.2 The AutoWatches Pane

The ChipProg-02 application displays the visible portion of the script in the Script window. The names of
variables, called AutoWatches, which belong to the visible script lines, are listed along with their values in the
right pane of the window. When you scroll through the Script window, contents of the AutoWatches pane
refreshes automatically.

The AutoWatches can be displayed in binary, hexadecimal, decimal or ASCII format. To select a format, click on
the Setup toolbar button or right click anywhere in the pane to open context menu.

7.4.2 The Watches Window

AutoWatches[ 18 pane of the Script window displays values of currently visible script variables. In addition, you
may want to monitor other explicitly specified script variables and expressionslm. To do so, ChipProg-02
provides the Watches window. For each variable, the window displays its name, value, type and address, if any.

A newly opened Watches window has one Main tab. You can add custom tabs (using Display Options
command in context menu) or rename any existing tabs. The tabs operate independently of each other, each tab
being functionally equivalent to a separate Watches window. However, if desired, you can open several Watches
windows.

Each Watches window has the +Watch toolbar button. Clicking on this button opens a dialog for adding a
selected object to the Watches window.

Grids in the Watches Window

For better readability, the Watches window can be divided into cells by vertical and horizontal grid lines. Enable
the grid by checking the corresponding boxes in the Configure menu > Environment > Fonts tab.

Context Menu

The window context menu contains the following commands, most of which are duplicated by toolbar buttons.

Command Description
Add Watch Adds one or more objects to the window. Opens the Add Watch[183) dialog to

choose an object by name. Also, you can enter an expression| 2031 as a name.
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Delete Watch Deletes a selected object from the Watches window.
Delete All Watches Deletes all watches from the window.
Modify Opens the Modify dialog to set a new value for a selected variable. Alternatively,

just enter the new value.

Move Watch Up Mowes selected watch up the list.
Move Watch Down Mowes selected watch down the list.
Display Options Opens the Display Optionslml dialog to change the display settings for selected

object and also to add/delete tabs to/from the window.

7.4.2.1 The Display Watches Options Dialog

Use this dialog to set the display options for the selected variable or expressionlE?I in the Watches[18 window.

Dialog Control Description

Watch Expression Contains selected expression. The drop—down list contains the previously
used expressions.

Display Format Specifies the format for displaying selected expression (binary,
hexadecimal, decimal, or ASCII).

Pop-up Description Contains check boxes that choose format for displaying pop-up SFR
descriptions.

Display Bit Layout If this box is checked the SFR bits will be displayed in the pop-up layout
descriptions.

Display Bit Descriptions Checking this box enables displaying the pop-up descriptions for the SFR
bits, if any.

Auto-size Name Field When this box is checked and when vertical grid is visible (see note

below), the window automatically adjusts the Name column width to fit
the longest record in the column.

Tabs Lists all tabs present in the window.

Add Tab Opens the Add New Tab to Watches Window dialog for entering a new
tab name. The window adds the new tab upon pressing OK.

Remove Tab Remowes the tab selected in the Tabs list.

Edit Tab Name Opens the Edit Watch Window Tab Name dialog for editing tab name.

Global Debug/ Display Opens Debug Options dialog.

Options

Note. To make grids visible in the Watches window, open Configure E"Imenu, the Environment dialog, the
Fontsl 8" tab and check the corresponding boxes in the Grid field.
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7.4.2.2 The Add Watch Dialog

Use this dialog to add symbol names (for example, a variable name or an expressionl z08)) to the Watches
window. The dialog contains a list of symbol names defined in, or known to, the program.

Dialog Control Description

Name or expression to Enter the symbol name or expression to be added. You can specify
watch: seweral names and expressions either manually (separated with
semicolons) or by selecting from the list with the Ctrl key pressed.

History List of previous names and expressions.

7.5  Script Editor

A script is similar to a source program written in C programming language. Scripts can be created and edited
using ChipProg-02 built-in editor described below or by using any other text editor. Scripts can be stored as
files in your working directory or in the directory where the ChipProg-02 is installed.

To open a built-in editor select Script menu > Editor window. The Editor toolbar that contains all buttons
related to editing is normally hidden. To customized editor toolbar right click on a blank area in the main toolbar,
select Customize in the drop-down menu, and check the boxes for editor functions that you want to make
visible.

To create a new script file and open it for editing, select Script menu > Editor window > New. This will open
a blank window shown below. Right clicking in the window brings up the Editor menu with buttons you can add
to the local Editor toolbar. On the figure the toolbar is shown above the window.
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Now you can edit the script in the window.

DHEBS||3 820 |RBRBS || NN
?noname? (1,12}
Undo | Save |Save As| Copy Cut Paste | Search | Search Next | Search/R
hﬁ LIndo Ctrl+Z, Alt+Backspace
H Save file Ctrl+S
B Save file as...
= Print...
®3 Copy Ctrl+C, Ctrl +Ins
4 Cut Ctrl+X, Shift+Del
il Paste Ctrl+V, Shift+Ins
[ Search for text... Ctrl+F
il Repeat search F3
& Search/Replace... Ctrl+H, Ctrl+P
& Display multi-file search results.., shift+F9
Display from line number... Ctri+L
ki Set bookmark... Alt+[
Iy Retrieve bookmark... Alt+]
< *y Condensed mode F12
“# Condensed mode setup Ctrl+F12
Device and Algorith
Edit | winvan [ Line numbers
Name Match brace/comment Alt+
ok Return to last editing context
- Tablewrite prof ~ User Scripts b
-~ Table read pro L
- CONFIGT Help on window... F1
fH- CONFIG2 Help on word under cursor Alt+F1
- CONFIGS Properties »
Fi-CONFIG4 .

Note that you should not use the punctuation characters (braces, dash, etc.) in the script file name.

To finish editing click on the Save button in the Editor toolbar, the program will prompt you for script file name

and location.
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7.5.1 The File Menu

Commands in this menu act on the currently active Edit[ 18 window.

Button Command Description
D New Opens the Editor window [187 for a new script file.
.Jﬁ‘ji Open... Brings up Open file dialpg to load a script file for editing. The file
ol name and path can be either entered or browsed here.
H Save Sawes contents of the active window to a file on disk.
_Ei Save As... Opens the Save as... dialog.
,u Print Opens standard Print dialog for default printer. You can print entire

file or just the selection.

Properties.. Common properties for open files.

7.5.2 The Edit Menu

Commands of this menu act on the active Edit/[180 window.

Button Command Description
ﬁa Undo Undoes the last text editing action performed in this window. For

example, if the last action deleted a line, then deleted line will be
restored. The number of steps provided by the Undo function is set in
the of the Configure > Editor Options > General[ 83\ tab.

@ Copy Copies selection to clipboard. The text format in the clipboard is
standard and the copied block is accessible to other programs.

: Cut Mowes selection to clipboard..
-

Cﬂ Paste Pastes text from clipboard, starting at the cursor position.
Clipboard Opens the Clipboard History/Repository dialog.
History/
Repository
Append to Copies and appends selection to clipboard contents.
Clipboard
Cut & Append to Cuts selection and appends it to clipboard.
Clipboard
Fast Copy Copies selection to a specified position in the same window.
Fast Move Moves a block from one position in a window to another position in the

same window.
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Block Off Unmarks a marked text block.

@ Search Opens the Search for Text[199 dialog.

@ Next Search Repeats search with parameters used in the previous search.

[@ Replace Opens the Replace Text[ 193 dialog.

%‘J Display Multi-file Re-opens the last multi—file search results in the Multi-File Search

: Search Results Results| 193 dialog.

Display from line Opens the Display from Line Number[199) dialog for you to specify a
number... line number. Source text will be displayed from this line.
Set bookmark... Opens the Set Bookmark[194 dialog to set a local bookmark.
Retrieve Opens the Retrieve Bookmark[ 19 dialog to retrieve a local
bookmark bookmark.

Condensed mode Toggles Condensed display model 183 on and off.

Condensed mode Opens the Condensed Mode Setup[198) dialog.

QR |7

setup

Line numbers Toggles line numbers on and off.

on/off
% Return to last Activates the most recently edited Source window, and places the
= editing context cursor in its final position during the edit.

7.5.3 Block Operations

Block operations are operations on blocks of text. The script Source window supports persistent blocks and
performs a full range of operations with standard (stream), vertical (column) and line blocks of text.

Non-persistent blocks In this mode, once a block is marked, you have to immediately carry out an operation
with it (delete, copy, etc.). Any movement of cursor turns the marking off. If a block is marked, then any entered
text will replace the block with the typed text.

Persistent blocks In this mode, the block remains marked until the marking is explicitly removed (hot key
Shift+F3) or the block is deleted (Ctrl+X). The Paste operation for persistent blocks has certain specifics. Two
additional block operations are available for persistent blocks: fast copy and fast move. These operations do not
use clipboard and require fewer keyboard manipulations.

To enable persistent block mode check corresponding box in the Main menu > Configure>Editor Options>
Generall & tab.

Standard blocks A standard (stream) block contains a "text stream” that begins at the initial line/column of the
block and ends at the final line/column.

The Standard blocks mode is enabled by default.

Line blocks A line block consists of lines of text. To mark a line block, put the cursor anywhere in the first line
and press Alt+Z; then put the cursor anywhere in the last line of the block and press Alt+Z once more (the
latter is not necessary if the block is to be immediately deleted or copied to the clipboard).

Line blocks are always available.
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Vertical blocks - A vertical block contains a rectangular text fragment. Characters within the block that go
beyond line ends are considered to be spaces.

Vertical blocks are convenient in cases like the following:

char Tinmer0O far ;
char Tinmerl far ;
char IntO far ;
char Int1l far ;

Assume the word "far" is to be moved to the place right after the word "char" in each line. The stream blocks
are of little help here. However the task can be easily done with one vertical block. Mark the persistent vertical
block containing the word "far" in each line, place the cursor on the first letter of word "Timer0" and press
Shift+F2 (fast mowe the block):

char Timer® far;
char Timerl far;
char 0Osc tar;
char DMA Fak;

uint8 RAD SYNC L = rollingTmp[7];

sam A= DA T LI mm 1T e Tomem [T

The Vertical Blocks checkbox in the the Main menu > Configure>Editor Options> General[ 8 tab
toggles between the vertical block and the stream block modes. Standard blocks are enabled by default; i.e. the
Vertical Blocks checkbox in the Editor Options dialog is unchecked by default. Line blocks are always
accessible, independent of the state of the Vertical Blocks checkbox.

To mark a block, move the mouse while pressing its left button or use the arrow keys on the keyboard while
holding the Shift key. To unmark the block, press Shift+F3.

Copying / moving blocks

A marked block can be copied or moved in two ways within the same Source window: directly (fast copying,
fast moving) or using clipboard (Copy/Cut/Paste). Copying and moving blocks across Source windows or to
another application is always done using clipboard.

Note. The result of copying a stream or vertical non-persistent block depends on the INSERT mode. If the mode
is enabled, the block is inserted into the text starting at the cursor position; otherwise the copied block
owverwrites the text in an area of equivalent size.

Fast copying / moving

Fast copying or moving of the blocks in the same window happens without the use of clipboard. It is convenient
because it requires pressing the keys only once per operation. Mark a persistent block, then place the cursor to
the destination position and press Shift+F1 to copy, or Shift+F2 to mowe the block.

7.5.4 Condensed Mode

In the Condensed mode, only lines that satisfy a specific criterion are displayed in the window. There are two
available criteria:

e Line must contain the given substring;
¢ The first non-space character in a line must be at a specified position (column).
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Examples:

(a) with the substring criterion and the substring set to "counter,” only the lines containing the word "counter”
are displayed;

(b) with the second criterion and the position set to four, only the lines in which text starts at column 4 will be
displayed.

Condensed mode brings lines having some common feature to "one place." If you attentively follow the rule to
begin a declaration of data at position 2, procedures at position 3, and interrupt handlers at position 4,
Condensed mode will help you find necessary declaration. If you comment certain lines with the same or similar
comments and use the Condensed mode with substring, you will be able to benefit from your composing style.
In Condensed mode, you can move the cursor just the same way as in normal mode.

The criterion for display is set in the Main menu > Script > Text Edit > Condensed Mode Setup[1%) dialog.
To toggle Condensed mode on/off, use the Edit menu command, the Condensed Mode command of the local
menu or the F12 hot key. To exit Condensed mode, press Esc; at exit the cursor returns to the position at
which it was before the mode was turned on. To exit condensed mode leaving cursor in the same line as while
in the mode, press Enter or begin editing the line.

7.5.5 Syntax Highlighting

When the Sourcel18A window displays script source, it marks certain language constructs with different
colors. This feature improves readability. The following constructions are highlighted:
e Punctuation and special characters: ()[]{} ., :; etc.
e Comments starting with // are highlighted.
e Comments enclosed in the /* */ pairs are highlighted only if the opening and closing pairs are placed in the
same line.
Strings enclosed in double or single quotation marks.
Keywords of the scripting language (for, while, and so on).
Type names of the language (char, float, and so on).
Library function names (printf, strcpy, and so on).

You can disable syntax highlighting through the Main menu > Configure>Editor Options> General[ 8N
tab>Syntax Highlighting flag. In addition, you can change the color of each construction; to do so use Main
menu > Configure> Environment > Colors[ 8 tab.

7.5.6 Automatic Word Completion

It is normal for words (labels, names of variables) to be repeated within some part of a file; the Source window
helps you typing such word.

When the cursor is at the end of line being composed, upon typing a letter the editor scans the text above and
below the current line. If a word beginning with the letters you just typed is found, the editor will "complete" this
word for you by writing the remaining part of the word from the current cursor position. To accept the completion
press Alt+Right (Alt+<right arrow>) and the editor will append the remaining part of the word to the text as if
you have typed it yourself. To discard completion, just continue typing and the editor will accept whatever you
type. At any point during typing you may press Alt+Right to accept editor's completion suggestion.

You can press Alt+Right at any time (not only when the editor offers you to complete a word). In this case the
editor will open a list of words that begin with the typed letters. If the list does not contain an applicable word,
just ignore the prompt. The right pane of the Source window, if it is open, also displays the word completion list.

To disable automatic word completion, uncheck the Automatic Word Completion box in the Main menu >
Configure>Editor Options> Generall 831 tab. When the box is checked, a number placed in the Scan
Range box defines the number of lines for the editor to scan. The default is 24 lines below and 24 lines abowve
the current line. When this parameter is greater than the total number of lines in the file (for example, 65535),
then program composing will become slower because the whole file will be scanned.

© 2021 Phyton, Inc. Microsystems and Development Tools



Scripting 191

7.5.7 The Quick Watch Function

The Quick Watch function works as follows: if you roll the mouse pointer over a variable name in the Source
window or the Script Source window, a small box containing the value of the variable will be opened. This box
disappears upon moving the mouse off the object.

7.5.8 Dialogs
This section describes dialogs used by Script Editor.

7.5.8.1 The Search for Text Dialog

This dialog sets criteria to search for text in files. This dialog and the Replace Text dialog have a number of
features in common. To specify file names, you can use one or several wildcards. Also, the hames may contain
paths. You can search more than one file by using parameters of the Multi-File Search area.

Dialog Control Description

String to Search for Text to search for.

Case Sensitive Unchecked by default. Checking this box makes the search case sensitive.
Whole Words Only Unchecked by default. If checked, the editor will search only for whole words:

the string will be found only if it is enclosed between punctuation characters or
delimiters (spaces, tabs, commas, quotation marks, etc.).

Regular Expressions Unchecked by default. Checking off this box specifies that the search string is a

regular exgression 190,

Global Search entire file for the string. Enabled by default.

Selected Text Search for string in the selected block.

From Cursor Search from the current cursor position.

Entire Scope Search from the beginning or end of the file (depending on the search direction).

Enabled by default.

Perform Multi-File If checked, the editor will search in all project files (see the notes below). If
Search unchecked, the search will be performed in current Source window only.
Search All Source If checked, the editor will search in all the source files included in the project.

Filesin Project

Include If checked, the editor will search in all the source files included in the project
Dependency Files and all files on which the source files depend, whether explicitly or implicitly.
Search Wildcard(s) Check this box to search for one or several wildcards specifying the files to be

searched. Separate wildcards with semicolons. No quotes are required to
denote Windows-style long names. Example: *. t xt; *. c; c: \ prog\ *. h.
This option and the Search All Source Filesin Project option act
independently of each other: you can search in all files of the project AND in
other files that comply with the specified wildcard(s).

Search If checked, the editor will search in subdirectories of all directories specified by
Subdirectories the Search All Source Files in Project option and by wildcards.
Starting Path Begin search from the directory specified in this text box. This directory serves

as the common path and is useful when there are several wildcards such as the
following ones:
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c:\prog\text\source\*.txt;c:\prog\text\source\*. doc

In this case, make use of wildcards (*. t xt ; *. doc) and common path
(c:\ prog\text\source).

Notes

1. When you search in the file opened in the Source window, then only the window buffer will be searched, not
the file on disk.

2. Multi-file search is performed in all source files of the project. Upon finishing, the Multi-File Search
Results[ 193 dialog remains open.

7.5.8.2 The Replace Text Dialog

This dialog sets parameters for search-and-replace operation. This dialog and the Search for Text dialog have
a number of common parameters, which function in the same way in both dialogs. To specify file names, you
can use one or several wildcards. Also, the names may contain paths. You can search in more than one file at

once by using parameters of the Multi-File Search area.

Element of dialog

Descrigtion

Text to Search for

Specifies the text string to look for (search string).

Replace with

Specifies the text string to replace the found one.

Case Sensitive

Unchecked by default. Checking this box specifies that the case of the string is
to be matched.

Whole Words Only

Unchecked by default. If checked the editor will search only for whole words: the
string will be found only if it is enclosed between punctuation or separation
characters (spaces, tabulation symbols, commas, guotation marks, etc.).

Regular
Expressions

Unchecked by default. Checking of this box specifies that the search string is a
regular expression 198,

Prompt at Replace

Checked by default. If checked, the editor will always pop up the Confirm
Replacemﬁ dialog requiring your permission to replace the found text. If
unchecked the editor will automatically replace the searched-and found text.

Global

Search entire file for the string. Enabled by default.

Selected Text

Search in selected block.

From Cursor

Search from current cursor position.

Entire Scope

Search from beginning or end of the file (depending on the search direction).
Enabled by default.

Perform Multi-File
Search and
Replace

Checked by default. If checked, the editor will search in all project files (see the
notes below). If unchecked, the search will be performed in the current Source
window only.

Search All Source
Filesin Project

If checked, search in all the source files included in the project.

Include
Dependency Files

If checked, search in all the source files included in the project and all files on
which the source files depend, whether explicitly or implicitly.

Search Wildcard(s)

Check this box to search for one or several wildcards specifying the files to be
searched. Separate wildcards with semicolons. No quotes are required to
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denote Windows-style long names. Example: *. t xt; *. c; c:\ prog\ *. h.
This option and the Search All Source Filesin Project option act
independently of each other: you can search in all files of the project AND in
other files that comply with the specified wildcard(s).

Search If checked, search in subdirectories of all the directories, which are specified by
Subdirectories the Search All Source Filesin Project option and by wildcards.
Starting Path Begin search from the directory specified in this text box. This directory serves

as the common path and is useful when there are several wildcards such as the
following ones:

c:\prog\text\source\*.txt;c:\prog\text\source\*.doc

In this case, make use of wildcards (*. t xt ; *. doc) and common path
(c:\ prog\text\source).

Notes

1. When you search in the file opened in the Source window, then only the window buffer will be searched, not
the file on disk.

2. Multi-file search is performed in all source files of the project. Upon finishing, the Multi-File Search
Results[ 193 dialog remains open.

7.5.8.3 The Confirm Replace Dialog

This dialog asks permission to replace the found string. You can turn the prompt on/off by checking/clearing the
Prompt at Replace box in the Replace Text[192) dialog.

Button Function
Yes Replace the found string.
No Cancel this replacement. If the procedure is started with the Change All

button for all occurrences in the search area, then the search-and-replace
process will continue.

Non-Stop From this moment, replace all found strings in this file without prompt.
Cancel Cancel the search-and-replace process.

Skip this File Stop searching in this file and switch to the next one.

Replace in All Files Replace all occurrences in all other files without asking for confirmation.
Move cursor to the If checked, the cursor will be automatically placed on the Yes button on
Yes/No Buttons each inquiry for confirmation.

7.5.8.4 The Multi-File Search Results Dialog

This dialog displays the multi-file search results. To learn about the multi-file search, see the Search for
Text[ 191 dialog.

The List of Matched Files shows files in which the search string is found. File name is on the left and its
directory is on the right. The line with green text beneath this box displays information about the file selected in
the box. "File in memory" means that the file is opened in the Source window. General information from FAT
means the file is on disk, not loaded. The Preview area shows the source line with the found text string.
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The Sort Files by area includes a radio button with four file sorting options. When the Consider Directory box
is checked, the files are sorted with respect to their directories.

The Edit button opens selected file in a new Source window and places the cursor on the line with the found
string. The found string background is highlighted. To check for other occurrences of the search string in the file,
press Ctrl+R or use the Next Search command of the Edit menu.

The Close button closes the dialog but search results are not lost. To reopen the dialog use the Display Multi-
file Search Results button. You can also use the same command of the Edit menu or press Shift+F5. The
files in the List of Matched Files box, which are opened in the Source window, will be marked with asterisks
on the left.

7.5.8.5 Search for Regular Expressions

Text editor supports "regular expressions." Regular expressions contain control characters in the search string:

? Means any one character in this place. Example: if you specify ?ell as the search string,
then "bell," "tell," "cell," etc. will be found.

% Means beginning of line. The characters following ‘%' must begin from column 1. Example:
%Counter - find the word "Counter," which begins at the first column.

$ End of line. The characters preceding the '$' should be at the trailing positions of the line.
Example: Counter$ - find the word "Counter" at the line end.

@ Match the next character literally; '@’ lets you specify the control characters as usual
letters. Example: @7 - search for the question mark character.

\XNN The hexadecimal value of the character. Example: \xXA7 - find the character with the
hexadecimal code of A7.

+ Indefinite number of repetitions of the previous character. For example, if you specify
1T+2, then the editor will find the lines containing "1" followed by "2", which are separated
with any number of the letter T.

[c1-c2] Match any character in the interval from c1 to c2. Example: [A-Z] means any letter from A
to Z
[~c1-c2] Match any character whose value is outside the interval from c1 to c2. Example: [~A-Z]

means any character except for the uppercase letters.

textl|text2 The "|" character is the logical "OR" and the editor will look for either textl or text2.
Example: LPT|COM|CON means search for "LPT" or "COM" or "CON."

7.5.8.6 The Set/Retrieve Bookmark Dialogs

Bookmarks help you return to a marked cursor position in a source file.

You can set and retrieve up to 10 local bookmarks. Every local bookmark has an individual numbered button
assigned to it.

To open the Set Bookmark dialog, press Alt+[. To open the Retrieve Bookmark dialog, press Alt+]. To
set/retrieve a bookmark, press its numbered button. The number of the bookmarked line, the bookmark position
in the line (in brackets) and the text of the line are shown at the right of the button.

Local bookmarks are stored in the configuration file and you can work with them in the next session.
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7.5.8.7 The Condensed Mode Setup Dialog

This dialog sets up the parameters for the Condensed mode[ 183 of the Source [187 window.

Display Lines of Text area has radio buttons for switching between two alternative criteria for condensing text
in the Source window: Containing String and Where First Non-blank Column Is:

1. If you check the Containing String radio button, Source window displays only lines with text that matches
the sub-string specified in the text box at the right. Additionally, you can specify case-sensitivity, that whole
words only should be used, and that the sub-string is a regular expressionl@.

2. If you check the Where First Non-blank Column Is radio button, the Source window will display the lines
where text begins from the position specified in the Column box. Then you should select one of four options by
checking an appropriate radio button:
e Equal to - the first non-space character should be exactly in the specified column. For example, if you
specify position number 2, the window will display only the lines whose text begins in column 2.
e Not Equal to - the first non-space character should be in any column except the position specified here. For
example, if you specify position number 2, the window will not display all the lines beginning in this column.
All other lines will be displayed.
e Lessthan - display only the lines in which text begins at a position less than the specified one.
e Greater than - display only the lines in which text begins at a position greater than the specified one.

Once setup is complete click OK to switch the Source window into Condensed mode.

7.5.8.8 The Display from Line Number Dialog

Use this dialog to display source file in the active Source[ 187 window starting with specified line. Enter the line
number or select any previous number from the History list. Line numbers start with 1.

8 Reference

8.1 How to ...

This chapter describes typical operations with a one selected programming module of a CPI2-Gx
gang programmer running in the Single Programming control mode[=0".. The description refers to
the operation made withing the ChipProg-02 GUI[ 123}, only.

8.1.1 How to check if device is blank

1. Select the target device type: press the Select Device button in the Main toolbar or select
command Main menu > Configure > Select device.

2. Connect a CPI2-Gx programmer to the device.

3. a) Click the Check button on the main toolbar, or
b) Double click on the Blank check function line in the Function list of the Program Manager/[109)
window, or
c) Select the Blank check function line in the Function list of the Program Manager [ 103 window
and click the Execute button, or
d) Select the Main menu > Commands and click on the Blank check line.

Wait for the message Checking ... OK in the Program Manager 1% window, or for the warning
message if the device is not blank.
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8.1.2 How to erase adevice

1. Make sure the device is electrically erasable. Some devices are not erasable; these may be
programmable once or over-writable — in this case the Erase button is disabled (grayed out).

2. If the device is electrically erasable:
a) Click the Erase button on the main toolbar or
b) Double click on the Erase function line in the Function list of the Program Manager | 10!
window or
c) Select the Erase function line in the Function list of the Program Manager /051 window and
click the Execute button or
d) Select the Main menu > Commands and click on the Erase line.

Wait for the message Erasing ... OK in the Program Manager/[ 05 window or for the warning
message if the device is not blank after erasing.

8.1.3 How to read data from device

There are several ways of reading device content into the active buffer:

- click the Read button on the main toolbar, or

- double click on the Read function line in the Function list of the Program Manager|[ 103 window,
or

- select the Read function line in the Function list of the Program Manager[181 window and click
the Execute button, or

- select Commands > Read menu command.

In every case above, wait for the message Reading ... OK in the Program Manager |19 window
or for the warning message if the device could not be read.

8.1.4 How to program a device

In order to write (program) a device you need to perform a few consecutive operations:

load the file[ 198 that you want to write to the device;

edit the file[ 197 (if necessary);

configure[ 197 the device to be programmed (if necessary);

« write[19] the prepared information into the device and verify the programming.

8.1.4.1 How to load afile into a buffer
1. Inthe main menu select File > Load or click the Load button on the local toolbar of the Buffer
window.

2. In the pop-up dialog box that appears enter file name, select file format, addresses, buffer| 17 and
sub-level to load the file to.

3. Wait for the message File loaded: "......" in the Program Manager [105] window, or for a warning
message if the file cannot be loaded for some reason.
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8.1.4.2 How to edit data before programming

1. If you need to modify source data before writing it into the target device, open the Buffer Dump| e

window. Please keep in mind that the View button must be released to enable editing.

2. Make necessary changes using Modify[10d) dialog or select the data to be modified and type new

data over old data.

8.1.4.3 How to configure target device

3.

. Parameters displayed in the Device and Algorithm Parameters| 31 window that can be modified

are shown in blue.

. Click on the name of the parameter to be changed to open a dialog. Set a new value for the

parameter or check/uncheck appropriate boxes and click OK. Modified parameter will be displayed in
red.

Repeat the above procedure for other parameters that you wand to modify.

Note. All changes above will become effective in the target device only upon programming by the
Program Parameters function in the Program Manager [ 109 window.

8.1.4.4 How to write information into the device

1. Click on the Options[8 tab in Program Manager/[18lwindow. Check the options you need. We
recommend you always check Blank checkl19% before programming and Verify[ 98 after
programming to ensure reliable programming.

2. Click on the Program Manager/[ 8 tab. Select the Program line in the Function box and double
click on it to start programming of the primary memory layer (Code). Click on the Execute button
to launch the process. Alternatively, you can do the same by clicking on the big Program button or
by selecting the menu command Commands > Program.

3. Wait for the message Programming ... OK in the Operation Progress box of the Program
Manager [ tab. If an error has occurred, ChipProg-02 issues an error message.

4. Execution of the main Program function (always shown at the top of the Function list) writes the
specified buffer layer to the Code memory of the device. However, other buffer layers may exist for
the selected device (Data, User, etc.). If more than one buffer layer exists for the selected device,
go down in the list of functions, expand those that are collapsed and execute the Program
functions for as many types of memory as device has (Data, User, etc.). Skip those steps if only
the Code layer exists in the device.

5. IMPORTANT. If any options in the Device and Algorithm Parameters Editor window[ % have
been modified, you have to program the options set after programming all memory layers (Code,
Data, User, etc.). Go down to the Device parameters & ID line, expand it if collapsed, select the
Program function and double click on it. Continue until every parameter that has been changed in
the Device and Algorithm Parameters window is successfully programmed.

6. Some microcontrollers can be protected against unauthorized reading of the code stored in them
by setting Lock bits. You can selectively lock only certain parts of the device memory. Go down to
the Lock bits line, expand it if collapsed and double click on the lock bit# lines one by one. Continue
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until every lock bit you want is set.

7. After every operation described above make sure that you see Ok [xxxxx... Ok] message in the
Operation Progress box of the Program Manager tab. In case you get an error message stop
programming and troubleshoot the issue.

8.1.5 How to verify programming

There are several ways to check if device was programmed correctly:

- click the Verify button on the main toolbar, or

- double click on the Verify function line in the Function list of the Program Manager/ 08 window,
or

- select the Verify function line in the Function list of the Program Manager /13 window and click
the Execute button, or

- select the Commands > Verify menu command.

Wait for the message Verifying ... OK in the Program Manager/[103 window or for a warning
message if the device verification has failed.

8.1.6 How to save data to disc

1. After you have read device content into the Buffer[ 17 or specified Buffer layer[ 171 you may want to
save the data to a PC hard drive or other media. To save the data:
a) Click the Save button on the local toolbar of the Buffer window, or
b) Select menu command File > Save.

2. In the pop-up dialog enter destination file path and name, format, start and end addresses in the
buffer, source sub-level, then click OK.

8.1.7 Multi-Target Programming

Multi-target device programming

In production environments, maximum programming efficiency is an important goal. It is possible to
organize several CPI2-Gx programmers into multiple virtual programmer clusters in order to achieve
concurrent parallel programming that takes the least amount of time to accomplish. Consider the
following example.:

- A panel has four identical boards;
- Each board carries three devices of different types;
- Each device should be written with its own file.

Then you will need CPI2-Gx device programmers with twelve CP12-GM1 modules altogether. An
optimal configuration can be formed by a couple of cascaded CPI2-06/12V1 programmers with 6
modules in each. Each module inside of a CPI2-Gx programmer has a unique serial number that can
be specified in the command line[:211in two different ways. If each motherboard carries 6 modules then
each module can be specified as a combination of the module order number and the motherboard serial number.
For example, #5@VM2-00012 is a fifth module set on the motherboard VM2-00012. A typical scenario of use:
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1. Prepare a matrix of the module serial numbers assigned to programming a particular target board
and a particular device on each board. For example for the programmers with motherboards' serial
numbers VM2-00011 and VM2-00012 the module distribution could look like:

|Device #1 (Project 1) Device #2 (Project 2) |Device #3 (Project 3)
Board #1 #1@VM2-00011 #2@VM2-00011 #3@VM2-00011
Board #2 H#HA@VM2-00011 #5@VM2-00011 #6@VM2-00011
Board #3 #1@VM2-00012 #2@VM2-00012 1#3@VM2-00012
Board #4 H#A4@VM2-00012 #5@VM2-00012 #6@VM2-00012

2. Connect the programmers to a computer's USB or LAN ports directly or through a USB hub or a
LAN switch.

3. Make tree programming projects| +71 - one for each target device. Save their .upp files that includes
device types, file names and other options. It is supposed that you have preliminary debugged these
projects on a CPI2-Gx programmer working in a single-programming mode.

4. Launch three copies of the ChipProg-02 program in the gang mode. In the command line of the
startupl 42 dialog specify serial numbers of the programming modules in accordance to the matrix
above - four numbers per a project. The program itself will "connect" appropriate modules to
appropriate USB or LAN ports and to appropriate target devices and load appropriate files to
appropriate buffers.

5. Then place the first panel into the fixture and start device programming either by the ATE signall 291
or manually by executing the Auto Programming[ 108 command in the GUIl 4. Then replace target
panels upon successful programming of all 12 devices.

8.2 Error Messages
8.2.1 Error Load/ Save File
5005 "Error reading file"
5004 "CRC mismatch, loading terminated"
5003 “Invalid .HEX file format"
5043 "Address out of range"
5078 "End address should be greater than start address"
5151 “Invalid file format"
5007 "Error writing file"
6899 "Cannot load file '%s": buffer #%u does not exist"
6900 "Cannot load file '%s": sub-level #%u does not exist"

7019 "Unable to open project file: '%s'.\n\nAfter start, the programmer attempts to load the most recent project.
This error means that the project file does not exist on disk."
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8.2.2 Error Addresses

5189 "Device start address (0x%LX) is too large.\nMax. address is 0x%LX"
5190 "Device end address (0x%LX) is too large.\nMax. address is Ox%LX."
5191 "Buffer start address is too large"

4024 "Address %s is out of range (%s...%s)"

4106 "File format does not allow addresses larger than OXFFFFFFFF"

4019 "Address in device: 0x%08X, Address in buffer: 0x%08X\n"

6626 "Buffer start address must be even"

6627 "Device start address must be even"

6628 "Buffer end address must be odd"

8002 "Buffer named '%s' already exists. Please choose another name for the buffer."

8.2.3 Error sizes

6372 "Buffer size is too small for selected split data option"

6495 "Requested buffer size (%lu) is too large"

6441 "Size of file is greater than buffer size:\nAddr = %08IX, length = %u"
6431 "Source block does not fit into destination sub-level"

6859 "File size is %u bytes that is less than header size (%u bytes), loading terminated. Probably, you have
specified an invalid file format."

4107 "Cannot allocate %Lu MBytes for the buffer, maximal buffer size is %Lu MBytes"

5192 ‘"Invalid number: '%s"

8.2.4 Error command-line option

5329 "/%s command-line option: Device name required"”
5330 "/%s command-line option: Missing file name"
5331 "/%s command-line option: Missing file format tag"
5332 "/%s command-line option: Invalid file format tag"
5333 "Command line: unable to determine the file format"
5334 "/%s command-line option: Invalid address value"

4104 "Command-line option /I ignored because /A option is not specified"
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8.2.5 Error Programming option
6409 "Invalid programming function or menu name:\n'%s"
6410 "Invalid programming option name '%s"
6902 "Invalid '%s' programming option value string: '%s"
6411 "Programming option '%s' cannot be changed"
6412 "Programming option string is too long.\nMax. length is %u."
6854 "Programming option '%s' has type of '%s'. Use '%s()' script function to get the value of this option."
5188 "Value %.2fis out of range of %.2f...%.2f for programming option '%s"

6561 "Value %ld is out of range of %Id...%Id for programming option '%s"

4001 "Not all of the saved auto-programming functions were restored. Check the auto-programming functions list."

8.2.6 Error DLL

6499 "Cannot find bit resource with id 0x%Xin DLL:\n'%s™
6500 "Error handling bit resource with id 0x%Xin DLL:\n'%s"

6502 "Unable to find device '%s' in DLL:\n'%s™

8.2.7 Error USB

4015 "USB device driver error 0x%04X in '%s'.\n\nCannot recowver from this error, exiting.\n\nPlease check if the
programmer power is on. If yes, disconnect the USB cable from computer and connect it again, then restart the %s
shell."

4016 "All sites reported USB device driver error.\n\nCannot recowver from this error, exiting.\n\nPlease check if the
programmer(s) power is on. If yes, disconnect the USB cable from computer and connect it again, then restart the
%s shell."

4017 "The following site(s):\n\n%s\n\nreported USB device driver error.\n\nThese site(s) will be removed from the

gang programming process.\n\nPlease check if the programmer(s) power is on. If yes, disconnect the USB cable
from computer and connect it again, then restart the %s shell."

8.2.8 Error programmer hardware

6546 "Source area does not fit into destination address space”
4005 "Attempt to read memory beyond buffer end: Addr = %s, len = %u bytes"
6988 "Unable to establish connection with programmer hardware. Please check if:\n\n"

4006 "Attached programmers have duplicate serial number ‘%s

4010 "This programmer with serial number '%s' has been already assigned the site number = %u"
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4011 "This gang programmer with serial number '%s' has been already assigned the site numbers = %u..%u"
4013 "The programmers attached are of different types and cannot be used for gang mode.\n\nExiting."

4014 "ExecFunction() does not work in Gang mode"

4020 "%s reported hardware error 0x%X, error group 0x%X. If problem persists, please contact Phyton."
4000 "The attached programmer with id = %u is not supported”

4102 "Device programming countdown value is zero%s"

8.2.9 Errorinternal

6527 "Internal error:\nCORE() for %s %s returned NULL.\nPlease contact your %s distributor.”

4025 ‘"Internal Error: Unable to allocate %u bytes for the buffer. Please contact Phyton."

8.2.10 Error confiquration

6503 "No programmer configuration files found (prog.ini)"
5325 "The device type '%s %s' stored in configuration "
"or choosen from script file function 'SetDevice()' is not supported by %s.\n"
"The device '%s %s' will be selected.\n"
"Use 'Configure / Select device' to choose the device "
"you need to operate on."

4002 "The '%s' configuration option has been set to an illegal state due to the data read from file. Setting this
option to its default state ('%s")."

8.2.11 Error device

5326 "Device selection error"

4018 "Device '%s'is not supported by the %s. Please choose another device."

8.2.12 Error check box

6852 "Error in check box option specification string: '=' expected"

6853 "Cannot find check box option string '%s™

8.2.13 Error mix

5195 " Number of repetitions cannot be zero"
5206 "The 'View only' option is on; editing disabled. Click the 'View' button on toolbar to enable editing."
6501 "No power-on tests defined in:\\n'%s"

6903 "%s'is a sub-menu name, not a function name"
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6401 "No more occurences”
6387 "Invalid fill string"
5172 "Checksum = %08IX"

5311 "No more mismatches"

8.2.14 Warning

5338 "Warning: JEDEC file has no file CRC"
5339 "Warning: JEDEC file has invalid CRC"
6933 "Warning: no ‘file end' record in file"

6845 "Attention! The %s %s device must be inserted into the programmer's socket shifted by %d row(s) relative to
the standard position as shown in the Device Information window."

6846 "Attention! Insert device into socket shifted by %d row(s) as shown on the picture."

8.3 Expressions

Expressions are mathematical constructs for operations| 2031 on one or more operands 208

When a number is required, you may use an expression; ChipProg-02 will accept the value expression. For
example, when using the Modify command in the Buffer window, you can enter the new value in the form of a
number or arithmetic expression.

Interpreting the expression result
The expression result is interpreted in accordance with the context in which it is used.

In the dialog box, when an address is required, the program tries to interpret the expression’s value as the
address. If you enter a variable name, the result of the expression will be the variable’s address but not the value
of the variable.

If the dialog expects a number to be entered, the expression’s value will be interpreted as a number (for
example, the Modify Memory dialog box of the Buffer Dump window). If you enter a variable name there, then
the result will be the value of the variable, but not its address.

Nonetheless, you can follow the default rules:

If you need to use the variable’s value, where an address is expected, then you can write something like var
+ 0. Inthis case, the variable’s value will be used in the expression.

If you need to use the variable address, apply the & (address) operation, that is, &var .

8.3.1 Operations

The program supports all arithmetic and logical operations valid for the C language, as well as pointer and
address operations:

Designation Description
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()
[ ]

&
(type)

(sizeof)

<<

>>

Brackets (higher priority)

Array component selector

Structure component or union selector

Selection of a structure component or a union addressed with a pointer

Logical negation

Bitwise inversion
Bitwise sign change
Returns address
Access by address

Explicit type conversion

(returns size of operand, in bytes)

Multiplication

Division

Modulus operator (produces the remainder of an integer division)

Addition

Subtraction

Left shift

Right shift

Less than

Less than or equal to
Greater than

Greater than or equal to
Equal to

Not equal to

Bitwise AND

Bitwise XOR
Bitwise OR
Logical AND
Logical OR

Assignment

© 2021 Phyton, Inc. Microsystems and Development Tools



Reference 205

The types of operands are converted in accordance with the ANSI standard.
The results of logical operations are 0 (false) or 1 (true).

Allowed type conwersions:
e Operands can be conwerted to simple types (char, int, ... float).
¢ Pointers can be converted to simple types (char *, int *, ... float *) and to structures or unions.
e The word "struct" is not necessarily (MyStruct *).

8.3.2 Operands

By default, numbers are treated as decimals. Integers should fit into 32 bits; floating point numbers should fit
into the single precision format (32 bits).

The following formats are supported:
1) Decimal integer.
Example: 126889
2) Decimal floating point.
Examples: 365. 678; 2. 12e-9
3) Hexadecimal.
<%CM%> understands numbers in C format and assembly format.
Examples: 0xF6D7; OF6D7H; OXFFFF1111
4) Binary.
Binary numbers must end with 'B'".
Examples: 011101B; 111111111111111000011B
5) Symbol (ASCII).
Examples: 'a' ;"' ab' ;' $B¥8' ." .

8.3.3 Expression Examples

#test#i + #estHj << 2
(unsigned char)#test#i + 2
sizeof(##array) > 200

main
i+j<<2/:CWO0x1200
(unsigned char)i + 2
sizeof(array) > 200
(a==b&&a<=4)||a>"'3
sptr -> Memberl -> ai]

*P

*((char *)ptr)
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8.4

Scripting Reference

Description of Script Language[20]

Script Language Built-in Functions[23)

Script Lanquage Built-in Variables |29

Alphabetical List of Script Language Built-in Functions and Variables[ 257

8.4.1 Scripting Language Description

8.4.1.1

ChipProg-02 scripting language is similar to C programming language. If you are familiar with C, you can
proceed to the section describing the differences between the script language and the C Ianguagemé’l.

Here are the links to the sections of this scripting language manual.

General Syntax of Script Language[ 20
Basic Data Types| 21

Data byte order[z1h
rations and Expressions|218)

OQeratorslzh

Functions| 228

Descriptions[ 228

Directives of the Script File Language Preprocessorlz_sh
Predefined Symbols in the Script File Compilationlzﬂ

Difference Between Scripting and C Languages

The script files are written in a C-type language and you should not expect it to meet standards. Many features
are not supported because they are not necessary and complication of the language can cause compiler errors
(the script file language compiler is not a simple thing).

Pointers are not directly supported. But arrays are supported, therefore a pointer can always be built from
an array and element number. Note that, for example, string operation functions, such as strcpylaﬁ, receive a
string and a byte number (index) as parameters, which form the pointer. In function declarations, index is equal
to zero by default.

Pointers to functions are not supported. If necessary, a table call can always be replaced with the switch
operator.

Multidimensional arrays are not supported. If it is necessary, you can write a couple of functions, such as:

int GetElement(int array[], int indexl, int index2);
void SetElenent(int array[], int indexl, int index2, int value);

Structures (and unions) are not supported. In fact, you can always do without structures. Structures may
be required for AP1 Windows and user DLLs operations, but as a rule only experienced programmers should do
it, such as those who know how to reach structure elements. As a tip, there are functions, such as
memcpyla, which receive a wid "pointer").

Enumerated types (enum) are not supported #define.

Preprocessor macros, such as #define half(x) (x / 2), are not supported. The same operations can be
done with functions.

Conditional operators such as x =y == 2? 3: 4;, are not supported; the operator "comma" outside
variable declaration is not supported. For example,

int i =0, j =1; is supported, but
for (i =0, j =1; ...) is not supported.

User functions with a variable amount of parameters are not supported. However, there are many system
functions, such as m@, with a variable number of parameters.
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- Declaration of user function parameters such as void array[] is not supported. The system functions
such as memcpy[31), have such parameters.
- Logical expressions are always fully computed. It is very important to remember it, as a situation like

char array[10];
if (i <10 & array[i] !'= 0)
array[i] = 1;
will cause an error at the execution stage, if i is greater than 9, because the expression of array[i] will be

computed. In a standard compiler such an expression is not computed, because the condition of i > 10 would
cancel any further processing of the expression.

- Constant expressions are always computed during execution. For example, inti = 10 * 22 will be
computed not during compilation, but during execution.

- The const key word is absent.

- Static variables cannot be declared inside functions.

But

- Variables can be declared anywhere, not just in front of the first executed operator. For example:
voi d main()
{
d obal Var = 0;
int i =1, Il will be OK as in C++
}

- Nested comments are allowed.

- Expressions like array = "1234" are allowed.

Default parameter values in declared functions, as in C++, are allowed. For example, void func(char
array[],int index = 0);. Expressions can also sene as default values, for example void func(char array[], int
index = funcl() + 1);.

- Expressions in global variable initializers are allowed. For example:

float table[] = { sin(0), sin(0.1) };

voi d main()

{

}
8.4.1.2 Scripting Language Syntax

Format[ 200

Comments| 207
Identifiers| 208

Resened words| 208
Integer Constants| 208
Long integer constants| 209

Floating-point Constants| 208
Character Constants[ 218

String Constants[ 218
8.4.1.2.1 Format

Spaces, tabs, line advance and page advance symbols are used as separators. You can use any number of
these separator symbols.

8.4.1.2.2 Comments

Comments begin with the pair of the /* symbols and end with the pair of the */ symbols.

Comments are allowed wherever the spaces are allowed.
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The one-line comments (/) are supported. The part of the line following the one-line comment symbol is

ignored.

Note. Only the one-line comments are allowed in the line that contains the #define directive.

Examples:
// The one-line comment

/* The nmulti-line comment */

8.4.1.2.3 Identifiers

Identifiers are used as the names of variables, functions and data types.

The allowable symbols are: digits from 0 to 9, the Latin lower and upper case letters a - z, A - Z and the

underscore symbol ().

A special case is accessing the names built in <%CM%>,
names are preceded by the dollar mark, for example, $SP,
declared. Identifiers shall comply with the following rules:

The first symbol can not be a digit.
The upper and lower case letters are discriminated.
An identifier can consist of up to 48 symbols.

Examples:

NAMEL namel Total _5

8.4.1.2.4 Reserved words

break extern return
case float  short
char for sizeof
continue  goto switch
default  if unsigned
do int void

else long  while

8.4.1.25 Integer constants

Decimal constants

Numbers from 0 to 9.
Examples:

12
111
956

for example, a special function register. Such
and can be used in the program while not being
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1007
Hexadecimal constants

Numbers from O to 9; letters a-f or A-F for the values of 10 to 15. The hexadecimal contents shall begin with

0x or OX.

Examples:
0x12 = 18 (decimal);
0x2f = 47 (decimal);

OxA = 10 (decimal);
Binary constants

Numbers 0 and 1. The binary constants shall end in b or B.

Examples:
010011101b = 0x9D (hexadeci mal) = 157 (deci mal);
0101B = 5

Note. If the value exceeds 65535, then it will be presented as the long integer.

8.4.1.2.6 Long integer constants

Latin letter | or L following the constant explicitly defines long integer constants. The explicit definition of a
long constant is useful, for example, for transforming the type of operand into the long type value.

Examples:
Long deci mal constant: 121 12 (decimal)
956L 956 (deci mal)
Long hexadeci mal constant: 0x12l 18 (decimal)
OxA3L 163 (decinmal)

8.4.1.2.7 Floating-point constants

A floating-point constant consists of the following parts:

- Integer part, which is the sequence of numbers
- Decimal point
- Fractional part, which is the sequence of numbers
- Exponential symbol e or E
- Exponential in the form of an integer constant (can have sign)
Any of the two parts (but not both at the same time) of the following pairs can be omitted:
- Integer or fractional part
- Decimal point or symbol e (E) and the exponential in the form of an integer constant
Examples:
345. = 345 (decimal);
3.14159 = 3.14159 (decimal);
2. 1E5 = 210000 (decinal);
. 123E3 = 123 (decinal);
4037e-5 = . 04037 (decinal).

© 2021 Phyton, Inc. Microsystems and Development Tools



210 CPI2-Gx Device Programmers - CPI12-Gx

8.4.1.2.8 Character constants

A character constant may consist of one ASCII code character enclosed within the apostrophes. Also, you
may specify the character by its hexadecimal value of exactly two hexadecimal digits preceded by characters
X',

Examples:
'‘A'a' 7 '$ '\x02' '\x88'

Special (control) character constants

New |ine (line feed) HL (LF) “\'n'
Hori zontal tabul ation HT "\t
Vertical tabulation VT "\v'
Backspaci ng BS "\'b'
Carriage return CR "\r!
Form f eed FF "\
Backsl ash \ A
Apost r ophe ' A
Quot ati on nmarks " A
Zero character (null) NUL "\ O

Note. The character constants are considered to be the int-type data.

8.4.1.2.9 String constants

A string constant is the quoted sequence of the ASCII code characters: "...".
A string constant is the quoted character array; its type is charf].
To mark the end of string, the compiler places the null symbol "\0' in the end of each string.

If you need to include the quotation mark (") in a string, then enter the backslash (\) before the quotation
mark. Any special character constants preceded by the backslash (\) can be included in the string.

A symbol can also be presented by its hexadecimal value (exactly two hexadecimal digits) preceded by the
symbols of \x'.

The string constants following in sequence are interpreted as one string constant. This is useful for the
advance of the constant part to the next line, for example:

printf("Line 1\n"
"Line 2");

Examples:

"This is the character string"
" A
"1234567890\ x33"

8.4.1.3 Basic Data Types

The script file compiler supports the following data types:

signed char 8 1 -128...+127
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unsigned char 8 1 0...255
signed short 16 2  -32768...+32767
unsigned short 16 2  0...65535

signed int 16 2  -32768...+32767

unsigned int 16 2 0...65535

signed long 32 4 -2147483648...2147483647

unsigned long 32 4 0...4294967295

float 32 4 +/-1.17549435E-38...+/-3.40282347E+38

The "pure" int type coincides with the signed int type.
The long type is equivalent to the signed long.

The short type is equivalent to the signed short.

The char type is equivalent to the signed char.

8.4.1.4 Databyte order

Data byte order

All many-byte data is stored in the memory in the "little engine” format, that is, the low byte is
allocated at the low address and the high byte is allocated at the high address in accordance with
the 80x86 processor architecture. For experienced programmers, it is useful to know this, if they
want to use Windows APl and DLL functions access

8.4.1.5 Operations and Expressions

Expressions
An expression consists of one or more operands and operation symbols.
Examples:
at++
b=10
x=({y*2z2)/w
Note. Any expression ending with semi is the operator.
Operand Metadesignation| 2:2)

Arithmetic Operations|2:2

Assignment Operations|[2:3

Relation Operations| 2

Logical Operations[2:3)

Bit Operations|[ 217
Array Operations| 210

Other Operations| 28

Operation Execution Priorities and Order[ 213

Operand Execution Order[220)

Arithmetic Conversions in Expressions

© 2021 Phyton, Inc. Microsystems and Development Tools


http://www.helpandmanual.com/order.html?c=%20%2C%A9%20%32%30%30%37%20%45%6E%74%65%72%20%79%6F%75%72%20%63%6F%6D%70%61%6E%79%20%6E%61%6D%65%2C%4C%65%6E%61%40%45%45%4C%45%4E%41%2C%43%3A%5C%54%65%63%68%57%72%69%74%65%72%5C%48%26%4D%5F%50%72%6F%6A%65%63%74%73%5C%43%4D%2D%41%52%4D%5C%45%4E%47%5C%63%6D%2D%61%72%6D%2E%68%6D%78

212

CPI2-Gx Device Programmers - CPI12-Gx

8.4.1.5.1 Operand Metadesignation

Some operations require specific operand types. The type of operand is indicated by one of the
following letters:

e - any expression

Vv - any expression referring to the variable, to which a value

can be assigned. Such expressions are called the address ones.

The prefix indicates the type of expression. For example, ie indicates any integer expression. All
the possible prefixes are as follows:

[
a - the arithmetic expression (the integer number, symbol or
floating-point number)

f - the function

Note.

8.4.1.5.2 Arithmetic Operations

+ Usage: ael + ae?

Sum of ael and ae2.
Example:

i=j+2;

Sets i equal to j plus 2.
Usage: ael - ae2
Subtraction of ael and ae2.
Example:

i=j-3
Usage: -ae

Example:

Usage: ael * ae2
Product of ael and ae2.
Example:

z=3%*X
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Quotient of ael and ae2.
Example:
i=j/5;
% Usage: ael % ae2
Remainder (modulus division) of the division of ael by ae2.
Example:

minutes = time % 60;

Note. Execution of the ++ and -- operations produces side effects; the value of variable used as
an operand changes.

++ Usage: iv++
Increasing iv by 1. The value of this expression is the value of ie
before increasing.
Example:
j= i+
++ Usage: ++iv
Increasing iv by 1. The value of this expression is the value of ie
after increasing.
Example:
i = ++j;
-- Usage: iv--
Decreasing iv by 1. The value of this expression is the value of ie
before decreasing.
Example:
j=i-
-- Usage: --iv
Decreasing iv by 1. The value of this expression is the value of ie
after decreasing.

Example:

=

8.4.1.5.3 Assignment Operations

Note. The value of expression containing the assignment operation is the value of the left operand
after the assignment.
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= Usage:v=¢e
The value of e is assigned to variable v.
Example:
X=Y,;

Note. The following operations combine arithmetic or bit-by-bit operations with the assignment
operation.

+= Usage: av += ae
Increasing av by ae.
Example:

y+= 2;

-= Usage: av -= ae
Decreasing av by ae.
Example:

X-=3;

*= Usage: av *= ae
Multiplication of av by ae.
Example:

timesx *= x;

/= Usage: av /= ae
Division of av by ae.
Example:

X /= 2;

%= Usage: iv %= ie
The value of ivin modulus ie.
Example:

X %= 10;

>>= Usage: iv >>= ie
The right ie bit shift of the iv binary form.
Example:

X>>=4;

Usage: iv <<= ie

The left ie bit shift of the iv binary form.

Example:
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X <<=1;
&= Usage: iv &= ie
The bit-by-bit AND operation of the iv and ie binary forms.
Example:
remitems &= mask;
= Usage: iv =ie
The bit-by-bit exclusive OR operation of the iv and ie binary forms.
Example:
control "= seton;
|= Usage: iv |=ie
The bit-by-bit OR operation of the iv and ie binary forms.
Example:

additems |= mask;

8.4.1.5.4 Relation Operations

Note. Logical False is presented by integral zero, and logical True is presented by any integer
other than zero.

The expressions that contain the relation operations or logical operations have the values of 0
(False) or 1 (True).

== Usage: iel == ie2
True, if iel is equal to ie2; False otherwise.
Example:
if (i == 0) break;
I= Usage: iel !=ie2
True, if iel is not equal to ie2.
Example:
while (i 1= 0)
i = func;
< Usage: ael < ae?
True, if ael is less than ae2.
Example:
if (x < 0)
printf ("negative");
<= Usage: ael <= ae2
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True, if ael is less than or equal to ae2.
Usage: ael > ae?
True, if ael is larger than ae2.
Example:
if (x> 0)
printf ("positive");
>= Usage: ael >= ae2

True, if ael is larger than or equal to ae2.

8.4.1.5.5 Logical Operations

I Usage: lae
True, if ae or pe is false.
Example:
if ("good)
printf ("not good");
|| Usage: el | e2

checked. The value of e2 will be checked only, if el is False. The expression will be
True, if el or e2 is True.
Example:
if(x < A || x > B) printf
("out of range™);
&&
Logical AND operation of el and e2. At first, the value of el
is checked. The value of e2 will be checked only, if el is True.
The expression will be True, if el and e2 are True.
Example:
if@!=08&&b>7)

n++;
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8.4.1.5.6 Array Operations

[ Usage: nameJie]
The expression value is the number equal to the value of the element
number ie of the name array. The array elements are numbered beginning from 0.
Example:
arnamel[i] = 3;
To assign 3 to the array element i.
Note the first element as described by the expression of
arname[0].

8.4.1.5.7 Bit Operations

~ Usage: ~ie
One's complement of the value ie. The expression value contains ones in
all those bits, in which ie contains 0, and contains 0 in all
those bits, in which ie contains ones.
Example:
opposite = ~mask;
>> Usage: iel >> je2
The right ie2 shift of the iel binary form.
The shift may be arithmetic (that is, the bits cleared from the left
assume the value of the sign bit) for the signed numbers and
logical for the unsigned numbers (the bits cleared from the left are
filled with zeroes).
Example:
X=X>>3;
<< Usage: iel << ie2
The left ie2 bit left of the ie2 binary form.
The bits cleared from the right are filled with zeroes.
Example:
fourx = x << 2;
& Usage: iel & ie2
The bit-wise AND operation of the iel and ie2 binary forms. The expression
value assumes 1 in all those bits, in which both iel and ie2 contain

1, and assumes 0 in all other bits.
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flag = ((x & mask) != 0);
| Usage:iel|ie2
The bit-wise OR operation of the iel and ie2 binary forms. The expression
value assumes 1 in all those bits, in which either iel or ie2 contain
1, and assumes 0 in all other bits.
Example:
attrsum = attrl | attr2;
N Usage: iel Mie2
The bit-wise exclusive OR operation of the iel and ie2 binary forms.
The expression value contains 1 in all those bits, in which iel and
ie2 contain different binary values, and the expression value
contains 0 in all other bits.
Example:

diffbits = x My;

8.4.1.5.8 Other Operations

sizeof Usage: sizeof(e)
The number of bytes required for allocation of e-type data. If e
describes the array, then e means the whole array, and not only the
address of the first element, as in other operations.
(type) Usage: (type)e
The value of e is converted into the data type.
Example:
x = (float)n/ 3;
The integer value of the variable n is transformed into

the floating-point number before dividing by 3.
() Usage: fe(el, e2,..., eN)

The fe function is called with the arguments el, e2,..., eN.

order from

Example:
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X = sqrt(y);

8.4.1.5.9 Operation Execution Priorities and Order

Priorities are the same for each group of operations listed in the table below. The higher the
priority of operation, the higher is its place in the table.

If there are no brackets and the operations are related to the same group, then the order of
execution determines the operation and operand grouping (from left to right or from right to left).

Examples

The expression of a * b / ¢ is equivalent to the expression of (a* b) / c,
as the operations are executed from left to right.

The expression of a = b = ¢ is equivalent to the expression of a = (b = ¢),
as the operation is executed from right to left.

[l Array element selection
I Logical negation From right to left (RL)

~ Bit-by-bit negation

- Sign change

++ Increasing by one
-- Decreasing by one
(type) Type conversion

sizeof Determining of size in bytes
*  Multiplication LR

/ Division

% Modulus division

+ Addition LR

- Subtraction

<< Left shift LR
Right shift

< Lessthan LR

<= Less than or equal to
> Larger than

>= Larger than or equal to
== Equal to LR

I= Not equal to
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& Bit-by-bit AND operation LR

A Bit-by-bit exclusive OR operation LR
| Bit-by-bit OR operation LR

&& Logical AND operation LR
|| Logical OR operation LR

*= [= Op= += =

<<= >>= &= = |=

8.4.1.5.10 Operand Execution Order

The operands are normally executed from left to right.

. If you assign a value to a variable in any expression (including the function call), do not use this
variable again in the same expression.

Example:
Y= (x=5) + (++x);

8.4.1.5.11 Arithmetic Conversions in Expressions

First, every char-type operand is converted into the int-type value, and the unsigned char-type
operand is converted into the unsigned int-type value.

Then, if one of the operands is of the float type, then the other will be converted into the float-type
value and the result will be of the float type.

Otherwise, if one of the operands is of the unsigned long type, then the other will be converted into
the unsigned long-type value and the result will be of the same type.

Otherwise, if one of the operands is of the long type, then the other will be converted into the long-
type value and the result will be of the same type.

Otherwise, if one of the operands is of the long type, and the other is of the unsigned int type, then
both operands will be converted into the unsigned long-type value and the result will be of the
same type.

Otherwise, if one of the operands is of the unsigned type, then the other will be converted into the
unsigned-type value and the result will be of the same type.

Otherwise, both operands should be of int type and the result will be of the same type.
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8.4.1.6 Operators

Format and nesting[221)

Operator label[ 21
Composite operator| 220

Operator-expression[ 223

Operator Break| 223
Operator Continue[22)

Operator Return| 223

Operator Goto| 224
Conditional Operator If-Else[223)

Cycle Operator While[223)
Cycle Operator Do-While[223)

Cycle Operator For[ 224

8.4.1.6.1 Formatand nesting

Format and nesting

Format. One operand can occupy one or more lines. Two or more operands can be located in
one line.

Nesting. The execution control operators (if, if-else, switch, while, do-while and for) can be nested
in each other.

8.4.1.6.2 Operator label

Operator label

The label can be placed before any operator, which makes it possible to go to this operator with
the help of the "goto" operator.

A label consists of an identifier followed by the colon (:). The definition domain of the label is the
specified function.

Example:
next: x = 3;

8.4.1.6.3 Composite operator

Composite operator

The composite operator (block) consists of one or more operators of any type enclosed in the
brackets ({}).
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There shall be no semicolon (;) behind the closing bracket.

Example:
{
x=1;
y=2
=3;
}

8.4.1.6.4 Operator-expression

Any expression, which ends with the semicolon (;), is the operator. Refer to the following examples of
operators-expressions.

Assi gnment oper at or
Identifier = expression;

Example:
X = 3;
Function call operator
Function_name (argunentl,..., argunentN);
Example:

fclose(file);

Enpty operat or
Consists only of semicolon (;).
It is used to identify the enpty body of the control operator.

8.4.1.6.5 Operator Break

Syntax:
break;

Stops execution of the nearest nested external operator switch, while, do, or for. Control is
transferred to the operator following the operator being completed. One purpose of this operator is
to complete the cycle, when specific value is assigned to the variable.

Example:
for (i=0;i<n;i++)
if (a[i] == 0)

break;
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8.4.1.6.6 Operator Continue

Syntax:

continue;

223

Transfers control to the beginning of the nearest external operator of the cycle while, do, or for,
which starts the next iteration. This effects produced by this operator are opposite to those of the

break operator.
Example:
for (i=0;i<n;i++)
{
if (a[i] == 0) continue;
afi] = bfif;
}

8.4.1.6.7 Operator Return

Syntax:

return;

Stops execution of the current function and returns control to the function that called it.
expression return;

Stops execution of the current function and returns control to the program that called it, together

with the expression value.
Example:
return x +y;

8.4.1.6.8 Operator Goto

Syntax:

goto | abel;

Control is unconditionally transferred to the operator with the label "label". It is used to exit from the nested

control operators. The scope of the label is limited within the current function.
Example:

got o next;

8.4.1.6.9 Conditional Operator I-Else

Syntax:
if (expression)

operator
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If the expression is True, then the operator will be executed. If the expression is False, then
nothing will happen.

Example:

if (@==Xx) temp=3;

if (expression)
operatorl

else

operator2

If the expression is True, then operatorl will be executed and control will be transferred to the
operator following operator2 (which means that operator2 will not be executed).

If the expression is False, then operator2 will be executed.

The "else" part of the operator can be omitted. That is why ambiguity may arise in the nested
operators with omitted "else" part. In this case, else is related to the nearest preceding operator in
the same block that does not have the "else" part.

Examples:
1) The "else" part relates to the second if operator:

if(x > 1)
if (y ==2)
z=5;
else
Z=06;
2) The "else" relates to the first if operator:
if (x> 1)
{
if (y==2)z=5;
}
elsez = 6;

3) The nested if operators:
if(x=="a)y=1;
else

if (x=="b")

{
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if(x=="c)y=4;
else

printf("ERROR")

8.4.1.6.10 Cycle Operator While

Syntax:

while (expression)

operator

If the expression is True, then the operator will be executed until the expression becomes False.
If the expression is False, then control is passed to the next operator.

Note. The value of the expression is determined before executing the operator. Therefore, if the
expression is False from the very beginning, then the operator will not be executed at all.

Example:
while (k < n)

{
y*=x
k++;

}

8.4.1.6.11 Cycle Operator Do-While

Syntax

do
oper at or
whi |l e (expression);

If the expression is True, then the operator will be executed and the expression value will be
calculated. This will be repeated until the expression becomes False.

If the expression is False, then control is passed to the next operator.

Note. The expression value is determined after the operator is executed. Therefore, the operator is
executed at least once.

The do-while operator checks the condition in the end of the cycle.
The while operator checks the condition in the beginning of the cycle.
Example:
x=1;
do

printf('%d\n", pow(x, 2));

while (++x <= 7);
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8.4.1.6.12 Cycle Operator For

Syntax:
for (expressionl; expression2; expression3)

operator

Expressionl describes the cycle initialization. Expression2 is checking the condition of the cycle
completion. If it is True, then:

the "for" operator of the cycle body will be executed,;
expression3 will be executed.
Everything will be repeated until expression2 becomes False.
If it is False, then the cycle will be finished and control will be passed to the next operator.
Expression3 is calculated after each iteration.
The "for" operator is equivalent to the following operator sequence:
expressionl;
while (expression2)
{
operator

expression3;

Example:
for(x = 1; x <= 7; x++)
printf("%d\n", pow(x, 2));

In any of the three expressions, or in all three expressions of the operator, "for" may be absent, but
the semicolons (;) separating them cannot be omitted.

If expression2 is omitted, then it will be considered True. The "for" operator (;;) is the endless
cycle equivalent to the While(1) operator.

8.4.1.7 Functions

Function Definition[228)

Function Calll 221
Function Main[zzh

8.4.1.7.1 Function Definition

Functions are defined by description of the type of result, formal parameters and composite operator (block) that
describe the actions carried out by the function.

Example:
i nt the type of result
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func( function nane
long a, char str[] list of paraneters, which describes the nanmes and
types
)
{ conposi te operator
/1
return O; returned val ue

}

The return operator can not return any value or return the value of the expression included in this operator.
The function, which does not return a value, shall be described as having type wvoid.

One or several last parameters on the list can assume the default values. Examples:

int func(int x, int y = 0);

int fi(char s[], char s1[] = "null", int x = func(0));
voi d errmesg(char s[])
{

printf{"***Error: %", s);

/1l the Return operator (explicit) is not required
}

8.4.1.7.2 Function Call

Syntax of a function call is as follows:
function_nane(el, e2, ..., eN)

Arguments that are not arrays (actual parameters) are transferred by value, that is, each expression el, ..., eN
is calculated and the parameter is transferred to the function. Arrays are transferred "by pointer”, as shown in
the example:

void func(char s[])

{
}

voi d nmain()

{

s[0] = 2;

char array[ 3];
func(array);

}

The func function modifies the value of element0 of the "array" array declared in the main function, and not of its
duplicate.

Pointers to functions (like all other pointers) are not supported.

8.4.1.7.3 The main Function

The script file operation commonly starts with the main function. The main function shall be declared as
follows:

voi d main()

{
}

Note. The main function should not necessarily be included in a script file. If there is no main function, then
the script file will be loaded into the memory and stay there with its global functions and data available to other
script files.
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8.4.1.8 Descriptions
Descriptions are used for variable definitions and to declare types of variable and functions defined
elsewhere. Descriptions are also used for defining new data types on the basis of existing data types.
A description can be an operator, if an initialized variable or array are described.
Basic Types|[22)
Arrays|22)

Local Variable Definition[ 229
Global Variable Definition[2231

8.4.1.8.1 Basic Types

Examples:

char c;

intx = 0;
The basic types are:
char - character (one byte);
short - short integer (word, 16 bit);
int - integer (word, 16 bit);
unsigned - non-negative integer (of the same size as integer);
long - long integer (word or double word);
float - floating-point number (single precision);
void - no value (used to neutralize the value

returned by function)
The Short type is equivalent to the Int type and was introduced for generality.
Also, see Basic Datal210)

8.4.1.8.2 Arrays

Only one-dimensional arrays are supported.
Example:
int a[50];

Variable a is the array consisting of 50 integer numbers.
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8.4.1.8.3 Local Variable Definition

The automatic variable is temporary, because it loses its value upon the exit from the block. The
domain of the variable is the block, where it is defined. Variables defined inside the block take
precedence over the variables defined in the enclosing blocks. Example:

void func(char c)

{

inti=0;

if (c =="0"

{
chari=8;
i++;

}

i++;

}

The local variable can be described everywhere within the function, as in C++.
Values of non-initialized local variables are undefined.

The function formal parameters are processed the same way as local variables.
Static variables inside the function are not implemented.

8.4.1.8.4 Global Variable Definition

Global variables
Example:
int Global_flag;

Global variables are defined on the same level as functions, that is, they are not local in any block.
They are initialized with 0, unless other initial value is explicitly defined. The scope is all script files
currently being executed. Global variables should be described in all the script files that can
access them.

Static variables
Example:
static int File_flag;

Constant. The scope is the script file, in which the variable is defined. The static variables shall be
described before they are used in the file for the first time.

Variable Initialization[2:9)

External Object Description[ 23
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8.4.1.8.4.1 Variable Initialization

Any variable, except for formal parameters, can be initialized upon definition.
Any permanent variable is initialized with 0, unless other initial value is explicitly defined.
Any expression can be used as the initial value.
Basic types
Examples:
inti=1+j;
float x = sin(_P1/ 2);
Arrays
Examples:
int af] = {1,4,9,16,25,36};
chars[20]={'a’,'b", 8};
The values of array elements are listed in curly brackets.
If an array size is defined, then the values, which are not explicitly defined, will be equal to 0.
If an array size is omitted, then it will be determined by the amount of initial values.
Strings
Example:
char s[] = "hello";

This description is equivalent to the description of
char s[]={h';e"I''I''0',\0'};

8.4.1.8.4.2 External Object Description

Any type of external objects (for example, variables or functions) not defined explicitly in another
script file, should be described explicitly.

Use the keyword Extern hen describing an external object.
Examples:

extern int Global_var;

extern char *Name;

extern int func();
The length of external one-dimensional array can be omitted.
Example:

extern float Num_array(];

Because all functions are defined on the external level, the adjective extern is not needed to
describe a function inside the block and you can omit it.

© 2021 Phyton, Inc. Microsystems and Development Tools



Reference 231

8.4.1.9 Directives of the Script Language Preprocessor

If you use the # symbol as the first symbol in the program line, this line is the preprocessor
(microprocessor) command line.

The preprocessor command line ends with the line advance symbol.
Identifier Change (#define)[2s1)

Inclusion of Files (#include)[zs1

Conditional[ 233

8.4.1.9.1 I|dentifier Change (#define)

Syntax:
#define identifier line
Example:
#define Count 100
Changes each occurrence of the Count identifier in the program text to 100.
#undef identifier
Example:
#undef Count
Cancels any previous definition for the Count identifier.

8.4.1.9.2 Inclusion of Files (#include)

Note. You can put the #include command line everywhere in the program, but normally, all
inclusions are located in the beginning of the source file text.

Syntax:
#include <file_name>
Example:

#include <system.h>

The preprocessor changes this line to the contents of the system.h file. The angle brackets
indicate that the system.h file will be taken from the standard catalog. The directory, where CPI2-
Gx is installed, and the list of directories specified in the "include-file directory" field in the Script
Files dialog[ 173, are automatically used as the standard directory. If the file is not found in any of
the standard directories, then the current directory will be checked.

#include "file_name"
Example:
#include "defs.h"

This structure operates the same way as the #include <system.h>, except that the compiler
searches the current directory first.

© 2021 Phyton, Inc. Microsystems and Development Tools



232

CPI2-Gx Device Programmers - CPI12-Gx

8.4.1.9.3 Conditional Compilation

Preprocessor command lines are used for conditional compilation of various parts of the source
text depending on external conditions.

Syntax:
#ifdef identifier
Example:

#ifdef Debug

True, if the Debug identifier was defined earlier by the #define directive. Identifiers can also be
defined in the Defines text box in the Script Files dialog.[173)

Syntax:
#ifndef identifier
Example:

#ifndef Debug

Syntax:

#el se
#endi f

If all previous checks of #if, #ifdef, or #ifndef show the True value, then the lines from #else to
#endif will be ignored during compilation.

If those checks show the False value, then the lines from the check to #else (and if #else is
missing, then from the check to #endif) will be ignored.

The #endif command ends the conditional compilation.
Example:
#ifdef DEBUG printf("Location: x = %d", X); #endif

8.4.1.10 Predefined Symbols in the Script File Compilation

8.4.2

The compiler automatically defines these symbols, as if they were defined by the #define directive.
Symbols that define the microcontroller family

One of the following symbols is defined:

__ARM - for the ARM debuggers

- for the MCS-51 debuggers;

__MCS_96 - for the MCS-96 debuggers;
__PIC - for the Microchip PIC debuggers.

Built-in Functions by Group

The script file system provides you with a large set of built-in functions intended for work with lines, files, for
mathematical calculations, and access to the processor resources. The system.h file contains descriptions of
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these built-in functions. You should include the system.h file in the script file source text with the #include
directive:

#i ncl ude <system h>

You can use these built-in functions in the same way you use any function that you have defined.

Buffer access functions| 23

Device programming control functions[ 23
Mathematical Functions|24)

String Operation Functions| 247
Character Operation Functions| 2431

Functions for File and Directory Operation[ 24
Stream File Functions| 250

Formatted Input-Output Functions|25h)

Script File Manipulation Functions[2sh
Text Editor Functions[ 250

Control Functions[253)
Windows Operation Functions and Other System Functions[2sA

Graphical Output Functions[2sh
/O Stream[ 255 Window Operation Functions[ 253

Event Wait Functions|28)
Other Various Functions| 258

Note. To get help on a function or variable, while editing the script source with the <% CM%> built-in editor,
point that function/variable name with the cursor and hit Alt+F1.

8.4.2.1 Buffer access functions

LoadProgram| 23

ReloadProgram| 28
SaveDatal 23

SetDevice[ 230
MinAddr| 238
MaxAddr| 23]
GetByte| 230
GetWord|[23)
GetDword[ 24
SetByte[ 230
SetWord[ 238
SetDword[ 22N
GetMemory/[ 234
SetMemory| 238
CheckSum|[2:)

8.4.2.1.1 CheckSum

unsigned long CheckSum(unsigned long start_addr, unsigned long end_addr, int addr_space);

Description
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Calculates checksum for data in the addr_space memory{addr_sp} starting at start_addr and
ending at end_addr. Checksum is calculated by simple addition of byte values.

Return Value
32-bit checksum.
Example

printf("%08IX", CheckSum(0, OXx1FFF, SubLevel(1, 0)));

8.4.2.1.2 GetByte

unsigned int GetByte(unsigned long addr, int addr_space);

Description

To read a byte from a specified address space{addr_sp} (parameter addr_space) at a specified
address.

Returned value
Read byte or word.
Example

printf("%02X", GetByte(SubLevel(0, 0), Ox1F));

8.4.2.1.3 GetDword

unsigned long GetDword(unsigned long addr, int addr_space);

Description

To read a double word (32 bits) from a specified memory area{addr_sp} (parameter addr_space) at
a specified address.

Returned value
Read double word.
Example

printf("%08IX", GetDword(0, Ox1F));

8.4.2.1.4 GetMemory

void GetMemory(void dest[], int n, unsigned long addr, int addr_space);
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Description

To read n-byte memory block from a specified memory area{addr_sp} (parameter addr_space) at a
specified address to the array dest.

Example

char array[20]; GetMemory(array, sizeof(array), 0x20, SubLevel(0, 0));

8.4.2.1.5 GetWord

unsigned int GetWord(unsigned long addr, int addr_space);
Description

To read a word (16 bits) from a specified memory area{addr_sp} (parameter addr_space) at a
specified address.

Returned address
Read word.
Example

printf("%04X", GetWord(0, 0x1F));

8.4.2.1.6 LoadProgram

void LoadProgram(unsigned char file_name[], int format, int addr_space=AS_CODE, unsigned long
start_addr=0);

Description
To download a program in the buffer{buffer} memory.
Parameters:

file_name - Name of the loaded file.

format - Format of the loaded file. Character constants with the
prefix F_ declared in the mprog.h header file
are provided for this parameter. To understand this
better, open the Load Programm Dialog.
and go through format names.

addr_space - address space{addr_sp} where the data is downloaded
(O by default).

start_addr - Load address. This parameter is used only for loading
a file that is a binary memory image.

Example

LoadProgram("C:\PROG\TEST.HEX", F_HEX, SubLevel(1, 0));
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8.4.2.1.7 MaxAddr

unsigned long MaxAddr(int addr_space);

Description

Returns the address of the address space{addr_sp} upper boundary.

8.4.2.1.8 MinAddr

unsigned long MinAddr(int addr_space);

Description

Returns the address of the address space{addr_sp} lower boundary.

8.4.2.1.9 ReloadProgram

void ReloadProgram();

Description

To reload the file that was the last to be loaded to the buffer. This is equivalent to "Re-Load" in the
File[ st menu.

8.4.2.1.10 SaveData

void SaveData(unsigned char file_name[], int format, int addr_space, unsigned long start_addr,
unsigned long end_addr);

Description
To save memory area from buffer{buffer} in the file.
Parameters:

file_name - Name of unloaded file.
format - Format of unloaded file. Character constants with
the prefix F_declared in the mprog.h header file
are provided for this parameter. To understand this better,
open the Save Program Dialog and go through
format names.
addr_space - address space{addr_sp} where data is unloaded from.
start_addr - Initial address of unloaded area.
end_addr - Final address of unloaded area (inclusive).
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Example

SaveData("C:\PROGW\TEST.HEX", F_HEX, SubLevel(0, 0), 0, 0x3FFF);

8.4.2.1.11 SetByte

void SetByte(unsigned long addr, int addr_space, unsigned int value);
Description

To write value (byte) to a specified memory area{addr_sp} (parameter addr_space) at a specified
address.

Description

SetByte(0x2000, SubLevel(0, 1), OxFF);

8.4.2.1.12 SetDevice

int SetDevice(char manufacturer[], char namel]);
Description

Set device type. The manufacturer parameter is the device manufacturer name, name is the device
name.

Returned value
TRUE if the device is successfully selected, FALSE if it is not found.
Example

SetDevice("Altera", "EP910");

8.4.2.1.13 SetDword

void SetDword(unsigned long addr, int addr_space, unsigned long value);
Description

To write a double word (32 bits) to a specified memory area{addr_sp} (parameter addr_space) at a
specified address.

Example

SetDword(0x2000, 0, 0x12345678);
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8.4.2.1.14 SetMemory

void SetMemory(void src[], int n, unsigned long addr, int addr_space);
Description

To write n-byte memory block to a specified memory area{addr_sp} (parameter addr_space) at a
specified address from the array src.

Example

SetMemory("12345678", 8, 0x20, 0);

8.4.2.1.15 SetWord

void SetWord(unsigned long addr, int addr_space, unsigned int value);
Description

To write a word (16 bits) to a specified memory area{addr_sp} (parameter addr_space) at a
specified address.

Example

SetWord(0x2000, 0, OXFFFF);

8.4.2.2 Device programming control functions and variables

Here is the list of the functions that control programming scripts (alphabetic order):

AllProgOptionsDefault/ 23
ExecFunction| 239
GetProgOptionBits|[ 2«1
GetProgOptionFloat[2+h
GetProgOptionList/ 241
GetProgOptionLong[ 24
GetProgOptionString[ 243

mprintf 242
ProgOptionDefault[ 243

SetProgOption| 243

Here is the list of the variables that controls programming operations in scripts (alphabetic order):

BlankCheck[2#4
BufferStartAddr[ 244
ChipEndAddr/ 24h
ChipStartAddr] 2+
DialogOnError| 243
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InsertTest[ 24
LastErrorMessage[ 23
ReverseBytesOrder| 245
VerifyAfterProgram| 245

VerifyAfterRead[ 24!

8.4.2.2.1 Function AllProgOptionsDefault

void AllProgOptionsDefault();

Description:

Set all the programming options to their default values.

8.4.2.2.2 Function ExecFunction

int ExecFunction(char func_name([], int buffer=0, int repetitions=1),
Description:

Perform the specified action (function) on device - programming, blank check, etc. The list of
available functions is displayed in the upper left corner of the Program window/10s).

Parameters:

func_name - function name, for example "Blank Check". If you need to execute a function located
in the pop-up menu, you should precede the function name with the menu name and separate them
with ¥ sign, e.g. "Data Memory”Program".

buffer - the buffer number.

repetitions - number of repetitions of the function.

Returned value:

For the value returned by ExecFunction, the header file mprog.h contains two constants:
EF_OK - function was completed successfully

EF_ERROR - there was an error while executing function. In this case, the error description is
copied into the built-in variable LastErrorMessage(24),

Example:

if (ExecFunction("Blank Check") '= EF_OK)
printf("Error in blank check: %s", LastErrorMessage);

See also DialogOnError| 24,
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8.4.2.2.3 Function GangExecute

int GangExecute(int site, int buffer=0);

Description:

In the gang mode, launch the Auto Programming command on the socket, the number of which is
specified by the site parameter (the first socket in the gang programmer has the number 0). The
buffer's number is specified by the parameter buffer. The default buffer number is 0.

A successful launch of the GangExecute() function returns 1; if the function fails it returns 0.
Regardless of the Auto Programming result, immediately after launching the GangExecute() function,
full control returns to the active script. In order to check the Auto Programming command completion,
use the script functions GangStatus() or GangWaitComplete().

8.4.2.2.4 Function GangGetError

int GangGetError(int site, char s[]);

Description:

In the gang mode get an error message about the failure of the socket, the number of which is specified
by the parameter site (the first socket in the gang programmer has the number 0). The error message
(a string) dumps to the array with the pointer s. If no single error has occurred during the programming
session the first byte in the error string will be 0 (zero).

8.4.2.2.5 Function GangStatus

int GangStatus(int site);

Description:

In the gang mode get the status of the operation on the socket, the number of which is specified by the
site parameter (the first socket in the gang programmer has the number 0). The function call returns
the status string, two bits of which define the operation statuses:

If the bit GS_EXECUTING =1 this indicates that Auto Programming is still in process;
If the bit GS_FAILED =1 this indicates an Auto Programming failure.

8.4.2.2.6 Function GangWaitComplete

void GangWaitComplete(int site);

Description:

In the gang mode, wait for completion of the Auto Programming operation on the socket, the number
of which is specified by the site parameter (the first socket in the gang programmer has the number 0).
Regardless of the operation result, a call of this function returns control to the script only upon
completion of the Auto Programming operation.
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8.4.2.2.7 Function GetBadDeviceCount

unsigned long GetBadDeviceCount(int site=0);

Description:

In the gang mode get the current number of devices that could not be successfully programmed or did
not pass verification in the socket, the number of which is specified in the site parameter (the first
socket in the gang programmer has the number 0). Each socket in the gang programmer has a virtual
counter "Bad" that increments the variable after each programming cycle failure. The "Bad" counter
display is accessible in the Statistics tab in the Program Manager window.

8.4.2.2.8 Function GetGoodDeviceCount
unsigned long GetGoodDeviceCount(int site=0);

Description:

In the gang mode, get the current number of the devices successfully programmed in the socket, the
number of which is specified by the site parameter (the first socket in the gang programmer has the
number 0). Each socket in the gang programmer has a virtual counter "Good" that increments the
variable after each successful device programming cycle. The "Good" counter display is accessible in
the Statistics tab in the Program Manager window.

8.4.2.2.9 Function GetProgOptionBits
unsigned long GetProgOptionBits(char option_name[]);
Description:

Returns current value of the option_name programming option. The option must be of type 'Bits' -
a list of options; each of them can be checked or unchecked. Example: "Sectors" option of the
Fujitsu MBM29LVO08BA device.

8.4.2.2.10 Function GetProgOptionFloat
float GetProgOptionFloat(char option_namel]);

Description:

Returns current value of the option_name programming option. The option must be of type ‘Long' -
a floating-point number. Example: "Vcc" option of the Microchip PIC16F628A device.

8.4.2.2.11 Function GetProgOptionList
unsigned int GetProgOptionList(char option_name[]);
Description:

Returns current value of the option_name programming option. The option must be of type ‘List" -
a menu-like list of strings. Example: "WDT" option of the Microchip PIC16F628A device.
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8.4.2.2.12 Function GetProgOptionLong
long GetProgOptionLong(char option_name[]);
Description:

Returns current value of the option_name programming option. The option must be of type 'Long’
- a 32-bit integer. Example: "Tpgm" option of the Atmel ATF2500C device.

8.4.2.2.13 Function GetProgOptionString
void GetProgOptionString(char option_name[], char str[]);
Description:
Copies the current value of the option_name programming option to the str string. The option must

be of type 'String' - a text string. Example: "Copyright" option of the National Semiconductor
COP87SERY7 device.

8.4.2.2.14 Function mprintf
void mprintf(char format[], ... );
Description:

The mprintf function is used just like Qrintflgﬁ_but the message is displayed not in the Console
window but in the "Operation Progress" window of the Program Manager [ 103 window.

8.4.2.2.15 Function OpenProject
void OpenProject(char file_namel]);

Description:

Load the project with the name specified as the file_name. Call of this function is equivalent of loading
the project via the menu Project > Open. Use of projects is very convenient, especially for mass
production.

8.4.2.2.16 Function ProgOptionDefault
void ProgOptionDefault(char option_name[]);
Description:

Set the default value of the option_name programming option.

8.4.2.2.17 Function ReadShadowArea

void ReadShadowArea(int sub_level, unsigned long addr, unsigned int len, void data[], int
site=0);

Description:

Read data from a specified shadow memory to the array "data". First, you have to create a shadow
area through the menu Configure > The Serialization, Checksum and Log File dialog > Custom
shadow memory tab. The start address of the data to be written into the addr may differ from the start
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address of the custom shadow area but it is necessary the end address should not exceed the end
address of the shadow area.

The int site=0 means the socket# 0; i.e., the only socket for a single-site programmer or the first
socket in a gang programmer. In the gang mode it is hecessary to specify the socket number (the first
one has the number 0).

8.4.2.2.18 Function SetProgOption
void SetProgOption(char option_name[], char option_string[]);
Description:

Set value for the programming option. The programming options are listed in the lower right corner
of the Device and Algorithm Parameters' Editor/[ s window.

Parameters:
option_name - option name, e.g. "Vpp".

option_string - option value as character string. Options can be of several types (certain option
type can be determined by hitting the "Edit" button in the Device and Algorithm Parameters'
Editor[ e31 window).

« floating point numbers, for example, programming voltage. For such options, the option_string
parameter should represent a floating point number, for example, "12.3".

« integer numbers. The option_string parameter should represent an integer value, for example,
I|215I|.

* "menu" type options. In these cases, the option_string parameter should be a menu item string,
for example, "Disabled". Menu can be observed by hitting the "Edit" button in the Device and
Algorithm Parameters' Editor[ ¢ window).

« character strings, for example, "Copyright".

« check boxes option. Check boxes option is a list of options; each of them can be checked or
unchecked. To specify a value for a check box option, append an '=' sign to the option name
followed with O or 1. For example, to set up the CPD memory protection bit of PIC18F8720 chip,
write

SetProgOption("Memory protection”, "CPD=1");
Examples

SetProgOption("Vpp", "12.5");
SetProgOption("PWRT", "Disabled");

See also examples that come with the ChipProg package.

8.4.2.2.19 Function WriteShadowArea

void WriteShadowArea(int sub_level, unsigned long addr, unsigned int len, void data[], int
site=0);

Description:
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Write data from the array data to a specified shadow memory. First, you have to create a shadow area
through the menu Configure > The Serialization, Checksum and Log File dialog > Custom
shadow memory tab. The start address of the data, to be written into the addr, may differ from the
start address of the custom shadow area but it is necessary that the end address should not exceed
the end address of the shadow area.

The int site=0 means the socket# 0; i.e., the only socket for a single-site programmer or the first
socket in a gang programmer. In the gang mode it is necessary to specify the socket number (the first
one has the number 0).

8.4.2.2.20 Variable BlankCheck
extern int BlankCheck;

The value of the "Blank check before program" option in the _Program Manager /18] window (tab
Options). Assigning value to BlankCheck automatically changes the option in the window and vice
versa.

8.4.2.2.21 Variable BufferStartAddr
extern unsigned long BufferStartAddr;

The value of the start address in the buffer used for operation. Assigning value to BufferStartAddr
automatically changes the buffer start address field in the window and vice versa.

8.4.2.2.22 Variable Checksum

extern unsigned long Checksum;

A checksum of the data to be written into the device being currently programmed. This checksum can
be specified by the script that defines an algorithm for the checksum computation. This parameter is
usually set in the Checksum tab of the Serialization, Checksum and Log File dialog of the
Configure menu.

8.4.2.2.23 Variable ChipEndAddr
extern unsigned long ChipEndAddr;

The value of the start address in the device used for operation. Assigning value to ChipEndAddr
automatically changes the end address field in the window and vice versa.

8.4.2.2.24 Variable ChipStartAddr
extern unsigned long ChipStartAddr;

The value of the start address in the device used for operation. Assigning value to ChipStartAddr
automatically changes the start address field in the window and vice versa.

8.4.2.2.25 Variable DeviceBatchSize

extern unsigned long DeviceBatchSize;

Number of devices in the lot to be programmed. This variable is used for counting down the devices
from the DeviceBatchSize value to zero. A check box for enabling the device count-down and other
controls is accessible in the Statistic tab of the Program Manager window.
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Example: if you need to program 10000 devices of the same type with the same data and then the
programming should be stopped, the DeviceBatchSize=10000.

8.4.2.2.26 Variable DialogOnError
extern int DialogOnError;

If the value of this variable is set to nonzero (default), then if there is an error occurred during a
programming function execution (see ExecFunction[2:9)), the dialog with error description is
displayed. Otherwise no dialog is displayed and ExecFunction() immediately returns with code
EF_ERROR.

8.4.2.2.27 Variable GangMode

extern int GangMode;

The variable's value will be 1 if the ChipProgUSB software has been launched in the gang mode; for
example, if it has been launched in the command line mode with the key /GANG, otherwise it will be 0.
The GangMode variable is accessible for reading only.

8.4.2.2.28 Variable InsertTest

extern int InsertTest;

The value of the "Insert test" option in The Program Manager Window/ 0% (tab Options). Assigning
value to InsertTest automatically changes the option in the window and vice versa.

8.4.2.2.29 Variable LastErrorMessage(]

extern char LastErrorMessage][];

String that contains the last error message about operation on device. See also ExecFunction| 2.

8.4.2.2.30 Variable NumSites

extern int NumSites;

The number of the gang programmer's operable sockets (for example, for a ChipProg-G41 device
programmer, NumSites is four. The NumSites variable is accessible for reading only.

8.4.2.2.31 Variable ReverseBytesOrder
extern int ReverseBytesOrder;

The value of the "Reverse bytes order" option in The Program Manager Window![ 108 (tab Options).
Assigning value to ReverseBytesOrder automatically changes the option in the window and vice
versa.

8.4.2.2.32 Variable SerialNumber
extern unsigned long SerialNumber;

The serial number of the device currently being programmed. This number can be specified by the
script that defines a start serial number and an algorithm for the serial number incrementation. These
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parameters are usually set in the Serial Number tab of the Serialization, Checksum and Log File
dialog of the Configure menu.

8.4.2.2.33 Variable Signature
extern char Signature[];

A string of characters to be written in the device being currently programmed as a unique signature.
This signature can be specified by the script. Usually it is set in the Signature String tab of the
Serialization, Checksum and Log File dialog of the Configure menu.

8.4.2.2.34 Variable VerifyAfterProgram
extern int VerifyAfterProgram;

The value of the "Verify after program" option in The Program Manager Window/[ 108 (tab Options).
Assigning value to VerifyAfterProgram automatically changes the option in the window and vice
versa.

8.4.2.2.35 Variable VerifyAfterRead

extern int VerifyAfterRead;

The value of the "Verify after read" option in The Program Manager Window/10s] (tab Options).
Assigning value to VerifyAfterRead automatically changes the option in the window and vice versa.

8.4.2.3 Mathematical functions

fmod|[ s3]
frexpl 2o8
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abs| 26
pow| =1}
pow10[ a8

8.4.2.4 String operation functions

Functions for string operation receive arrays as parameters. Functions of the memxxxx type can
use arrays of any type; other functions use the char arrays.

The script file language does not support pointers, that is why all string operation functions include
the index, desr_index, and scr_index parameters to specify the initial shift in the array. The default
value of these parameters is 0. These parameters are not considered in the following line function
descriptions.

Note once again that arrays are transferred "by pointer”, that is, the array itself is transferred and
not its copy.

memccpy[ s
memcpy/ =3
memmove[ 33
movmem| s
memchr(af)
memset[ a3

setmem/ s

memcmpl 33
memicmpl 33
stpcpyd)
strcat/s)
strchrfs3)
strempfa4)
stricmp[s
strempif
i (2
strcpyls
[
striwr[38)

i (=2
strncat/ 34
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strncmpl 348)
strncmpil 34)
strnicmpl a7
strncpy[ =)
strnsetf 3
strpbrk[ s
strspnl s
[l 3ed)
strrchrfs
strrev

8.4.2.5 Character operation functions

isalnum =03
isalpha
isasciil =}
iscntrif=od)
isgraphf sof
islower[ =R
isprintf e
isspace| 30

isupper
toasciil s
tolower| =53

toupper 2

8.4.2.6 Functions for file and directory operation

chdir[ 272

getcurdir( 28
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findfirst
ff_attribl 263
_ff_timefzee)
_ff_date[2es)
_ff_sizefzH
ff_ name
fnsplit[ 29
fnmergel 26
getcwd

getdisk()[ 29N
setdiskl =8

mkdirf a4
rmdir[ =9
searchpathl =}
getdfree[ 2N
unlink[
chsizel272
close[ 274
creat[273)

creatnew/ 27

creattempl 2781
dupl273)
dup2[ 273
eof[ 28
filelengthl 2s8)
getftime[ 297
setftime[ A
isatty[ s3]
lock( =)
unlock] 353
locking A
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Iseekl =)
open| a8
read[ =8
write[ 359
rename| =30l

setmode| s

|****

8.4.2.7 Streamfile functions

clearerr
fclosel2s3)
fdopenlzeh
feof(2sd)
ferrorf 23

fflushl 2e3)
fgetc [289)

fgets[ a8
filenol zs9
fopenl2s)
fprintf[2e)
fputcze
fputs[zoh
freadf2e)
freopen
fscanf(2e)
fseekl 2R
ftelll o3
fwrite[ 298
getc[29)
getw] 09
putc|32M
il (B

rewind
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8.4.2.8 Formatted input-output functions

Formatted input-output functions perform data conversion in accordance with the format line. You
can find description of the format line in any book on the C language.

Note that the arguments for input functions should be arrays, and not simple variables. This is
because the pointers are not supported in the script file language, and it is impossible to transfer
an address with the simple variable.

Attention! Your arguments passed to the formatted input-output functions shall match the format
line. Otherwise, the CPI2-Gx program may fail.

frintfl 2001
fscanf[209)
scanf(s)
pscanf[ 3
sscanf[ s
printfl =20

_printf[ 267
sprintfls)
MessageBox
MessageBoxEx a3

8.4.2.9 Script File Manipulation Functions

ExecScript( 22
GetScriptFileName) 209
TerminateScript[ s
TerminateAllScripts|[zsh
exitl 282

8.4.2.10 Text editor functions

The text editor functions manipulate with text in the Source [ You can start the script files with
the custom hot keys (for more about this, see ).

All text editor functions assume that the text editor window is active, when function is called, so
they do not receive the window handle as a parameter unlike other functions that manipulate
windows in CPI2-Gx.

The CPI2-Gx package includes several examples of script files performing useful commands. The
sources are located in the KEYCMD sub-directory.
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Note that line and column numbers begin from 1.
GotoXY[wh
Up
Downl2A)
Left
Right]ssd)
Toffss1)
Eoff 20
Eollzh
BackSpace[ 270
Crl 27
DelLinel273)
DelChar[ 277
CurChar[27h
Getlinel A
ForwardTill[ 23
ForwardTillNot/ 29
GetWord|[ 28]
WordLeft[ 358
WordRight[ s
FirstWord[2e8)
SetMark[ 30
GetMark| 298
Text[3sh
BlockBegin[ 278
BlockEnd[27h
BlockOfflz7h

BlockCopyl 278

BlockFastCopy[ 27
BlockDelete[ 278

BlockMove[ 27h
BlockPaste[27h
Search[33
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SearchReplacel
SetFileName| 8

GetFileName[ 297

SaveFile[s

|****
OpenEditorWindow/ 18
Text editor built-in variables
InsertMode| s3)

CaseSensitivel se)
WholeWords|ze)
[rx] [ aed
BlockCol1[ el
BlockCol2[ sh
BlockLine1[ssh
BlockLine2[ 3
BlockStatus| 36
CurLine[ s
CurColl =
LastFoundString[ 363

8.4.2.11 Debug shell control functions

These functions control CPI2-Gx.

RedrawScreen| 329
LoadDesktopl 37
LoadOptions| 308
SaveDesktopl 33h
SaveOptions [33}
OpenWindoleﬁ
OpenUserWindow/ 3

OpenStreamWindow] 313
CloseWindow[ 27

FindWindow] 288)
MoveWindow[ 315
ActivateWindow/ 267
SetWindowSize[34)
SetWindowSizeT[ 38
GetWindowWidth[ 308

GetWindowHeight[ 308
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SetWindowFont/[ s3]
WindowHotkey [ 350
AddWatchl[ 268

Ins pectm
ExecMenul 280
ExitProgram| 283
LoadProject[ 308
CloseProject[27h
LoadProgram| 308

ReloadProgram| 329
SaweDatal33h

8.4.2.12 Windows operation functions and other system functions

Attention! Only the experienced programmers should use the Windows operation functions.
These functions provide advanced capabilities, but when used incorrectly, they may hang the

operating system.
APz
LoadLibraryf =0
FreeLibrary| 2o
WaitSendMessagel 258l
WaitGetMessage| 9

inport[ 303}
inportbf =0}
outport/ =8
peek[8)
peekb[a8)
pokelsd
pokebla19)
exec| 2
getenv[2oh
putenv(z2h

8.4.2.13 Graphical output functions

Graphical output functions draw various graphical objects and text in special User window/[ 88, To
draw in a user window, first open it with the OpenUserWindow/ =17 function that returns the

window identifier (handle). Then use the identifier to reference the window (multiple user windows
can be open at the same time). For more information, see User window/ 18,

In all graphical output functions, the first parameter () is the window identifier.
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OpenUserWindow/s17)
ClearWindow/[ 274

SetCaption[ ss)
SetToolbarf =
SetUpdateMode! s
UpdateWindow[ 23]
SelectPen[d
SelectBrush| 4
SelectFont[ 338
SetTextColor| 33
SetBkColor/ss)
SetBkMode[ =)

DisplayText[ 273

DisplayTextF[ A
MoveTol =8

LineTol =R
FillRect[zsN
Rectangle[32)
InvertRect[ 203
Curcuit[ 27
Ellipse[ )
Polylinef =3
SetPixell 33
AddButton[zsh
RemoveButtons|[23)
WaitWindowEvent[ 7

[****] IEQ
LastEventint{1...4}[ 300

8.4.2.14 /O Stream window operation functions

Stream window control functions allow you to display text in the special /O Stream window| 1),
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In all Stream window control functions, the first parameter (handle) is the window identifier.

OpenStreamWindow| 8
SetTextColor[ 8
wprintf[ss9)

wgetchar( s
LastChar| 308
wgethex| =8

wagetstring| s8]
LastString[ 300

8.4.2.15 Event Wait Functions

These extremely useful functions sene to simulate external environment. Also, you can use them in simulators

to dewelop various tests.

Wait/ 53
WaitMemoryAccess| 5

WaitExprTrue[ssh
WaitExprChange

WaitStopl 357
WaitWindowEvent[35h

8.4.2.16 Other Various Functions

delay[277
gettime@
getdatelgéﬂ
difttimel 273
atoff269)
atoi279)
itoa[ 308
ltoa[3h
ultoa[ 39
rand[ 32
random|[ 328
randomize| 32
srand[ 32
strtol[ 349
strtoul[349)
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8.4.3 Built-in Variables by Group

You can access script language built-in variables in the same way as regular global variables. Howewver, some built-
in variables are accessible only for reading, and in case of attempt to write to such variable.

The built-in variables are declared in the system.h header file.

Programming variables:
InsertTest[ 245
ReverseBytesOrder| 24
BlankCheck[2sA)

Verify AfterProgram|[ 248

VerifyAfterRead[ 248
ChipStartAddr[ 2+

BufferStartAddr 243
LastErrorMessage[ 249
DialogOnErrorlm

Text editor built-in variables:
InsertMode] 363)
CaseSensitive[ 363
WholeWords| s
RegularExpressions[ 3R
BlockCol1|36h
BlockCol2[ 360
BlockLine1[3eh)
BlockLine2[ 361
BlockStatus[ 36
CurLine[ s}

CurCol[363)

LastFoundString[363)

Miscellaneous variables:
WorkFieldWidth[ 33
WorkFieldHeight[363)
AppIName [ 360)
DesktopName][][ 362
SystemDir{][ 363

errno| 36.

_fmodelgtﬁ
MainWindowHandle[ 364
NumWindows [ 363
WindowHandles([][ 363
SelectedString[]| 33
LastMessagelnt[36A
LastMessagel ong] 36h

8.4.4 List of Built-in Functions and Variables

Below is the alphabetical list of all built-in functions and variables of scripting language.

AllProgOptionsDefault[233)
API[ 26}
ActivateWindow/ 267
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AddButton[ 267
AddWatchl 2
AppINamef][ s
BackSpace[ 278
BlankCheck| 24
BlockBegin| 270}
BlockCol1/[ssh
BlockCol2[ 31
BlockCopy[ 27}
BlockDelete[ 231
BlockEnd[ 271
BlockFastCopy/ 2711
BlockLine1[ sl
BlockLine2[ sl
BlockMovel 271
BlockOff[ 27h
BlockPaste[z7h
BlockStatus|zel
BufferStartAddr| 2«3
CaseSensitive|[ 36
CheckSum|233)
ChipEndAddr[ 242
ChipStartAddr[ 23
ClearWindow/ 274
CloseProject] 274
CloseWindow[ A
Crl=A
CurChar| 27
CurColls)
CurLinel s
Curcuit[ 270
DelChar[ 277
DelLine[27)

DesktopName[][ 63
DialogOnError| 263
DisplayText| 273

DisplayTextF[ 2
Downl 27

Ellipse[ 28
Eoff 288

Eoll2eh
ExecFunction| 23]
ExecMenul/2s)
ExecScript[ 282
ExitProgram | 2s)
Expr( 283
FileChanged[ 258
FillRect[2sN
FindWindow/ 28
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FirstWord[ 2e3!
FloatExpr| 2s3!
ForwardTill[ 260
ForwardTillNot/ 299)
FrameRect[2e
FreeLibrau@
GetByte[ 234
GetDword[ 23
GetFileName|zoh
GetLine[ 298
GetMark| 2e
GetMemory/| 2o
GetProgOptionBits| 2«1
GetProgOptionFloat/ 24}
GetProgOptionList/2:)
GetProgOptionLong[ 222

GetProgOptionStringl 242
GetScriptFileName[2e)
GetWindowHeight[ 300
GetWindowW idth[ 08
GetWord| s
GotoXY[ah
InsertMode] 363
InsertTest[ 2
Inspect| s
InvertRect/ 30
LastCharl sl
LastErrorMessage[2#)
LastEvent[ 3%
LastEventint{1...4}[ 300
LastFoundString[ 631

LastMessagelnt[3h
LastMessageLong] 3%

LastString[ 307

Left[ )

LineTol s0A
LoadDesktop[o0
LoadLibrary[ =
LoadOptions| 308!
LoadProgram | =8
LoadProject[ =03
MainWindowHandle[ 3}
MaxAddr[ 25

MessageBox| 313
MessageBoxEx| 33
MinAddr 23}

MoveTol 313

MoveW indow/ 3131
NumWindows A
OpenEditorWindow/ 318
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OpenStreamWindow( 318
OpenUserWindow/3

OpenWindow/ a7
Polyline[z:8)
ProgOptionDefault[24]
Rectangle/ A
RedrawScreen(zz1
RegularExpressions| 2%
ReloadProgram| 2
RemoveButtons[ 3
ReverseBytesOrder[ 24
Right[=)
SaveData[ =
SaveDesktoplz:1)
SaveFile[ =2
SaveOptions| s
Searchl( 3
SearchReplace[ 3
SelectBrush[=A
SelectFont[33
SelectPen|[=3h
SelectedString[][ 3¢
SetBkColor|[ =)
SetBkModel[ =38
SetBytelEb"I
SetCaption| 33)
SetDevice[230
SetDWord[=3)
SetFileName[33)
SetMark] =N
SetMemory[sa)
SetPixell s
SetProgOption[2:3)
SetTextColor| =)
SetToolbar( s
SetUpdateMode[ 3
SetWindowFont/ 23
SetWindowSize[ 3
SetWindowSizeT[ 38
SetWord[ 3

SystemDir[][ 33
TerminateAllScripts |31

TerminateScript/ s}
Textlsh

Tof[ 30

Uplss3)
UpdateWindow[3)
VerifyAfterProgram |2

VerifyAfterRead| 241
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WaitEprTruelssa)
WaitGetMessage| 33!
WaitSendMessage! 56!
WaitWindowEvent[N
WholeW ords /3
WindowHandles[][ 368

WindowHotkey[ a8
WordLeft[ =8

WordRight/ 29
WorkFieldHeight[ 3631
W orkFieldWidth[ e
GetWord[268)
ff_attrib[ 263
_ﬁ_date%
ff name[2s3)
ff_sizel2eh
ff_time[268)
fmode[z6d)
fullpathl 28
_printfl 267
abs[26N
acos| 2N
asin( 2
atan[z)
atoff 269
atoif 278
ceill 272
chdir[ 272
chsizel2A
clearerr[ 27
close[ 27
cos| 273
creat[zr)
creatnew%
creattempl /%
delay[ 277
difftime[ 273
dup( 279
dup2[ =4
eof(2s0)
errmof s
exec[ 21
exitl 22
expl 283
fabs| 23
fclose[23)
fdopen| 23R
feofl 28R
ferror 2
flushl 283
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foetc| e
fgets 2
filelengthl 2s3)
filenof 29
findfirst[ 2sM
findnext( 2sh
floor( 2s8
fmodf2ed)
fnmergel 263
fnsplit[ 283
fopen(z9)
fprintf[ 269
fputc[ 2eh
fputs| 2o
fread[ 298
freopen(2e2)
frexpl 23
fscanfl 23
fseek] 29
ftelll 2o
fwrite[ 28
getc2h
getcurdir[ 299
getcwd| 299)
getdate| 298
getdfree[ 20N
getdisk()[ 20N
getenv(zon
getftime[2s7
gettime[ 299
getw =)
inport[ a0
inportb| 02
isalnum | o3
isalphal 03
isasciil 203
isatty[3
iscntrl[zoh
isdigit[ =00
isgraphl sh
islower/z0h
isprint[=o8)
ispunct[ o)
isspacel 308
isupper] 03
isxdigit[ 3%
itoal 8
lockl s
locking] )
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log[ 219
log10[=:01
Iseekl=d)
Itoal a1h
memccpy/ 3
memchr[=f]
memcmpl =
memcpy/ 313
memicmpl s
memmove[33)
memset[ 33
mkdir[a
movmem |z
mprintfl242)
openf 3
outport/318)
outportb[ =8
peek] )
peekbl 8]
pokef =)
pokeb[ 31
pow/ 319}
Qowlolzéﬁ
printf[ 32
pscanf( 28
putcl2n
putenvl sz
putw[ =27
rand[ s
random |32
randomize[3)
read[ =2
rename/ 32
rewind[ %)
rmdir[ )
scanffs
searchpath[ss)
setdisk[3)
setftimel s
setmem)| 337
setmode| =)
sin[34D
sprintf[ s}
sqrtf s
srand[ 2
sscanff 32
stpcpy| 33
streat[33)
strchrf 33
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strcmpls4l
strempil a4
strcpyl 4l
strcspnla)
stricmpla
strlenfs#)
striwr[ 343
strncat[ 3
strncmpl 34
strncmpil 34)
strncpyl 38
strnicmpl 37
strnset[s4N
strpbrk[ a7
strrchr( s
strrevl 348
strset[34)
strspnl s
strstr[s)
strtol[ 39
strtoul[38)
strupr| s
tan[ssd)

tanh( s
tell[ =9
toascii[ 301
tolower[ 353
toupper] ss2)
ultoa[
unlink[ 33
unlockl3s3)
wgetcharl sh
wgethex| 28
wagetstring[ 23]
wprintf[ s
write[ =53

8.4.5 Scripting Functions
Enter topic text here.

8.45.1 fnmerge

Declaration:
void fnmerge(char path[], char drive[], char dir[], char name[], char ext[]);

Builds a path from component parts.
fnmerge makes the path name from its components. The new path name is
X\DIR\SUBDIR\NAME.EXT
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where:

drive = X

dir = \DIR\SUBDIR\
name = NAME

ext = EXT

fnmerge assumes there is enough space in path for the constructed path name. The maximum
constructed length, MAXPATH, is defined in system.h.

fnmerge and fnsplit/ 263 are invertible: if you split the given path with fnsplit, then merge the
resultant components with fnrmerge and you end up with this path.

8.4.5.2 Function ff attrib

Declaration:
char _ff_attrib(char ffblk[]);

Description

Returns the attribute byte of the file found upon the function findfirst[26? or findnext[ 287 access. The ffblk
parameter is the buffer filled with information on the file after findfirst or findnext access.

Example
See function findfirst[28A

8.4.5.3 Function _ff date

Declaration:
int _ff_date(char ffblk[]);
Description

Returns the word with the file (creation or modification) date for the file found upon the function findfirst| 2671 or
findnext[ 280 access. The ffblk parameter is the buffer filled with information on the file after the findfirst or
findnext access.

Example
See function findfirst[ 287

8.4.5.4 Function _ff name

Declaration:
void _ff_nane(char ffblk[], char fnane[]);
Description

Copies the name of the file found upon the function findfirst[ 287 or findnext[28A access to the fmane array. The
fiolk parameter is the buffer filled with information on the file after the findfirst or findnext access. The file name
does not contain the disk nhame or path.

Example
See function findfirst[28A
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8.4.5.5 Function ff size

Declaration:
long _ff_size(char ffblk[]);
Description

Returns the size of the file found upon the function findfirst[2sM or findnext[26M access. The ffblk parameter is
the buffer filled with information on the file after the findfirst or findnext access.

Example
See function findfirst[ 287

8.4.5.6 Function _ff _time

Declaration:
int ff_time(char ffblk[]);
Description

Returns the word with the file creation (or modification) time for the file found upon the function findfirst| 2871 or
findnext[ 287 access. The ffblk parameter is the buffer filled with information on the file after the findfirst or
findnext access.

Example
See function findfirst[ 28,

8.4.5.7 Function _fullpath

Declaration:

int _fullpath(char buf[], char pathl]);

Description

Converts a relative path name to the absolute one.

_fullpath converts the relative path name in a path to the absolute path name that is stored in the
array of characters pointed to by buf. The function returns FALSE the path contains an invalid
drive letter.

Returned value

If successful, the _fullpath function will return TRUE. On error, it returns FALSE.

8.4.5.8 Function GetWord

Declaration:
void _GetWord(char dest[]);
Description

Copies the word under the cursor to the dest array. If there is no word under the cursor, then the first element
of dest will be 0.
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8.4.5.9 Function _printfv

Declaration:

void _printf(char format[], ... );

Description

Acts like printf[328), but does not append the newline character to the line.

Note. Your arguments passed to this function shall match the format line. In case of mismatch, the <% CM%
> program may crash, because it cannot check the correspondence between the format string and
parameters passed.

8.4.5.10 Function abs

Declaration:

| ong abs(long x);

Description

The abs function calculates the absolute value of the integer argument val.
Returned value

The abs function returns the absolute value of the integer argument val.

8.4.5.11 Function acos

Declaration:
float acos(float x);
Description

The acos function calculates the arc cosine of the floating-point number x. Argument x should range from -1
to 1, otherwise the result will be equal to 0 (for x > 1) or to PI (for x < -1). The function returns value in the
range from O to PI.

Returned value

The acos function returns the arc cosine of argument x.

8.4.5.12 Function ActivateWindow

Declaration:
voi d ActivateW ndow( unsi gned | ong handl e);

Description

Activates the specified window. The window becomes 'active’ and is placed over all other windows of <%CM%
>,

8.4.5.13 Function AddButton

Declaration:
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i nt AddButton(unsigned | ong handle, char button_text[], int x, int y, int
wi dth, int height);

Description

Adds a button to the window. The button is a usual button of the standard Windows dialog boxes. When you
click the button, the event is generated that can be captured with the WaitWindowEvent[ss7 function, and the
corresponding operation is carried out.

If the specified button already exists in the window (already added by AddButton with the same parameters),
the new button will not be added and the existing button will be used.

Parameters:
button_text - the text witten on the button
X, VY - the coordinates of the upper left corner within the w ndow
wi dt h - the button wi dth
hei ght - the button height

Returned value

The button identifier. It is used by the WaitWindowEvent[ 357 function to determine, which button was clicked
(there multiple buttons in the window).

Example
AddBut t on(handl e, "Start", 50, 50, 70, 24);

8.4.5.14 Function AddrExpr

Declaration:

unsi gned | ong Addr Expr(char str[]);

Description

Calculates the expression and returns the result (the str parameter) as an address in microcontroller memory.
Example

int addr_port0 = Addr Expr (" PORT0");
Wai t MenoryAccess(addr_port0, AS _DATA, 1, MA WRI TE);

Note that 'AddrExpr("PORTOQ")' is the same as 'Expr("&PORTQ")".
Also, see Expr[263), EloatExprl 288, Operations and Expressions|ih.

8.4.5.15 Function AddWatch

Declaration:
voi d AddWatch(char nane[], int format=DF_HEX);

Description

Adds the specified name (the name parameter) to the Watches 183 window( 183\ in the specified format. If the
Watches window is not already opened, it will be opened automatically.

Examples

AddWat ch(" Dur ati on", DF_DEC);
AddWat ch( " Addr ess") ; /1l the default format is hexadeci el
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8.4.5.16 Function API

Declaration:
unsi gned | ong APl (char func_nane[], ... );
Description

Calls a 16-bit Windows API function with the name specified in func_name and transfers the parameters
specified in API to this function.

Make sure you use the correct parameter number and size, because <% CM%> knows nothing about them.
When necessary, use the explicit type conversions and put character 'L' in the end of long-type constants.

To reduce problems, when an array is transferred as the parameter, a long (32-byte) pointer is transferred.
Returned value

What was returned by the called API function is in registers DXAX If it is a pointer, then data can be
accessed using the peek[318), pokel=18), peekbl 1), or pokebl=13) functions.

Example
int ScreenHei ght = API (" Get SystemMetrics", SM CYFULLSCREEN);

8.4.5.17 Function asin

Declaration:
float asin(float x);
Description

The asin function calculates the arc sine of the floating-point number x. The argument x should range from -1
to 1, otherwise the result will be equal to PI/2 (for x > 1) or to -PI/2 (for x < -1). The function returns value in
the range from -P1/2 to PI/2.

Returned value

The asin function returns the arc sine of argument x.

8.4.5.18 Function atan

Declaration:
float atan(float x);
Description

The atan function calculates the arc tangent of the floating-point number x. The function returns value in the
range from -P1/2 to PI/2.

Returned value

The atan function returns the arc tangent of argument x.

8.4.5.19 Function atof

Declaration:

float atof (char s[]);
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Description

Conwerts an ASCII-string (parameter s) into the floating-point number.

8.4.5.20 Function atoi

Declaration:
int atoi(char s[]);

Description

Converts an ASCII-string (parameter s) into the integer number.

8.4.5.21 Function BackSpace

Declaration:
voi d BackSpace();
Description

Works like the BackSpace key.
8.4.5.22 Function BlockBegin
Declaration:

voi d Bl ockBegi n(int bl ock_type);

Description

Begins marking of block (see Block Operations|183). The block_type parameter indicates the type of block.
For conwvenience, the system.h header file defines constants for the block functions:

EB_NONE - no block (not used in this function)
EB_LI NE - line block
EB_VERT - vertical block

EB_STREAM - stream bl ock

8.4.5.23 Function BlockCopy

Declaration:
voi d Bl ockCopy();
Description

Copies the block to the clipboard.

8.4.5.24 Function BlockDelete

Declaration:
voi d Bl ockDel ete();
Description

Deletes the block. The block is copied to the clipboard
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8.4.5.25 Function BlockEnd

Declaration:
voi d Bl ockEnd();

Description

Finishes marking of block. It is supposed that before calling BlockEnd(), the BIockBeginlz_m'ﬁ function is called
and then the cursor is moved to the end of the block.

8.4.5.26 Function BlockFastCopy

Declaration:
voi d Bl ockFast Copy();

Description

Copies the block from the cursor position.

8.4.5.27 Function BlockMove

Declaration:
voi d Bl ockMove();

Description

Movwes the block to the cursor position.

8.4.5.28 Function BlockOff

Declaration:
voi d Bl ockOff ();
Description

Turns the block off..

8.4.5.29 Function BlockPaste

Declaration:
voi d Bl ockPast e();
Description

Pastes the block from the clipboard to the cursor position

8.4.5.30 Function CallLibraryFunction

Declaration:
unsi gned long Call Li braryFunction(unsigned |ong inst, char func_nane[], ... );
Description

Calls the func_name function from DLL and its HINSTANCE is transferred to inst. Otherwise, this function is
similar to the function API[263) call.

Example
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unsi gned | ong instance = LoadLi brary("EXTEND. DLL");
long result = CallLibraryFunction(instance, "Initialize", 0, 1L);

8.4.5.31 Function ceil

Declaration:

float ceil (float x);

Description

The ceil function calculates the least integer value that is greater than or equal to x.
Returned value

The ceil function returns the double-type number equal to the least integer that is no greater than x.

8.4.5.32 Function chdir

Declaration:
int chdir(char path[]);
Description

Sets up the new default directory specified in parameter path. The latter might also contain a disk name, but
the disk does not change: only the default directory changes on this disk.

Returned value

If the directory change is successful, O will be returned, and -1 otherwise.

8.4.5.33 Function CheckSum

Declaration:

unsi gned | ong CheckSun({unsigned | ong start_addr, unsigned |ong end_addr, int
addr _space);

Description

Calculates the checksum for data in the addr_space memory that starts from start_addr and ends at
end_addr. The checksum is calculated by simple addition of byte values.

Returned value
The 32-bit checksum.

Example
printf("%08l X', CheckSum(0, Ox1FFF, AS_DATA));

8.4.5.34 Function chsize

Declaration:

int chsize(long handle, long size);

Description
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Changes the file size.

chsize changes the size of the file associated with handle. It can truncate or extend the file,
depending on the value of size compared to the file's original size.

The mode, in which you open the file, must allow writing.

If chsize extends the file, it will append the null characters (\0). If it truncates the file, all data
beyond the new end-of-file indicator will be lost.

Returned value

On success, chsize returns 0. On failure, it returns -1 and sets the errnol32 global variable to one
of the following values:

EACCESS Perm ssi on deni ed
EBADF Bad fil e nunber
ENGCSPC No space left o

8.4.5.35 Function ClearAllBreaks

Declaration:
void ClearAll Breaks();
Description

Clears all breakpoints of all types.

8.4.5.36 Function ClearBreak

Declaration:
voi d Cl earBreak(unsi gned | ong addr);
Description

Clears the code breakpoint at the specified address.

8.4.5.37 Function ClearBreaksRange

Declaration:

voi d Cl ear BreaksRange(unsigned | ong start_addr, unsigned |ong end_addr);
Description

Clears the code breakpoints in the range from start_addr to end_addr inclusive.

8.4.5.38 Function clearerr

Declaration:
void clearerr(unsigned long stream);

Description
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Resets error indication.

clearerr resets the specified stream's error and end-of-file indicators to 0. Once the error indicator
is set up, the stream operations continue to return the error status until a call is made to clearerr
or rewind. The end-of-file indicator is reset with each input operation.

8.4.5.39 Function ClearWindow

Declaration:

voi d Cl ear Wndow(unsi gned | ong handl e);

Description

Clears the specified window, which can be a User 18hwindow[ 280 or an 1/O Stream [18hwindow[18h,

8.4.5.40 Function close

Declaration:

int close(long handle);
Description

Closes afile.

The close function closes the file associated with handle (the file handle obtained from a call to
creat, creatnew| 278, creattempl 278, dupl2r9), dup2[27), ).

It does not write the Ctrl-Z character to the end of the file. If you want to terminate the file with Ctrl-
Z, you must explicitly output it.

Returned value

Upon successful completion, close returns 0. On error (if it fails because handle is not the handle
of a valid, open file), close returns -1 and the errnol3:3 global variable is set to

EBADF Bad file number
8.4.5.41 Function CloseProject

Function CloseProject

Declaration:

voi d Cl oseProject();

Description

Closes the project. If no project is loaded, nothing will happen.

Calling this function is useful, if you want to prepare the shell for loading a program without a project.

8.4.5.42 Function CloseWindow

Declaration:
voi d Cl oseW ndow(unsi gned | ong handl e);
Description

Closes the specified window. The handle parameter is the window identifier produced by the calls of the
OpenWindow( 3, and Findwindow| 28 functions.
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8.4.5.43 Function cos

Declaration:

float cos(float x);

Description

The cos function calculates the cosine of the floating-point number x.
Returned value

The cos function returns the cosine of argument 0x.

8.4.5.44 Function Cr

Declaration:

void Cr();
Description

Works like the Enter key.

8.4.5.45 Function creat

Declaration:

int creat(char path[], int amode);

Description

Creates a new file or overwrites an existing one.

Note. Remember that the backslash in a path requires "\\'.

creat creates a new file or prepares to rewrite an existing file given by path. amode applies only to
newly created files. A file created with creat is always created in the translation mode specified by
the _fmode! =6l global variable (O_TEXT or O_BINARY). If the file exists and the write attribute is
set, then creat will truncate the file to the length of 0 bytes, leaving the file attributes unchanged. If
the existing file has the read-only attribute set, then the creat call will fail and the file will remain
unchanged. The creat call examines only the S_IWRITE bit of the access-mode word amode. If
this bit is 1, then the file can be written to. If the bit is 0, then the file is marked as read-only. All
other operating system attributes are set to 0. amode can be one of the following (defined in

system.h):

Value of amode Access permission
S IWRITE Perm ssion to wite
S | READ Perm ssion to read

SIREAD | S IWITE Permssion to read and wite (wite perm ssion
i nplies read perm ssion))

Returned value

Upon successful completion, creat returns the new file handle (a nonnegative integer); otherwise,
it returns -1. In the event of error, the errno[3:2) global variable is set to one of the following:

EACCES Per m ssi on deni ed
ENCENT Path or file nane not found
EMFI LE Too many open files
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8.4.5.46 Function creatnew

Declaration:

int creatnew(char path[], int amode);
Description

Creates a new file.

creatnew is identical to creat with the only exception: if the file exists, then creatnew will return
error and leave the file untouched. The amode

FA HIDDEN Hidden file
FA RDONLY Read-only attribute
FA SYSTEM System file

Returned value

Upon successful completion, creatnew returns the handle of new file (a non-negative integer);
otherwise, it returns -1. In the event of error, the errnol 32 global variable is set to one of the
following values:

EACCES Permission denied
EEXIST File already exists

EMFILE Too many open files
ENOENT Path or file name not found

8.4.5.47 Function creattemp

Declaration:
int creattemp(char path(], int attrib);
Description

Creates a unique file in the directory associated with the path name. A file created with creattemp
is always created in the translation mode specified by the _fmode[el global variable (O_TEXT or
O_BINARY).

path is the path name ending with backslash (\). The unique file name is selected in the directory
given by path. The newly created file name is stored in the path string supplied. path should be
long enough to hold the resulting file name. The file is not automatically deleted, when the program
terminates.

creattemp accepts attrib, the DOS attribute word. Upon successful file creation, the file pointer is
set to the beginning of the file. The file is opened for both reading and writing.

The attrib argument to creattemp can be either zero or an OR-combination of any of the following
constants (defined in system.h):

FA_HI DDEN Hi dden file

FA_RDONLY Read-only attribute

FA_SYSTEM System file

Returned value

Upon successful completion, the new file handle (a hon-negative integer) is returned; otherwise, -
1 is returned. In the event of error, the errnol3 global variable is set to one of the following values:
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EACCES Perm ssi on deni ed
EMFI LE Too many open files
ENCENT Path or file nane not found

8.4.5.48 Function CurChar

Declaration:
char CurChar();
Description

Returns the character under the cursor. If the cursor is beyond the line end, then CurChar() will return 0.

8.4.5.49 Function Curcuit

Declaration:
voi d Curcuit(unsigned long handle, int x1, int yl, int x2, int y2);
Description

Draws an unpainted ellipse using the pen selected with the SelectPen[ 33 function; (x1, y1) are the
coordinates of the upper left corner of the rectangle, in which the ellipse will be drawn, (x2, y2) are the
coordinates of its lower right corner.

8.4.5.50 Function delay

Declaration:
voi d del ay(unsigned int mlliseconds);
Description

Suspends the program for the specified time interval.

Example
while (1)
{
Step(); /1 to execute a step
RedrawScreen(); // To update the screen. Step() does not do it.
del ay(1000); /1 wait for one second. During this time step
} /'l results can be observed

8.45.51 Function DelChar

Declaration:
voi d Del Char (int count=1);

Description
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Deletes count characters beginning from the cursor position

8.4.5.52 Function DelLine

Declaration:
voi d Del Li ne(int count=1);
Description

Deletes the current line.

8.4.5.53 Function difftime

Declaration:
unsigned long difftinme(int tinmel[], int tine2[]);
Description

Obtains the time difference between the two counts transferred in the timel and time2 arrays. The counts
should be obtained with the gettime[299) function; time1 is the earlier count.

Because the gettime function uses the system timer, computation error for the intenal can be as long as 104
milliseconds.

Returned value
The time difference between two counts in milliseconds.
Example

int tinmel[4];
int tinme2[4];
gettinme(tinmel);
while (1)

{

gettine(tinme2);
printf("Difference: %u", difftime(tinel, time2));

8.4.5.54 Function DisplayText

Declaration:
voi d Di spl ayText (unsi gned | ong handl e, char text[], int x, int y);
Description

Displays text in the window using a monospaced font and text coordinates, that is, x is the column number,
and y is the line number.

To display text with any font and in any place, use the DisplayTextF|2_7§’| function.

8.4.5.55 Function DisplayTextF

Declaration:
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voi d Di splayText F(unsi gned | ong handl e, char text[], int x, int y);
Description

Displays text in the window using a proportional font (see the SelectFont[ 334 function) and graphical
coordinates (in pixels).

8.4.5.56 Function Down

Declaration:
voi d Down(int count=1);
Description

Movwe the cursor count lines down. The same result can be achieved by incrementing the CurLine[se2) built-in
variable.

8.4.5.57 Function dup

Declaration:

int dup(long handle);

Description

Duplicates a file handle.

dup creates a new file handle that has the following common features with the original file handle:

Same open file or device
Same file pointer (that is, changing the file pointer of one changes the other)

Same access mode (read, write, read/write))
handlecreat| z5open(=s), dupl23), or dup2[273.
Returned value

Upon successful completion, dup returns the new file handle, a nonnegative integer; otherwise,
dup returns -1. In the event of error, the errnolse3 global variable is set to one of the following

values:
EBADF Bad file number
EMFI LE Too many open files

8.4.5.58 Function dup2

Declaration:

int dup2(long oldhandle, long newhandle);

Description

Duplicates a file handle (oldhandle) onto an existing file handle (newhandle).

dup?2 creates a new file handle that has the following common features with the original file handle:
Same open file or device

Same file pointer (that is, changing the file pointer of one changes the other)
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Same access mode (read, write, read/write)

dup2 creates a new handle with the value of newhandle. If the file associated with newhandle is
open, when dup?2 is called, then the file will be closed.

newhandle and oldhandle are the file handles obtained from the creatl 2], open[=3), duplz9), or
dup2[ 274 call.

Returned value

dup2 returns 0 on successful completion, and -1 otherwise. In the event of error, the errno[3:)
global variable is set to one of the following values:

EBADF Bad file number
EMFILE Too many open files

8.4.5.59 Function Ellipse

Declaration:
void Ellipse(unsigned Iong handle, int x1, int yl, int x2, int y2);
Description

Draws an ellipse using the pen selected with the SelectPen[ 33} function and paints it with the brush selected
by the SelectBrush[33A function; (x1, y1) are the coordinates of the upper left corner of the rectangle, in which
the ellipse will be drawn; (x2, y2) are the coordinates of its lower right corner.

8.4.5.60 Function eof

Declaration:

int eof (I ong handl e);

Description

Checks for end-of-file.

eof determines whether the file associated with handle has reached the end-of-file.
Returned Value

If the current position is the end-of-file, then eof will return 1; otherwise, it will return 0. The return value of -1
indicates an error; the errnol 26 global variable is set to

EBADF Bad file nunber

8.4.5.61 Function Eof

Declaration:
voi d Eof ();
Description

Movwe the cursor to the file end.
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8.4.5.62 Function Eol

Declaration:
voi d Eol ();

Description

Mowe the cursor to the end of the current line.

8.4.5.63 Function exec

Declaration:
int exec(char prograni{], char parans[], char work dir[], int show=SW SHOW ;
Description

Starts a Windows application or DOS.

Parameters:
program - the name of the file under execution
parans - the command |ine paraneters
work _dir - the working directory for the application to be started
show - the constant to define the application wi ndow di splay node.

Constants with the SW_prefix are given in system h.

Note that the script file will not wait for the started application to stop operation, if special measures are not
taken.

Returned value

What was returned by the function API ShellExecute, that is, HINSTANCE of the application or error
message.

Example

exec("pifedit.exe", "conmand. pif");

8.4.5.64 Function ExecMenu

Declaration:
int ExecMenu(char title[], char items[], int start_sel=0);
Description

Displays the dialog menu on the screen.

Parameters:

title - the dialog box title;

items - the line describing the menu itens. Every itemends with the
zero

byte; the last itemends with two zero bytes.
start_sel - the nunmber of the nenu itemthat will be selected by default,
when the w ndow opens.

Returned value

The number of the menu item selected by the user or -1, if the Cancel button or Esc key is pressed. The
selected menu line is copied to the SelectedString [363) built-in variable. If the user cancels the selection,
then the null string will be copied to the Selected String.

Example
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int choice =
ExecMenu(" Choose programto | oad", /1l the title
" Load Exanple #1 \0"
" Load Exanple #2 \0"

" Load Exanple #3 \0" /1l the itens
"\0"); // the second zero at the end
switch (choice)
{
case 0: LoadProgran("EXAMPLELl. OMF", LF_UBROF); break;
case 1: LoadProgran("EXAMPLE2. OW", LF_UBROF); break;
case 2: LoadProgran("EXAMPLE3. OW", LF_UBROF); break;
default: printf("No exanple will be |oaded");

}

8.4.5.65 Function ExecScript

Declaration:

voi d ExecScript(char file_name[], char include_dir[]="", char defines[]="", int
debug=0) ;

Description

The ExecScript function starts the script file, whose name is indicated in the file_name parameter.

Parameters:
file_nane[] The nanme of the script file to be started. It can contain
a partial or full path. If extension is not specified,
the CMD extension will be automatically substituted. If the
file

is not found, the <%CM% systemdirectory will be
automatically scanned.

include_dir[] The listing of directories, where the conpiler will search
for the #include-files. You can specify
multiple directory nanes separated by senicol on.

char defines[] The string with the definitions of preprocessor variables.
Al'so, see the Script Files [179dial og[17d)
debug If not equal to O, then the Script Source window[1 will be

opened for the | oaded script file. After |oading the
script
file, switches to the debug node.

Note that only the first parameter is required, other parameters have the default values.
If the specified script file is already under executing, then another script file cannot be loaded.

Also, see Inclusion of Files (#include)lgh.

8.4.5.66 Function exit

Declaration:
void exit();
Description

Stops execution of the script file that called this function. The file is unloaded from the memory, if possible.
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8.4.5.67 Function ExitProgram

Declaration:
voi d ExitProgram);
Description

Exits the work session of <%CM%> in the same way as by closing its window.

8.4.5.68 Function exp

Declaration:

float exp(float x);

Description

The exp function raises number e to the power x. The argument shall range from -88.72280 to 88.72280.
Returned value

The exp function returns the value of e raised to the power x.

8.4.5.69 Function Expr

Declaration:
unsigned long Expr(char str[]);
Description

Calculates the expression and returns the result as a 32-bit integer. The expression string is
passed in the str parameter.

Example
printf("Result=%08IX", Expr("array[i] -> StartValue");
Also, see AddrExpr(268), FloatExpr|2e8, Expressions|[z1.

8.4.5.70 Function fabs

Declaration:

float fabs(float x);

Description

The fabs function determines the absolute value of the floating-point number val.
Returned function

The fabs function returns the absolute value of val.
8.4.5.71 Function fclose
Declaration:

int fclose(unsigned long stream);

Description
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Closes a stream.

fclose closes the specified stream. All buffers associated with the stream are flushed before
closing. The system-allocated buffers are freed upon closing.

Returned value

fclose returns 0 on success. It will return EOF, if any errors are detected.

8.4.5.72 Function fdopen

Declaration:

unsigned long fdopen(long handle, char type[]);
Description

Associates a stream with a file handle.

obtained from creatl 22dupl 279, dup2[273), or openl=3. The type of stream must match the mode of
the opened handle. The type string used in a call to fdopen is one of the following values:

Value Description

r Open for reading only.

Create for writing.

a Append; open for writing at the end-of-file or create for writing, if the file does not exist.
r+ Open an existing file for update (reading and writing).

w+ Create a new file for update.

at

To specify that the given file is being opened or created in the text mode, append t to the value of
the type string (for example, rt or w+t).

Similarly, to specify the binary mode, append brb or w+b). If t or b is not given in the type string,
the mode is controlled by the _fmode global variable. If _fmode is set to O_BINARY, then files will
be opened in the binary mode. If _fmode is set to O_TEXT, then files will be opened in the text
mode.

Note. The O_* constants are defined in file system.h.

. output cannot be directl